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 1
I n t r o d u c t i o n
This COMSOL Multiphysics Modeling Guide provides an in-depth examination 
of the application modes in COMSOL Multiphysics® and how to use them to 
model different types of physics and to perform equation-based modeling using 
PDEs.

This chapter gives an overview of the available application modes as well as some 
general guidelines for effective modeling.
 1
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Ove r v i ew o f  t h e  COMSOL Mu l t i p h y s i c s  
App l i c a t i o n  Mode s

Solving PDEs generally means you must take the time to set up the underlying 
equations, material properties, and boundary conditions for a given problem. 
COMSOL Multiphysics, however, relieves you of much of this work. The package 
provides a number of application modes that consist of predefined templates and user 
interfaces already set up with equations and variables for specific areas of physics. 
Special properties allow the selection of, for instance, analysis type and model 
formulations. The application mode interfaces consist of customized dialog boxes for 
the physics in subdomains and on boundaries, edges, and points along with predefined 
PDEs. A set of application-dependent variables makes it easy to visualize and 
postprocess the important physical quantities using conventional terminology and 
notation. Adding even more flexibility, the equation system view provides the 
possibility to examine and modify the underlying PDEs in the case where a predefined 
application mode does not exactly match the application you want to model.

Note: Suites of application modes that are optimized for specific disciplines together 
with large model libraries are available in a group of optional products: the AC/DC 
Module, Acoustics Module, Chemical Engineering Module, Earth Science Module, 
Heat Transfer Module, MEMS Module, RF Module, and Structural Mechanics 
Module.

Application Modes in COMSOL Multiphysics

The following table lists the application modes in COMSOL Multiphysics and their 
availability for 1D, 1D axisymmetric, 2D, 2D axisymmetric, and 3D geometries:

APPLICATION MODE 1D 1D AXI 2D 2D AXI 3D

 Acoustics

Acoustics  √  √  √

 Diffusion

Convection and Diffusion  √  √  √  √  √
:  I N T R O D U C T I O N



Diffusion  √  √  √  √  √

 Electromagnetics

AC Power Electromagnetics  √

Conductive Media DC  √  √  √

Electrostatics  √  √  √

Magnetostatics  √  √  √

 Heat Transfer

Convection and Conduction  √  √  √  √  √

Conduction  √  √  √  √  √

 Fluid Dynamics

Incompressible Navier-Stokes  √  √  √

 Structural Mechanics

Plane Strain  √

Plane Stress  √

Axial Symmetry, Stress-Strain  √

Solid, Stress-Strain  √

 Deformed Mesh

Moving Mesh (ALE)  √  √  √  √  √

Parameterized Geometry  √

 Optimization and Sensitivity

Optimization*  √  √  √  √  √

Sensitivity Analysis  √  √  √  √  √

 PDE Modes

Coefficient Form  √  √  √

General Form  √  √  √

Weak Form, Subdomain  √  √  √

Weak Form, Boundary  √  √  √

Weak Form, Edge  √

Weak Form, Point  √  √

 Classical PDEs

Convection-Diffusion Equation  √  √  √

Laplace’s Equation  √  √  √

APPLICATION MODE 1D 1D AXI 2D 2D AXI 3D
O V E R V I E W  O F  T H E  C O M S O L  M U L T I P H Y S I C S  A P P L I C A T I O N  M O D E S  |  3
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* This application mode is available only if your COMSOL installation includes a valid 
license for the Optimization Lab.

As the table indicates, these application modes fall into five broad categories:

T H E  P H Y S I C S  M O D E S

Use the physics modes to instantly access convenient templates for specific application 
areas. Here you can specify physical properties for models in fields such as structural 
mechanics, heat transfer, and electromagnetics. Details on how to use the physics 
modes appear in the section “Using the Physics Modes” on page 13.

T H E  D E F O R M E D  M E S H  A P P L I C A T I O N  M O D E S

These application modes provide support for applications with moving boundaries 
using the Moving Mesh (ALE) application mode and for parameterized geometries in 
2D. See the chapter “Deformed Meshes” on page 445 for more information.

T H E  O P T I M I Z A T I O N  A N D  S E N S I T I V I T Y  A P P L I C A T I O N  M O D E S

The Sensitivity Analysis application mode adds sensitivity analysis to any type of 
multiphysics model. See “Sensitivity Analysis” on page 287 for more information.

The Optimization application mode provides functionality for combining multiphysics 
modeling with optimization. See the chapter “Optimization” on page 309 for details.

Note: The Optimization application mode requires the Optimization Lab.

T H E  P D E  M O D E S

Turn to these modes to model directly with PDEs when you cannot find a suitable 
physics mode. With these modes you define the problem in terms of mathematical 
expressions and coefficients.

Heat Equation  √  √  √

Helmholtz Equation  √  √  √

Poisson’s Equation  √  √  √

Schrödinger Equation  √  √  √

Wave Equation  √  √  √

APPLICATION MODE 1D 1D AXI 2D 2D AXI 3D
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COMSOL Multiphysics includes three PDE modes:

• The Coefficient form allows you to solve linear or almost linear problems using 
PDEs and coefficients that often correspond directly to various physical properties.

• The General form provides a computational framework specialized for highly 
nonlinear problems. Consider using a weak form for these problems, too.

• The Weak form makes it possible to model a wider class of problems, for example 
models with mixed time and space derivatives, or models with phenomena on 
boundaries, edges, or points as described with PDEs. In terms of convergence rate, 
these modes also set a computational framework suited for all types of nonlinear 
problems. 

For details on how to apply the PDE modes, see the sections “PDE Modes for 
Equation-Based Modeling” on page 245 and “The Weak Form” on page 345.

C L A S S I C A L  P D E S

The Classical PDEs folder contain application modes that describe a suite of 
well-known PDEs. They are special cases of the coefficient form PDE and are not 
meant to serve as templates.

Selecting an Application Mode

When creating a model in COMSOL Multiphysics, you can select a single application 
mode that describes one type of physics or select several application modes for 
multiphysics modeling and coupled-field analyses.

M O D E L I N G  U S I N G  A  S I N G L E  A P P L I C A T I O N  M O D E

Most of the physics application modes contain stationary, eigenvalue, and dynamic 
(time-dependent) analysis types. As already mentioned, these application modes 
provide modeling interfaces where you can create models using material properties, 
boundary conditions, and initial conditions. Each of the application modes comes with 
a template that automatically supplies the appropriate underlying PDE.

If you cannot find a physics mode that matches a given problem, try one of the PDE 
modes, which allow you to define a custom model in general mathematical terms. 
Indeed, COMSOL Multiphysics can model virtually any scientific phenomenon or 
engineering problem that originates from the laws of science.
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M U L T I P H Y S I C S  M O D E L I N G  U S I N G  M U L T I P L E  A P P L I C A T I O N  M O D E S

When modeling real-world systems, you often need to include the interaction between 
different kinds of physics. For instance, the properties of an electronic component such 
as an inductor vary with temperature. To solve such a problem, combine two or several 
application modes into a single model using the multiphysics features of COMSOL 
Multiphysics. For the example just mentioned, combine the Conductive Media DC 
and Heat Transfer by Conduction application modes. In this way you create a system 
of two PDEs with two dependent variables: V for the electric potential and T for the 
temperature. There are also predefined multiphysics couplings that provide two or 
more coupled application modes for some common multiphysics applications.

Combining physics modes and PDE modes also works well. Assume, for instance, that 
you want to model the fluid-structure interactions due to the vibrations of yoghurt in 
a cardboard container as it rides on a conveyor belt. You could start with the Plane 
Stress mode for structural mechanics to model the container walls and then add a PDE 
to model the irrotational flow of the fluid. This approach also creates a system of two 
PDEs but requires that you define one of them from scratch, in this case using the 
general PDE formulation.

To summarize the proposed strategy for modeling processes that involve several types 
of physics: Look for application modes suitable for the phenomena of interest. If you 
find them among the physics modes, use them; if not, add one or more PDE modes.

The approach when coupling multiple application modes is to use the dependent 
variables or their derivatives directly, or to use expressions containing the dependent 
variables. The coupling can occur in subdomains and on boundaries.
:  I N T R O D U C T I O N



Mode l i n g  Gu i d e l i n e s

To allow you to model large-scale problems, COMSOL Multiphysics lets you tune 
solver settings and use symmetries and other model properties to reach a solution or—
failing that—interrupt the solution process to retrieve a partial solution.

Using Symmetries

By using symmetries in a model you can reduce its size by one-half or more, making 
this an efficient tool for solving large problems. This applies to the cases where the 
geometries and modeling assumptions include symmetries.

The most important types of symmetries are axial symmetry and symmetry and 
antisymmetry planes or lines:

• Axial Symmetry is common for cylindrical and similar 3D geometries. If the 
geometry is axisymmetric, there are variations in the radial (r) and vertical (z) 
direction only and not in the angular (θ) direction. You can then solve a 2D problem 
in the rz-plane instead of the full 3D model, which can save considerable memory 
and computation time. Many COMSOL Multiphysics application modes are 
available in axisymmetric versions.

• Symmetry and Antisymmetry Planes or Lines are common in both 2D and 3D 
models. Symmetry means that a model is identical on either side of a dividing line 
or plane. For a scalar field, the normal flux is zero across the symmetry line. In 
structural mechanics, the symmetry conditions are different. Antisymmetry means 
that the loading of a model is oppositely balanced on either side of a dividing line 
or plane. For a scalar field, the dependent variable is 0 along the antisymmetry plane 
or line. Structural mechanics applications have other antisymmetry conditions. 
Many application modes have symmetry conditions directly available in the 
Boundary Settings dialog box.

To take advantage of symmetry planes and symmetry lines, all of the geometry, 
material properties, and boundary conditions must be symmetric, and any loads or 
sources must be symmetric or antisymmetric. You can then build a model of the 
symmetric portion, which can be half, a quarter, or an eighth of the full geometry, and 
apply the appropriate symmetry (or antisymmetry) boundary conditions.
M O D E L I N G  G U I D E L I N E S  |  7
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Effective Memory Management

Especially in 3D modeling, extensive memory usage dictates some extra precautions. 
First, check that you have selected an iterative linear system solver. Normally you do 
not need to worry about which solver to use, because the application mode makes an 
appropriate default choice. In some situations, though, it might be necessary to make 
additional changes to the solver settings and the model.

E S T I M A T I N G  T H E  M E M O R Y  U S E  F O R  A  M O D E L

Out-of-memory messages occur when COMSOL Multiphysics tries to allocate an 
array that does not fit sequentially in memory. It is common that the amount of 
available memory seems large enough for an array, but there might not be a contiguous 
block of that size due to memory fragmentation. The only solver that requires a single 
large contiguous memory block is the UMFPACK direct solver.

In estimating how much memory it takes to solve a specific model, the following 
factors are the most important:

• The number of node points

• The number of dependent and independent variables

• The element order

• The sparsity pattern of the system matrices. The sparsity pattern, in turn, depends 
on the shape of the geometry and the mesh. For example, an extended ellipsoid 
gives sparser matrices than a sphere.

The PARDISO out-of-core solver can make use of available disk space to solve large 
models that do not fit in the available memory.

C R E A T I N G  A  M E M O R Y - E F F I C I E N T  G E O M E T R Y

A first step when dealing with large models is to try to reduce the model geometry as 
much as possible. Often you can find symmetry planes and reduce the model to a half, 
a quarter or even an eighth of the original size. Memory usage does not scale linearly 
but rather polynomially (Cnk, k > 1), which means that the model needs less than half 
the memory if you find a symmetry plane and cut the geometry size by half. Other 
ways to create a more memory-efficient geometry include:

• Avoiding small geometry objects where not needed and using Bézier curves instead 
of polygon chains.
:  I N T R O D U C T I O N



• Making sure that the mesh elements are of a high quality. Mesh quality is important 
for an iterative linear system solver. Convergence is faster and more robust if the 
element quality is high.

• Avoiding geometries with sharp, narrow corners. Mesh elements get thin when they 
approach sharp corners, leading to poor element quality in the adjacent regions.

Selecting an Element Type

As the default element type for most application modes, COMSOL Multiphysics uses 
second-order Lagrange elements or shape functions (see “Finite Elements” on page 
484 of the COMSOL Multiphysics Reference Guide for an overview of the available 
element types). These and other higher-order elements add additional degrees of 
freedom on midpoint and interior nodes in the mesh elements. These added degrees 
of freedom provide a more accurate solution but also require more memory due to the 
reduced sparsity of the discretized system. For many application areas, such as stress 
analysis in structural and solid mechanics, the increased accuracy of a second-order 
element is important. In fluid-flow modeling using the incompressible Navier-Stokes 
equations, a combination of element types using an element for the velocity 
components of a higher order than that for the pressure usually provides the best 
result. The default element for the Incompressible Navier-Stokes application mode is 
the P2-P1 element using second-order elements for the velocity components and 
linear elements for the pressure. For other applications you can select a first-order 
element instead of a second-order element, or reduce the element order in general, to 
reduce memory use.

Analyzing Model Convergence and Accuracy

It is important that the finite element model accurately captures local variations in the 
solution such as stress concentrations. In some cases you can compare your results to 
values from handbooks, measurements, or other sources of data. Many examples in the 
COMSOL Multiphysics Modeling Guide and the COMSOL Multiphysics Model 
Library include comparisons to established results or analytical solutions. Look for 
these benchmark models as a means of checking results.

If a model has not been verified by other means, a convergence test is useful for 
determining if the mesh density is sufficient. Here you refine the mesh and run the 
analysis again, and then you see if the solution is converging to a stable value as the 
mesh is refined. If the solution changes when you refine the mesh, the solution is mesh 
dependent, so the model requires a finer mesh. You can use adaptive mesh refinement 
M O D E L I N G  G U I D E L I N E S  |  9
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(see “Avoiding Inverted Mesh Elements” on page 374 of the COMSOL Multiphysics 
User’s Guide), which adds mesh elements based on an error criterion to resolve those 
areas where the error is large.

For convergence, it is important to avoid singularities in the geometry (see “Avoiding 
Singularities and Degeneracies in the Geometry” on page 94 of the COMSOL 
Multiphysics User’s Guide for more information).

Achieving Convergence When Solving Nonlinear Equations

Nonlinear problems are often difficult to solve. In many cases, no unique solution 
exists. COMSOL Multiphysics uses a Newton-type iterative method to solve nonlinear 
systems of PDEs. This solution method can be sensitive to the initial estimate of the 
solution. If the initial conditions are too far from the desired solution, convergence 
might be impossible, even though it might be simple from a different starting value.

You can do several things to improve the chances for finding the relevant solutions to 
difficult nonlinear problems:

• Provide the best possible initial values.

• Solve sequentially and iterate between single-physics equations; finish by solving the 
fully coupled multiphysics problem when you have obtained better starting guesses.

• Ensure that the boundary conditions are consistent with the initial solution and that 
neighboring boundaries have compatible conditions that do not create singularities.

• Refine the mesh in regions of steep gradients.

• For convection-type problem, introduce artificial diffusion to improve the 
problem’s numerical properties (see “Stabilization Techniques” on page 481). Most 
application modes for fluid flow provide artificial diffusion as part of the default 
settings.

• Scaling can be an issue when one solution component is zero. In those cases, the 
automatic scaling might not work. See “Scaling of Variables and Equations” on page 
531 of the COMSOL Multiphysics Reference Guide for more information.

• Turn a stationary nonlinear PDE into a time-dependent problem. Making the 
problem time dependent generally results in smoother convergence. By making sure 
to solve the time-dependent problem for a time span long enough for the solution 
to reach a steady state, you solve the original stationary problem.

• Use the parametric solver and vary a material property or a PDE coefficient starting 
from a value that makes the equations less nonlinear to the value at which you want 
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to compute the solution. This way you solve a series of increasingly difficult 
nonlinear problems. The solution of a slightly nonlinear problem that is easy to solve 
serves as the initial value for a more difficult nonlinear problem.

Avoiding Strong Transients

If you start solving a time-dependent problem with initial conditions that are 
inconsistent, or if you use boundary settings or subdomain settings that switch 
instantaneously at a certain time, you induce strong transient signals in a system. The 
time-stepping algorithm then takes very small steps to resolve the transient, and the 
solution time might be very long, or the solution process might even stop. Stationary 
problems can run into mesh-resolution issues such as overshooting and undershooting 
of the solution due to infinite flux problems.

Unless you want to know the details of these transients, start with initial conditions 
that lead to a consistent solution to a stationary problem. Only then turn on the 
boundary values, sources, or driving fluxes over a time interval that is realistic for your 
model.

In most cases you should turn on your sources using a smoothed step over a finite time. 
What you might think of as a step function is, in real-life physics, often a little bit 
smoothed because of inertia. The step or switch does not happen instantaneously. 
Electrical switches take milliseconds, and solid-state switches take microseconds. See 
“Specifying Discontinuous Functions” on page 149 of the COMSOL Multiphysics 
User’s Guide for information about smoothed step functions to try out.

Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
M O D E L I N G  G U I D E L I N E S  |  11
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the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates code.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
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U s i n g  t h e  P h y s i c s  M o d e s
This chapter provides an overview of the physics application modes within 
COMSOL Multiphysics. It goes on to describe how these application modes make 
modeling various types of physics easier, faster, and more efficient. Later chapters 
review each physics mode in detail, including step-by-step examples of how to build 
and solve models for that particular physics application.
 13
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Th e  Ph y s i c s  Mode s

One convenient way to solve a physics problem is to set it up with the assistance of 
templates that COMSOL Multiphysics provides in the form of its physics modes. The 
software computes the PDE coefficients based on application-specific parameters and 
material properties that you supply, such as Young’s modulus for a 
structural-mechanics model or the heat capacity for a heat-transfer model.

Defining the Physics for a Model

When working with a physics mode, you have access to all necessary settings for 
material properties, boundary conditions, and other modeling parameters through the 
Physics menu.

S U B D O M A I N  S E T T I N G S  A N D  M A T E R I A L  P R O P E R T I E S

Enter application-specific subdomain properties by choosing Subdomain Settings from 
the Physics menu or double-clicking a subdomain in Subdomain mode, which you 
enter by opening the Subdomain Settings dialog box, by clicking the Subdomain Mode 
button on the Main toolbar, or on the Physics menu by first pointing to Selection Mode 
and then clicking Subdomain Mode. For a complete description of the material 
properties available within each application mode, see the following chapters.

B O U N D A R Y  S E T T I N G S

To set up boundary conditions, choose Boundary Settings from the Physics menu or 
double-click a boundary in Boundary mode, which you enter by opening the Boundary 

Settings dialog box, by clicking the Boundary Mode button on the Main toolbar, or on 
the Physics menu by first pointing to Selection Mode and then click Boundary Mode. The 
Boundary Settings dialog box is slightly different for application mode and provides the 
appropriate boundary conditions. For a complete description of the boundary 
conditions available for the physics modes, see the following chapters.

PO I N T  S E T T I N G S

Some models include point sources or use a point in the geometry to fix the value of 
a variable. To access the point settings, choose Point Settings from the Physics menu or 
double-click a point in Point mode, which you enter by opening the Point Settings 
dialog box, by clicking the Point Mode button on the Main toolbar, or on the Physics 
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menu by first pointing to Selection Mode and then click Point Mode. The Point Settings 
dialog box is not available in all application modes.

PO S T P R O C E S S I N G  U S I N G  A P P L I C A T I O N  M O D E  V A R I A B L E S

With the postprocessing mode you can visualize any variable or expression of variables 
by working with the Plot Parameters, Cross-Section Plot Parameters, and Domain Plot 

Parameters dialog boxes. You can also have COMSOL Multiphysics compute 
integrated values with the help of the Subdomain Integration and Boundary Integration 
dialog boxes.

Each application mode provides a special set of application-specific variables called 
application mode variables. Lists of these variables for each application mode appear 
in the following chapters.

Note: For all application modes you have access to shape-function variables and 
equation variables for the corresponding PDE solution form (coefficient, general, or 
weak). For further details, please refer to “Using Variables and Expressions” on page 
138 of the COMSOL Multiphysics User’s Guide.

The Physics Modes

The following table lists the available physics modes:

TABLE 2-1:  THE PHYSICS MODES

APPLICATION MODE DEFAULT

Suffix
DEPENDENT 
VARIABLES

ANALYSIS 
CAPABILITIES

S
T

A
T

IO
N

A
R

Y

T
IM

E
 D

E
P

E
N

D
E

N
T

T
IM

E
 H

A
R

M
O

N
IC

E
IG

E
N

FR
E

Q
U

E
N

C
Y

ACOUSTICS

Acoustics aco  p  √  √
HEAT TRANSFER

Conduction ht  T  √  √

Convection and Conduction cc  T  √  √
DIFFUSION
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Physics Mode Documentation

Chapters 3–8 in this manual give detailed descriptions of each physics mode, typically 
broken down into the following sections:

VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The Variables and Space Dimensions section describes the dependent and 
independent variables or space dimensions (1D, 2D, 3D, or axisymmetric) you can use 
in the application mode.

Convection and Diffusion cd  c  √  √

Diffusion di  c  √  √
ELECTROMAGNETICS

AC Power Electromagnetics qa  Az  √

Conductive Media DC dc  V  √

Electrostatics es  V  √

Magnetostatics qa  Az  √
STRUCTURAL MECHANICS

Solid, Stress-Strain sld  u, v, w  √  √  √

Plane Stress ps  u, v  √  √  √

Plane Strain pn  u, v  √  √  √

Axial Symmetry, Stress-Strain axi  uor, w  √  √  √
INCOMPRESSIBLE NAVIER STOKES

Incompressible Navier-Stokes, 2D ns  u, v, p  √  √

Incompressible Navier-Stokes, 3D ns  u, v, w, p  √  √

TABLE 2-1:  THE PHYSICS MODES

APPLICATION MODE DEFAULT

Suffix
DEPENDENT 
VARIABLES

ANALYSIS 
CAPABILITIES

S
T

A
T

IO
N

A
R

Y

T
IM

E
 D

E
P

E
N

D
E

N
T

T
IM

E
 H

A
R

M
O

N
IC

E
IG

E
N

F
R

E
Q

U
E

N
C

Y
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P D E  F O R M U L A T I O N

The PDE Formulation section presents the equations the physics mode solves. It also 
lists the material properties, sources, and coefficients in the COMSOL Multiphysics 
formulation.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

The Application Scalar Variables section lists nongeometric variables specific to the 
application mode. The default values are physical constants such as the permittivity of 
vacuum or arbitrary values, for example, the frequency 50 Hz for the AC Power 
Electromagnetics application mode. Not every application mode has application scalar 
variables.

S U B D O M A I N  S E T T I N G S

The Subdomain Settings section lists the subdomain properties in the application 
mode such as material properties and sources and sinks.

B O U N D A R Y  C O N D I T I O N S

The Boundary Conditions section lists the available boundary conditions while 
explaining their physical interpretation and the quantities that you specify to define the 
boundary settings.

L I N E  A N D  PO I N T  S E T T I N G S

In some application modes there are line and point settings for defining line and point 
sources, pressure constraints, and other properties.

A P P L I C A T I O N  M O D E  VA R I A B L E S

The Application Mode Variables section lists all the variables available to you when 
formulating the equation and performing postprocessing. You can create functions of 
these variables for postprocessing and visualizing the analysis and when expressing 
physical properties. The Predefined quantities lists in the dialog boxes for visualization 
and postprocessing do not always include all the variables; if a variable does not appear 
in the list, simply type its name in the Expression edit field.

Application mode variables are defined on the following geometric domains:

• Subdomains: S

• Boundary segments: B

• Edges: E

• Points: P
T H E  P H Y S I C S  M O D E S  |  17
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In the tables that review the application mode variables for each case, the Domain 
column indicates the top level where the variables are defined. Many variables that are 
available on subdomains are also available on boundaries, edges, and points, but they 
then take the average value of the values in the subdomains around the boundary, 
edge, or point (for the subdomains in which the variable is present). In addition to the 
letters above, indicating the domains where the application mode variable is valid, a V 
indicates that it is a vector-valued variable.

In some cases the table also lists the solution form for which a variable is available: 

• Coefficient form: c

• General form: g

• Weak form: w

The Name column in the table of application mode variables lists the variables available 
for use, whereas the Expression column lists the implementation of the application 
mode variables in terms of other variables. The italic i and j in the variable names can 
refer to any of the space coordinates. For example, Ti can mean either Tx, Ty, or Tz in 
3D where the space coordinates are x, y, and z. In 2D axisymmetry, Ti stands for either 
Tr or Tz. Further, you construct the variable names of vector components and tensor 
components using the names of the space coordinates. For example, if an application 
mode uses x1, y1, z1, then the variables for the vector components of the temperature 
gradient are Tx1, Ty1, Tz1.

Note: All application mode variables include a suffix indicating which application 
mode they belong to. Table 2-1 on page 15 lists the default suffix for the physics 
modes. For example, the default suffix added to application mode variable names for 
an Incompressible Navier-Stokes application mode is _ns.

Note: The default space coordinate names are x, y, z for Cartesian coordinate systems 
and r, (phi), and z for cylindrical coordinate systems. It is possible to change these 
names when defining a new geometry in the Model Navigator. The variable t 
represents the time for time-dependent models.

ϕ
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A c o u s t i c s
This chapter describes how to use the Acoustics application mode for modeling 
and simulation of acoustics and vibrations. It consists of three major sections:

• An overview of acoustics modeling

• A description of the Acoustics application mode

• A step-by-step review of how to model a reactive muffler
 19



20 |  C H A P T E R
Fundamen t a l s  o f  A c ou s t i c s

What is Acoustics?

Acoustics is the physics of sound. Sound is the sensation, as detected by the ear, of very 
small rapid changes in the air pressure above and below a static value. This static value 
is atmospheric pressure (about 100,000 pascals), which varies slowly. Associated with 
a sound pressure wave is a flow of energy. Physically, sound in air is a longitudinal wave 
where the wave motion is in the direction of the energy flow. The wave crests are the 
pressure maxima, while the troughs represent the pressure minima.

Sound results when the air is disturbed by some source. An example is a vibrating 
object, such as a speaker cone in a hi-fi system. It is possible to see the movement of a 
bass speaker cone when it generates sound at a very low frequency. As the cone moves 
forward, it compresses the air in front of it, causing an increase in air pressure. Then it 
moves back past its resting position and causes a reduction in air pressure. This process 
continues, radiating a wave of alternating high and low pressure at the speed of sound.

Five Standard Acoustics Problems

Five standard problems or scenarios occur frequently when analyzing acoustics:

• The radiation problem—A vibrating structure (a speaker, for example) radiates 
sound into the surrounding space. A far-away boundary condition is necessary to 
model the unbounded domain.

• The scattering problem—An incident wave impinges on a body and creates a 
scattered wave. A far-away radiation boundary condition is necessary.

• The sound field in an interior space (such as a room)—The acoustic waves stay in a 
finite volume so no radiation condition is necessary.

• Coupled fluid-elastic structure interaction (structural acoustics)—If the radiating or 
scattering structure consists of an elastic material, then you must consider the 
interaction between the body and the surrounding fluid. In the multiphysics 
coupling, the acoustic analysis provides a load (the sound pressure) to the structural 
analysis, and the structural analysis provides accelerations to the acoustic analysis.

• The transmission problem—The incident sound wave propagates into a body, which 
can have different acoustic properties. Pressure and acceleration are continuous on 
the boundary.
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Mathematical Models for Acoustic Analysis

Sound waves in a lossless medium are governed by the following equation for the 
(differential) pressure p (with SI unit N/m2):

Here ρ0 (kg/m3) refers to the density and cs (m/s) denotes the speed of sound. The 
dipole source q (N/m3) and the monopole source Q (1/s2) are both optional. The 
combination ρ0   cs

2 is called the bulk modulus, commonly denoted β (N /m2).

A special case is a time-harmonic wave, for which the pressure varies with time as

where ω = 2π   f (rad/s)  is the angular frequency,  f (Hz) as usual denoting the 
frequency. Assuming the same harmonic time-dependence for the source terms, the 
wave equation for acoustic waves reduces to an inhomogeneous Helmholtz equation:

 (3-1)

With the source terms removed, you can also treat this equation as an eigenvalue PDE 
to solve for eigenmodes and eigenfrequencies.

Typical boundary conditions are:

• Sound-hard boundaries (walls)

• Sound-soft boundaries

• Impedance boundary conditions

• Radiation boundary conditions

These are described in more detail below.

In lossy media, an additional term of first order in the time derivative needs to be 
introduced to model attenuation of the sound waves:
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The damping term is absent from the standard PDE formulations in the Acoustics 
application mode. However, in line with COMSOL Multiphysics’ general modeling 
philosophy, the da coefficient is accessible from the user interface through the 
Subdomain Settings - Equation System dialog box.

Note also that even when the sound waves propagate in a lossless medium, attenuation 
frequently occurs by interaction with the surroundings at the boundaries of the system. 
The tutorial model “Example—Reactive Muffler” on page 35 provides an example of 
this.
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Th e  A c ou s t i c s  App l i c a t i o n  Mode

The Acoustics application mode in COMSOL Multiphysics is designed for the analysis 
of various types of acoustics problems, all concerning pressure waves in a fluid. An 
acoustics model can be part of a larger multiphysics model that describes, for example, 
the interactions between structures and acoustic waves.

Variables and Space Dimensions

The Acoustics application mode solves for the acoustic pressure, p. It is available for 
2D, 2D axisymmetric, and 3D geometries.

PDE Formulation

COMSOL Multiphysics supplies two PDE formulations—or analysis types—for the 
Acoustics application mode from which you can choose:

• Time-harmonic analysis

• Eigenfrequency analysis

T I M E - H A R M O N I C  A N A L Y S I S

The time-harmonic—or frequency-domain—formulation is based on the 
inhomogeneous Helmholtz equation given in Equation 3-1 on page 21 and repeated 
here for convenience:

With this formulation you can compute the frequency response using the parametric 
solver to sweep over a frequency range using a harmonic load.

E I G E N F R E Q U E N C Y  A N A L Y S I S

In the eigenfrequency formulation the source terms are absent and you solve for the 
eigenmodes and the eigenvalues or eigenfrequencies:

 (3-2)

∇ 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ ω2p

ρ0 cs
2

---------------– Q=

∇ 1
ρ0
------– ∇p⎝ ⎠

⎛ ⎞⋅ λ2 p

ρ0 cs
2

-------------+ 0=
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The eigenvalue λ introduced in this equation is related to the eigenfrequency, f, 
through λ = −i2π f.

You can switch between specifying the eigenfrequencies and the eigenvalues by 
choosing Properties from the Physics menu and changing the value of the property  
Specify eigenvalues using in the Application Mode Properties dialog box. There you can 
also change the analysis type.

Equations 3-1 and 3-2 are both defined in three space dimensions. Because they are 
given in coordinate-independent notation, the equations apply to 2D, 2D 
axisymmetric, and 3D models alike. However, upon expanding the operators, the 
extra symmetries possessed by 2D and 2D axisymmetric models imply that the 
equations can be further adapted to the case at hand. For this reason, the general 
discussion that follows immediately below applies in all its details only to the 3D case, 
while the particularities of the remaining cases are presented in two separate 
subsections.

Subdomain Settings

The application-mode characteristic quantities defined on subdomains are:

• In the Fluid density edit field you enter the density of the fluid in which the acoustic 
waves propagate. The default value is 1.25 kg/m3, the density of air expressed in SI 
units.

• The Speed of sound edit field takes the speed of the sound wave. The default value 
is 343 m/s, the speed of sound in air at approximately 20 degrees Celsius.

• The Dipole source edit fields contain the individual components of the dipole source 
vector, q, one for each space dimension. The dipole source has the SI unit N/m3. 
Its default value is 0.

• The monopole source term Q in the Monopole source edit field has the SI unit 1/s2. 
It has the default value 0.

QUANTITY VARIABLE DESCRIPTION

 ρ0 rho0 Fluid density

 cs cs Speed of sound

 q qx, qy, qz Dipole source

 Q Q Monopole source

∇
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You specify these properties in the Subdomain Settings dialog box.

Boundary Conditions

This section describes the boundary conditions available for the Acoustics application 
mode and lists the analysis types to which each condition applies.

S O U N D - H A R D  B O U N D A R I E S  ( WA L L S )

A sound-hard boundary is a boundary at which the normal component of the 
acceleration is zero:

For zero dipole charge and constant fluid density, this means that the normal derivative 
of the pressure is zero at the boundary:

Sound-hard boundaries are available for all analysis types.

S O U N D - S O F T  B O U N D A R I E S

At a sound-soft boundary the differential pressure vanishes:

n–
1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ 0=

n∂
∂p 0=

p 0=
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Sound-soft boundaries are also available for all analysis types.

P R E S S U R E  S O U R C E

This boundary condition means that you specify a constant acoustic pressure to be 
maintained at the boundary:

 

The pressure-source condition is available only for time-harmonic analysis.

I M P E D A N C E  B O U N D A R Y  C O N D I T I O N

The impedance boundary condition is a generalization of the sound-hard and 
sound-soft boundary conditions:

Here Z (SI unit Pa·s/m ) is the acoustic input impedance of the external domain. From 
a physical point of view, the acoustic input impedance is the ratio between pressure and 
normal particle velocity.

The impedance boundary condition is a good approximation for a locally reacting 
surface—a surface for which the normal velocity at any point depends only on the 
pressure at that exact point.

Note that in the two opposite limits  and , the sound-hard and 
sound-soft boundary conditions are recovered. Impedance boundary conditions are 
available for time-harmonic and transient analysis.

R A D I A T I O N  B O U N D A R Y  C O N D I T I O N S

The radiation boundary conditions allow an outgoing wave to leave the modeling 
domain with minimal reflections. In specifying a boundary condition of this kind you 
have the choice between three wave types: plane, cylindrical, or spherical. You can thus 
adapt the condition to the geometry of your modeling domain.

The radiation boundary conditions read

p p0=

n 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ iωp
Z

----------– 0=

Z ∞→ Z 0→

n–
1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ ik κ r( )+( ) p
ρ0
------+ ik κ r( ) i k n⋅( )–+( )

p0
ρ0
------e

i k r⋅( )–
=
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where k is the wave number (a predefined application-mode variable; see Table 3-1 on 
page 30) and κ ( r ) is a function whose form depends on the wave type:

• Plane wave: κ( r ) = 0

• Cylindrical wave: κ( r ) = 1 / (2 r)

• Spherical wave: κ( r ) = 1 / r

In the latter two cases, r is the shortest distance from the point r = (x, y, z) on the 
boundary to the source. The right-hand side of the equation represents an optional 
incoming plane pressure wave with amplitude p0 and wave vector k = k nk, where nk 
denotes the unit vector in the direction of propagation.

To define a radiation boundary condition, select a plane, cylindrical, or spherical wave 
from the Wave type list. In addition, you must specify:

• p0—the pressure source amplitude

• nk—the wave direction vector

• r0 = (x0, y0, z0)—a point on the source axis (for a cylindrical wave) or the source 
location (for a spherical wave)

• raxis—the source axis direction (only for cylindrical waves)

The default value of  nk is the inward normal vector, −n, which is the natural direction 
for waveguides and similar structures. For wave propagation in open space, k can point 
in any direction.

Note: You do not have to normalize the vector whose components you enter in the 
Wave direction edit fields; the software explicitly normalizes the components to make 
nk a unit vector in the direction that you specify.

Radiation boundary conditions are available for time-harmonic analysis only.

S P E C I F I E D  N O R M A L  A C C E L E R A T I O N

The inward normal acceleration an represents an external source term. You can also 
use it for coupling your acoustics model to a structural analysis. The specified normal 
acceleration is available for time-harmonic analysis.

n–
1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ an=
T H E  A C O U S T I C S  A P P L I C A T I O N  M O D E  |  27



28 |  C H A P T E R
I N T E R F A C E  C O N D I T I O N S  O N  B O R D E R S

The set of interface conditions for interior boundaries in the Acoustics application 
mode is:

•  Continuity

•  Sound soft boundaries—p = 0

•  Pressure condition—p = p0 (not available for eigenvalue analysis)

Scalar Variables

The following scalar variables appear in the Acoustics application mode, independently 
of the number of space dimensions:

Here H and E stands for time-harmonic analysis and eigenfrequency analysis, 
respectively.

•  Frequency—This is an important property for time-harmonic acoustics analysis. It 
is related to the angular frequency by the equation

QUANTITY VARIABLE DESCRIPTION ANALYSIS

 f freq Frequency H

 iω iomega Imaginary angular frequency E

 pref p_ref Reference pressure Both

n 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞
1

1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞
2

–⋅ 0=
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The wavelength is given by λ = cs / f. Therefore, the higher the frequency, the shorter 
the wavelength. To resolve a wave, it is important that the mesh size be smaller than 
the wavelength. As a rule of thumb, use a minimum mesh resolution of a few 
elements per wavelength with the default second-order Lagrange elements. 

Another important acoustics property is the wave number, k, which is defined as

•  Imaginary angular frequency—For the eigenfrequency analysis type the quantity 
iω is used as a scalar variable in place of the frequency, f. By default, it is related to 
the eigenvalue, λ, by the equation

(Note that the symbol λ is used here in a different meaning than in the previous 
paragraph.)

•  Reference pressure—The zero level on the dB scale varies with the type of fluid. The 
default value (which is the standard value for air) is 0.02 mPa (20·10−6 Pa), which 
then corresponds to 0 dB. This variable occurs only in calculations of the sound 
pressure level based on the root mean square (rms) pressure,

an expression valid for the case of harmonically time-varying acoustic pressure, p.

Application Mode Variables

The variables in the following table are available for use in expressions and for 
postprocessing purposes. Almost all application-mode parameters are available as 

ω 2πf=

k 2π
λ

------ ω
cs
----= =

iω λ–=

p 1
2
--- p conj p( )=
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variables. Some variables are available only in certain analysis types as indicated in the 
Analysis column, where an H means that the variable is available only for 
time-harmonic analysis. The table uses an index convention where a single index i 
denotes any one of the global space variables (x, y, z) while a summation over  i runs 
over all three space dimensions.

TABLE 3-1:  ACOUSTICS APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

p  p Both All Pressure  p

Lp  Lp Both S Sound pressure 
level

rho0  ρ0 Both S Fluid density  ρ0

cs  cs Both S Speed of sound  cs

k  k Both S Wave number  ω /cs

qi  qi Both S Dipole source, 
xi component

 qi

normq  | q | Both S Dipole source, 
norm

ai  ai Both S Local acceleration, 
xi component

norma  | a | Both S Local acceleration, 
norm

na  an Both B Outward normal 
acceleration

vi  vi H S Local velocity, 
xi component

 ai/(iω)

normv  | v | Both S Local velocity, 
norm

nv  vn H B Outward normal 
velocity

 an/(iω)

10 p
2

p0
2

------
⎝ ⎠
⎜ ⎟
⎛ ⎞

log

qi
2

i
∑

1
ρ0
------–

xi∂
∂p qi–⎝ ⎠
⎛ ⎞

ai
2

i
∑

n 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅

vi
2

i
∑
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To form the complete application mode variable names, add a suffix consisting of an 
underscore and the application mode name (default: aco), for example, Lp_aco. (This 
does not apply to the dependent variable for the pressure.)

Units

The following table collects the SI units for the most important physical quantities in 
the Acoustics application mode:

2D

P D E  F O R M U L A T I O N

In 2D, the independent variables are the Cartesian coordinates x and y, while the 
model is assumed to be uniform in the perpendicular z direction. Under this 
assumption, any wave motion in the latter direction is accounted for by specifying the 
out-of-plane wave number, kz, defined by the equation

Ii  Ii Both S Intensity, 
xi component

normI  I Both S Intensity, norm

QUANTITY SYMBOL SI UNIT ABBREVIATION

Pressure  p pascal Pa

Density  ρ kilogram/meter3 kg/m3

Frequency  f hertz Hz

Wave number  k 1/meter 1/m

Dipole source  q newton/meter3 N/m3

Monopole source  Q 1/second2 1/s2

Speed of sound  cs meter/second m/s

Acoustic impedance  Z pascal-second/meter Pa·s/m

Normal acceleration  an meter/second2 m/s2

Source location  r0 meter m

Wave direction  nk (dimensionless) 1

TABLE 3-1:  ACOUSTICS APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

conj vi( ) p

Ii
2

i
∑
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 (3-3)

Time-Harmonic Analysis
Using Equation 3-3 and expanding the 3D  operators in Equation 3-1, the equation 
for the pressure, p(x ,  y), becomes

where the ’s denote 2D differential operators.

Eigenfrequency Analysis
Identical reasoning as for the time-harmonic case leads to the equation

S C A L A R  V A R I A B L E S

In addition to the scalar variables available in the three-dimensional case, in 2D you 
can also specify the value of the out-of-plane wave number, kz:

The default value of kz is 0.

A P P L I C A T I O N  M O D E  V A R I A B L E S

With the interpretation that the index i stands for either x or y and that summations 
run over these two values, all variables listed in Table 3-1 on page 30 are defined also 
in the 2D case.

QUANTITY VARIABLE DESCRIPTION ANALYSIS TYPE

 f freq Frequency (time-harmonic) H

 iω iomega Imaginary angular frequency E

 kz kz Out-of-plane wave number Both

 pref p_ref Reference pressure Both

p x y z t, , ,( ) p x y,( )ei ωt kz– z( )
=( )

∇

∇ 1
ρ0
------– ∇p q–( )⋅ ω

cs
------⎝ ⎠
⎛ ⎞ 2

kz
2

–
p
ρ0
------– Q=

∇

∇ 1
ρ0
------– ∇p⎝ ⎠

⎛ ⎞⋅ λ
cs
------⎝ ⎠
⎛ ⎞ 2

kz
2

+
p
ρ0
------+ 0=
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2D Axisymmetric

P D E  F O R M U L A T I O N

In the 2D axisymmetric case, the independent variables are the radial coordinate, r, and 
the axial coordinate, z. The only dependence of the azimuthal coordinate, , allowed 
is through a phase factor:

 (3-4)

where m denotes the circumferential wave number. Because  is a periodic 
coordinate, m must be an integer.

Time-Harmonic Analysis
Using Equation 3-4 and expanding the operators in Equation 3-1, leads to the 
following equation for the acoustic pressure,  p(r ,  z):

Eigenfrequency Analysis
The corresponding eigenvalue equation reads

B O U N D A R Y  C O N D I T I O N S

Axial Symmetry
This condition is available only for axisymmetric models, where it applies to the 
symmetry boundary  r = 0.

S C A L A R  V A R I A B L E S

Beside the scalar variables common with the 3D and 2D cases, you can specify the value 
of the circumferential wave number, m, in the 2D axisymmetric case:

QUANTITY VARIABLE DESCRIPTION ANALYSIS TYPE

 f freq Frequency H

 iω iomega Imaginary angular frequency E

 m m Circumferential wave number Both

 pref p_ref Reference pressure for dB computation Both

ϕ

p r ϕ z t, , ,( ) p r z,( )ei ωt mϕ–( )
=

ϕ

∇

∇ 1
ρ0
------– ∇p q–( )⋅ ω

cs
------⎝ ⎠
⎛ ⎞ 2 m

r
-----⎝ ⎠
⎛ ⎞ 2

–
p
ρ0
------– Q=

∇ 1
ρ0
------– ∇p⎝ ⎠

⎛ ⎞⋅ λ
cs
------⎝ ⎠
⎛ ⎞ 2 m

r
-----⎝ ⎠
⎛ ⎞ 2

+
p
ρ0
------+ 0=
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The default value of m is 0.

A P P L I C A T I O N  M O D E  V A R I A B L E S

With the interpretation that the index i stands for either r or z and that summations 
run over these two values, Table 3-1 on page 30 applies also to the 2D axisymmetric 
case.
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Examp l e—Rea c t i v e  Mu f f l e r

Introduction

This model examines the sound-transmission properties of an idealized reactive 
muffler with infinitely long inlet and outlet pipes (or a reflection-free source at the inlet 
pipe and a reflection-free end of the outlet pipe) and one expansion chamber. One 
measure of the transmission properties is the transmission-loss coefficient, Dtl, which 
is defined as

where Wi is the time-averaged incident sound power and Wt is the transmitted sound 
power. This problem has a theoretical 1D solution that you can compare with the FEM 
solution.

Model Definition

In the following figure, a plane sound wave enters the inlet pipe (left) and is reflected 
and attenuated in the expansion chamber. The attenuated sound wave exits through 
the outlet pipe (right).

The diameter of both the inlet pipe and the outlet pipe is d, and the corresponding 
cross-sectional area is S1. The expansion chamber has a diameter D  with a 
corresponding cross-sectional area S2.

Dtl 10
Wi
Wt
-------⎝ ⎠
⎛ ⎞log⋅=

Expansion 

L

d
D

Inlet pipe Outlet pipe

chamber

Symmetry line
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According to Ref. 1, the 1D theoretical solution for the transmission loss to this 
problem is

where k is the wave number; S1 and S2 are the areas of the pipes and expansion 
chamber; and L gives the length of the expansion chamber.

The model computes the pressure, p, for the fluid in the region defined by the above 
geometry. This is a time-harmonic problem so you can use the Helmholtz equation 
defined in the axisymmetric Acoustics application mode:

where ω = 2π  f  is the angular frequency, ρ0 is the fluid density, and cs is the speed of 
sound. The q term is a dipole source with the dimension of force per volume.

Because this is an axisymmetric model, you need to include only half of the geometry 
as indicated in the following figure:

You must apply axial symmetry boundary conditions on the line of symmetry.

Assume the walls are rigid, and thus use sound-hard (wall) boundary conditions,

which means that the normal derivative of the pressure is zero at the boundaries.

Radiation boundary conditions describe the inlet and outlet boundaries:

Dtl 10 1
S1

2 S2⋅
--------------

S2
2 S1⋅
--------------–⎝ ⎠

⎛ ⎞
2

kL( )2sin( )⋅+log⋅=

∇ 1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ ω2p

ρ0 cs
2

---------------– 0=

Expansion Inlet pipe Outlet pipe
chamber

Line of symmetry

n∂
∂p 0=

n–
1
ρ0
------– ∇p q–( )⎝ ⎠

⎛ ⎞⋅ ik
ρ0
------⎝ ⎠

⎛ ⎞p+
ik i k n⋅( )–( ) p0 e

i k r⋅( )–

ρ0
------------------------------------------------------------------=
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The radiation boundary condition is useful when the surroundings are merely a 
continuation of the domain, which is the case in this model. The term on the 
right-hand side represents an incoming pressure wave with an amplitude p0 and a 
direction given by the wave vector, k. In this model, an incoming pressure wave with 
the amplitude p0 = 1 Pa enters at the inlet boundary.

To determine the transmission loss in the model, you must first calculate the incident 
and transmitted time-averaged sound intensities and the corresponding sound power 
values. The equation

gives the time-averaged sound intensities where p is equal to p0 at the inlet and the 
computed solution at the outlet.

Using the boundary integration tool, you can evaluate the incident and transmitted 
sound powers, W, as:

Results and Discussion

Figure 3-1 shows the theoretical transmission loss (square markers) and the COMSOL 
Multiphysics solution (triangle markers) as a function of frequency. The theoretical 
solution has an upper frequency limit for its validity. This limit is the cut-on frequency, 
which defines the frequency range where only plane waves can propagate; above this 
frequency, also higher modes can propagate.

According to Ref. 1, the first cut-on frequency for a pipe is

.

Its value in this case is approximately 332 Hz, but it is evident from the above figure 
that a discrepancy exists between the theoretical and the FEM solution, even below the 
cut-on frequency. The discrepancy also increases with frequency between the 1D 
theoretical model and a 3D analysis, as you can see in Ref. 1. In the lower frequency 
range, however, there is good agreement between the theoretical solution and the 
FEM solution.

I p2

2ρ0 c
-------------=

W I 2πr⋅( ) rd∫=

f01 1.841 c
πD
--------=
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Figure 3-1: Muffler transmission loss versus frequency: theoretical solution (squares) and 
COMSOL Multiphysics solution (triangles).

Reference

1. H.P. Wallin, Ljud och Vibrationer, Institutionen för Farkostteknik, KTH, 
Stockholm, Sweden, 1999 (in Swedish).

Model Library path: COMSOL_Multiphysics/Acoustics/reactive_muffler

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go to the Model Navigator and select Axial symmetry (2D) in the Space dimension list.

2 In the list of application modes open the COMSOL Multiphysics>Acoustics>Acoustics 

folder and then select Time-harmonic analysis.

3 Click OK.
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O P T I O N S  A N D  S E T T I N G S

1 Go to the Options menu and choose Constants to parameterize the model.

2 In the Constants dialog box enter the following constants, representing fluid 
properties and some geometrical properties to calculate the cut-on frequency and 
the theoretical transmission loss:

G E O M E T R Y  M O D E L I N G

1 Shift-click the Rectangle/Square button to specify a rectangle.

2 Go to the Rectangle dialog box and type 0.3 in the Width edit field and 1 in the 
Height edit field.

3 Click OK.

4 Click the Zoom Extents button.

5 Shift-click the Rectangle/Square button to specify another rectangle.

NAME EXPRESSION DESCRIPTION

rho_air 1.2[kg/m^3] Density of air

c_air 340[m/s] Speed of sound in air

p0 1[Pa] Pressure-source amplitude

d 0.3[m] Diameter, pipes

D 0.6[m] Diameter, expansion chamber

S1 pi*d^2/4 Cross-sectional area, pipes

S2 pi*D^2/4 Cross-sectional area, expansion 
chamber

L 2[m] Length, expansion chamber

f01 1.841*c_air/(pi*D) First cut-on frequency

freq 20[Hz] Sound frequency
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6 In the Rectangle dialog box, type 0.6 in the Width edit field, 2 in the Height edit field, 
and 1 in the z edit field. Click OK.

7 Shift-click the Rectangle/Square button to specify a third rectangle.

8 In the Rectangle dialog box type 0.3 in the Width edit field, 1 in the Height edit field, 
and 3 in the z edit field. Click OK.

9 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Subdomain Settings
This model uses the fluid properties of air, specified in SI units.

Enter these quantities:

1 From the Physics menu choose Subdomain Settings.

2 In the Subdomain Settings dialog box select all subdomains from the Subdomain 

selection list.

3 Type rho_air in the Fluid density edit field.

4 Type c_air in the Speed of sound edit field.

5 Leave the default settings (all 0) for the Dipole source and the Monopole source.

6 Click OK.

QUANTITY ALL SUBDOMAINS

 ρ0 rho_air

 cs c_air
 3 :  A C O U S T I C S



Boundary Conditions
1 From the Physics menu choose Boundary Settings.

2 In the Boundary Settings dialog box enter the following boundary condition types 
and properties:

3 Select Boundaries 1, 3, and 5 in the Boundary selection list.

4 Select Axial symmetry in the Boundary condition list.

5 Select Boundaries 8–12 in the Boundary selection list.

6 Select Sound hard boundary (wall) in the Boundary condition list.

7 Select Boundary 2 in the Boundary selection list.

8 Select Radiation condition in the Boundary condition list.

9 Type 1 in the Pressure source edit field.

10 Finally select Boundary 7 in the Boundary selection list.

11 Select Radiation condition in the Boundary condition list.

12 Click OK.

SETTINGS BOUNDARIES 1, 3, 5 BOUNDARIES 8–12 BOUNDARY 2 BOUNDARY 7

Boundary 
condition

Axial symmetry Sound hard 
boundary (wall)

Radiation 
condition

Radiation 
condition

Wave type Plane wave Plane wave

p0 1 0
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Expression Variables
1 On the Options menu, point to Expressions, and then click Scalar Expressions.

2 In the Scalar Expressions dialog box enter the following:

The red brackets in the Unit column for D_tl appear because P_in and P_out, 
which you define as integration coupling variables shortly, do not have units. 
Because the expression is, nevertheless, dimensionally correct, you can ignore this 
warning.

3 Click OK.

4 Go to the Options menu and choose Expressions and then Boundary Expressions.

5 In the Boundary Expressions dialog box select Boundary 2 from the Boundary 

selection list and enter the following boundary expression variable:

6 In the Boundary Expressions dialog box select Boundary 7 from the Boundary 

selection list and enter the following boundary expression variable:

NAME EXPRESSION DESCRIPTION

k 2*pi*freq/c_air Wave number

D_tl_analytical 10*log10(1+(S1/(2*S2)- 
S2/(2*S1))^2*(sin(k*L))^2)

Transmission loss, 
theoretical 1D model

D_tl 10*log10(P_in/P_out) Transmission loss

NAME EXPRESSION

I_in real(conj(p0)*p0)/(2*rho_air*c_air)

NAME EXPRESSION

I_in

I_n real(conj(p)*p)/(2*rho_air*c_air)
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7 Click OK.

Integration Coupling Variables
1 Go to the Options menu and choose Integration Coupling Variables and then Boundary 

Variables.

2 In the Boundary Integration Variables dialog box select Boundary 2 and then enter 
the following boundary integration expression:

3 In the Boundary Integration Variables dialog box select Boundary 7 and enter the 
following boundary integration expression; when done, click OK.

M E S H  G E N E R A T I O N

1 Go to the Mesh menu and choose Free Mesh Parameters.

2 In the Free Mesh Parameters dialog box, select Finer in the Predefined mesh sizes list.

3 Click Remesh, then click OK.

C O M P U T I N G  T H E  S O L U T I O N

1 From the Solve menu, choose Solver Parameters. 

2 In the Solver Parameters dialog box, select Parametric from the Solver list.

3 Type freq in the Parameter names edit field.

4 Type range(20,5,200) in the Parameter values edit field.

5 Click OK.

6 Go to the Physics menu and choose Scalar Variables.

7 In the Expression column, type freq in the edit field for the frequency.

8 Click OK.

9 Click the Solve button to start the simulation.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default visualization plots the magnitude of the pressure field at the final frequency 
(200 Hz).

NAME EXPRESSION INTEGRATION ORDER

P_in I_in*2*pi*r 4

NAME EXPRESSION INTEGRATION ORDER

P_in

P_out I_n*2*pi*r 4
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Next generate the transmission-loss plots in Figure 3-1.

1 Go to the Postprocessing menu and select Domain Plot Parameters.

2 On the General page, select all frequencies from the Solutions to use list in the Domain 

Plot Parameters dialog box.

3 Select the Keep current plot check box.

4 On the Point page, select Point 1 from the Point selection list.

5 Type D_tl in the Expression edit field.

6 Click the Line Settings button and select Triangle in the Line marker list. Click OK.

7 Click Apply in the Domain Plot Parameters dialog box.

To make it easy to compare the two solutions, plot the theoretical solution in the 
same figure.

8 Type D_tl_analytical in the Expression edit field.

9 Click the Line Settings button. Select Color from the Line color list and Square from 
the Line marker list. Click OK.

10 Click OK in the Domain Plot Parameters dialog box

11 In the figure window, click the Edit Plot toolbar button. Finish the plot by editing 
the plot title and axis labels, and adding labels.
 3 :  A C O U S T I C S



 4
D i f f u s i o n
This chapter explains how to use both the Diffusion application mode and the 
Diffusion and Convection application mode to model and simulate various types of 
transport problems. It concludes with a step-by-step example that introduces the 
concept of effective diffusivity in porous media.
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Th e  D i f f u s i o n  App l i c a t i o n  Mode

The Diffusion application mode treats the mass transport mechanism with the same 
name, which is the simplest one to describe in mathematical terms. This application 
mode is available in 1D, 2D, and 3D as well as in axisymmetric formulations in 1D and 
2D.

The dependent variable is the mass concentration, c.

Note: The optional Chemical Engineering Module provides an application mode for 
the diffusion of several species as well as an application mode for problems that 
involve potential flow. It also supports modeling using pseudo-2D and pseudo-3D 
geometries.

PDE Formulation

Heat transfer is a diffusion process, so the generic diffusion equation has the same 
structure as the heat equation. Diffusion is governed by the equation

where c is the concentration, D is the diffusion coefficient, and R is a reaction rate. 
The diffusion process can be anisotropic, in which case D is a tensor.

Subdomain Settings

The diffusion equation coefficients to specify on the subdomains are:

COEFFICIENT VARIABLE DESCRIPTION

 δts Dts_c Time-scaling coefficient

 D D_c Diffusion coefficient, diffusion coefficient tensor

 Dij Dxixj_c Diffusion coefficient tensor, xixj component

 R R_c Reaction rate

δts
c∂
t∂

----- ∇ D– ∇c( )⋅+ R=
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Time-scaling Coefficient   This coefficient is normally 1. If desired, you can change the 
time scale, for example, from seconds to minutes by setting it to 1/60.

Diffusion Coefficient   This material property, denoted by D, describes a material’s 
diffusive conductivity, in other words the relation between the concentration gradient 
and the mass flux.

Reaction Rate   The reaction rate describes the volume density of mass creation. The 
reaction rate can be nonlinear.

You specify the equation coefficients in the Subdomain Settings dialog box.

For equations in 2D or 3D, pay special attention to the isotropic diffusion coefficient, 
D. If you select this coefficient, the application mode expands it to the diagonal of the 
diffusion coefficient tensor, that is, Dxixi equals D.

Boundary Conditions

The boundary conditions are:

BOUNDARY CONDITION DESCRIPTION

 c = c0 Concentration

Flux

Insulation/Symmetry

n– D– c∇( )⋅ N0 kc cb c–( )+=

n D– c∇( )⋅ 0=
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Concentration   In the equation for the concentration boundary condition, c0 is a 
user-specified concentration.

Flux   In the equation for the flux condition, N0 is an arbitrary user-specified flux 
expression. Furthermore, kc represents the mass transfer coefficient and cb is the bulk 
concentration in a fictitious diffusion layer at the boundary.

Thin boundary layer   You can use the thin boundary layer condition to model a thin 
layer of a material with a small diffusion coefficient compared to the adjacent domains. 
The layer has the thickness d and the diffusion coefficient D. This boundary condition 
is only available at the border between the parts in an assembly.

Continuity   This is the default boundary condition on interior boundaries and pair 
boundaries; it is not applicable to exterior boundaries.

Flux discontinuity   This boundary condition represents a discontinuity in the mass flux 
across an interior boundary or a border between parts in an assembly; it is not 
applicable to exterior boundaries.

Axial symmetry   The axial symmetry condition is identical to the insulation/symmetry 
condition. It is available only for axisymmetric models using cylindrical coordinate 
systems. Use this boundary condition on the symmetry axis.

Thin boundary layer

 n · ( N1 − N2 ) = 0 Continuity

 −n · ( N1 − N2 ) = N0 Flux discontinuity

Axial symmetry

BOUNDARY CONDITION DESCRIPTION

n1 D– c∇( )1⋅ D
d
---- c1 c2–( )=

n2 D– c∇( )2⋅ D
d
---- c2 c1–( )=

n D– c∇( )⋅ 0=
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Specify the boundary conditions in the Boundary Settings dialog box. For boundary 
conditions on pair boundaries, click the Pair tab above the selection area in the left part 
of the dialog box.

Application Mode Variables

The Diffusion application mode uses the following expressions and coefficients in 
boundary conditions, equations, and for postprocessing purposes.

NAME TYPE DESCRIPTION EXPRESSION

c S/B Concentration  c

grad_c, cxi S/V Concentration gradient

dflux_c S Diffusive flux

ndflux_c B Normal diffusive flux

dflux_c_xi V Diffusive flux, xi component

Dts_c S Time-scaling coefficient  δts

D_c, Dxixj_c S Diffusion coefficient  D, Dij

R_c S Reaction rate  R

N_c B Inward diffusive flux  N0

kc_c B Mass-transfer coefficient  kc

∇c , c∂
xi∂

-------

D∇c

n D∇c–( )⋅

Dij
c∂
xj∂

-------–

j
∑
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The vector expressions indicated with a V in the Type column are not present in 1D 
versions of the diffusion application mode.

Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: di), for example, 
dflux_d_di. (This does not apply to the dependent variable for the concentration.)

cb_c B Bulk concentration  cb

c0_c B Concentration  c0

NAME TYPE DESCRIPTION EXPRESSION
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Th e  Con v e c t i o n  and D i f f u s i o n  
App l i c a t i o n  Mode

This application mode models the most common type of transport in chemical 
systems: transport by convection and diffusion. You can simulate transport by 
convection and diffusion in 1D, 2D, and 3D as well as for axisymmetric systems in 1D 
and 2D.

The dependent variable in the application mode is the mass concentration, c.

Note: The optional Chemical Engineering Module contains an application mode for 
the convection and diffusion of several species. It also supports modeling using 
pseudo-2D and pseudo-3D geometries.

PDE Formulation

The equations for the nonconservative and conservative formulations for a species, c, 
are:

 nonconservative

 conservative

The nonconservative formulation is the default for advection and diffusion types of 
equations in COMSOL Multiphysics because the software assumes an incompressible 
fluid. Thus the term  equals zero and gets dropped from the nonconservative 
formulation. This ensures that no nonphysical source term arises from a flow field 
where the incompressibility constraint, , is not absolutely fulfilled.

For stationary analysis the term with the time derivative gets dropped.

δts
c∂
t∂

----- ∇ D c∇–( )⋅+ R u ∇c⋅–=

δts
c∂
t∂

----- ∇ D c cu+∇–( )⋅+ R=

c∇ u⋅

∇ u⋅ 0=
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Subdomain Settings

The various coefficients used in the equations are:

The Time-scaling coefficient, δts, is normally 1, but you can change the time scale, for 
example, from seconds to minutes by setting it to 1/60.

For equations in 2D or 3D, pay special attention to the isotropic diffusion coefficient, 
D. If you select this coefficient, the application mode expands it to the diagonal of the 
diffusion coefficient tensor, that is, Dxixi equals D.

You specify the equation coefficients in the Subdomain Settings dialog box.

A R T I F I C I A L  D I F F U S I O N

To specify and activate artificial diffusion:

1 Open the Subdomain Settings dialog box.

2 Click the Physics tab.

3 With at least one subdomain selected, click the Artificial Diffusion button.

This opens the Artificial Diffusion dialog box shown in Figure 4-1.

Figure 4-1: The Artificial Diffusion dialog box.

Stabilization is sometimes needed because pure Galerkin discretization is unstable for 
convectively or source-term dominated transport equations. The stabilization methods 

COEFFICIENT VARIABLE DESCRIPTION

 δts Dts_c Time-scaling coefficient

 D D_c Diffusion coefficient or tensor

 Dij Dxixj_c Diffusion coefficient tensor, xixj component

 R R_c Reaction rate

 u, v, w u_c, v_c, w_c Velocity in the x1, x2, and x3 directions
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and their effects on the numerical solution are described in Chapter 17, “Stabilization 
Techniques.”

The Convection and Diffusion application mode supports artificial diffusion using the 
following methods:

• Isotropic diffusion

• Streamline diffusion

• Crosswind diffusion

Isotropic Diffusion
Isotropic diffusion is described in the section “Isotropic Diffusion” on page 486.

Streamline Diffusion
There are three types of streamline diffusion available:

• The anisotropic diffusion method is described in the section “Anisotropic 
Diffusion” on page 487.

• The Petrov-Galerkin streamline diffusion method is almost the same as the SUPG 
method described in the section “Streamline Upwind Petrov-Galerkin (SUPG)” on 
page 488. The only difference is an intrinsic time scale that the method uses. The 
convection-diffusion equation uses the original time scale designed for transport 
equations dominated by convection (see Ref. 1).

There is no strict theory on the value of the tuning parameter, δsd,T, but a good rule 
of thumb is to select δsd,T = 0.5/p where p is the order of the basis functions.

• The Petrov-Galerkin/Compensated method uses a modified intrinsic time scale 
that completely eliminates the streamline diffusion contributions in regions 
dominated by diffusion (Ref. 1).

There is no strict theory on the value of the tuning parameter, δsd,T, but a good rule 
of thumb is to select δsd,T = 0.5/p where p is the order of the basis functions.

The drawback is that this formulation can cause discontinuities and that it 
introduces additional nonlinearities.
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Crosswind Diffusion
Crosswind diffusion provides extra diffusion in the region of sharp gradients. There are 
two types of crosswind diffusion available:

• Ordo h3/2–The Ordo h3/2 crosswind-diffusion algorithm adds a diffusion 
coefficient according to Ref. 2.

This method should be used only with linear elements but is computational 
inexpensive. The constant δcd is per default set to 0.35. This value is however only 
valid for SI units and must be recalculated if other physical units are used.

• Shock capturing–The COMSOL Multiphysics implementation adds shock 
capturing according to:

where is the equation residual  and  is the test function 
for c. The effective diffusion coefficient, αe

c, is 

where D is the mean diffusion coefficient and R is the reaction term. The tuning 
coefficient δcd is set to 0.35, which correlates to second-order basis functions (see 
Ref. 3).

Boundary Conditions

The available boundary conditions are:

BOUNDARY CONDITION DESCRIPTION

 c = c0 Concentration

Flux

Insulation/Symmetry

1
2
---αc

ehe ℜ c( )
c∇

--------------- ĉ∇ I 1

u 2
--------- u u⊗( )–⎝ ⎠

⎛ ⎞ c∇⋅ ⋅ Ωd

Ωe

∫
e 1=

Nel

∑

ℜ c( ) ℜ c( ) ∇Γc R–=( ) ĉ

αc
e max 0 δcd 1 γp

e⁄–,( )=

γp
e u he

2D
-------------=

βp
R

c∇ 2
------------ c∇=

n– D c cu+∇–( )⋅ N0=

n D c cu+∇–( )⋅ 0=
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Concentration   In the equation for the concentration boundary condition, c0 is a 
user-specified concentration.

Flux   In the equation for the flux condition, N0 is an arbitrary user-specified flux 
expression.

Convective flux   This boundary condition typically applies at outlets, where you can 
assume that mass is transported out of the domain by convection only.

Thin boundary layer   You can use the thin boundary layer condition to model a thin 
layer of a material with a small diffusion coefficient compared to the adjacent domains. 
The layer has the thickness d and the diffusion coefficient D. This boundary condition 
is only available at the border between the parts in an assembly.

Continuity   This is the default boundary condition on interior boundaries and pair 
boundaries; it is not applicable to exterior boundaries.

Flux discontinuity   This boundary condition represents a discontinuity in the mass flux 
across a border between parts in an assembly.

Axial symmetry   The axial symmetry condition is identical to the insulation/symmetry 
condition. It is available only for axisymmetric models using cylindrical coordinate 
systems. Use this boundary condition only on the symmetry axis.

You specify boundary conditions in the Boundary Settings dialog box. For boundary 
conditions on pair boundaries, click the Pair tab above the selection area in the left part 
of the dialog box.

Convective flux

Thin boundary layer

 n · ( N1 − N2 ) = 0 Continuity

 −n · ( N1 − N2 ) = N0 Flux discontinuity

Axial symmetry

BOUNDARY CONDITION DESCRIPTION

n D– c∇( )⋅ 0=

n1 D– c cu+∇( )1⋅ D
d
---- c1 c2–( )=

n2 D– c∇ cu+( )2⋅ D
d
---- c2 c1–( )=

n D c cu+∇–( )⋅ 0=
T H E  C O N V E C T I O N  A N D  D I F F U S I O N  A P P L I C A T I O N  M O D E  |  55



56 |  C H A P T E R
Application Mode Variables

The Convection and Diffusion application mode uses the following expressions and 
coefficients in boundary conditions, equations, and for postprocessing purposes:

NAME TYPE DESCRIPTION EXPRESSION

c S/B Concentration  c

grad_c, cxi S/V Concentration gradient

dflux_c S Diffusive flux

cflux_c S Convective flux  | c u |
tflux_c S Total flux

ndflux_c B Normal diffusive flux

ncflux_c B Normal convective flux   c n · u

ntflux_c B Normal total flux

dflux_c_xi V Diffusive flux, xi component

cflux_c_xi V Convective flux, xi component   cui

tflux_c_xi V Total flux, xi component

cellPe_c S Cell Peclet number

Dts_c S Time-scaling coefficient  δts

udl_c S Dimensionless velocity  udl

D_c, Dxixj_c S Diffusion coefficient  D, Dij

R_c S Reaction rate  R

u_c, v_c, w_c S Velocity of c, xi component  ui

N_c B Inward flux  N0

c0_c B Concentration  c0

beta_c_xi S Convective field, xi component  ui

∇c , c∂
xi∂

-------

D∇c

D– ∇c cu+

n D∇c–( )⋅

n D– ∇c cu+( )⋅

Dij
c∂
xj∂

-------–

j
∑

Dij
c∂
xj∂

-------–

j
∑ cui+

uh
D

--------
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The vector expressions indicated with a V in the Type column are not present in 1D 
versions of the Convection and Diffusion application mode.

Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: cd), for example, 
dflux_d_cd. (This does not apply to the dependent variable for the concentration.)
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Dm_c S Mean diffusion coefficient

res_c S Equation residual

res_sc_c S Shock capturing residual

da_c S Total time-scale factor  δts

NAME TYPE DESCRIPTION EXPRESSION

Dijβiβj

i j,
∑

β
--------------------------

∇ D– ∇c cu+( )⋅ R–

∇ cu( )⋅ R–
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Examp l e—Ef f e c t i v e  D i f f u s i v i t y  i n  
Po r ou s  Ma t e r i a l s

This model introduces the concept of effective diffusivity in porous media by 
comparing the transport through an artificial porous structure described in a detailed 
model with a simplified homogeneous porous media approach using effective 
transport properties.

The exercise consists of two parts. The first part describes how to create the model with 
a detailed geometry. The second part shows how to define a homogeneous model for 
porous media using an effective diffusivity calculated using the detailed model from 
the first part.

Introduction

Transport through porous structures is usually treated using simplified homogeneous 
models with effective transport properties. This is in most cases a necessity, since the 
typical dimensions of the pores and particles making up the porous structure are several 
orders of magnitude smaller than the size of the subdomain that is to be modeled.

However, it might be interesting to investigate the assumptions and simplifications 
done when homogenizing a porous structure by comparing a homogeneous model 
with a model defined using the detailed structure.
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The artificial porous structure used in this model is depicted in Figure 4-2 below.

Figure 4-2: Artificial porous structure. The domain colored in red is accessible for 
diffusion.

Model Definition

The model equation in the modeled domain shown in Figure 4-2 is the 
time-dependent equation

where c denotes concentration (mol/m3 using SI units) and D the diffusion coefficient 
(m2/s) of the solute.

The boundary conditions are of three different types. A concentration boundary 
condition applies at the left vertical boundary in Figure 4-2. It is expressed as

where c0 is a given concentration.

The right vertical boundary in Figure 4-2 is set according to

where km is the mass transfer coefficient (m/s), and c1 is the concentration in a bulk 
solution outside of the porous structure.

All other boundaries are insulating boundaries according to

Concentration
boundary

Flux
boundaries

∂c
∂t
----- ∇+ D c∇–( )⋅ 0=

c c0=

D c∇–( ) n⋅ km c c1–( )=
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The initial condition is given by a bell-shaped profile along the x-axis with its maximum 
at x = 0 and a corresponding value of c = c0:

Assume a gaseous solution with a solute content of 3 mol/m3 at the concentration 
boundary. The diffusion coefficient is set to 1·10−5 m2/s.

The second part of this exercise uses a homogenized 1D model geometry with 
effective transport properties and an average porosity. The model equation then 
becomes:

where ε denotes the average porosity and Deff the effective diffusivity. These properties 
are calculated from the results of the detailed structure; see the next section. At the 
boundaries, the concentration and flux conditions described above apply.

Results and Discussion

The simulations are run for t = 0 to 0.1 s, when the simulation reaches steady state. 
Figure 4-3 below shows the concentration profile after 0.05 s in the porous structure. 
Already at this stage the concentration has almost reached steady state, which is visible 
by the nearly linear concentration profile across the structure.

Figure 4-3: Concentration profile in the modeled artificial porous structure at t = 0.05 s.

D c∇–( ) n⋅ 0=

c t0( ) c0 ax2
–( )exp=

ε∂c
∂t
----- ∇+ Deff c∇–( )⋅ 0=
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When modeling porous media, the exact concentration in the pore structure is not the 
most important issue because the description of the structure is homogenized and not 
detailed as in Figure 4-3. The most interesting issue is then the description of the flux. 
To calculate the average flux, integrate over the flux boundary and divide by its length, 
L0, which yields the following expression:

Figure 4-4 shows the value of this integral as a function of time. If you let the process 
reach steady-state, the average flux becomes 8.051·10−3 mol·m2/s. Considering the 
almost linear profile across the structure, it is natural to replace the porous structure 
with a 1D homogenized structure along the x-axis. It is then possible to calculate the 
effective diffusivity according to the following:

where cout is the average concentration (mol/m3) at the flux boundary, and L1 is the 
length of the geometry along the x-axis. The average concentration is obtained by 
integrating according to the expression below:

This gives and average concentration cout = 1.61·10−3 mol/m3 and using L1 = 
8·10−4 m gives the effective diffusivity according to the following:

which yields a value for the effective diffusivity of 2.15·10−6 m2/s compared to the 
“free” diffusivity of 1·10−5 m2/s. The effective and “free” diffusivities are usually 
related according to the equation

where ε is the porosity of the structure and τ the tortuosity, which is a measure of the 
actual length per unit effective length a molecule has to diffuse in a porous structure. 

Naverage
1

L0
------ km c c1–( ) Sd

0

L0

∫=

Deff c0 cout–( )
L1

-------------------------- Naverage=

cout
1

L0
------ c S.d

0

L0

∫=

Deff 8.051 10 3– 8.0 10 4–⋅×⋅

3 1.61 10 3–⋅–( )
--------------------------------------------------------------=

Deff Dε
τ
--=
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To calculate the porosity of the modeled structure, you integrate the value 1 over the 
structure and then divide this by the length and width of the structure:

resulting in a value of 0.382. The value of τ can then be calculated to 1.78. In addition, 
the tortuosity is usually expressed as a power of the porosity, resulting in an expression 
for the effective diffusivity according to

If you use the calculated values for porosity and effective diffusivity, the value for p is 
1.60. The experimental values for p for porous structures used for transport in 
catalysts, soils, and other porous structures is usually in the range 1.5–2.

Using the value of the effective diffusivity, a simple homogenized 1D model provides 
the possibility to compare the value of the flux using a homogenized model to the 
value using the detailed 2D structure. Figure 4-4 shows that there is an excellent 
agreement between the model using a detailed geometry and the homogenized model. 

ε 1
L0L1
-------------- 1 xd yd

0

L0

∫
0

L1

∫=

Deff Dεp
=
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The difference in the time-dependent flux is hardly visible between the two cases in the 
graph.

Figure 4-4: Average flux at the flux boundary in the detailed 2D model (solid line) and 
the 1D homogenized approximation (dashed line).

Modeling in COMSOL Multiphysics

Both models described above are straightforward to define in COMSOL Multiphysics. 
One feature that is of great use in this model is the ability to define integration 
coupling variables to automatically generate the values of the integrals needed to 
evaluate the results of the model. The definition of these integrals is described in detail 
in the step-by-step instructions below.

Model Library path: COMSOL_Multiphysics/Diffusion/
effective_diffusivity
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Modeling Using the Graphical User Interface

You can start by setting up the first and most extensive part of the exercise, which is 
the 2D model of the detailed porous structure.

1 Double-click on the COMSOL Multiphysics icon on your desktop to open the 
Model Navigator.

2 Select 2D from the Space dimension list.

3 Select COMSOL Multiphysics>Convection and Diffusion>Diffusion>Transient analysis as 
in the figure below.

4 Click OK.

O P T I O N S  A N D  S E T T I N G S

Define the constants required as input to the model.

1 Select Constants in the Options menu.

2 Define the concentration c0 in the Name column in the Constants dialog box.

3 Type 3[mol/m^3] in the corresponding Expression column.

4 Type Concentration in the corresponding Description column.

The Name column defines the name that you have to use to refer back to this 
constant, the Expression column is used to calculate its Value, and the Description 
column is used to make notes regarding this constant. Any constant can be a 
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function of the other constants, which is the reason why the Expression column is 
not always identical to the Value column.

5 Below the above constant, type a in the Name column, 1000 in the Expression 
column, and Dimensionless constant in the Description column.

6 Continue generating the constant list by typing k_f in the Name column, 5[m/s] in 
the Expression column, and Mass transfer coefficient in the Description 
column.

7 Type D1 in the Name column, 1e-5[m^2/s] in the Expression column, and 
Diffusivity in the Description column. The constant dialog box should look 
according to the figure below. You can now save this list for later access in the 1D 
model in the second part of the exercise.

8 Click Apply.

9 Click the Export Variables To File button in the Constants dialog box (floppy disk 
symbol).

10 Save the data file in your working directory as diffusion.txt.

11 Click Save in the Export Variables dialog box.

12 Click OK in the Constants dialog box.

Continue with the functions.

1 In the Options menu, choose Expressions>Scalar Expressions.

2 Define a concentration function c1 in the Name column in the Scalar Expressions 
dialog box.

3 Type c0*exp(a*(-(x/4e-4[m])^2)) in the corresponding Expression column.

4 Type Concentration in the corresponding Description column.

5 Click Apply. You can now save the expression for use in the 1D model.
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6 Click the Export Variables To File button in the Scalar Expressions dialog box (floppy 
disk symbol).

7 Save the data file in your working directory as diffusion1.txt.

8 Click Save in the Export Variables dialog box.

9 Click OK in the Scalar Expressions dialog box.

The last step in the Options menu is to set the size of the drawing table.

1 Select Axes/Grid Settings in the Options menu.

2 Set the minimum and maximum values for the x- and y-axes according to the figure 
below. You can do this by clicking on the edit fields and typing the corresponding 
values.

3 Click the Grid tab and clear the Auto check box.

4 Set the x spacing and y spacing grid lines as in the figure below.

5 Click OK.

G E O M E T R Y  M O D E L I N G

1 Click the Rectangle/Square button on the Draw toolbar.
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2 Use the mouse to drag from the (x, y) coordinates (0, 0) to (1e-4, 1e-4) to create 
a square with one corner at the origin and one corner across the diagonal from 
origin at (1e-4, 1e-4); see the figure below.

3 Click the Fillet/Chamfer button on the Draw toolbar.

4 Select Vertex 1 in the Vertex selection list.

5 Type 2e-5 in the Radius edit field.

6 Click Apply. The rectangle R1 now changes name to CO1 (composite object 1).

7 Select Vertex 2 in the Vertex selection list.

8 Click Apply. The name is now changed to CO2.

9 Select Vertex 5 in the Vertex selection list.

10 Click Apply. The name is now changed back to CO1 (this since the name is not taken 
anymore).

11 Select Vertex 7 in the Vertex selection list.

12 Click Apply. The name is now changed again back to CO2.

13 Click OK.

You should now have the rectangle according to the figure above but now with 
rounded corners.

1 Click the Scale button (with CO2 selected; that is, colored red).

2 Type 0.8 in both the x and y edit fields in the Scale factor area, then click OK.

3 Click the Move button on the Draw toolbar.

4 Type 1e-5 in both the x and y Displacement edit fields.
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The rounded square should now be positioned according to the figure below.

You can now copy and paste to create the porous structure.

1 Click the Array button on the Draw toolbar.

2 Enter 1e-4 in the x and y edit fields in the Displacement area.

3 In the Array size edit fields enter 8 for both x and y.

4 Click OK.

You now have to select each second column of objects and displace them.

1 Press the Ctrl key and drag the mouse over the objects in each second column to 
obtain the selection according to the figure below. You can use the rubber band 
functionality by dragging the mouse. You keep the selection by pressing the Ctrl key.
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2 Click the Move button on the Draw toolbar.

3 Type 5e-5 in the y edit field in the Displacement area.

4 Click OK.

5 Click Zoom Extents. Your graphical user interface should look as in the figure below.

6 Choose Deselect All from the Edit menu.

7 Press the Ctrl key and click the objects CO9, CO25, CO41, CO57 to obtain the 
selection according to the following figure.

8 Press Ctrl+C to copy and Ctrl+V to paste the selected objects.

9 In the Paste dialog box, type -1e-4 in the y edit field in the Displacement area. Click 
OK.

10 Click the Zoom Extents button on the Main toolbar.
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11 Click the Rectangle/Square button and drag the mouse from the coordinates (x, y) 
(0, 0) to (8·10−4, 8·10−4) to create a square with one corner at origin and the 
corner across the diagonal from the origin at (8·10−4, 8·10−4). The graphical user 
interface should look according to the figure below.

12 Press Ctrl+A to select all objects.

13 Click the Difference button. The geometry should be according to the figure below.

This finalizes the geometry section for the first part of this exercise. You can now 
continue with the properties and boundary conditions.

P H Y S I C S  S E T T I N G S

Subdomain Settings
1 Select Subdomain Settings from the Physics menu.
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2 Select Subdomain 1 from the Subdomain selection list.

3 Type D1 in the Diffusion coefficient edit field. Note that you have defined D1 in the 
Constants dialog box in the Options menu.

4 Click the Init tab to set the initial condition.

5 Type c1 in the Concentration, c edit field (c(t0)). Note that you have defined c1 as a 
scalar expression variable.

6 Click OK.

Boundary Conditions
1 Select Boundary Settings from the Physics menu.

2 Select Boundary 1 in the Boundary selection list.

3 Select Concentration from the Boundary condition list.

4 Type c0 in the Concentration edit field.

5 Select Boundary 276 from the Boundary selection list.

6 Select Flux from the Boundary condition list.

7 Type k_f in the Mass transfer coefficient edit field. The bulk concentration in the 
Bulk concentration edit field should be 0.

8 Click OK.

All other boundaries, except for the two boundaries that you have altered above, 
should remain at the default Insulation/Symmetry boundary condition.

M E S H  G E N E R A T I O N

Click the Initialize Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

1 Click the Solver Parameters button on the Main toolbar.

2 Type range(0,2e-3,0.1) in the Times edit field to define the Time stepping. This 
gives an integration from 0 to 0.1 s with 2 ms increments between each output.

3 Select Direct (SPOOLES) from the Linear system solver list. The SPOOLES solver 
makes use of the symmetry in the diffusion equation, which the solver detects 
automatically, thus saving memory.

4 Click OK.

5 Click the Solve button on the Main toolbar.
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PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot gives the concentration at the final time step 0.1 s; see the figure 
below.

You can now continue generating the integral expressions needed to evaluate the 
average flux. To plot the integrals as a function of time, you have to create an 
integration coupling variable.

1 In the Options menu, select Integration Coupling Variables>Boundary Variables.

2 Select Boundary 276 in the Boundary selection list.

3 Type tot_flux in the Name column.

4 Type k_f*c in the Expression column.

5 Clear the Global destination check box.

6 Click the Destination tab.

7 Check the box for Point 532 in the Point selection list.

8 Click OK.

You have now defined the integration variable. However, the value has not been 
evaluated yet. To do that, you do not have to run the solution process; instead just 
update the solution:

Select Update Model from the Solve menu.

This should evaluate the integral at all output times. You can now plot the value of the 
average flux:

1 Select Domain Plot Parameters from the Postprocessing menu.
 4 :  D I F F U S I O N



2 Click the Point tab. Select Point 532 in the Point selection list.

3 Type tot_flux/0.8[mm] in the Expression edit field to plot the average flux 
(0.8 mm is the length of the integration boundary).

4 Click OK.

This generates the solid line in Figure 4-4.

To get the porosity of the domain for the 1D model, do a subdomain integration:

1 Select Subdomain Integration from the Postprocessing menu.

2 Select Subdomain 1 in the Subdomain selection list.

3 Type 1/(0.8[mm])^2 in the Expression edit field.

4 Click OK. The value 0.381976 should be visible in the message window.

5 Save the model in your working directory.

You can now continue with the 1D model. Note that the figure window denoted 
Figure 1, showing the average flux of species, should still be open.

M O D E L  N A V I G A T O R

1 Click the New button. Select 1D from the Space dimension list.

2 Select COMSOL Multiphysics>Convection and Diffusion>Diffusion>Transient analysis 
from the Application Modes tree; see the figure below.

3 Click OK.
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O P T I O N S  A N D  S E T T I N G S

You can now load the constants from the 2D model above. 

1 Select Constants from the Options menu.

2 Click the Import Variables From File button in the lower left corner of the Constants 

dialog box (open-catalog symbol).

3 Select the file diffusion.txt that you have previously created in your working 
directory in the Import Variables dialog box.

4 Click Open.

5 Define a new constant in the Constants dialog box by typing epsilon in the Name 
column, 0.381976 in the Expression column, and Porosity in the Description 
column.

6 Change the diffusivity D1 to 2.15e-6 in the corresponding Expression field.

7 Click OK in the Constants dialog box.

You can continue by loading the scalar expression from the 2D model.

1 Select Expressions>Scalar Expressions from the Options menu.

2 Click the Import Variables From File button in the lower left corner of the Scalar 
Expressions dialog box (open-catalog symbol).

3 Select the file diffusion1.txt that you have previously created in your working 
directory in the Import Variables dialog box.

4 Click Open.

5 Click OK in the Scalar Expressions dialog box.

G E O M E T R Y  M O D E L I N G

1 Select Specify Objects>Line from the Draw menu.

2 Type 0 8e-4 in the Coordinates, x edit field to create a line from x = 0 to x = 8·10−4.

3 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S

Subdomain Settings
1 Select Subdomain Settings from the Physics menu.

2 Select Subdomain 1 from the Subdomain selection list.

3 Type epsilon in the Time-scaling coefficient edit field.

4 Type D1 in the Diffusion coefficient edit field.
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5 Click the Init tab.

6 Type c1 in the Concentration, c edit field (c(t0)). This sets the initial condition.

7 Click OK.

Boundary Conditions
1 Select Boundary Settings from the Physics menu.

2 Select Boundary 1 from the Boundary selection list.

3 Select Concentration from the Boundary condition list.

4 Type c0 in the Concentration edit field.

5 Select Boundary 2 from the Boundary selection list.

6 Select Flux from the Boundary condition list.

7 Type k_f in the Mass transfer coefficient edit field.

8 Click OK.

M E S H  G E N E R A T I O N

Click the Refine Mesh button on the Main toolbar to create a fine mesh.

C O M P U T I N G  T H E  S O L U T I O N

1 Click the Solver Parameters button on the Main toolbar.

2 Type range(0,2e-3,0.1) in the Times edit field to define the Time stepping.

3 Click OK.

4 Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Click the Point tab. Select Point 2 from the Point selection list.

3 Type k_f*c in the Expression edit field.

4 Click the Line Settings button.

5 Select Dashed line from the Line style list, then click OK.

6 Click the General tab. Select the Keep current plot check box.

7 Select Figure 1 from the Plot in list, then click OK to create a plot according to 
Figure 4-4 on page 63.
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 5
E l e c t r o m a g n e t i c s
This chapter explains the application modes in COMSOL Multiphysics for 
electromagnetics and how to use them for electromagnetic field simulations. 
Specifically, it takes a detailed look at the Conductive Media DC application mode, 
the Electrostatics application mode, the Magnetostatics application mode, and the 
AC Power Electromagnetics application mode. It concludes by presenting three 
step-by-step examples using the Conductive Media application mode DC to model 
a copper plate, the Electrostatics application mode to model an electric sensor, and 
the Magnetostatics application mode to model a permanent magnet.
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Th e  E l e c t r omagne t i c s  App l i c a t i o n  
Mode s

For simulating electromagnetic fields, COMSOL Multiphysics offers four application 
modes.

The first three perform static simulations:

• Electrostatics

• Conductive media DC

• Magnetostatics

With static problems you solve for either electric properties, as is the case for the first 
two modes, or magnetic properties, as in magnetostatics. 

In time-varying electromagnetic fields the electric and magnetic quantities are 
coupled, so you simulate them with the fourth application modes of interest here: AC 
Power Electromagnetics.

This section of the manual begins with a brief introduction to electromagnetics and a 
definition of the electromagnetic quantities. Then it discusses each of the four 
application modes in detail.

Note: The optional AC/DC Module contains specialized and extended application 
modes and models for electromagnetic simulations, for example, for computations of 
inductors and capacitors. The optional RF Module includes application modes for 
wave-propagation simulations that are especially useful in microwave engineering and 
photonics.
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Fundamen t a l s  o f  E l e c t r omagne t i c s

The problem of electromagnetic analysis on a macroscopic level is that of solving 
Maxwell’s equations subject to certain boundary conditions. Maxwell’s equations are 
a set of equations, written in differential or integral form, stating the relationships 
between the fundamental electromagnetic quantities. These quantities are:

• The electric field intensity, E

• The electric displacement or electric flux density, D

• The magnetic field intensity, H

• The magnetic flux density, B

• The current density, J

• The electric charge density, ρ

You can formulate the equations in differential or integral form. This discussion 
presents them in differential form because it leads to differential equations that the 
finite element method can be handle.

For general time-varying fields, Maxwell’s equations are

The first two equations are also referred to as Maxwell-Ampère’s law and Faraday’s 
law, respectively. The last two are forms of Gauss’ law in the electric and magnetic 
form, respectively. 

Another fundamental relationship is the equation of continuity:

Out of these five equations only three are independent. The first two combined with 
either the electric form of Gauss’ law or the equation of continuity form an 
independent system.

∇ H× J D∂
t∂

-------+=

∇ E× B∂
t∂

-------–=

∇ D⋅ ρ=

∇ B⋅ 0=

∇ J⋅ ρ∂
t∂

------–=
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C O N S T I T U T I V E  R E L A T I O N S H I P S

To obtain a closed system, you need the constitutive relationships describing the 
macroscopic properties of the medium. They are

 (5-1)

where ε0 is the permittivity of vacuum, µ0 is the permeability of vacuum, and σ is 
the electric conductivity. In the SI system the permeability of a vacuum is  
4π·10−7 H/m. The velocity of an electromagnetic wave in a vacuum is given as c0, and 
you can derive the permittivity of a vacuum from the relationship

The electric polarization vector P describes how a material is polarized when an 
electric field E is present. It can be interpreted as the volume density of electric dipole 
moments. P is generally a function of E. Some materials can have a nonzero P in the 
absence of an electric field.

The magnetization vector M similarly describes how a material is magnetized when a 
magnetic field H is present. It can be interpreted as the volume density of magnetic 
dipole moments. M is generally a function of H. One use of the magnetization vector 
is to describe permanent magnets, which have a nonzero M when no magnetic field is 
present.

For linear materials the polarization is directly proportional to the electric field, 
P = ε0 χe E, where χe is the electric susceptibility. Similarly, in linear materials the 
magnetization is directly proportional to the magnetic field, M = χm H, where χm is 
the magnetic susceptibility. For such materials the constitutive relations are

where εr is the material’s relative permittivity, and µr is its relative permeability. 
Usually these are scalar properties but can, in the general case, be 3-by-3 tensors when 
the material is anisotropic. The properties ε and µ (without subscripts) are the 
material’s permittivity and permeability.

D ε0E P+=

B µ0 H M+( )=

J σE=

ε0
1

c0
2µ0

---------- 8.854 10 12–  F/m 1
36π
--------- 10 9–  F/m⋅≈⋅= =

D ε0 1 χe+( )E ε0εrE εE= = =

B µ0 1 χm+( )H µ0µrH µH= = =
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Generalized Constitutive Relationships
For nonlinear materials, a generalized form of the constitutive relationships is useful. 
The relationship used for electric fields is

The field Dr is the remanent displacement, which is the displacement when no electric 
field is present.

Similarly, a generalized form of the constitutive relationship for the magnetic field is

where Br is the remanent magnetic flux density, which is the magnetic flux density 
when no magnetic field is present.

You can generalize the third line in Equation 5-1 by introducing an externally 
generated current Je. This relationship is then

PO T E N T I A L S

Under certain circumstances it can be helpful to formulate a problem in terms of the 
electric scalar potential V and magnetic vector potential A. They are given by the 
equalities

which are direct consequences of the magnetic case of Gauss’ law and Faraday’s law, 
respectively.

M A T E R I A L  P R O P E R T I E S

This discussion has so far only formally introduced the constitutive relationships. These 
seemingly simple relationships can be quite complicated at times. In fact, these 
relationships require some special considerations when working with four main groups 
of materials:

• Inhomogeneous materials

• Anisotropic materials

D ε0εrE Dr+=

B µ0µrH Br+=

J σE Je
+=

B ∇ A×=

E ∇V–
A∂
t∂

-------–=
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• Nonlinear materials

• Dispersive materials

A material can belong to one or more of these groups.

Inhomogeneous materials are the least complicated. An inhomogeneous medium is 
one in which the constitutive parameters vary with the space coordinates so that 
different field properties prevail at different parts of the material structure.

For anisotropic materials the field relationships at any point differ for different 
directions of propagation. This means that a 3-by-3 tensor is necessary to properly 
define the constitutive relationships. If this tensor is symmetric, the material is often 
referred to as reciprocal. In these cases you can rotate the coordinate system such that 
a diagonal matrix results. If two of the diagonal entries are equal, the material is 
uniaxially anisotropic; if none of the elements have the same value, the material is 
biaxially anisotropic (Ref. 2). You need anisotropic parameters, for instance, to 
examine permittivity in crystals (Ref. 2) and when working with conductivity in 
solenoids.

In some nonlinear materials the permittivity or permeability depend on the intensity 
of the electromagnetic field. Nonlinearity also includes hysteresis effects where not 
only the existing field intensities influence a material’s physical properties but the 
history of the field distribution also plays a role.

Finally, dispersion describes changes in a wave’s velocity with wavelength. In the 
frequency domain you can express dispersion with a frequency dependence of the 
constitutive laws.

B O U N D A R Y  A N D  I N T E R F A C E  C O N D I T I O N S

To get a full description of an electromagnetic problem, you must also specify 
boundary conditions at material interfaces and physical boundaries. At interfaces 
between two media, you can mathematically express the boundary conditions as

where ρs  and Js denote the surface charge density and surface current density, 
respectively, and n2 is the outward normal from medium 2. Of these four equations, 

n2 E1 E2–( )× 0=

n2 D1 D2–( )⋅ ρs=

n2 H1 H2–( )× Js=

n2 B1 B2–( )⋅ 0=
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only two are independent. This is an overdetermined system of equations, so you 
would like to reduce it. First select either equation one or equation four. Then select 
either equation two or equation three. Together these selections form a set of two 
independent conditions.

From these relationships, you can derive the interface condition for the current density,

Interface Between a Dielectric and a Perfect Conductor
A perfect conductor has infinite electrical conductivity and as such has no internal 
electric field. Otherwise it would produce an infinite current density according to the 
third fundamental constitutive relationship. At an interface between a dielectric and a 
perfect conductor, the boundary conditions for the E and D fields are simplified. 
Assume that subscript 1 corresponds to a perfect conductor; then D1 = 0 and E1 = 0 
in the relationships just given. If, in addition, you are dealing with a time-varying case, 
then B1 = 0 and H1 = 0, as well, as a consequence of Maxwell’s equations. The result 
is the following set of boundary conditions for the fields in the dielectric medium for 
the time-varying case:

Electromagnetic Force for Particle Tracing

The electromagnetic force is available for particle tracing plots in the Conductive 
Media DC application mode and the Electrostatics application mode in the COMSOL 
Multiphysics products.

The following expression is used to describe the electromagnetic force on a particle 
with the charge q moving through the electric and magnetic fields with the velocity v:

U S I N G  T H E  E L E C T R O M A G N E T I C  F O R C E  F O R  P A R T I C L E  T R A C I N G

The electromagnetic force is the default selection in the Predefined forces list on the 
Particle Tracing page.

n2 J1 J2–( )⋅
ρs∂
t∂

--------–=

n– 2 E2× 0=

n– 2 H2× Js=

n– 2 D2⋅ ρs=

n– 2 B2⋅ 0=

F q E v B×+( )=
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There is one parameter in this force expression: the particle charge, q, which you define 
by clicking the Parameters button. The default value of q is the elementary charge:

The particle mass appears in the force equation, and you enter its value in the Mass edit 
field. The default value for the particle mass is mp = 9.1095·10−31 kg, which is the 
mass of an electron.

Note: The default settings work for models that use SI units.

Electromagnetic Forces

The electromagnetics application modes that solve for the magnetic vector potential A 
(the Magnetostatics and AC Power Electromagnetics application modes) contain a 
predefined subdomain variable for computing the Lorentz force, which gives the force 
distribution exerted on a current-carrying conductor placed in magnetic flux density 
B. The Lorentz force is defined as

 (5-2)

The Lorentz force gives very good accuracy for electromagnetic force calculations in 
conducting domains. For nonconducting domains you can use a more general 
method: integrating the Maxwell stress tensor variables over the boundaries of the 
object for which to calculate the total force. The Maxwell surface stress tensor is 
available as a boundary variable.

For a full list of variables available within an application mode (including the force 
variables), see the table at the end of the corresponding application mode section.

PARAMETER NAME IN 
EQUATION

DESCRIPTION DEFAULT VALUE DEFAULT VARIABLE NAME

 q particle charge 1.602·10-19 C partq

F J B×=
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Th e  Condu c t i v e  Med i a  DC App l i c a t i o n  
Mode

Electrolysis and the computation of resistances of grounding plates involves a medium 
with electric conductivity σ and a steady current.

You can use the Conductive Media DC application mode for 3D, 2D in-plane, and 
2D axisymmetric models.

PDE Formulation

When handling conductive media you must consider the equation of continuity. In a 
stationary coordinate system, the point form of Ohm’s law states that 

where Je is an externally generated current density. The static form of the equation of 
continuity then gives

To handle current sources, generalize the equation to

The in-plane Conductive Media DC application mode assumes that your model has a 
symmetry where the electric potential varies only in the x and y directions and is 
constant in the z direction. This implies that the electric field, E, is tangential to the 
xy-plane. The application mode solves the following equation where d is the thickness 
in the z direction:

The axisymmetric Conductive Media DC application mode considers the situation 
where the fields and geometry are axially symmetric. In this case the electric potential 
is constant in the  direction, which implies that the electric field is tangential to the 
rz-plane.

J σE Je
+=

∇ J⋅ ∇– σ V∇ Je
–( )⋅ 0= =

∇– σ V∇ Je
–( )⋅ Qj=

∇– d σ V∇ Je
–( )⋅ dQj=

ϕ
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Writing the generalized equation for Qj in cylindrical coordinates and multiplying it by 
r to avoid singularities at r = 0 results in

S P E C I F Y I N G  T H E  C O N D U C T I V I T Y

You can provide the conductivity in three different ways:

• Isotropic conductivity: a scalar number or expression

• Anisotropic conductivity: several components of a conductivity tensor to define an 
anisotropic material

• Temperature-dependent conductivity (which occurs in, for example, Joule heating, 
which is also called resistive heating). In this case the following equation describes 
the conductivity:

where ρ0 is the resistivity at the reference temperature T0. α is the temperature 
coefficient of resistivity, which describes how the resistivity varies with temperature. T 
is the current temperature, which can be a value that you specify or the temperature 
from a heat transfer application mode (in the Joule Heating predefined multiphysics 
coupling, this is the default setting).

To specify an isotropic or anisotropic conductivity, select Conductivity from the 
Conductivity relation list. To use the linear temperature dependence in the equation 
above, select Linear temperature relation from the Conductivity relation list. If you want 
to use another expression for a temperature-dependent conductivity, select 
Conductivity from the Conductivity relation list and specify the conductivity as a function 
of temperature.

Boundary Conditions

The relevant interface condition at interfaces between different media for this 
application mode is

r∂
∂

z∂
∂

T

– rσ r∂
∂V

z∂
∂V

rJe
–

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ rQj=

σ 1
ρ0 1 α T T0–( )+( )
-----------------------------------------------=

n2 J1 J2–( )⋅ 0=
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This is fulfilled by the natural boundary condition

C U R R E N T  F L O W

The current-flow boundary condition 

specifies the normal component of the current density for the current flowing across 
the boundary.

I N W A R D  C U R R E N T  F L O W

The inward-current flow boundary condition

is similar to the previous current-flow boundary condition except this case specifies the 
normal component of the current density rather than the complete vector. When the 
normal component Jn is positive then the current flows inwards towards the boundary.

D I S T R I B U T E D  R E S I S T A N C E

You can use the distributed resistance boundary condition

to model a thin sheet of a resistive material. The sheet has the thickness d and is 
connected to the potential Vref.

E L E C T R I C  I N S U L A T I O N

The electric-insulation boundary condition

specifies that no current flows across the boundary.

This boundary condition is also applicable at symmetric boundaries where the 
potential is known to be symmetric with respect to the boundary.

E L E C T R I C  PO T E N T I A L

The electric-potential boundary condition 

n σ V∇ Je
–( )1 σ V∇ Je

–( )2–[ ]⋅ n– J1 J2–( )⋅ 0= =

n J⋅ n J0⋅=

n J⋅– Jn=

n J⋅ σ
d
--- V Vref–( ),= n J1 J2–( )⋅ σ

d
--- V Vref–( )=

n J⋅ 0=
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specifies the voltage at a boundary. Because you are solving for the potential in this 
application mode, you generally define the value of the potential at some boundary in 
the geometry. 

G R O U N D

The ground boundary condition 

is a special case of the previous one but specifies zero potential. This boundary 
condition is also applicable at symmetry boundaries where the potential is known to 
be antisymmetric with respect to the boundary.

C U R R E N T  S O U R C E

You can apply the current-source boundary condition

to interior boundaries that represent either a current source or sink.

C O N T I N U I T Y

The continuity boundary condition

specifies that the normal components of the electric current are continuous across the 
interior boundary.

C O N T A C T  R E S I S T A N C E

You can use the contact resistance boundary condition

to model a thin layer of a resistive material. The layer has the thickness d and the 
conductivity σ. This boundary condition is only available at the border between the 
parts in an assembly.

V V0=

V 0=

n J1 J2–( )⋅ Jn=

n J1 J2–( )⋅ 0=

n J1⋅ σ
d
--- V1 V2–( )=

n J2⋅ σ
d
--- V2 V1–( )=
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A X I A L  S Y M M E T R Y

In axisymmetric models, use the boundary condition for axial symmetry at the 
symmetry axis r = 0.

Line Sources

In 3D you can specify line sources along the edges of a geometry.

L I N E  C U R R E N T  S O U R C E

You can apply a line current source Qjl to edges. This source represents electric current 
per unit length.

Point Sources

It is possible to add point sources to both 2D and 3D models.

PO I N T  C U R R E N T  S O U R C E

You can apply a point current source Qj0 to points. This source represents an electric 
current flowing out of the point.

Application Mode Variables

The following table shows the fundamental fields, all derivable from the electric 
potential, that are available for postprocessing and for use in equations and boundary 
conditions.

NAME TYPE DESCRIPTION EXPRESSION

V S electric potential  V

sigma S electric conductivity  σ
sigmaij S electric conductivity, xixj component  σij

Qj S current source  Qj

Jei S external current density, 
xi component

normJe S external current density, norm

Jii S potential current density, 
xi component

 σijEj

normJi S potential current density, norm

Ji
e

Je Je⋅

Ji Ji⋅
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: dc), for example, 
normE_dc. (This does not apply to the dependent variable for the potential.) 

Ji S total current density, xi component

normJ S total current density, norm

Ei S electric field, xi component

normE S electric field, norm

Q S resistive heating  J · E

nJ B current density outflow  n ·  J

Qjl E line current source  Qjl

Qj0 P point current source  Qj0

NAME TYPE DESCRIPTION EXPRESSION

Ji
e Ji

i
+

J J⋅

V∂
xi∂

-------–

E E⋅
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Th e  E l e c t r o s t a t i c s  App l i c a t i o n  Mode

Applications involving electrostatics include high-voltage apparatus, electronic 
devices, and capacitors. The term “statics” means that the time rate of change of the 
electric field is slow, and that wavelengths are very large compared to the size of the 
domain of interest.

The Electrostatics application mode is available for 3D, 2D in-plane, and 2D 
axisymmetric models.

PDE Formulation

COMSOL Multiphysics carries out the modeling of static electric fields using the 
electric potential V. By combining the definition of potential with Gauss’ law and the 
equation of continuity, it is possible to derive the classic Poisson’s equation.

Specifically, under static conditions the electric potential, V, is defined by the 
relationship

Combining this equation with the constitutive relationship D = ε0 E + P between D 
and E, it is possible to represent Gauss’ law as Poisson’s equation

The In-plane Electrostatics application mode assumes a symmetry where the electric 
potential varies only in the x and y directions and is constant in the z direction. This 
implies that the electric field, E, is tangential to the xy-plane. Given this symmetry, you 
solve the same equation as in the 3D case.

The Axisymmetric Electrostatics application mode considers the situation where the 
fields and geometry are axially symmetric. In this case the electric potential is constant 
in the  direction, which implies that the electric field is tangential to the rz-plane.

Writing the previous equation for ρ in cylindrical coordinates and multiplying it by r 
to avoid singularities at r = 0, the equation becomes

E V∇–=

∇– ε0 V∇ P–( )⋅ ρ=

ϕ
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Application Scalar Variables

There is one application-specific scalar variable in this mode:

Boundary Conditions

The relevant interface condition at interfaces between different media for this mode is

In the absence of surface charges, this condition is fulfilled by the natural boundary 
condition

E L E C T R I C  D I S P L A C E M E N T

The electric-displacement boundary condition

specifies the normal component of the electric displacement at a boundary.

S U R F A C E  C H A R G E

The surface-charge boundary condition

specifies the surface charge density at an outer boundary or at an interior boundary 
between two nonconducting media. 

Z E R O  C H A R G E / S Y M M E T R Y

The zero charge/symmetry boundary condition

PROPERTY NAME DEFAULT DESCRIPTION

 ε0 epsilon0 8.854187817·10-12 F/m Permittivity of vacuum

r∂
∂

z∂
∂

T

– rε0
r∂

∂V

z∂
∂V

rP–

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ rρ=

n2 D1 D2–( )⋅ ρs=

n ε0 V∇ P–( )1 ε0 V∇ P–( )2–[ ]⋅ n– D1 D2–( )⋅ 0= =

n D⋅ n D0⋅=

n– D⋅ ρs,= n D1 D2–( )⋅ ρs=
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specifies that the normal component of the electric displacement equals zero.

This boundary condition is also applicable at symmetry boundaries where the potential 
is known to be symmetric with respect to the boundary.

E L E C T R I C  PO T E N T I A L

The electric-potential boundary condition 

specifies the voltage at a boundary. Because you are solving for the potential in this 
application mode, you generally define the value of the potential at some boundary in 
the geometry.

G R O U N D

The ground boundary condition 

is a special case of the previous one but specifying zero potential. This boundary 
condition is also applicable at symmetry boundaries where the potential is known to 
be antisymmetric with respect to the boundary.

C O N T I N U I T Y

The continuity boundary condition

specifies that the normal component of the electric displacement is continuous across 
the boundary.

T H I N  L O W  P E R M I T T I V I T Y  G A P

You can use the thin low permittivity gap condition

n D⋅ 0=

V V0=

V 0=

n D1 D2–( )⋅ 0=

n D1⋅ ε
d
--- V1 V2–( )=

n D2⋅ ε
d
--- V2 V1–( )=
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N

to model a thin gap of a material with a small permittivity compared to the adjacent 
domains. The layer has the thickness d and the relative permittivity εr. This boundary 
condition is only available at the border between the parts in an assembly.

A X I A L  S Y M M E T R Y

In axisymmetric models, use the boundary condition for axial symmetry on the 
symmetry axis r = 0.

Line Sources

In 3D models you can specify line sources along the edges of a geometry.

L I N E  C H A R G E

You can apply a line charge Ql along edges. Provide the source as the electric charge 
per unit length.

Point Sources

It is possible to use point sources in 2D and 3D models.

PO I N T  C H A R G E

You can apply a point charge Q0 at points in a model.

Application Mode Variables

The fundamental fields, which are derivable from the electric potential, are available 
for postprocessing and for use in equations and boundary conditions. The expressions 
for some variables in the following table vary depending on the constitutive 
relationship as indicated in the Const. Rel. column; the abbreviations indicate the 
constitutive relationship as given in the second table.

NAME TYPE CONST. REL. DESCRIPTION EXPRESSIO

V S electric potential  V

epsilon0 S permittivity of a vacuum  ε0

epsilonr S epsr, Dr relative permittivity  εr

epsilonr S P relative permittivity  1

epsilonrij S epsr, Dr relative permittivity, xixj component  εrij

epsilonrij S P relative permittivity, xixj component  1
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i

i

+ Dri

N

r

epsilon S permittivity  ε0εr

epsilonij S permittivity, xixj component  ε0εrij

Pi S P electric polarization, xi component  Pi

Pi S epsr, Dr electric polarization, xi component  Di − ε0 E

normP S electric polarization, norm

Dri S epsr remanent displacement, 
 xi component

 0

Dri S P remanent displacement, 
xi component

 Pi

Dri S Dr remanent displacement, 
xi component

 Dri

normDr S remanent displacement, norm

rho S space-charge density  ρ
Ei S electric field, xi component

normE S electric field, norm

Di S epsr electric displacement, xi component  εijEj

Di S P electric displacement, xi component  ε0 Ei + P
Di S Dr electric displacement, xi component  ε0εrij Ej 
normD S electric displacement, norm

We S electric-energy density

nD B surface-charge density  −n · D

Ql E line-charge density  Ql

Q0 P charge  Q0

NAME TYPE CONST. REL. DESCRIPTION EXPRESSIO

P P⋅

Dr D⋅

V∂
xi∂

-------–

E E⋅

D D⋅

E D⋅
2

--------------
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: es), for example, 
normE_es. (This does not apply to the dependent variable for the potential.)

TABLE 5-1:  ABBREVIATIONS FOR THE CONSTITUTIVE RELATIONSHIPS

ABBREVIATION CONSTITUTIVE RELATIONSHIP

epsr D = ε0εr E

P D = ε0 E + P
Dr D = ε0εr E + Dr
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Magne t o s t a t i c s  App l i c a t i o n  Mode

It is often possible to model magnets, electric motors, and transformers with 
magnetostatics. The term “statics” implies that the time rate of change of the magnetic 
field is slow.

The Magnetostatics application mode is available for 2D in-plane and 2D 
axisymmetric models.

PDE Formulation

To derive the equation system this mode solves, start with Ampère’s law for static cases,

The current is

where Je is an externally generated current density, and v is the velocity of the 
conductor.

Using the definitions of magnetic potential,

and the constitutive relationship, B = µ0 ( H + M ), you can rewrite Ampère’s law as

In the 2D case there are no variations in the z direction, and the current is parallel to 
the z-axis. Therefore you can add a term −σ∆V/L to the definition of the current where 
∆V is the potential difference over the distance L. This leads to

In 2D, that equation simplifies

∇ H× J=

J σv B× Je
+=

B ∇ A×=

∇ µ0
1– ∇ A× M–( )× σv ∇ A×( )×– Je

=

J σv B× Je σ∆V
L

--------–+=

∇ µ0
1– Az∇

M– y

Mx

–
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅– σv Az∇⋅+ σ∆V
L

-------- Jz
e

+=
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The axisymmetric case uses another form of the contribution of the current coming 
from a potential difference −σ ( Vloop/(2π r )) because current is present only in the 
azimuthal direction. The above equation then becomes, in cylindrical coordinates, 

The dependent variable u is the nonzero component of the magnetic potential divided 
by the radial coordinate r, that is,

The application mode performs this transformation to avoid singularities at the 
symmetry axis.

Application Mode Property

The application mode property appears in the following table:

Application Scalar Variable

The application scalar variable in this application mode is the permeability of vacuum.

Boundary and Interface Conditions

The relevant interface conditions are

The natural boundary condition fulfills this equation if the surface current vanishes. 
You can then transform the Neumann condition of the previous PDE to

PROPERTY VALUES DESCRIPTION

Analysis type Static | Time-harmonic Specifies which type of analysis to perform

PROPERTY NAME VALUE DESCRIPTION

 µ0 mu0 4π·10-7 H/m Permeability of vacuum

r∂
∂

z∂
∂

T

rµ0
1– r∂

∂u

z∂
∂u

µ0
1– 2

0
u

Mz

M– r

–+

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

– rσ v r∂
∂u

z∂
∂u

⋅

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

2σvru+ + σ
Vloop
2πr

------------- Jϕ
e

+=

u
Aϕ
r

-------=

n2 H1 H2–( )× Js=
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M A G N E T I C  F I E L D

The magnetic-field boundary condition

specifies the tangential component of the magnetic field at the boundary.

S U R F A C E  C U R R E N T

The surface current boundary condition

specifies a surface current flowing in the z direction.

E L E C T R I C  I N S U L A T I O N

The electric-insulation boundary condition

sets the magnetic field to zero. The term electric insulation arises from the fact that 
this boundary condition makes the normal component of the electric current equal to 
zero.

M A G N E T I C  P O T E N T I A L

The magnetic-potential boundary condition 

specifies the magnetic potential.

M A G N E T I C  I N S U L A T I O N

The magnetic-insulation boundary condition 

sets the magnetic potential to zero at the boundary. This boundary condition is also 
applicable at symmetry boundaries where the magnetic field is known to be tangential 
to the boundary.

n µ0
1– Az∇

M– y

Mx

–
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ n µ0
1– ∇ A× M–( )×– n H×– 0= = =

n H× n H0×=

n H×– Jszez= n H1 H2–( )× Jszez=

n H× 0=

Az A0z=

Az 0=
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The term magnetic insulation comes from the fact that this boundary condition 
makes the normal component of the magnetic field equal to zero. Thus the boundary 
is not truly insulating.

C O N T I N U I T Y

The continuity boundary condition

is the natural boundary condition implying continuity of the tangential component of 
the magnetic field.

Point Sources

You can specify that points in the geometry carry a current I0 flowing in the 
z direction.

Application Mode Variables

For time-harmonic analysis, all fundamental field quantities are available for 
postprocessing and for use in equations and boundary conditions. The same holds true 
for the magnetic potential and the time average of energy and heating expressions.

At the edges of a modeled structure you have access to the magnetic potential, electric 
field, and tangential magnetic field for postprocessing. The energy flow in the normal 
direction is also available.

The expressions for some variables in the following table vary depending on the 
constitutive relationship as indicated in the Const. Rel. column; the abbreviations 
indicate the constitutive relationship as given in the second table.

n H1 H2–( )× 0=

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Az S magnetic 
potential, 
z component

 Az

mu0 S permeability of a 
vacuum

 µ0

mur S mur, Br relative 
permeability

 µr
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mur S M relative 
permeability

 1

murij S mur, Br relative 
permeability, 
xixj component

 µrij

murij S M relative 
permeability, 
xixj component

 1

mu S permeability  µ0µr

muij S permeability, 
xixj component

 µ0µrij

sigma S electric 
conductivity

 σ

deltaV S potential 
difference

 ∆V

L S length  L

Mi S M magnetization, 
xi component

 Mi

Mi S mur, Br magnetization, 
xi component

  Bi / µ0 − Hi

normM S magnetization, 
norm

Bri S mur remanent flux 
density, 
xi component

 0

Bri S M remanent flux 
density, 
xi component

 µ0Mi

Bri S Br remanent flux 
density, 
xi component

 Bri

normBr S remanent flux 
density, norm

Jez S external current 
density, 
z component

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

M M*⋅

Br Br
*⋅

Jz
e
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vi S velocity, 
xi component

 vi

normv S velocity, norm

Bx S magnetic flux 
density, 
x component

By S magnetic flux 
density, 
y component

normB S magnetic flux 
density, norm

Hi S mur magnetic field, 
xi component

Hi S M magnetic field, 
xi component

  Bi / µ0 − Mi

Hi S Br magnetic field, 
xi component

normH S magnetic field, 
norm

Jpz S potential current, 
z component

 σ∆V/L

Jvz S velocity current 
density, 
z component

 σ(vx By − vy Bx)

Jz S total current 
density, 
z component

normJ S total current 
density, norm

 |Jz|

Wm S magnetic energy 
density

Q S resistive heating

FLtzi S Lorentz force, xi 
component

 J × B

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

v v⋅

Az∂
y∂

---------

Az∂
x∂

---------–

B B*⋅

µrij
1– Bj µ0⁄

µrij
1– Bj Brj–( ) µ0⁄

H H*⋅

Jz
e Jz

v Jz
p

+ +

H B⋅
2

--------------

Jz vxBy vyBx–
∆V
L

-------- σ 1– Jz
e

+ +⎝ ⎠
⎛ ⎞
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FsLtzi B Lorentz surface 
force, xi 
component

 Js × B

Jsz B surface current 
density, 
z component

 ny Hx − nx Hy

unTi B Maxwell surface 
stress tensor, xi 
component, up 
side of boundary

dnTi B Maxwell surface 
stress tensor, xi 
component, down 
side of boundary

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Aphidr S magnetic 
potential divided 
by r

 u

Aphi S magnetic 
potential, 

component

 ru

Aphir S magnetic 
potential, 
r derivative of 

component

Aphiz S magnetic 
potential, 
z derivative of 

component

mu0 S permeability of a 
vacuum

 µ0

mur S mur, Br relative 
permeability

 µr

mur S M relative 
permeability

 1

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

1
2
--- Hup Bup⋅( )nidown–

ndown Hup⋅( )Biup+

1
2
--- Hdown Bdown⋅( )niup–

nup Hdown⋅( )Bidown+

ϕ

ϕ

r u∂
r∂

------ u+

ϕ

r u∂
z∂

------
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murij S mur, Br relative 
permeability, 
xixj component

 µrij

murij S M relative 
permeability, 
xixj component

 1

mu S permeability  µ0µr

muij S permeability, 
xixj component

 µ0µrij

sigma S electric 
conductivity

 σ

Vloop S loop potential  Vloop

Mi S M magnetization, 
xi component

 Mi

Mi S mur, Br magnetization, 
xi component

  Bi / µ0 − Hi

normM S magnetization, 
norm

Bri S mur remanent flux 
density, 
xi component

 0

Bri S M remanent flux 
density, 
xi component

 µ0Mi

Bri S Br remanent flux 
density, 
xi component

 Bri

normBr S remanent flux 
density, norm

Jephi S external current 
density, 

component

vi S velocity, 
xi component

 vi

normv S velocity, norm

normE S electric field, 
norm

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

M M*⋅

Br Br
*⋅

ϕ

Jϕ
e

v v⋅

Eϕ
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Br S magnetic flux 
density, 
r component

Bz S magnetic flux 
density, 
z component

normB S magnetic flux 
density, norm

Hi S mur magnetic field, 
xi component

Hi S M magnetic field, 
xi component

  Bi / µ0 − Hi

Hi S Br magnetic field, 
xi component

normH S magnetic field, 
norm

Jpphi S loop current, 
component

 σVloop/2πr

Jiphi S induced current 
density, 

component

Jvphi S velocity current 
density, 

component

 σ(vz Br − vr Bz)

Jphi S total current 
density, 

component

normJ S total current 
density, norm

Wm S magnetic energy 
density

Q S resistive heating

Jsphi B surface current 
density, 

component

 nr Hz − nz Hr

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Aϕ∂
z∂

----------–

u
Aϕ∂
r∂

----------+

B B*⋅

µrij
1– Bj µ0⁄

µrij
1– Bj Brj–( ) µ0⁄

H H*⋅

ϕ

ϕ

σEϕ

ϕ

ϕ

Jϕ
e Jϕ

v Jϕ
p

+ +

Jϕ

H B⋅
2

--------------

Jϕ vrBz vzBr–
Vloop
2πr

------------- σ 1– Jϕ
e

+ +⎝ ⎠
⎛ ⎞

ϕ
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: qa), for example, 
normH_qa. (This does not apply to the dependent variables for the magnetic 
potential’s z component.)

unTi B Maxwell surface 
stress tensor, xi 
component, up 
side of boundary

dnTi B Maxwell surface 
stress tensor, xi 
component, down 
side of boundary

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

1
2
--- Hup Bup⋅( )nidown–

ndown Hup⋅( )Biup+

1
2
--- Hdown Bdown⋅( )niup–

nup Hdown⋅( )Bidown+

TABLE 5-2:  ABBREVIATIONS FOR THE CONSTITUTIVE RELATIONSHIPS

ABBREVIATION CONSTITUTIVE RELATIONSHIP

mur  B = µ0µr H

M  B = µ0 (H + M)
Br  B = µ0µr H + Br
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AC Powe r  E l e c t r omagne t i c s

AC power electromagnetics problems are common when studying motors, 
transformers, and conductors carrying alternating currents. 

You can use the AC Power Electromagnetics application mode for 2D in-plane and 
2D axisymmetric models.

PDE Formulation

To derive the equation system this mode solves, start with Ampère’s law,

.

Now assume time-harmonic fields and use the definitions of the potentials,

and combine them with the constitutive relationships B = µ0 ( H + M ) and 
D = ε0  E + P to rewrite Ampère’s law as

In the 2D in-plane case there are no variations in the z direction, and the electric field 
is parallel to the z-axis. Therefore you can write  as −∆V/L where ∆V is the 
potential difference over the distance L.

Now simplify these equations to

.

The axisymmetric case uses another form of the gradient of the electric potential, 
, because the electric field is present only in the azimuthal 

direction. The above equation, in cylindrical coordinates, becomes

∇ H× J D∂
t∂

-------+ σE σv B× Je D∂
t∂

-------+ + += =

B ∇ A×=

E ∇V–
t∂

∂A–=

jωσ ω2ε0–( )A ∇ µ0
1– ∇ A M–×( )× σv ∇ A×( ) σ jωε0+( )∇V+×–+ Je jωP+=

∇V

∇– µ0
1– Az∇

M– y

Mx

–
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅ σv+ ∇Az⋅ jωσ ω2ε0–( )Az+ σ∆V
L

-------- Jz
e

+ jωPz+=

∇V Vloop 2πr( )⁄–=
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ru
The dependent variable u is the nonzero component of the magnetic potential divided 
by the radial coordinate r, so that

The application mode performs this transformation to avoid singularities on the 
symmetry axis.

Application Scalar Variables

The application scalar variables in this application mode are:

The frequency occurs as a variable in time-harmonic problems.

Boundary and Interface Conditions

The relevant interface condition is

The natural boundary condition fulfills this equation if the surface current vanishes. 
You can transform the Neumann condition of this PDE into

PROPERTY NAME DEFAULT DESCRIPTION

 µ0 mu0 4π·10-7 H/m Permeability of vacuum

 ε0 epsilon0 8.854187817·10-12 F/m Permittivity of vacuum

 ν nu 50 Hz Frequency

r∂
∂

z∂
∂ rµ0

1– r∂
∂u

z∂
∂u

µ0
1– 2

0
u

Mz

M– r

–+

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

– rσ v r∂
∂u

z∂
∂u

⋅

⎝ ⎠
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎜ ⎟
⎛ ⎞

r σjω ω2ε0–( )u 2σv+ + +

σ
Vloop
2πr

-------------- Jϕ
e

+ jωPϕ+=

u
Aϕ
r

-------=

n2 H1 H2–( )× Js=
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M A G N E T I C  F I E L D

The magnetic-field boundary condition

specifies the tangential component of the magnetic field at the boundary.

S U R F A C E  C U R R E N T

The surface-current boundary condition

lets you specify a surface current flowing in the z direction.

E L E C T R I C  I N S U L A T I O N

The electric-insulation boundary condition

sets the magnetic field to zero. The term electric insulation comes from the fact that 
this boundary condition makes the normal component of the electric current equal to 
zero.

M A G N E T I C  P O T E N T I A L

The magnetic-potential boundary condition 

specifies the magnetic potential.

M A G N E T I C  I N S U L A T I O N

The magnetic insulation boundary condition 

n µ0
1– Az∇

M– y

Mx

–
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

1

µ0
1– Az∇

M– y

Mx

–
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

2

–⋅

n µ0
1– ∇ A× M–( )1 µ0

1– ∇ A× M–( )2–[ ]×–=

n H1 H2–( )×– 0= =

n H× n H0×=

n H×– Jszez= n H1 H2–( )× Jszez=

n H× 0=

Az A0z=

Az 0=
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sets the magnetic potential to zero at the boundary. This boundary condition is also 
applicable at symmetry boundaries where the magnetic field is known to be tangential 
to the boundary.

The term magnetic insulation comes from the fact that this boundary condition 
makes the normal component of the magnetic field zero. Thus the boundary is not 
truly insulating.

C O N T I N U I T Y

The continuity boundary condition

is the natural boundary condition implying continuity of the tangential component of 
the magnetic field.

Point Sources

You can specify that points in the geometry carry a current I0 flowing in the 
z direction.

Application Mode Variables

For time-harmonic analysis, all the fundamental field quantities are available for 
postprocessing and for use in equations and boundary conditions. The same holds true 
for the magnetic potential and the time average of energy and heating expressions.

At the edges of the modeled structure you can also use the magnetic potential, electric 
field and tangential magnetic field for postprocessing. The energy flow in the normal 
direction is also available.

The expressions for some variables in the following table vary depending on the 
constitutive relationship as indicated in the Const. Rel. column; the abbreviations 
indicate the constitutive relationship as given in the second table.’

n H1 H2–( )× 0=

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Az S magnetic 
potential, 
z component

 Az

nu S frequency  ν
omega S angular frequency  2πν
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epsilon0 S permittivity of a 
vacuum

 ε0

mu0 S permeability of a 
vacuum

 µ0

mur S mur, Br relative 
permeability

 µr

mur S M relative 
permeability

 1

murij S mur, Br relative 
permeability, 
xixj component

 µrij

murij S M relative 
permeability, 
xixj component

 1

mu S permeability  µ0µr

muij S permeability, 
xixj component

 µ0µrij

epsilonr S epsr, Dr relative 
permittivity

 εr

epsilonr S P relative 
permittivity

 1

epsilon S permittivity  ε0εr

sigma S electric 
conductivity

 σ

deltaV S potential 
difference

 ∆V

L S length  L

Pz S P electric 
polarization, 
z component

 Pze
jphase

Pz S epsr, Dr electric 
polarization, 
z component

 Dz − ε0 Ez

Drz S epsr remanent 
displacement, 
z component

 0

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION
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Drz S P remanent 
displacement, 
z component

 Pz

Drz S Dr remanent 
displacement, 
z component

 Drze
jphase

Mi S M magnetization, 
xi component

 Mie
jphase

Mi S mur, Br magnetization, 
xi component

  Bi / µ0 − Hi

normM S magnetization, 
norm

Bri S mur remanent flux 
density, 
xi component

 0

Bri S M remanent flux 
density, 
xi component

 µ0Mi

Bri S Br remanent flux 
density, 
xi component

 Bri e
jphase

normBr S remanent flux 
density, norm

Jez S external current 
density, 
z component

vi S velocity, 
xi component

 vi

normv S velocity, norm

Ez S electric field, 
z component

 −jωAz

normE S electric field, 
norm

 |Ez|

Dz S epsr electric 
displacement, 
z component

 ε0εrEz

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

M M*⋅

Br Br
*⋅

Jz
eejphase

v v⋅
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Dz S P electric 
displacement, 
z component

 ε0 Ez + Pz

Dz S Dr electric 
displacement, 
z component

 ε0εr Ez + Drz

normD S electric 
displacement, 
norm

 |Dz|

Bx S magnetic flux 
density, 
x component

By S magnetic flux 
density, 
y component

normB S magnetic flux 
density, norm

Hi S mur magnetic field, 
xi component

Hi S M magnetic field, 
xi component

  Bi / µ0 − Mi

Hi S Br magnetic field, 
xi component

normH S magnetic field, 
norm

Jpz S potential current, 
z component

 σ∆V/L

Jiz S induced current 
density, 
z component

 σEz

Jdz S displacement 
current density, 
z component

 jωDz

Jvz S velocity current 
density, 
z component

 σ(vx By − vy Bx)

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Az∂
y∂

---------

Az∂
x∂

---------–

B B*⋅

µrij
1– Bj µ0⁄

µrij
1– Bj Brj–( ) µ0⁄

H H*⋅
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z
e*
⎠
⎞
⎠
⎞

Jz S total current 
density, 
z component

normJ S total current 
density, norm

 |Jz|

Weav S time average 
electric energy 
density

Wmav S time average 
magnetic energy 
density

Wav S time average total 
energy density

Qav S time average 
resistive heating

Poxav S time average 
power flow, 
x component

Poyav S time average 
power flow, 
y component

normPoav S time average 
power flow, norm

Qmav S time average 
magnetic 
hysteresis losses

FLtzi S Lorentz force, 
xi component

 J × B

FLtzavi S cycle average 
Lorentz force, 
xi component

FsLtzi B Lorentz surface 
force, 
xi component

 Js × B

FsLtzavi B cycle average 
Lorentz surface 
force, 
xi component

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Jz
e Jz

v Jz
p Jz

i Jz
d

+ + + +

1
4
---Re EzDz

*( )

1
4
---Re H B*⋅( )

We
av Wm

av
+

1
2
---Re Jz Ez

* vxBy
* vyBx

*
–

∆V*

L
----------- σ 1– J+ + +⎝

⎛
⎝
⎛

1
2
---Re EzHy

*( )–

1
2
---Re EzHx

*( )

Sav Sav*⋅

1
2
---– Re jωH B*⋅( )

1
2
--- J B*×( )i

1
2
--- Js B*×( )

i
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Jsz B surface current 
density, 
z component

 ny Hx − nx Hy

nPoav B time average 
power outflow

 n · Sav

unTiav B Maxwell surface 
stress tensor, 
xi component, 
upside of 
boundary

dnTiav B Maxwell surface 
stress tensor, 
xi component, 
downside of 
boundary

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Aphidr S magnetic 
potential divided 
by r

 u

Aphi S magnetic 
potential, 

component

 ru

Aphir S magnetic 
potential, 
r derivative of 

component

Aphiz S magnetic 
potential, 
z derivative of 

component

nu S frequency  ν
omega S angular frequency  2πν
epsilon0 S permittivity of 

vacuum
 ε0

mu0 S permeability of 
vacuum

 µ0

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

1
4
---Re Hup Bup

*⋅( )nidown–

1
2
---Re ndown Hup⋅( )Biup

*( )+

1
4
---Re Hdown Bdown

*⋅( )niup–

1
2
---Re nup Hdown⋅( )Bidown

*( )+

ϕ

ϕ

r u∂
r∂

------ u+

ϕ

r u∂
z∂

------
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mur S mur, Br relative 
permeability

 µr

mur S M relative 
permeability

 1

murij S mur, Br relative 
permeability, 
xixj component

 µrij

murij S M relative 
permeability, 
xixj component

 1

mu S permeability  µ0µr

muij S permeability, 
xixj component

 µ0µrij

epsilonr S epsr, 
Dr

relative 
permittivity

 εr

epsilonr S P relative 
permittivity

 1

epsilon S permittivity  ε0εr

sigma S electric 
conductivity

 σ

Vloop S loop potential  Vloop

Pphi S P electric 
polarization, 

 component

Pphi S epsr, 
Dr

electric 
polarization, 

 component

Drphi S epsr remanent 
displacement, 

 component

 0

Drphi S P remanent 
displacement, 

 component

Drphi S Dr remanent 
displacement, 

 component

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

ϕ

Pϕejphase

ϕ

Dϕ ε0Eϕ–

ϕ

ϕ

Pϕ

ϕ

Drϕejphase
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Mi S M magnetization, 
xi component

 Mi e
jphase

Mi S mur, Br magnetization, 
xi component

normM S magnetization, 
norm

Bri S mur remanent flux 
density, 
xi component

 0

Bri S M remanent flux 
density, 
xi component

 µ0 Mi

Bri S Br remanent flux 
density, 
xi component

 Bri e
jphase

normBr S remanent flux 
density, norm

Jephi S external current 
density, 

 component

vi S velocity, 
xi component

 vi

normv S velocity, norm

Ephi S electric field, 
 component

 

normE S electric field, 
norm

Dphi S epsr electric 
displacement, 

 component

Dphi S P electric 
displacement, 

 component

Dphi S Dr electric 
displacement, 

 component

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Bi µ0⁄ Hi–

M M*⋅

Br Br
*⋅

ϕ

Jϕ
e ejphase

v v⋅

ϕ
jωAϕ–

Eϕ

ϕ

ε0εrEϕ

ϕ

ε0Eϕ Pϕ+

ϕ

ε0εrEϕ Drϕ+
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normD S electric 
displacement, 
norm

Br S magnetic flux 
density, 
r component

Bz S magnetic flux 
density, 
z component

normB S magnetic flux 
density, norm

Hi S mur magnetic field, 
xi component

Hi S M magnetic field, 
xi component

  Bi / µ0 − Mi

Hi S Br magnetic field, 
xi component

normH S magnetic field, 
norm

Jpphi S loop current, 
 component

 σVloop / 2πr

Jiphi S induced current 
density, 

 component

Jdphi S displacement 
current density, 

 component

Jvphi S velocity current 
density, 

 component

 σ(vz Br − vr Bz)

Jphi S total current 
density, 

 component

normJ S total current 
density, norm

Weav S time-average 
electric energy 
density

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

Dϕ

Aϕ∂
z∂

----------–

u
Aϕ∂
r∂

----------+

B B*⋅

µrij
1– Bj µ0⁄

µrij
1– Bj Brj–( ) µ0⁄

H H*⋅

ϕ

ϕ

σEϕ

ϕ

jωDϕ

ϕ

ϕ

Jϕ
e Jϕ

v Jϕ
p Jϕ

i Jϕ
d

+ + + +

Jϕ

1
4
---Re EϕDϕ

*( )
 5 :  E L E C T R O M A G N E T I C S



ϕ
e*

⎠
⎟
⎞

⎠
⎟
⎞

Wmav S time-average 
magnetic energy 
density

Wav S time-average total 
energy density

Qav S time-average 
resistive heating

Porav S time-average 
power flow, 
r component

Pozav S time-average 
power flow, 
z component

normPoav S time-average 
power flow, norm

Jsphi B surface current 
density, 

 component

 nr Hz − nz Hr

nPoav B time-average 
power outflow

 n · Sav

unTiav B Maxwell surface 
stress tensor, 
xi component, 
upside of 
boundary

dnTiav B Maxwell surface 
stress tensor, 
xi component, 
downside of 
boundary

NAME TYPE CONST. 
REL.

DESCRIPTION EXPRESSION

1
4
---Re H B*⋅( )

We
av Wm

av
+

1
2
---Re Jϕ Eϕ

* vrBz
* vzBr

*
–

Vloop
*

2πr
------------- σ 1– J+ + +

⎝
⎜
⎛

⎝
⎜
⎛

1
2
---Re EϕHz

*( )–

1
2
---Re EϕHz

*( )

Sav Sav*⋅

ϕ

1
4
---Re Hup Bup

*⋅( )nidown–

1
2
---Re ndown Hup⋅( )Biup

*( )+

1
4
---Re Hdown Bdown

*⋅( )niup–

1
2
---Re nup Hdown⋅( )Bidown

*( )+
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: qa), for example, Jz_qa. 
(This does not apply to the dependent variable for the magnetic potential.)

TABLE 5-3:  ABBREVIATIONS FOR THE CONSTITUTIVE RELATIONSHIPS

ABBREVIATION CONSTITUTIVE RELATIONSHIP

mur B = µ0µr H

M B = µ0 (H + M )
Br B = µ0µr H + Br
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Examp l e—El e c t r i c  S e n s o r

This is a model from electric impedance tomography, a method of imaging the interior 
permittivity distribution of an object by measuring current and voltage at the surface. 
The technique is used in, for example, medical diagnosis. Because different organs have 
different properties, you can “see” the organs and their movement from the outside.

The model shows how you can determine the shape and the placement of small objects 
with different material properties inside a closed box from outside. Applying a potential 
difference on the boundaries of the box gives rise to a surface charge density that varies 
depending on the permittivity distribution inside the box. By looking at the surface 
charge density you can therefore see the shape of the different materials inside the box.

Model Definition

This model solves Gauss’ law with ρ = 0.

 

The box contains air with εr equal to 1 and the different objects are made of material 
with different values of the relative permittivity, εr: 1, 2, and 3.

To get a voltage difference, set V = 0 on the bottom and V = 1 on top of the box. On 
all the other boundaries, use an electric insulation condition: n · D = 0.

Results and Discussion

The surface charge density is higher above material with higher permittivity as 
expected. You can clearly see the shape of the figures inside the box on the top surface 
in the following plot.

∇ ε0εr∇V( )⋅– ρ=
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Inside the geometry the streamlines show how the electric field varies. The gradient of 
the electric field is lower in media with larger value of the permittivity.

Model Library path: COMSOL_Multiphysics/Electromagnetics/
electric_sensor

Modeling Using the Graphical User Interface

1 Open COMSOL Multiphysics.

2 In the Model Navigator, change the space dimension to 3D and select COMSOL 

Multiphysics>Electromagnetics>Electrostatics in the list of COMSOL Multiphysics 
application modes.

3 Click OK.

G E O M E T R Y  M O D E L I N G

1 Select Work-Plane Settings from the Draw menu. Set z to 0.1 and click OK.
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2 From the Options menu, choose Axes/Grid Settings.

3 Enter the following data; when done, click OK (to enter the spacings on the Grid 
page, first clear the Auto check box):

4 Draw a rectangle by clicking on the Rectangle/Square button and then clicking at the 
points (−1, 0.5) and (−0.5, 2.5).

5 Specify two rectangles by choosing Specify Objects>Rectangle from the Draw menu. 
Use the following data:

6 Select all objects by pressing Ctrl+A. On the Draw toolbar, click the Union button 
and then the Delete Interior Boundaries button.

7 Draw an ellipse by pressing the Ellipse/Circle (Centered) button. Click (1.5, 1.5) and 
(0.5, 1).

8 Draw another ellipse clicking at the points (1.5, 1.5) and (1, 0.5).

9 From the Draw menu or the Draw toolbar, open the Create Composite Object dialog 
box and select E1 and E2. Clear the Keep interior boundaries check box, and click OK.

AXIS PAGE

x min -2

x max 3

y min 0

y max 3

GRID PAGE

x spacing 0.5

y spacing 0.5

R2 R3

Width 1.5 1.5

Height 0.25 0.25

x -1.5 -1.5

y 1 1.75
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10 Select Extrude from the Draw menu, select both objects and enter 0.8 in the Distance 
edit field. Click OK.

11 Click the Block button. Enter the following dimensions and base point coordinates 
to create a block:

12 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 Open the Boundary Settings dialog box from the Physics menu.

2 Press Ctrl+A to select all boundaries. Set the boundary condition to Zero charge/

Symmetry.

3 Select Boundary 3 and set the boundary condition to Ground.

BLOCK BLK1

Length Axis base point

x 5 -2

y 3 0

z 1 0
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4 Select Boundary 4 and set the boundary condition to Electric potential and V0 to 1.

5 Click OK.

Subdomain Settings
In the Subdomain Settings dialog box, set the following values of εr:

M E S H  G E N E R A T I O N

1 Open the Free Mesh Parameters dialog box and select Fine from the Predefined mesh 

sizes list on the General tab. Click OK to close the dialog box.

2 Click the Initialize Mesh button on the Main toolbar to initialize the mesh.

C O M P U T I N G  T H E  S O L U T I O N

Solve the model by clicking the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

1 Open the Plot Parameters dialog box.

2 On the General page clear the Slice check box and select the Boundary and Streamline 
check boxes.

3 Click the Boundary tab. In the Boundary data area, select Surface charge density from 
the Predefined quantities list. In the Unit edit field, type pC/m^2.

4 In the Boundary color area, select Cyclic from the Color table list.

5 On the Streamline page, click the Line Color tab.

6 Click the Use expression button. Then click the Color Expression button and set the 
color data to Electric potential in the Predefined quantities list. Click OK.

7 Click the Start Points tab. Type 100 in the Number of start points edit field.

8 Select Tube from the Line type list.

9 Click the Tube Radius button and set the Radius data to Electric field, norm. Click OK.

10 Click OK.

To see the streamlines inside the box you must suppress some of the boundaries:

1 On the Options menu, point to Suppress and then click Suppress Boundaries.

2 In the dialog box select Boundaries 1, 2, and 6–37. Click OK.

3 Open the Plot Parameters dialog box and click OK.

SETTING SUBDOMAIN 1 SUBDOMAIN 2 SUBDOMAIN 3

 εr 1 2 3
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Examp l e—A Pe rmanen t  Magn e t

As an example of a magnetostatics problem, consider how to model a 
horseshoe-shaped permanent magnet. It consists of a ferromagnetic material, but the 
two end sections, often painted red and white, are premagnetized in opposite 
directions. The magnetic field pattern around such a permanent magnet is well known.

The domain consists of four regions: 

• Three parts of the permanent magnet—the two premagnetized ends and the curved 
midsection

• The air surrounding the magnet

The permeability µ in air equals µ0 = 4π·10−7 H/m. Because the magnet is made of a 
ferromagnetic material, its relative permeability normally depends on the strength of 
the magnetic field, but in this model it is a constant with a value of 5000. The 
premagnetization adds a magnetization vector, pointing in the positive x direction at 
the upper end and in the negative x direction in the lower end. The magnitude of the 
magnetization is 750 kA/m.

It is reasonable to neglect the field at the boundaries of the computational domain, 
thus leading to the Dirichlet boundary condition A = 0 on the exterior boundary.

Model Library path: COMSOL_Multiphysics/Electromagnetics/
permanent_magnet

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go to the Model Navigator and select 2D in the Space dimension list.

2 Open the COMSOL Multiphysics>Electromagnetics folder and then select 
Magnetostatics in the list of application modes.

3 Use the default quadratic Lagrange elements.

4 Click OK.
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O P T I O N S  A N D  S E T T I N G S

1 Enter the following values in the Axes/Grid Settings dialog box. To set the grid 
spacing, click the Grid tab and clear the Auto check box.

2 Enter these names and expressions in the Constants dialog box:

G E O M E T R Y  M O D E L I N G

Start by modeling the upper and the lower premagnetized parts of the magnet.

1 Click the Rectangle/Square button and draw a rectangle from (0, 0.2) to (0.4, 0.4).

2 Click the Rectangle/Square button and draw a rectangle from (0, −0.4) to (0.4, −0.2).

Next draw the rest of the magnet using boundary modeling:

3 Click the Line button, and click the points (0.4, 0.2), (0.4, 0.4), and (0.6, 0.4).

4 Click the 2nd Degree Bézier Curve button, then click at the points (1, 0.4), (1, 0), 
(1, −0.4), and (0.6, −0.4).

5 Click Line and then click at the points (0.4, −0.4), (0.4, −0.2), and (0.6, −0.2).

6 Click 2nd Degree Bézier Curve and then click at the points (0.8, −0.2), (0.8, 0), 
(0.8, 0.2), and (0.6, 0.2).

7 Close the region with the right mouse button.

The last step in creating the geometry is to model the surrounding air.

8 Draw a rectangle from (−3, −2) to (3, 2).

AXIS GRID

x min -3 x spacing 0.2

x max 3 Extra x

y min -2 y spacing 0.2

y max 2 Extra y

NAME EXPRESSION

murFe 5000

Mpre 750000
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P H Y S I C S  S E T T I N G S

Boundary Conditions
Use the default magnetic insulation boundary condition everywhere.

Subdomain Settings
The relative permeability for the magnet is 5000, and the magnetization vector is 
(Mpre, 0) in the upper premagnetized part and (−Mpre, 0) in the lower part.

1 Go to the Physics menu and choose Subdomain Settings.

2 Enter the PDE coefficients as shown in the following table. For Subdomains 1 and 
4 use the default constitutive relationship B = µ0µrH, and for Subdomains 2 and 3 
use the constitutive relationship B = µ0H + µ0M.

SETTINGS SUBDOMAIN 1 SUBDOMAIN 2 SUBDOMAIN 3 SUBDOMAIN 4

 µr 1 murFe

 Mx -Mpre Mpre

 My 0 0
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M E S H  G E N E R A T I O N

To resolve the field at the ends of the magnets, use a smaller mesh size at those 
boundaries:

1 From the Mesh menu, choose Free Mesh Parameters.

2 Click the Boundary tab.

3 Select Boundaries 4 and 7 (the ends of the magnet).

4 Type 0.01 in the Maximum element size edit field.

5 Click OK.

6 Click the Initialize Mesh button on the Main toolbar to create the mesh.

C O M P U T I N G  T H E  S O L U T I O N

Use the adaptive solver to improve the solution accuracy.

1 Go to the Solve menu and choose Solver Parameters.

2 In the Solver Parameters dialog box, select the Adaptive mesh refinement check box 
underneath the Solver list.

3 Click OK.

4 Click the Solve button.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

Use the streamline plot to visualize the magnetic field using field lines where the 
distance between the lines is inversely proportional to the magnetic field strength.

1 Open the Plot Parameters dialog box.

2 Select the Contour and Arrow check boxes and clear the Surface check box in the Plot 

type area on the General page.

3 Click the Contour tab.

4 Select Magnetic potential, z component from the Predefined quantities list.

5 Click the Arrow tab.

6 Select Magnetic flux density from the Predefined quantities list.

7 Type 20 as Number of points in the x points and y points edit fields in the Arrow 

positioning area.

8 Select Normalized from the Arrow length list.

9 Clear the Auto check box and type 0.2 in the Scale factor edit field.

10 Click OK.
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The resulting plot shows the well-known field pattern.

Alternative Modeling Approach

An alternate way to model a permanent magnet is to set surface currents on the 
premagnetized parts. To do so, change the model from the previous discussion in the 
following fashion:

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 Select the Interior boundaries check box in the Boundary Settings dialog box.

2 Enter these boundary coefficients:

SETTINGS BOUNDARIES 5, 9 BOUNDARIES 6, 8

Type Surface current Surface current

Jsz Mpre -Mpre
 5 :  E L E C T R O M A G N E T I C S



Subdomain Settings
Modify the subdomain settings to remove the magnetization:

C O M P U T I N G  T H E  S O L U T I O N

Go to the Solver Parameters dialog box and clear the Adaptive mesh refinement check 
box to turn off the adaptive solver. Simply use the mesh obtained by solving the 
previous problem. Solve the problem again.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The solution plot reveals a result identical to the one where you modeled the 
premagnetization using a magnetization vector.

References
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SETTING SUBDOMAINS 2, 3

Mx 0
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 6
F l u i d  M e c h a n i c s
This chapter explains how to use the Incompressible Navier-Stokes application 
mode for the modeling and simulation of fluid mechanics and fluid statics. Note 
that the engineering community often uses the term CFD, computational fluid 
dynamics, to refer to the numerical simulation of fluids. This chapter concludes 
with step-by-step instructions on how to model a common benchmark problem: 
flow over a backward step in the absence of external forces.
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Th e  Na v i e r - S t o k e s  App l i c a t i o n  Mode

Fluid mechanics deals with studies of gases and liquids either in motion (fluid 
dynamics) or at rest (fluid statics). When studying liquid flows, it is often safe to 
assume that the material’s density is constant or almost constant. You then have an 
incompressible fluid flow. Using the Incompressible Navier-Stokes application mode 
you can solve transient and steady-state models of incompressible fluid dynamics.

In the Model Navigator you find two entry points for Incompressible Navier-Stokes. 
These are Steady-state analysis, and Transient analysis.

Note: The optional Chemical Engineering Module contains more extensive 
application modes for incompressible Navier-Stokes problems including 
non-Newtonian flow and turbulence modeling using the k-ε and k-ω models. It also 
supplies application modes for non-isothermal and weakly compressible flow, swirl 
flow, multiphase flow, and the Brinkman equations and Darcy’s law for flow in porous 
media.

Variables and Space Dimension

The Incompressible Navier-Stokes application mode solves for the pressure p and the 
velocity vector components. It is available for 2D, 2D axisymmetric, and 3D 
geometries.

PDE Formulation and Equations

COMSOL Multiphysics uses a generalized version of the Navier-Stokes equations to 
allow for variable viscosity. 

Starting with the momentum balance in terms of stresses, the generalized equations in 
terms of transport properties and velocity gradients are

 (6-1)
ρ

t∂
∂u ∇ η ∇u ∇u( )T

+( )[ ]⋅– ρ u ∇⋅( )u ∇p+ + F=

∇ u⋅ 0=
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The first equation is the momentum transport equations, and the second is the 
equation of continuity for incompressible fluids. The following variables and 
parameters appear in the equations:

• η is the dynamic viscosity

• ρ is the density

• u is the velocity field

• p is the pressure

• F is a volume force field such as gravity

These application modes are general enough to account for all types of incompressible 
flow. In practice, though, successful analysis of turbulent flows requires simplifications 
of the description of transport of momentum.

Subdomain Settings

The subdomain quantities are:

Density   This material property specifies the fluid density.

Dynamic Viscosity   This term describes the relationship between the shear stresses in a 
fluid and the shear rate. Intuitively, water and air have a low viscosity, and substances 
often described as thick, such as oil, have a higher viscosity. You can describe some 
non-Newtonian fluid by defining a shear-rate dependent viscosity. Examples of 
non-Newtonian fluids include yoghurt, paper pulp, and polymer suspensions.

Volume Force   The volume force vector, F = (Fx, Fy, Fz), describes a distributed force 
field such as gravity. The unit of the volume force is force/volume.

PARAMETER VARIABLE DESCRIPTION

 ρ rho Density

 η eta Dynamic viscosity

 F F Volume force
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You specify the subdomain properties in the Subdomain Settings dialog box.

Boundary Conditions

The boundary conditions for the Incompressible Navier-Stokes application mode are 
grouped into the following types:

• Wall

- No slip (default)

- Slip

- Sliding wall

- Moving/leaking wall

• Inlet

- Velocity (default)

- Pressure, no viscous stress

• Outlet

- Velocity

- Pressure

- Pressure, no viscous stress (default)

- No viscous stress

- Normal stress
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• Symmetry boundary

- Symmetry (default)

- Axial symmetry (2D axisymmetry only)

• Open boundary

- Normal stress (default)

- No viscous stress

• Stress

- General stress (default)

- Normal stress

- Normal stress, normal flow

You specify a boundary condition in the Boundary Settings dialog box, where you first 
select the appropriate Boundary type and then a Boundary condition.

Figure 6-1: Boundary Settings dialog box for the Incompressible Navier-Stokes application 
mode.

If a mathematical formulation describes more than one type of physical boundary 
condition, it can appear in more than one boundary type. However, every possible use 
of a single mathematical formulation cannot be covered. Hence, the boundary types 
should be regarded as guidelines, not as restrictions on the applicability of the 
formulations.

The theory of most boundary conditions can be found in Ref. 1.
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WA L L

These boundary conditions describe the existence of a solid wall.

No Slip
This is the standard and default boundary condition for a stationary solid wall. The 
condition prescribes

that is, that the fluid at the wall is not moving.

Moving/Perforated Wall
If the wall moves, so must the fluid. Hence, this boundary condition prescribes

Note that setting this boundary condition does not automatically cause the associated 
wall to move. The section “The Moving Mesh Application Mode” on page 455 of the 
COMSOL Multiphysics Modeling Guide describes how to set up a model with moving 
boundaries.

You can also use the Moving/perforated wall boundary condition to simulate a wall 
where fluid is leaking into or leaving through a perforated wall.

Sliding Wall
If you use this boundary condition, the wall is assumed to behave like a conveyor belt, 
that is, that the surface is sliding in its tangential direction. The wall does not have to 
actually move in the coordinate system.

In two space dimensions (2D), the tangential direction is unambiguously defined by 
the direction of the boundary. However, the situation becomes more complicated in 
3D. For this reason, this boundary condition has slightly different definitions in the 
different space dimensions.

2D and Axial Symmetry   The velocity is given as a scalar Uw and the condition 
prescribes

where t = (−ny , nx) for 2D and t = (−nz , nr) for axial symmetry.

3D   The velocity is set equal to a given vector uw projected onto the boundary plane:

u 0=

u uw=

u n⋅ 0=

u t⋅ Uw=
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Slip
The slip condition assumes that there are no viscous effects at the slip wall and hence, 
no boundary layer develops. From a modeling point of view, this may be a reasonable 
approximation if the important effect of the wall is to prevent fluid from leaving the 
domain. Mathematically, the constraint can be formulated as:

where t is a tangential vector to the boundary.

I N L E T

This boundary type contains different ways to specify conditions on a boundary where 
the fluid is supposed to enter the domain. Notice that the formulations contained in 
this boundary type all appear, some of them slightly modified, in the Outflow 
boundary type as well. Hence, there is nothing in the mathematical formulations that 
prevents a fluid from leaving the domain through boundaries where you have specified 
the Inlet boundary type.

Velocity
This boundary condition offers two ways to specify an inlet velocity. The first is to set 
the velocity equal to a given vector u0:

The other is to specify a normal inflow velocity:

Note that the boundary normal, n, points out of the domain.

Pressure, No Viscous Stress
This boundary condition specifies vanishing viscous stress along with a Dirichlet 
condition on the pressure:

It is a numerically stable boundary condition that admits total control of the pressure 
level along the entire boundary. However, if the inflow is not normal to the boundary, 
this condition is an overspecification. In the case that your solution turns out to have 
a non-normal inflow velocity, there are two choices. Either, move the boundary farther 

u uw n uw⋅( )n–=

u n⋅ 0,= t pI– η ∇u ∇u( )T+( )+( )n⋅ 0=

u u0=

u nU0–=

η ∇u ∇u( )T
+( )n 0,= p p0=
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away to a location where the inflow is normal to the boundary or, use a stress type 
boundary condition described on page 143.

Note that this condition is identical to the Pressure, no viscous stress condition for 
Outflow boundaries. Hence, depending on the pressure field in the rest of the 
subdomain, a boundary with this condition can very well become an outflow 
boundary.

O U T F L O W

This boundary type contains different ways to specify conditions on a boundary where 
the fluid exits the domain. Note that all of the formulations in this type can be found, 
possibly slightly modified, in other boundary types as well. Hence, there is nothing in 
the mathematical formulations that prevent a fluid from entering the domain through 
boundaries where you have set the Outflow boundary type.

Setting outlet conditions for the Navier-Stokes equations is not a trivial task. A general 
rule of thumb, however, is that if there is something interesting happening at an 
outflow boundary, extend the computational domain to include this phenomenon.

Velocity
This boundary condition offers two ways to specify an outlet velocity. The first is to set 
the velocity equal to a given vector u0:

The other is to specify a normal outlet velocity:

Observe that the boundary normal, n, is pointing out of the domain.

Pressure, No Viscous Stress
This boundary condition specifies vanishing viscous stress along with a Dirichlet 
condition on the pressure:

It is a numerically stable boundary condition that admits total control of the pressure 
level at the whole boundary. However, if the outflow is not normal to the boundary, 
this condition is an overspecification. In the case that your solution turns out to have 
a non-normal outflow velocity, there are two choices. Either move the boundary 

u u0=

u nU0=

η ∇u ∇u( )T+( )n 0,= p p0=
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farther away to a location where the outflow is normal to the boundary or use a stress 
type boundary condition described on page 143.

Note that this condition is identical to the Pressure, no viscous stress condition for 
Inflow boundaries. Hence, depending on the pressure field in the rest of the 
subdomain, a boundary with this condition can very well become an inflow boundary.

Pressure
This boundary condition prescribes only a Dirichlet condition for the pressure:

Use this boundary condition only for high Reynolds number outflow boundaries; that 
is, boundaries where the cell Reynolds number Rec = ρ| u |h/(2η) >>1 (h is the local 
mesh element size). It is far less stable than the Pressure, no viscous stress boundary 
condition, but it is consistent with a non-normal outflow velocity. The cell Reynolds 
number is available for postprocessing using the default name cellRe_ns.

No Viscous Stress
Prescribes vanishing viscous stress:

This condition can be useful in some situations because it does not impose any 
constraint on the pressure. A typical example is a model with volume forces that give 
rise to pressure gradients that are hard to prescribe in advance. It should however be 
combined with a point constraint on the pressure to be numerically stable (see “Point 
Settings” on page 144).

Normal Stress
The total stress on the boundary is set equal to a stress vector of magnitude, f0, 
oriented in the negative normal direction:

This implies that the total stress in the tangential direction is zero. This boundary 
condition implicitly sets a constraint on the pressure that for 2D flows can be written

 (6-2)

If ∂un/∂n is small, Equation 6-2 can be interpreted as p ≈ f0.

p p0=

η ∇u ∇u( )T+( )n 0=

pI– η ∇u ∇u( )T+( )+( )n f0n–=

p 2η
∂un
∂n

---------- f0+=
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S Y M M E T R Y  B O U N D A R Y

Prescribes no penetration and vanishing shear stresses:

In 2D Axial Symmetry, the above formulation is called Symmetry.

Axial Symmetry
This boundary condition is only available in 2D Axial Symmetry. Use it on all 
boundaries with coordinate r = 0. It prescribes ur = 0 and vanishing stresses in the 
z direction.

O P E N  B O U N D A R Y

You can use this boundary type on boundaries that are open to large volumes of fluid. 
Fluid can both enter and leave the domain on boundaries with this type of condition.

No Viscous Stress
Prescribes vanishing viscous stress:

This condition can be useful in some situations because it does not impose any 
constraint on the pressure. A typical example is a model with volume forces that give 
rise to pressure gradients that are hard to prescribe in advance. It should however be 
combined with a point constraint on the pressure to be numerically stable (see “Point 
Settings” on page 144).

Normal Stress
The total stress on the boundary is set equal to a stress vector of magnitude, f0, 
oriented in the negative normal direction:

This implies that the total stress in the tangential direction is zero. This boundary 
condition implicitly sets a constraint on the pressure that for 2D flows can be written

 (6-3)

If ∂un/∂n is small, Equation 6-3 can be interpreted as p ≈ f0.

u n⋅ 0,= t pI– η ∇u ∇u( )T+( )+( )n⋅ 0=

η ∇u ∇u( )T+( )n 0=

pI– η ∇u ∇u( )T+( )+( )n f0n–=

p 2η
∂un

∂n
---------- f0+=
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S T R E S S

This type of boundary condition represents a very general class of conditions also 
known as traction boundary conditions.

General Stress
The total stress on the boundary is set equal to a given stress F:

This boundary condition implicitly sets a constraint on the pressure that for 2D flows 
can be written

 (6-4)

If ∂un/∂n is small, Equation 6-4 can be interpreted as p ≈ −n · F.

Normal Stress
The total stress on the boundary is set equal to a stress vector of magnitude, f0, 
oriented in the negative normal direction:

This implies that the total stress in the tangential direction is zero. This boundary 
condition implicitly sets a constraint on the pressure that for 2D flows can be written

 (6-5)

If ∂un/∂n is small, Equation 6-5 can be interpreted as p ≈ f0.

Normal Stress, Normal Flow
In addition to the stress condition set in the Normal stress condition, this condition 
also prescribes that there must be no tangential velocities on the boundary:

Also this boundary condition implicitly sets a constraint on the pressure that for 2D 
flows can be written

 (6-6)

If ∂un/∂n is small, Equation 6-6 can be interpreted as p ≈ f0.

pI– η ∇u ∇u( )T+( )+( )n F=

p 2η
∂un
∂n

---------- n F⋅–=

pI– η ∇u ∇u( )T+( )+( )n f0n–=

p 2η
∂un

∂n
---------- f0+=

pI– η ∇u ∇u( )T+( )+( )n f0n,–= t u⋅ 0=

p 2η
∂un

∂n
---------- f0+=
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Point Settings

If it is not possible to specify the pressure level using a boundary condition, the 
pressure must be set in some other way, for example, by specifying a fixed pressure at 
a point. You find a dialog box for Point Settings on the Physics menu.

Numerical Stability—Stabilization Techniques

The momentum equations (see Equation 6-1) are (nonlinear) convection-diffusion 
equations. As described in Chapter 17, “Stabilization Techniques,”such equations are 
unstable if discretized using the Galerkin finite element method. Stabilized finite 
element methods are therefore necessary in order to obtain physical solutions. You 
control the stabilization settings from the Stabilization page in the Subdomain Settings, 
which appears in Figure 6-2.

Figure 6-2: The Stabilization page of the Subdomain Settings dialog box.

There are three types of stabilization available in the Incompressible Navier-Stokes 
application mode:

• Streamline diffusion (GLS)

• Crosswind diffusion

• Isotropic diffusion

For optimal functionality, the exact weak formulations and constants of GLS and 
crosswind diffusion depend on the order of the basis functions (elements). To control 
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this, there are two option buttons, each with its corresponding list, at the bottom of 
the Stabilization page shown in Figure 6-2. In most cases, the model utilizes only one 
element type. If this is the case, select this type from the Elements of type list. This is 
the default setting for all dimensions but 3D.

However, when using the geometric multigrid (GMG) solver/preconditioner, the 
equations can be discretized with different elements on the different multigrid 
hierarchies. Then select from the element type that is used on the finest mesh hierarchy 
from the Geometric multigrid with list. This is the default setting for 3D because the 
default solver for in 3D is BiCGStab with geometric multigrid as the preconditioner. 
The resulting weak expressions then take forms adapted to multigrid hierarchies 
created in a way equivalent to the hierarchy generation method that you get when you 
choose Lower element order first (any) from the Hierarchy generation method list in the 
Linear System Solver Settings dialog box (see “Constructing a Multigrid Hierarchy” on 
page 560 of the COMSOL Multiphysics Reference Guide).

The values of constants of the GLS and crosswind diffusion follow Ref. 2 and Ref. 3 
and cannot be changed without performance losses.

Streamline diffusion and crosswind diffusion are functional only for the element types 
available in the lists on the Stabilization page.

S T R E A M L I N E  D I F F U S I O N  ( G L S )

For strongly coupled system of equations, the streamline diffusion must be applied to 
the whole system of equations, not only to each equation separately. These ideas were 
first explored by Hughes and Mallet (Ref. 4) and were later extended to Galerkin 
least-squares (GLS) applied to the Navier-Stokes equations (Ref. 5) which is the form 
that COMSOL supports. The time scale tensor is the diagonal tensor presented in Ref. 
6.

Streamline diffusion is active per default since it is necessary when the flow is 
dominated by convection.

The unstabilized incompressible Navier-Stokes equations are subject the 
Babuska-Brezzi condition which states that the basis functions for the pressure must 
be of lower order than the basis functions for the velocity. If the incompressible 
Navier-Stokes equations are stabilized by GLS, then it is possible to use equal order 
interpolation. Hence, streamline diffusion is necessary when using linear Lagrange 
elements. This applies also if the model is solved using geometric multigrid (GMG) as 
a solver or a preconditioner, and at least one multigrid hierarchy uses linear Lagrange 
elements.
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C R O S S W I N D  D I F F U S I O N

Crosswind diffusion can also be formulated for system of equations and when applied 
to the Navier-Stokes equations it becomes a chock capturing operator. COMSOL 
supports the formulation in Ref. 5 with shock capturing viscosity taken from Ref. 7. 

Incompressible flows do not contain shock waves, but crosswind diffusion is still useful 
to introduce extra diffusion in sharp boundary layers and shear layers that otherwise 
would require a very dense mesh to resolve. 

The tuning parameter, Ck, controls the amount of crosswind diffusion introduced in 
the model. The recommended range for low Mach number flows and incompressible 
flows is 0 < Ck < 0.5 (Ck=0 means no diffusion at all). The value must not be neither 
space, nor time dependent.

Crosswind diffusion is active per default since it makes it easier to obtain a solution 
even if the mesh is not perfect. It is, however, advisable to investigate the influence Ck.

Crosswind diffusion also has the effect that iterative solvers can use inexpensive 
presmoothers such as SSOR (see “Solver Settings” on page 149). If you deactivate 
crosswind diffusion, you must change all applications of SSOR to Vanka (see 
“Preconditioners for the Iterative Solvers” on page 555 in the COMSOL Multiphysics 
Reference Guide).

I S O T R O P I C  D I F F U S I O N

Isotropic diffusion adds diffusion to the momentum equations of the Navier-Stokes 
equations in the same way as described in “Isotropic Diffusion” on page 486. The 
continuity equation gain no extra stability.

I M P R OV E D  R E S I D U A L  A P P R O X I M A T I O N  F O R  L I N E A R  E L E M E N T S

Both GLS and crosswind diffusion evaluate the residuals of the Navier-Stokes 
equations to determine the amount of diffusion. The residuals of the momentum 
equations contain second order derivatives of the velocity which, if linear elements are 
used, are evaluated to zero. The impact of this is small if the flow is dominated by 
convection where

  (6-7)

is a good approximation of the momentum equations. Equation 6-7 is not a good 
approximation for flows dominated by viscous effects, however, and if the mesh is 
coarse, the result can be that the pressure field contains small oscillations.

u∂ t∂⁄ u ∇u⋅+ p∇–=
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The oscillations can be removed by refining the mesh. An alternative is to select the 
Improved Residual Approximation for Linear Elements check box shown in Figure 6-2. 
The viscous terms are then reconstructed by polynomial-preserving recovery (see 
“Using Special Operators” on page 163 of the COMSOL Multiphysics User’s Guide). 
The polynomial-preserving recovery makes the equation system more complicated and 
thereby more expensive to solve.

The improved residuals can be useful if the Navier-Stokes equations are part of a 
multiphysics problem and you cannot afford to refine the mesh.

Corner Smoothing

You find the Corner smoothing property in the Application Mode Properties dialog box. 
It can be a useful property when the model contains walls with slip conditions, as 
described below.

Figure 6-3: The Application Mode Properties dialog box where Corner smoothing can be 
turned on and off.

Consider the situation sketched in Figure 6-4. At the point where the boundaries Γ1 
and Γ2 intersect, there are two boundary normals, one for Γ1 and one for Γ2. These 
two normals are denoted  and  in Figure 6-4. If the boundaries now both 
have no-penetration condition, there are two Dirichlet conditions at the point of 
intersection, namely

 (6-8)

and

 (6-9)

nΓ1 nΓ2

nΓ1 u⋅ 0=

nΓ2 u⋅ 0=
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The only way that both Equation 6-8 and Equation 6-9 can be fulfilled is if u ≡ 0 at 
the point of intersection. This is not always the expected solution, however.

Figure 6-4: Intersection between the boundaries Γ1 and Γ2.  and  are the 
boundary normals prescribed by Γ1 and Γ2 respectively. Ω is the computational domain.

When corner smoothing is activated, any Dirichlet condition d(n) = 0 is replaced by 
d(nw) = 0, where nw is a vector of dependent boundary variables whose solution in 
each point is the average of all normals in that point. In the current example, equations 
6-8 and 6-9 are replaced with

 (6-10)

and nw has the solution . Equation 6-10 can then be satisfied 
for u ≠ 0.

Application Mode Variables

A number of variables and physical quantities are available for postprocessing and for 
use in equations and boundary conditions. They appear in the following table (where 
xi denotes the various space coordinate directions and, in the Type column, V 
represents vertices (points, B represents boundaries, and S represents subdomains):

NAME TYPE DESCRIPTION EXPRESSION

u, v, (w) B S V  xi velocity  u, v, w

p B S Pressure  p

U B S Velocity field

V S Vorticity
 (2D)

Ω
Γ2

Γ1

nΓ1nΓ2

nΓ1 nΓ2

nw u⋅ 0=

nw nΓ1 nΓ2+( ) 2⁄=

ui( )2

i
∑

x∂
∂v

y∂
∂u

–
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: ns), for example, V_ns. 
(This does not apply to the dependent variables for the velocities and pressure.)

Solver Settings

L I N E A R  S Y S T E M  S O L V E R

The recommended solver type for small and medium-sized fluid-flow problems is a 
direct solver, and the PARDISO direct solver is the default solver for 1D and 2D 
models. It is not as robust as UMFPACK or SPOOLES but is more memory efficient.

Vxi S Vorticity  xi components of  (3D)

rho S Density  ρ
eta S Dynamic viscosity  η
F_xi S Volume force, xi dir.  xi components of F

K_xi B Viscous force per area, 
xi component

T_xi B Total force per area, 
xi component

cellRe S Cell Reynolds number

res_ui_c S Equation residual, ui 
component

 (ui component)

res_sc_ui_c S Shock capturing 
residual, ui component (ui component)

beta_xi S Convective field, 
xi component

 ρui

Dm S Mean diffusion 
coefficient

 η

da S Total time-scale factor  ρ

NAME TYPE DESCRIPTION EXPRESSION

∇ u×

nj

j
∑ η

ui∂
xj∂

--------
uj∂
xi∂

--------+⎝ ⎠
⎛ ⎞

nj

j
∑ p– δij η

ui∂
xj∂

--------
uj∂
xi∂

--------+⎝ ⎠
⎛ ⎞+

ρ u h
η

--------------

ρ u ∇⋅( )u ∇p F        –+

∇ η ∇u ∇u( )T
+( )[ ]⋅–

ρ u ∇⋅( )u ∇p F–+
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3D problems are often too large to solve using a direct solver. The default solver is 
BiCGStab with the geometric multigrid (GMG) preconditioner. The GMG 
preconditioner uses the SSOR preconditioner/smoother as the presmoother and 
postsmoother. It is possible to use SSOR thanks to the GLS streamline diffusion and 
to the crosswind diffusion (see “Numerical Stability—Stabilization Techniques” on 
page 144). If you deactivate any of these stabilization settings, then you must replace 
the SSOR smoothers by the Vanka preconditioner/smoother (see “The Vanka 
Algorithm” on page 570 in the COMSOL Multiphysics Reference Guide.).

For more information about the solvers, see Chapter 6, “Solving the Model,” on page 
377 in the COMSOL Multiphysics User’s Guide.

TR A N S I E N T  S O L V E R  S E T T I N G S

The transient Incompressible Navier-Stokes application mode uses per default the 
generalized-α time-stepping method (see “The Time-Dependent Solver” on page 391 
of the COMSOL Multiphysics User’s Guide) with manual time step control.

The time step for the transient Incompressible Navier-Stokes application mode is 
calculated from the CFL number:

The Navier-Stokes application mode contains a variable dt_cfl_gn_app that 
corresponds to a CFL number equal to one. n is the index of the geometry on which 
the application mode is active and app is the application mode name. As an example, 
assume that the application mode name is ns and that the application mode is active on 
geometry 2. The time step variable is then dt_cfl_g2_ns.

dt_cfl_gn_app is defined by

where Ωe is the set of all mesh cells in geometry n on subdomains where the 
Navier-Stokes is active. udiff is a diffusive velocity scale equal to η/(ρh). The argument 
fvvudiff is necessary to prevent the time step from becoming too large when |u| is small. 
Because udiff is often extremely small, the algorithm multiplies it by a factor, fvv, which 
per default is 10.

A necessary condition for explicit time stepping techniques to be stable is that the CFL 
number is smaller than one. COMSOL uses implicit schemes which are stable for any 

CFL u ∆t
h

-------------=

dt_cfl_gn_app min
Ωe

h
max u fvvudiff,( )
-------------------------------------------⎝ ⎠
⎛ ⎞=
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∆t. Large ∆t has the advantage that the computation can be completed in few time 
steps. There are however two drawbacks:

• The solver introduces numerical diffusion that increases with ∆t. In other words, 
using large ∆t means that the result becomes less accurate compared to using small 
∆t.

• The equation system becomes harder to solve for large ∆t. That is, more 
computational work is required to complete each time step.

A compromise between efficiency and accuracy is to use a ∆t such that . 
The default is ∆t = 5·dt_cfl_app, and you find this setting on the Time Stepping page 
in the Solver Parameters dialog box.

Use the following guidelines if you want to modify the time step:

• The time step can be increased if you expect the model to feature only very slow 
transients.

• Decrease the time step if the solver repeatedly fails to solve the nonlinear system (see 
“The Time-Dependent Solver Log” on page 452 of the COMSOL Multiphysics 
User’s Guide).

• In situations where the viscosity is high, fvv=10 can result in very small time steps. 
The factor fvv, the viscous velocity factor, is available as an application scalar variable 
named visc_vel_fact_app and you can set it to any suitable value in the 
Application Scalar Variables dialog box (choose Scalar Variables from the Physics 
menu). A lower value of fvv results in a larger maximum time step length.

• Time steps based on the CFL number do not increase if the model reaches a steady 
state. Free time stepping can be used if the model is well resolved. The time steps 
then increase when the simulation approaches steady state. You can change to free 
time stepping by selecting Free from the Time steps taken by solver list on the Time 

Stepping page in the Solver Parameters dialog box.

In some models the transient behavior is not guided by the Navier-Stokes equations, 
and the CFL condition can be either too restrictive or too lax. If this is the case, go to 
the Time Stepping page in the Solver Parameters dialog box. Then change the Time steps 

taken by solver to Free or edit the Time step expression to take the time scale of the 
guiding physics into account.

A D V A N C E D  S O L V E R  S E T T I N G S

For a flow that is parallel to a coordinate axis, the automatic scaling feature in 
COMSOL Multiphysics does not work if you use the nonlinear stationary solver. For 

2 CFL 10≤ ≤
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such cases, turn off the scaling feature or use manual scaling; see “Scaling of Variables 
and Equations” on page 531 of the COMSOL Multiphysics Reference Guide. The 
problem occurs when one solution component is on average zero.

Khan and Richardson Force for Particle Tracing

The Khan and Richardson force is available for particle tracing plots in the 
Incompressible Navier-Stokes application mode and other application modes for fluid 
dynamics in the COMSOL Multiphysics products.

B A C K G R O U N D

The force expression that the software uses is derived partly using experimental results, 
and it is valid for a wide range of Reynolds numbers, stretching from creeping flow 
toward the turbulent regime (Ref. 8).

The following equation describes the total force that a fluid exerts on an immersed 
spherical particle:

where the definition of the particle Reynolds number, Rep, is

.

The orientation of a given force component (for example, positive or negative 
x-component) is determined by the sign of the corresponding component in the vector 
difference , because this determines whether the fluid is accelerating or slowing 
down the particle in that direction.

U S I N G  T H E  K H A N  A N D  R I C H A R D S O N  F O R C E  F O R  P A R T I C L E  TR A C I N G

The Khan and Richardson force is the default selection in the Predefined forces list on 
the Particle Tracing tab.

There is one parameter in this force expression: the particle radius rp, which you define 
by clicking the Parameters button. Table 6-1 shows the default values for this 
parameter:

TABLE 6-1:  PARAMETER FOR THE KHAN AND RICHARDSON FORCE

PARAMETER NAME 
IN EQUATION

DESCRIPTION DEFAULT VALUE DEFAULT VARIABLE NAME

 rp particle radius 10-4 m partr

F πrp
2ρ u up–( )2 1.84 Rep( ) 0.31– 0.293 Rep( )0.06+( )3.45=

Rep u up– 2rpρ( ) η⁄=

u up–
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The particle mass appears in the force equation, and you enter its value in the Mass edit 
field. The default value for the particle mass is mp = (4π / 3)·10−9 kg, which is the mass 
of a particle with the same density as water and a radius of 10−4 m, which is the default 
radius.

Note: The default settings work for models that use SI units.
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Examp l e—St e ad y  I n c omp r e s s i b l e  
F l ow

Introduction

This model examines the physics of plane, incompressible, and steady flow: flow over 
a backward step in the absence of external forces. This is a common benchmark 
problem in CFD. There is no known exact solution, but experimental data has been 
published (see Ref. 1) making it possible to check the accuracy of the FEM solution. 
The model includes analyses using both regular triangular meshes and mapped meshes, 
comparing the solutions for various mesh densities.

Model Definition

Fluid enters from the left side with a parabolic velocity profile, passes over a step, and 
leaves through the right boundary (Figure 6-5 shows the model geometry).

Figure 6-5: The backstep geometry.

The model computes the fluid’s velocity components u = (u, v) in the x and 
y directions and its pressure p in the region defined by the geometry in the preceding 
figure. The PDE model for this application uses the stationary incompressible 
Navier-Stokes equations

η– ∇2u ρ u ∇⋅( )u ∇p+ + F=

∇ u⋅ 0=
⎩
⎪
⎨
⎪
⎧
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where the quantities are (using SI units):

• Dynamic viscosity, η = 1.79·10−5 Pa·s

• Density, ρ = 1.23 kg/m3

• A force field, F, absent in this model

The first equation is the balance of momentum from Newton’s second law. The other 
relationship is the equation of continuity, where zero on the right-hand side states that 
the fluid is incompressible.

The shape of the flow pattern depends only on the Reynolds number.

In this model, you choose boundary conditions so that the average velocity at the inlet 
is Vmean = 0.544 m/s. To obtain a corresponding parabolic velocity profile, set 
(u, v) = (6Vmean  s(1 − s), 0), where s is a boundary parameterization variable that runs 
from 0 to 1 along the boundary. The fluid is always stationary at the walls, so 
(u, v) = (0, 0) is the appropriate boundary condition. At the exit boundary, assume a 
constant static pressure p = 0.

For such a fluid flow you can expect a velocity field with a boundary layer of thickness 
approximately equal to  at the walls. To resolve this steep solution gradient you 
need a few rows of elements across the layer. For a flow with a large Reynolds number, 
elements in the interior of the channel can be much larger than those near the walls.

U S I N G  T H E  I N C O M P R E S S I B L E  N A V I E R - S T O K E S  A P P L I C A T I O N  M O D E

Start by setting up a model and solve this problem on a fixed isotropic mesh. The given 
input data correspond to a Reynolds number of

Even though you are working with a steady flow model, it needs initial conditions 
because the incompressible Navier-Stokes equations are nonlinear. To achieve a 
numerical solution, the nonlinear solver solves the equations iteratively.

Results and Discussion

Figure 6-6 shows the velocity field in a streamline plot. Behind the step you can 
identify a recirculation region that expands with increasing Re. The distance from the 
step to the stagnation point, where the flow reattaches to the lower wall, is the 
reattachment length. A dimensionless number quantifying the recirculation region is 

1 Re⁄

Re 0.544 2 0.0052 1.23⋅ ⋅ ⋅

1.79 10 5–⋅
------------------------------------------------------------- 389≈=
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the reattachment length divided by the step height. According to experimental data, 
this quotient is approximately 7.93 at a Reynolds number of 389.

Figure 6-6: A streamline plot of the velocity field.

For a high enough Re, the eddy crosses the outflow boundary, which means that there 
is an inflow through the assumed outflow boundary. This finding calls for the inclusion 
of more of the downstream region in the computational domain to get a reliable 
solution. That fact explains why the computational domain in this model is slightly 
longer than the one in Ref. 2.

The Incompressible Navier-Stokes application mode uses Lagrange p2-p1 elements to 
stabilize the pressure. Thus 2nd-order Lagrange elements model the velocity 
components while linear elements model the pressure. The default element settings in 
this application mode always provide one order higher Lagrange elements for the 
velocity components than for the pressure. Stabilizing the solution using streamline 
diffusion is not recommended for the Navier-Stokes equations except at higher 
Reynolds numbers.

Four mesh cases were considered for this model: a homogeneous structured mesh, a 
homogeneous unstructured mesh, and two inhomogeneous mesh cases, where local 
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mesh refinements provide improved accuracy around the point where the step is taken. 
The following plots show examples of the mesh cases:

Case 1: Homogeneous structured mesh

Case 2: Homogeneous unstructured mesh

Case 3: Structured mesh

Case 4: Unstructured mesh

To compare the results using these mesh cases, we solved the model for varying mesh 
densities for all four mesh cases. The graph in Figure 6-7 shows the resulting 
reattachment length divided by the step height as a function of the degrees of freedom 
for the different mesh cases:
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Figure 6-7: Reattachment length divided by step height as functions of the degrees of 
freedom for Case 1 (squares), Case 2 (diamonds), Case 3 (x-marks), and Case 4 
(triangles).

All solutions give reasonable results. Comparing results for structured and 
unstructured meshes and different numbers of degrees of freedom (DOFs), it is 
evident that the unstructured mesh cases give more accurate and more stable results 
even with a lower number of DOFs. However, in the limit of an infinite number of 
DOFs, the results for all mesh cases converge to the experimental result of  7.93.

The number of mesh elements is related to the number of DOFs. However, the 
relation is not the same for structured and unstructured meshes. The same number of 
mesh elements create more DOFs for a structured mesh than for an unstructured 
mesh, simply because of the rectangular shape of the mesh elements.

For the same number of DOFs the solution time is longer for a structured mesh than 
for an unstructured mesh. This is due to the structured mesh having a stronger coupled 
system, which results in system matrices that are less sparse.
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Model Library path: COMSOL_Multiphysics/Fluid_Dynamics/backstep

Model Library path: COMSOL_Multiphysics/Fluid_Dynamics/backstep_quad

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go to the Model Navigator and select 2D in the Space dimension list.

2 In the list of application modes open the COMSOL Multiphysics>Fluid Dynamics folder 
and then the Incompressible Navier-Stokes folder. Select Steady-state analysis.

3 Make sure that Lagrange - P2 P1 is the element type in the Element list.

4 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 To parameterize the model, go to the Options menu and choose Constants.

2 Make the following entries in the Constants dialog box to represent the fluid 
properties and velocity (the descriptions are optional):

NAME EXPRESSION DESCRIPTION

rho 1.23[kg/m^3] Fluid density

eta 1.79e-5[Pa*s] Dynamic viscosity

V_mean 0.554[m/s] Average inlet velocity
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3 Click OK to close the dialog box.

G E O M E T R Y  M O D E L I N G

1 Shift-click the Rectangle/Square button to specify a rectangle.

2 In the Rectangle dialog box, type 0.08 in the Width edit field and 0.0101 in the 
Height edit field. In the Position area, type 0.02 in the x edit field (keep the Base 

setting Corner).

3 Click OK.

4 Shift-click the Rectangle/Square button to specify another rectangle.

5 In the Rectangle dialog box, type 0.02 in the Width edit field and 0.0052 in the 
Height edit field. In the Position area, type 0.0049 in the y edit field (again, keep the 
Base setting Corner).

6 Click OK.

7 Click the Zoom Extents button on the Main toolbar.
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Subdomain Settings
With appropriate scaling it is possible to set the fluid density ρ = 1 and the viscosity 
η = 1/Re. If you model in this way, the Reynolds number contains information about 
fluid density together with details on length scale, velocity scale, and viscosity. For such 
a model, type 1/Re in the Dynamic viscosity edit field in the Subdomain Settings dialog 
box. Be aware, though, that you must reverse the scaling before interpreting the results 
quantitatively.

This model, however, uses actual fluid properties specified in SI units.

1 From the Physics menu choose Subdomain Settings to launch the Subdomain Settings 
dialog box.

2 Select Subdomains 1 and 2.

3 In the Density edit field type rho.

4 In the Dynamic viscosity edit field type eta.

The nonlinear solver also requires an initial value. With a low Reynolds number a 
simple constant expression is sufficient:

5 With both subdomains still selected, click the Init tab.
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6 Enter the initial value V_mean in the edit field for u(t0); this value corresponds to a 
uniform x-velocity of magnitude Vmean throughout the domain. Leave the initial 
values for the y-velocity and the pressure at their default zero values.

7 Click OK.

Boundary Conditions
The relevant boundary conditions for the model are:

The no-slip condition is the default setting, so you only need to modify the settings for 
Boundaries 1 and 8.

1 From the Physics menu, choose Boundary Settings. 

2 Select Boundary 1.

3 In the Boundary type list select Inlet.

SETTINGS BOUNDARY 1 BOUNDARIES 2–5, 7 BOUNDARY 8

Boundary type Inlet Wall Outlet

Boundary condition Velocity No slip Pressure, no  
viscous stress

U0 V_mean*6*s*(1-s)

p0 0
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4 In the U0 edit field type V_mean*6*s*(1-s).

5 Select Boundary 8. From the Boundary type list select Outlet, then click OK.

M E S H  G E N E R A T I O N

Because the Navier-Stokes equations are computationally difficult, it is important to 
use an appropriate mesh. If the mesh is too coarse, the solution might not converge at 
all or errors might be large. Conversely, if the mesh is too fine, the solution time for 
the nonlinear system of equations might be unnecessarily long. In this case, solve the 
model with two different types of mesh, first using a mapped mesh and later using a 
conventional unstructured triangular mesh.

Mesh Case 1—Mapped Mesh
1 From the Mesh menu, choose Mapped Mesh Parameters.

2 In the Mapped Mesh Parameters dialog box, click the Boundary tab.

3 Specify the numbers of mesh elements according to the following table by first 
selecting the appropriate boundaries in the Boundary selection list, then selecting the 
Constrained edge element distribution check box, and finally entering the number of 
elements in the Number of edge elements edit field.

4 Click Remesh, then click OK.

Mesh Case 2—Triangular Mesh
1 From the Mesh menu, choose Free Mesh Parameters.

SETTINGS BOUNDARIES 1–4, 6 BOUNDARIES 5, 7

Number of mesh elements 34 62
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2 On the Global page, click the Custom mesh size option button, then type 9e-4 in the 
Maximum element size edit field.

3 Click Remesh, then click OK.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to start the simulation.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default visualization displays the magnitude of the velocity field.

To see the velocity field and the pressure field simultaneously, use a combination of 
arrow and surface plots:

1 From the Postprocessing menu, choose Plot Parameters to open the Plot Parameters 
dialog box.

2 Click the Surface tab.

3 On the Surface Data page, select Incompressible Navier-Stokes (ns)>Pressure from the 
Predefined quantities list.

4 Click the Arrow tab.

5 Select the Arrow plot check box.
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6 Click OK to view the combined plot.

To reproduce the plot in Figure 6-6, visualizing the recirculation region, use a 
conditional expression testing for a negative x-component in the velocity.

1 Open the Plot Parameters dialog box again. Add a streamline plot and remove the 
arrows by selecting the Streamline check box and clearing the Arrow check box on 
the General page.

2 Click the Surface tab.

3 On the Surface Data page, type (u<-eps)*(x-0.02)/0.0049 in the Expression edit 
field. Clear the Smooth check box (the given expression is deliberately 
discontinuous).

4 Click the Streamline tab.

5 On the Start Points page, click the Specify start point coordinates button.

6 In the x edit field type 0.03 and in the y edit field type range(5e-4,10e-4,95e-4). 
These values result in nine streamlines, which at x = 0.03 m are equally spaced in the 
y direction.

7 Click the Line Color tab, then click the Color button.

8 In the Streamline Color dialog box, click the lightest gray swatch, then click OK.

9 Click OK to close the Plot Parameters dialog box and display the new plot.
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 7
H e a t  T r a n s f e r
This chapter covers heat transfer application modes. It starts with some 
background on heat transfer. It then reviews specifics of the Conduction 
application mode and then the Convection and Conduction application mode. It 
concludes with COMSOL Multiphysics models of three heat-transfer examples 
taken from a NAFEMS (National Agency for Finite Element Methods and 
Standards) benchmark collection.
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Hea t  T r a n s f e r  F undamen t a l s

What Is Heat Transfer?

From the kitchen toaster to the latest high-performance microprocessor, heat is 
ubiquitous and of great importance in the engineering world. To optimize thermal 
performance and reduce costs, engineers and researchers are making use of finite 
element analysis. Because most material properties are temperature-dependent, the 
effects of heat enter many other disciplines and drive the requirement for multiphysics 
modeling.

For instance, both the toaster and the microchip contain electrical conductors that 
generate thermal energy as electric current passes through them. As these conductors 
release thermal energy, system temperature increases as does that of the conductors. If 
the electric conductivity is temperature dependent, it changes accordingly and, in turn, 
affects the electric field in the conductor. Other examples of multiphysics couplings 
that involve heat transfer are thermal stresses, thermal-fluid convection, and induction 
heating.

Heat transfer is defined as the movement of energy due to a temperature difference. It 
is characterized by the following three mechanisms:

• Conduction is heat transfer by diffusion in a stationary medium due to a 
temperature gradient. The medium can be a solid or a fluid.

• Convective heat transfer is when heat is transported by a fluid motion. (Engineers 
sometimes uses convection to refer to heat transfer between either a hot surface and 
a cold moving fluid or a cold surface and a hot moving fluid.)

• Radiation is heat transfer via electromagnetic waves between two surfaces (A and 
B) with different temperatures TA and TB, provided that Surface A is visible to an 
infinitesimally small observer on Surface B.

Note: The Heat Transfer Module supports simulations of all three types of heat 
transfer mechanism, including surface-to-surface and surface-to-ambient radiation.

The examples later in this chapter shows transient heat transfer by conduction, 
convection, and radiation. For an introductory example of a multiphysics coupling of 
a heat balance to a momentum balance through the Navier-Stokes equations, see “Free 
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Convection” on page 356 of the COMSOL Multiphysics Model Library. In that 
model the heat flux accounts for transport by convection and conduction. The system 
consists of heated tubes subjected to a stream of a fluid perpendicular to the main axis 
of the tubes. The tubes heat the streaming medium as it travels from the bottom to the 
top of the domain.

The Heat Equation

The mathematical model for heat transfer by conduction is the heat equation:

Quickly review the variables and quantities in this equation:

• T is the temperature.

• ρ is the density.

• Cp is the heat capacity at constant pressure.

• k is thermal conductivity.

• Q is a heat source or a heat sink.

For a steady-state model, temperature does not change with time, and the first term 
containing ρ and C vanishes.

If the thermal conductivity is anisotropic, k becomes the thermal conductivity tensor:

To model heat conduction and convection through a fluid, the heat equation also 
includes a convective term. COMSOL Multiphysics represents this formulation in the 
Convection and Conduction application mode as:

where u is the velocity field. This field can either be provided as a mathematical 
expression of the independent variables or calculated by a coupling to the velocity field 
from an application mode such as Incompressible Navier-Stokes.

ρCp
∂T
∂t
------- ∇– k∇T( )⋅ Q=

k

kxx kxy kxz

kyx kyy kyz

kzx kzy kzz

=

ρCp t∂
∂T ρCpu∇ T⋅+ ∇ k T∇( )⋅ Q+=
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For transport through conduction and convection, a heat flux vector can be 
approximated by

where q is the heat flux vector. If the heat transfer is by conduction only, q is instead 
determined by

For a detailed discussion of the fundamentals of heat transfer, see Ref. 1.

Note: Heat capacity here refers to the quantity that represents the amount of heat 
required to change one unit of mass of a substance by one degree. It has units of 
energy per mass per degree (J/(kg·K) in SI units). This quantity is also called specific 
heat or specific heat capacity.

q k T ρ Cp T u+∇–=

q k T∇–=
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Th e  Condu c t i o n  App l i c a t i o n  Mode

This application mode models heat transfer by conduction. It also includes convection 
and radiation effects around edges and boundaries. The Conduction application mode 
is suitable for modeling of heat transfer in solids. To start modeling with this 
application mode, go to the Model Navigator and select Heat Transfer and then 
Conduction.

Variables and Space Dimensions

The Conduction application mode is available in 1D, 2D, and 3D as well as for 
axisymmetric models using cylindrical coordinates in 1D and 2D. The dependent 
variable is the temperature, T.

PDE Formulation

The mathematical model for heat transfer by conduction is the following version of the 
heat equation

with the following material properties:

• δts is a time-scaling coefficient.

• ρ is the density.

• Cp is the heat capacity.

• k is the thermal conductivity tensor.

• Q is the heat source (or sink).

For a steady-state problem the temperature does not change with time and the first 
term disappears.

In rare cases you might decide to add domain-specific transversal convection or 
radiation in 1D planar and axisymmetric models and 2D planar models. Represent this 
by adding the two terms on the right:

δtsρCp
∂T
∂t
------- ∇– k∇T( )⋅ Q=

δtsρCp
∂T
∂t
------- ∇– k∇T( )⋅ Q

htrans
dA

----------------+ Text T–( )
Ctrans

dA
----------------- Tambtrans

4 T4
–( )+=
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where:

• htrans is the transversal convective heat transfer coefficient.

• Text is the transversal external temperature.

• Ctrans is a user-defined constant.

• Tambtrans is the transversal ambient temperature.

• dA is the thickness in 2D and area in 1D.

Note: When using transversal convection or radiation, the heat equation must be 
modified to accommodate the area dA. For all practical purposes the use of this 
feature is a rare exception, and the terms htrans and Ctrans are usually set to zero.

Subdomain Settings

The subdomain quantities are:

Time-scaling coefficient   This coefficient is normally 1, but you can change the time 
scale, for example, from seconds to minutes by setting it to 1/60.

Density   It specifies the material’s density. Enter this quantity as mass per volume.

QUANTITY VARIABLE DESCRIPTION

 δts Dts Time-scaling coefficient

 ρ rho Density

 Cp C Heat capacity

 k k Thermal conductivity

Thermal conductivity tensor

 kij kxixj Thermal conductivity tensor, xixj component

 Q Q Heat source

 htrans htrans Transversal convective heat transfer coefficient

 Text Text Transversal external temperature

 Ctrans Ctrans User-defined constant

 Tambtrans Tambtrans Transversal ambient temperature

k
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Heat capacity   The heat capacity C describes the amount of heat energy required to 
produce a unit temperature change in a unit mass.

Thermal conductivity   The thermal conductivity k describes the relationship between 
the heat flux vector q and the temperature gradient  as in

, 

which is Fourier’s law of heat conduction. Enter this quantity as power per length and 
temperature.

Heat source   The heat source describes heat generation within the domain. Express 
heating and cooling with positive and negative values, respectively. Enter the quantity 
Q as unit power per unit volume (W/m3 in SI units).

Boundary Condition Types

The available boundary conditions are:

H E A T  F L U X

COMSOL Multiphysics supplies only one generalized boundary condition for heat 
flux, but it accounts for general heat flux as well as heat flux from convection and 
radiation.

BOUNDARY CONDITION DESCRIPTION

Heat flux

Insulation or symmetry

 T = T0 Prescribed temperature

 T = 0 Zero temperature

Thin thermally resistive 
layer (pair boundaries only)

T∇

q k T∇–=

n k∇T( )⋅ q0 h+ Tinf T–( ) Cconst Tamb
4 T4

–( )+=

n k∇T( )⋅ 0=

n1 k1∇T1( )⋅ k
d
--- T2 T1–( )=

n2 k2∇T2( )⋅ k
d
--- T1 T2–( )=

n k∇T( )⋅ q0 h+ Tinf T–( ) Cconst Tamb
4 T4

–( )+=
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The application mode interprets the heat flux q0 in the direction of the inward normal. 
It interprets the convection and radiation terms in the direction of the outward 
normal.

• Specify q0 to represent a heat flux that enters the domain. For instance, any electric 
heater is well represented by this condition, and you can omit its geometry. Enter 
the quantity q0 as unit power per unit area (W/m2 using SI units). While this is 
directly applicable to 3D, unit depth and unit area are assumed in 2D and 1D 
applications, respectively.

• h(Tinf – T) models convective heat transfer with the surrounding environment, 
where h is the heat transfer coefficient and Tinf is the ambient bulk temperature. 
The value of h depends on the geometry and the ambient flow conditions. For a 
thorough introduction on how to calculate heat transfer coefficients see Ref. 1.

• Cconst (T
4

amb– T4) models radiation heat transfer with the surrounding 
environment. Tamb is the temperature of the surrounding radiation environment, 
which might differ from Tinf. Cconst is the product of the surface emissitivity ε and 
the Stefan-Boltzmann constant σ = 5.669·10−8 W/(m2·K4) (with the same unit as 
the Stefan-Boltzmann constant):

The surface emissivity is a material property discussed and tabulated in Ref. 1.

Note: A problem with radiation boundaries is nonlinear, so you must work with 
absolute (thermodynamical) temperature units. See “Using Units” on page 187 of 
the COMSOL Multiphysics User’s Guide.

I N S U L A T I O N  O R  S Y M M E T R Y

This condition specifies where the domain is well insulated, or it reduces model size by 
taking advantage of symmetry. Intuitively this equation says that the gradient across 
the boundary must be zero. For this to be true, the temperature on one side of the 
boundary must equal the temperature on the other side. Because there is no 
temperature difference across the boundary, heat cannot transfer across it.

An interesting numerical check for convergence is the numerical evaluation of the 
above condition along the boundary, something easily accomplished with the 

Cconst εσ=

n k∇T( )⋅ 0=
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postprocessing features of COMSOL Multiphysics. Another check is to plot the 
temperature field as a contour plot. Ideally the contour lines should be perpendicular 
to any insulated boundary.

A X I A L  S Y M M E T R Y

This boundary condition is available only for axisymmetric versions of the heat transfer 
application models. Use it only on the symmetry axis r = 0.

P R E S C R I B E D  TE M P E R A T U R E

This boundary prescribes the temperature T0. This condition means that the finite 
element solution returns a solution in which the above condition is either true or 
minimally approximated.

P R E S C R I B E D  Z E R O  TE M P E R A T U R E

This boundary specifies a zero boundary temperature.

C O N T I N U I T Y

The default setting for interior boundaries is Continuity, which is a special case of the 
above Heat source/sink condition. In the absence of sources or sinks, that condition 
becomes −n1· ( q1 − q2 ) = 0. This means that the heat flux in the normal direction is 
continuous across the boundary. This is the default boundary condition on interior 
boundaries.

The temperature is naturally continuous on an internal boundary following the 
continuity of the finite element field. Therefore, the Continuity boundary condition is 
identical to the condition that applies between any two neighboring elements in the 
mesh. In fact, as long as you have not selected Enable interior boundaries in the 
Boundary Settings dialog box, the interior boundaries are not in any way different from 
any other mesh element boundaries, where the Continuity condition effectively 
applies.

The Continuity boundary condition is available on interior boundaries and assembly 
pairs only.

T T0=

T 0=
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H E A T  F L U X  D I S C O N T I N U I T Y

The Heat flux discontinuity condition is available on interior boundaries and pairs 
representing borders between parts in an assembly:

The right-hand side represents a flux discontinuity, or equivalently, a heat source or 
heat sink depending on sign. The temperature is always continuous due to the 
continuity of the finite element field. If the right-hand side is zero, this equation 
specifies continuity also in the normal heat flux.

T H I N  T H E R M A L L Y  R E S I S T I V E  L A Y E R

Use this boundary condition to model a thin layer of thermally resistive material using 
these equations:

The layer has the thickness d and the thermal conductivity k. This boundary condition 
is only available for pairs representing borders between the parts in an assembly.

Boundary Settings

You specify the boundary conditions in the Boundary Settings dialog box.

QUANTITY EDIT FIELD DESCRIPTION

 q0 q Inward heat flux

 h h Convective heat transfer coefficient

 Tinf Tinf Ambient bulk temperature

 Const Const Radiation constant: product of emissivity and 
Stefan-Boltzmann constant

 Tamb Tamb Temperature of the surrounding radiating environment

 T0 T0 Prescribed temperature

n1– q1⋅ n2 q2⋅– q   on Ω∂=

n1 k1∇T1( )⋅ k
d
--- T2 T1–( )=

n2 k2∇T2( )⋅ k
d
--- T1 T2–( )=
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Application Mode Variables

The Conduction application mode uses the following variables for domain equations, 
boundary equations, and postprocessing purposes.

NAME DOMAIN/
TYPE

DESCRIPTION EXPRESSION

T S/B Temperature  T

gradT, Txi S/V Temperature gradient

flux S Heat flux

nflux_T B Normal heat flux

fluxxi V Heat flux, xi component

Dts S Time-scaling coefficient  δts

rho S Density  ρ
C S Heat capacity  Cp

k, kxixj S Thermal conductivity  k, kij

Q S Heat source  Q

htrans S Transversal convective heat transfer 
coefficient

 htrans

Text S Transversal external temperature  Text

Ctrans S User-defined constant  Ctrans

Tambtrans S Transversal ambient temperature  Tambtrans

T0 B Prescribed temperature  T0

h B Convective heat transfer coefficient  h

Tinf B Ambient bulk temperature  Tinf

Const B Radiation constant: product of 
emissivity and Stefan-Boltzmann 
constant

 Const

Tamb B Temperature of the surrounding 
radiating environment

 Tamb

∇T , T∂
xi∂

-------

k∇T–

n k∇T–( )⋅

kij
T∂
xj∂

-------–

j
∑
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: ht), for example, flux_ht. 
(This does not apply to the dependent variable for the temperature.)

Note: The vector expressions V are not present in the 1D formulation of the 
Conduction application mode.
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Th e  Con v e c t i o n  and Condu c t i o n  
App l i c a t i o n  Mode

In addition to heat transfer by conduction, the Convection and Conduction 
application mode includes heat transfer by convection. In the convection term for the 
equation that defines this application mode you can specify the velocity vector as an 
analytical expression. Alternatively, you can connect it directly to the solution of the 
equations of motion, for example, through a multiphysics coupling to the 
Incompressible Navier-Stokes application mode. The Convection and Conduction 
application mode is suitable for modeling of heat transfer in fluids.

Variables and Space Dimensions

The Convection and Conduction application mode is available in 1D, 2D, 3D, Axial 
symmetry 1D, and Axial symmetry 2D.

Note: The optional Chemical Engineering Module also contains this Convection and 
Conduction application mode. In addition to the above-mentioned space dimensions, 
it features pseudo-2D and pseudo-3D geometry options in which it uses time as a 
second or third spatial dimension. This feature is useful in situations where 
convection in the direction of the flow is large. This often applies to reactors and 
equipment for unit operations.

PDE Formulation

This application mode supports the following nonconservative formulation of the 
transient PDE for heat transfer by convection and conduction:

δtsρCp t∂
∂T ∇ k T∇–( )⋅+ Q ρC– pu ∇T⋅=
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Subdomain Settings

The following table contains the quantities in the equations:

Note: The time-scaling coefficient, δts, is not available together with GLS, SUPG, or 
crosswind diffusion.

For equations in 2D or 3D, pay special attention to the isotropic thermal conductivity, 
k. If you select this coefficient, the application mode expands it to the diagonal of the 
thermal conductivity tensor, that is, kii equals k.

COEFFICIENT VARIABLE DESCRIPTION

 δts Dts_T Time-scaling coefficient

 ρ rho_T Density

 Cp C_T Heat capacity

 k k_T Thermal conductivity

Thermal conductivity tensor

 kij kxixj_T Thermal conductivity tensor, xixj component

 Q Q_T Heat source

 u, v, w u_T, v_T, w_T Velocity in the x1, x2, and x3 directions

k
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S T A B I L I Z A T I O N

Figure 7-1 shows the Stabilization page of the Subdomain Settings dialog box.

Figure 7-1: The Stabilization page of the Subdomain Settings dialog box.

The Convection and Conduction application mode supports artificial diffusion using 
the following methods:

• Isotropic diffusion

• Streamline diffusion

• Crosswind diffusion

Stabilization is needed because pure Galerkin discretization is unstable for 
convection-dominated or source-term dominated transport equations. The 
stabilization methods and their effects on the numerical solution are described in 
Chapter 17, “Stabilization Techniques.”

For optimal functionality, the exact weak formulations and constants of GLS, SUPG, 
and crosswind diffusion depend on the order of the basis functions (elements). You can 
control this dependence through two option buttons, each with its corresponding list, 
at the bottom of the Stabilization page shown in Figure 7-1. In most cases, the model 
uses only one element type. If this is the case, select this type from the Elements of type 
list. This is the default setting for all dimensions but 3D.

However, when using geometric multigrid (either as a solver or as a preconditioner), 
the equations can be discretized with different elements on the different multigrid 
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hierarchies. Then, select the element type that is used on the finest mesh hierarchy 
from the Geometric multigrid with list. This is the default setting for 3D, because the 
default solver for General Heat in 3D is BiCGStab with geometric multigrid as 
preconditioner. The resulting weak expressions then take forms adapted to multigrid 
hierarchies created in a way equivalent to the hierarchy generation method Lower 

element order first (any) (see “Constructing a Multigrid Hierarchy” on page 560 of the 
COMSOL Multiphysics Reference Guide).

The values of the GLS and SUPG constants follow Ref. 2 and Ref. 3 and cannot be 
changed without performance losses. In contrast, the constant Ce for Crosswind 
diffusion (see Equation 7-1) is a tuning constant. Ref. 4 gives the recommendations 
0.7 for quadratic elements and 0.35 for linear elements. In general, the higher the 
value of this constant, the more diffusion it introduces. COMSOL uses the values for 
Ce listed in Table 7-1.

Streamline Diffusion
Streamline diffusion is active by default.  Figure 7-2 shows the Streamline Diffusion 

Settings dialog box. There are three types of streamline diffusion available:

• Galerkin least-squares (GLS)—GLS is the default choice and is by all references 
superior to any of the other methods available.

TABLE 7-1:  VALUES OF C
e

 FOR CROSSWIND DIFFUSION IN COMSOL MULTIPHYSICS

ELEMENT ORDER C
e

1 0.7

2 0.4

3 0.2

4 0.1

5 0.05
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• Streamline upwind Petrov-Galerkin (SUPG)—a subset of GLS that stabilizes only 
with respect to convection, not reaction as well. SUPG is computationally less 
expensive than GLS but its stabilization properties are not as good (Ref. 1).

• Anisotropic diffusion—this is the only streamline diffusion method that needs a 
user-defined constant. The Tuning parameter edit field becomes active when you 
select Anisotropic diffusion from the list.

Figure 7-2: The Streamline Diffusion Settings dialog box.

The constants of GLS and SUPG are controlled as described in the section “Streamline 
Diffusion” on page 487. For anisotropic diffusion, there is no theory on what the value 
of this constant is, and the optimal value depends on the model.

Crosswind Diffusion
Crosswind diffusion provides extra diffusion in the region of sharp gradients. The 
method adds the following contribution to the weak formulation (Ref. 4):

 (7-1)

where R is the PDE residual,  is the test function for T, and

 (7-2)

The added diffusion is orthogonal to the streamline diffusion, so you can use 
streamline diffusion and crosswind diffusion simultaneously. Scalar stabilization does 
not explicitly take any multiphysics coupling into account and is therefore the 
appropriate choice if the temperature equation is the only equation solved for; the 
temperature is a passive scalar (that is, if other equations are completely independent 
of the temperature); or if other equations depend only weakly on the temperature.

1
2
---max 0 Ce 2k

h β
----------–,⎝ ⎠

⎛ ⎞ h R
T∇

----------- T̂ I u u⊗
u 2

---------------–⎝ ⎠
⎛ ⎞ T∇∇ Ωd

Ωe

∫
e 1=

Nel

∑–

T

β
ρCp u T∇⋅( )

T∇ 2
--------------------------------- T∇ if T 0≠∇

0 if T 0=∇⎩
⎪
⎨
⎪
⎧

=
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Figure 7-3 shows the Crosswind Diffusion Settings dialog box.

Figure 7-3: The Crosswind Diffusion Settings dialog box.

The variable glim is needed because both Equation 7-1 and Equation 7-2 contain 
terms of the form , which become singular if . Hence, all occurrences 
of  are replaced by  where glim is a measure of a small 
gradient.

Isotropic Diffusion
Isotropic diffusion is described in the section “Isotropic Diffusion” on page 486.

Boundary Conditions

The available boundary conditions are:

The Continuity and Heat flux discontinuity boundary conditions are available on 
interior boundaries and assembly pairs only. The Thin thermally resistive layer 
boundary condition is only available on assembly pairs.

BOUNDARY CONDITION DESCRIPTION

 T = T0 Temperature

Heat flux

Insulation/symmetry

Convective flux

Axial symmetry

 −n1 · q1 − n2 · q2 = 0 Continuity

 −n1 · q1 − n2 · q2 = q Heat flux discontinuity

Thin thermally resistive 
layer

1 T∇⁄ T∇ 0=

1 T∇⁄ 1 max T∇ glim,( )⁄

n– k T∇–( )⋅ q0=

n k T∇–( )⋅ 0=

n k– T∇( )⋅ 0=

n k T∇–( )⋅ 0=

n1 k1∇T1( )⋅ k
d
--- T2 T1–( )=

n2 k2∇T2( )⋅ k
d
--- T1 T2–( )=
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In cases where convection across a boundary is much greater than diffusion, use the 
convective flux boundary condition. It sets the diffusive flux at the boundary to zero, 
but it allows convective flux to exit the domain.

Note: When working in an axisymmetry application mode, use the axial symmetry 
boundary condition only on the symmetry axis.

Application Mode Variables

The Convection and Conduction application mode uses the following expressions and 
coefficients in boundary conditions, equations, and for postprocessing purposes.

NAME TYPE DESCRIPTION EXPRESSION

T S/B Temperature  T

grad_T S/V Temperature gradient

dflux_T S Conductive flux

cflux_T S Convective flux

tflux_T S Total heat flux

ndflux_T B Normal conductive flux

ncflux_T B Normal convective flux

ntflux_T B Normal total heat flux

dflux_T_xi V Conductive flux, xi component

cflux_T_xi V Convective flux, xi component  ρ Cp Tui

tflux_T_xi V Total heat flux, xi component

cellPe_T S Cell Peclet number

Dts_T S Time-scale factor  δts

∇T , T∂
xi∂

-------

k∇T

ρCpTu

k∇T– ρCpTu+

n k∇T–( )⋅

ρCpTn u⋅

n k∇T– ρCpTu+( )⋅

kij
T∂
xj∂

-------–

j
∑

kij
T∂
xj∂

-------–

j
∑ ρCpTui+

ρCpuh
k

-------------------
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: cc), for example, 
tflux_T_cc. (This does not apply to the dependent variable for the temperature.)

The vector variables, indicated by V in the Type column, are not present in 1D versions 
of the Convection and Conduction application mode.
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rho_T S Density  ρ
C_T S Heat capacity  Cp

k_T, kxixj_T S Thermal conductivity  k, kij

Q_T S Heat source  Q

u_T, v_T, w_T S Velocity of c, xi component  ui

Dm_T S Mean diffusion coefficient

res_T_cc S Equation residual

res_sc_T_cc S Shock-capturing residual

da_T S Total time-scale factor  δts ρ Cp

q B Inward heat flux  q0

T0 B Prescribed temperature  T0

NAME TYPE DESCRIPTION EXPRESSION

kijβiβj

i j,
∑

β
-------------------------

∇ k– ∇T ρCpTu+( )⋅ Q–

∇ ρCpTu( )⋅ Q–
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Examp l e s  o f  Hea t  T r a n s f e r  Mode l s

The following heat transfer benchmark examples show how to model heat transfer 
using:

• Steady-state and transient analysis

• Temperature, heat flux, convective cooling, and radiation boundary conditions

• Thermal conductivity as a function of temperature

All examples are taken from a NAFEMS benchmark collection (Ref. 2).

1D Steady-State Heat Transfer with Radiation

The first example shows a 1D steady-state thermal analysis including radiation to a 
prescribed ambient temperature.

Model Definition

This 1D model has a domain of length 0.1 m. The left end is kept at 1000 K, and at 
the right end there is radiation to 300 K. For the radiation, the model properties are:

• The emissivity, ε, is 0.98.

• The Stefan-Boltzmann constant, σ, is 5.67·10−8 W/(m2·K4).

In the domain, use the following material property:

• The thermal conductivity is 55.563 W/(m·K).
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Results

The following plot shows the temperature as a function of position:

Figure 7-4: Temperature as a function of position.

The benchmark result for the right end is a temperature of 927.0 K. The COMSOL 
Multiphysics model, using a default mesh with 15 elements, gives a temperature at the 
end as 926.97 K, which is the exact benchmark value to four significant digits.

Model Library path: COMSOL_Multiphysics/Heat_Transfer/
heat_radiation_1d

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go to the Model Navigator and select 1D from the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>Heat Transfer folder 
and then the Conduction node.

3 Select Steady-state analysis.

4 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 Go to the Options menu and choose Constants.
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2 Enter the following constants (the descriptions are optional); when done, click OK.

G E O M E T R Y  M O D E L I N G

1 Go to the Draw menu, point to Specify Objects and click Line.

2 In the Line dialog box, type 0 0.1 in the x edit field under Coordinates.

3 Click OK.

4 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 Go to the Physics menu and choose Boundary Settings.

2 In the Boundary Settings dialog box, select Boundary 1.

3 In the Boundary condition list, select Temperature.

4 In the Temperature edit field, type 1000.

5 Select Boundary 2.

6 From the Boundary condition list, select Heat flux.

7 Type epsilon*sigma in the Problem-dependent constant edit field.

8 Type 300 in the Ambient temperature edit field.

NAME EXPRESSION DESCRIPTION

epsilon 0.98 Emissivity

sigma 5.67e-8[W/(m^2*K^4)] Stefan-Boltzmann constant

k 55.563[W/(m*K)] Thermal conductivity
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9 Click OK.

Subdomain Settings
1 Go to the Physics menu and choose Subdomain Settings.

2 In the Subdomain Settings dialog box, enter k in the Thermal conductivity edit field.

Set the initial value to match the boundary condition. It serves as starting value for 
the nonlinear solver:

3 Click the Init tab.

4 Type 1000 as the initial value in the Temperature edit field.

5 Click OK.
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M E S H  G E N E R A T I O N

Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

Figure 7-4 on page 189 shows the temperature distribution in the domain. Use the 
zoom tools to focus on the temperature at the right end.

2D Steady-State Heat Transfer with Convection

This example shows a 2D steady-state thermal analysis including convection to a 
prescribed external (ambient) temperature.

Model Definition

This model domain is 0.6 m-by-1.0 m. For the boundary conditions:

• The left boundary is insulated.

• The lower boundary is kept at 100 °C.

• The upper and right boundaries are convecting to 0 °C with a heat transfer 
coefficient of 750 W/(m2·°C).

In the domain use the following material property:

• The thermal conductivity is 52 W/(m·°C).
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Results

The following plot shows the temperature as a function of position:

Figure 7-5: Temperature distribution resulting from convection to a prescribed external 
temperature.

The benchmark result for the target location (x = 0.6 m and y = 0.2 m) is a 
temperature of 18.25 °C. The COMSOL Multiphysics model, using a default mesh 
with 556 elements, gives a temperature of 18.28 °C. Successive uniform refinements 
show temperatures of 18.26 °C and 18.25 °C, converging toward the benchmark 
result.

Model Library path: COMSOL_Multiphysics/Heat_Transfer/
heat_convection_2d
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Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go to the Model Navigator and select 2D from the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>Heat Transfer folder 
and then the Conduction node.

3 Select Steady-state analysis.

4 Click OK.

G E O M E T R Y  M O D E L I N G

1 On the Draw menu point to Specify Objects and click Rectangle.

2 In the Rectangle dialog box, find the Size area and type 0.6 in the Width edit field, 
then type 1 in the Height edit field.

3 Click OK.

4 Click the Zoom Extents button.

P H Y S I C S  S E T T I N G S

Boundary Conditions
The default boundary condition is thermal insulation, so you must set boundary 
conditions for only three of the boundaries.

1 Go to the Physics menu and choose Boundary Settings.

2 In the Boundary Settings dialog box select Boundary 2.

3 In the Boundary condition list select Temperature.

4 Type 100[degC] in the Temperature edit field to specify a temperature in degrees 
Celsius (the default unit for temperature in the SI base unit system is kelvin).

5 Select Boundaries 3 and 4.

6 In the Boundary condition list select Heat flux.

7 Type 750 in the Heat transfer coefficient edit field.

8 Type 0[degC] in the External temperature edit field.
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9 Click OK.

Subdomain Settings
1 Go to the Physics menu and choose Subdomain Settings.

2 In the Subdomain Settings dialog box enter 52 in the Thermal conductivity edit field.

3 Click OK.

M E S H  G E N E R A T I O N

Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

Figure 7-5 on page 193 shows the temperature distribution in the domain. To get a 
the numerical value of the temperature at the reference point, do the following steps:

1 Go to the Postprocessing menu and choose Data Display>Subdomain to open the Data 

Display dialog box.

2 Select oC from the Unit list.

3 In the Coordinates area enter 0.6 in the x edit field and 0.2 in the y edit field.

4 Click OK. The temperature (about 18.28 °C) appears in the message log at the 
bottom of the main COMSOL Multiphysics window.
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2D Axisymmetric Transient Heat Transfer

This example shows an axisymmetric transient thermal analysis with a step change to 
1000 °C at time 0.

Model Definition

This model domain is 0.3 m-by- 0.4 m. For the boundary conditions, assume the 
following:

• The left boundary is the symmetry axis.

• The other boundaries have a temperature of 1000 °C. The entire domain is at 0 °C 
at the start, which represents a step change in temperature at the boundaries.

In the domain use the following material properties:

• The density, ρ, is 7850 kg/m3

• The heat capacity is 460 J/(kg·°C)

• The thermal conductivity is 52 W/(m·°C)
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Results

The following plot shows the temperature as a function of position after 190 seconds:

Figure 7-6: Temperature distribution after 190 seconds.

The benchmark result for the target location (r = 0.1 m and z = 0.3 m) is a temperature 
of 186.5 °C. The COMSOL Multiphysics model, using a default mesh with about 720 
elements, gives a temperature of roughly 186.4 °C.

As an additional postprocessing step, map the axisymmetric solution to 3D using an 
extrusion coupling variable to show the solution for the entire cylinder (see 
Figure 7-7).
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Figure 7-7: Postprocessing of the temperature in the full 3D geometry.

Model Library path: COMSOL_Multiphysics/Heat_Transfer/
heat_transient_axi

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Go the Model Navigator and select Axial symmetry (2D) from the Space dimension list.

2 From the list of application modes, select COMSOL Multiphysics>Heat Transfer> 

Conduction.

3 Select Transient analysis.

4 Click OK.
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G E O M E T R Y  M O D E L I N G

1 Go to the Draw menu, point to Specify Objects and click Rectangle.

2 In the Rectangle dialog box go to the Size area and enter 0.3 in the Width edit field 
and 0.4 in the Height edit field.

3 Click OK.

4 Click the Zoom Extents button on the Main toolbar.

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 Go to the Physics menu and choose Boundary Settings.

2 In the Boundary Settings dialog box select Boundary 1.

3 In the Boundary condition list select Axial symmetry.

4 Select the Select by group check box and choose Boundaries 2, 3, and 4 by selecting 
one of them.

5 Select Temperature in the Boundary condition list.

6 Type 1000[degC] in the Temperature edit field.

7 Click OK.

Subdomain Settings
1 Go to the Physics menu and choose Subdomain Settings.
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2 In the Subdomain Settings dialog box enter the thermal properties in the domain 
according to the following table:

3 Click the Init tab.

4 Type 0[degC] in the T(t0) edit field for the initial temperature.

5 Click OK.

M E S H  G E N E R A T I O N

Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

1 Go to the Solve menu and choose Solver Parameters.

2 In the Time stepping area in the Solver Parameters dialog box enter 
range(0,10,190) in the Times edit field.

3 Click OK.

4 Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

Getting the Reference Temperature
Figure 7-6 on page 197 shows the temperature distribution in the domain. To get the 
numerical value at the reference point, use the Data Display dialog box:

1 Choose Postprocessing>Data Display>Subdomain.

2 In the Coordinates area enter 0.1 in the r edit field and 0.3 in the z edit field.

3 Click OK.

The value of the temperature in the reference point appears in the message log. You 
can also click in the temperature plot at (0.1, 0.3) to display the temperature at that 
point in the message log.

PROPERTIES SUBDOMAIN 1

 k (isotropic) 52

 ρ 7850

 Cp 460
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Postprocessing in 3D
To postprocess the solution in 3D, first revolve the geometry into a cylinder in a 3D 
geometry and then map the axisymmetric solution to the cylinder using an extrusion 
coupling variable:

1 From the Draw menu, choose Revolve.

2 In the Revolve dialog box, leave the default settings and click OK. This creates a 
cylinder in 3D. Note that the axis of revolution in 3D is the y-axis, which means that 
the plane that you map the radial coordinate r to is the xz-plane.

3 Click the Geom1 tab at the top of the drawing area to return to the 2D axisymmetric 
geometry.

4 Choose Options>Extrusion Coupling Variables>Subdomain Variables.

5 In the Subdomain Extrusion Variables dialog box, select Subdomain 1 and then type 
T_2D in the first row of the Name column and T is the first row of the Expression 
column. This creates an extrusion coupling variable T_2D that represents the 
temperature (the variable T).

Click the General transformation button. The default source transformation (x: r and 
y: z) is correct.

6 Click the Destination tab.

7 Select Geom2 from the Geometry list, select Subdomain from the Level list, and finally 
select the 1 check box for Subdomain 1 in the Subdomain selection list. The variable 
T_2D is the only extrusion coupling variable and the software selects it automatically.

8 In the Destination transformation area, type sqrt(x^2+z^2) in the x edit field, and 
leave the value y in the y edit field. This transforms r and z in the axisymmetric 
geometry to  and y, respectively, in the 3D geometry.

9 Click OK.

10 From the Solve menu, choose Update Model to map the solution to the 3D geometry.

11 From the Postprocessing menu, choose Plot Parameters.

12 To plot the temperature in the cylinder as a subdomain plot, clear the Slice check 
box and select the Subdomain check box in the Plot type area on the General page.

13 Select the Element selection check box and type x>0 in the Logical expression for 

inclusion edit field to “look inside” by removing all elements with a negative x 
coordinate.

14 Click the Subdomain tab, and then type T_2D in the Expression edit field.

x2 z2
+
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15 Click OK to generate Figure 7-7 on page 198. To reproduce that plot, also click the 
Headlight button on the Camera toolbar.
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S t r u c t u r a l  M e c h a n i c s
This chapter explains how to use the Structural Mechanics application modes to 
simulate and analyze applications involving solid mechanics. It begins with a brief 
theoretical backgrounder on structural mechanics, after which subsequent sections 
give details of the application modes.
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Th e  S t r u c t u r a l  Me c h an i c s  App l i c a t i o n  
Mode s

COMSOL Multiphysics includes four application modes for stress analysis and general 
structural mechanics simulation:

• The Solid, Stress-Strain application mode (for 3D geometries)

• The Plane Stress application mode (for 2D geometries)

• The Plane Strain application mode (for 2D geometries)

• The Axial Symmetry Stress-Strain application mode (for 2D axisymmetric 
geometries)

The last three cases are 2D simplifications of the full 3D equations, simplifications that 
are valid under certain assumptions.

Note: The optional Structural Mechanics Module contains application modes and 
models that allow for extended, specialized analyses of structural and solid mechanics 
problems.
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Th eo r y  Ba c k g r ound

Strain-Displacement Relationship

It is possible to completely describe the strain conditions at a point with the 
deformation components—(u, v, w) in 3D—and their derivatives. You can express the 
shear strain in a tensor form, εxy, εyz, εxz, or in an engineering form, γxy, γyz, γxz. 
Following the small-displacement assumption, the normal strain components and the 
shear strain components are given from the deformation as follows:

The symmetric strain tensor ε consists of both normal and shear strain components:

Stress-Strain Relationship

The stress in a material is described by the symmetric stress tensor

consisting of three normal stresses (σx, σy, σz) and six, or if symmetry is used, three 
shear stresses (τxy, τyz, τxz). The stress-strain relationship for linear conditions reads:

εx x∂
∂u

=

εy y∂
∂v

=

εz z∂
∂w

=

εxy
γxy

2
-------=

1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞=

εyz
γyz
2

-------=
1
2
---

z∂
∂v

y∂
∂w

+⎝ ⎠
⎛ ⎞=

εxz
γxz

2
-------=

1
2
---

z∂
∂u

x∂
∂w

+⎝ ⎠
⎛ ⎞=

ε
εx εxy εxz

εxy εy εyz

εxz εyz εz

=

σ
σx τxy τxz

τyx σy τyz

τzx τzy σz

= τxy τyx= τxz τzx= τyz τzy=

σ Dε=
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where D is the 6×6 elasticity matrix, and the stress and strain components are described 
in vector form with the six stress and strain components in column vectors defined as

Note: The following descriptions use the compact notation σ and ε, meaning either 
the stress/strain vector or tensor depending on the context.

The elasticity matrix D and the more basic matrix D−1 (the inverse of D, also known 
as the flexibility or compliance matrix) are defined differently for isotropic, 
orthotropic, and anisotropic material. For isotropic materials, the D−1 matrix looks like

where E is the modulus of elasticity (also known as Young’s modulus), and ν is 
Poisson’s ratio, which defines contraction in the perpendicular direction. Inverting 
D−1

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

=

D 1– 1
E
----

1 ν– ν– 0 0 0
ν– 1 ν– 0 0 0
ν– ν– 1 0 0 0

0 0 0 2 1 ν+( ) 0 0
0 0 0 0 2 1 ν+( ) 0
0 0 0 0 0 2 1 ν+( )

=
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Implementation

COMSOL Multiphysics bases its implementation of the structural mechanics 
application modes on a weak formulation of the equilibrium equations expressed in the 
global stress components.

E Q U I L I B R I U M  E Q U A T I O N

The equilibrium equations expressed in the stresses for 3D are

where F denotes the volume forces (body forces).

Using compact notation, you can write this relationship as

where σ is the stress tensor. Substituting the stress-strain and strain-displacement 
relationships in the above equation results in Navier’s equation expressed in the 
displacement. 

S E T T I N G  U P  E Q U A T I O N S  F O R  T H E  D I F F E R E N T  A N A L Y S E S

All the application modes for structural mechanics support the following analysis types:

• Static analysis

D E
1 ν+( ) 1 2ν–( )

---------------------------------------

1 ν– ν ν 0 0 0
ν 1 ν– ν 0 0 0
ν ν 1 ν– 0 0 0

0 0 0 1 2ν–
2

---------------- 0 0

0 0 0 0 1 2ν–
2

---------------- 0

0 0 0 0 0 1 2ν–
2

----------------

=

x∂
∂σx–

y∂
∂τxy–

z∂
∂τxz Fx=–

x∂
∂τxy–

y∂
∂σy–

z∂
∂τyz Fy=–

x∂
∂τxz–

y∂
∂τyz–

z∂
∂σz Fz=–

∇– σ⋅ F=
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• Eigenfrequency analysis

• Transient analysis

The equations to solve and the solvers to use vary depending on the analysis type. You 
specify them by selecting an analysis type in the Model Navigator or during modeling in 
the Application Mode Properties dialog box or the Solver Parameters dialog box.

Static Analysis
These analysis types all use the same equation but invoke a different solver. The 
following discussion uses static analyses to represent all these types of analysis because 
they use the same equations.

Substitution of the stress-strain relationship and the strain-displacement relationship 
into the static equilibrium equation produces Navier’s equation of equilibrium 
expressed in the displacements.

For static conditions including temperature, Navier’s equation reads

Details about the corresponding coefficients appear in the application mode 
implementation sections.

Eigenfrequency Analysis
The difference between this analysis type and the static analysis is that it adds the mass.

If you want to solve for the eigenfrequencies, use the following formulation:

The eigenfrequency f relates to the eigenvalue λ as

The density appears in the da coefficient. In COMSOL Multiphysics you can work 
with either eigenvalues or eigenfrequencies.

Transient Analysis
A transient problem requires the introduction of Newton’s Second Law.

∇– c u∇( )⋅ F=

λd– au ∇– csta u = 0∇⋅

f λ
2π
-------=

ρ∂2u
∂t2
---------- ∇– c u∇⋅ F=
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COMSOL Multiphysics provides Rayleigh damping to model viscous damping by 
specifying two damping coefficients. The default is to use no damping. To activate 
Rayleigh damping, see “Damping” on page 215.

To see how the software handles the Rayleigh damping, consider a system with a single 
degree of freedom. You can describe the motion for a system with viscous damping and 
with a single degree of freedom as

 (8-1)

The Rayleigh damping model expresses the damping parameter ξ in terms of the mass 
m and the stiffness k as

You can reduce the 2nd-order system in Equation 8-1 to a 1st-order system in time by 
introducing new variables v = (u_t, v_t, w_t)t:

The expanded system look like the following, with the Rayleigh damping modeled in 
an equivalent way to the single-degree-of-freedom system shown above:

The difference between this system and the scalar case with just one degree of freedom 
is that the damping parameters are defined locally, meaning that they can vary in space 
and between subdomains.

md2u
dt2
---------- ξdu

dt
------- ku+ + f t( )=

ξ αdMm βdKk+=

v ∂
∂t
-----u=

I 0
0 ρ

∂
∂t
----- u

v
∇ 0 0

csta cstaβdK
∇ u

v
0 I–

0 αdMρ
u
v

+⋅– 0
K

=
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App l i c a t i o n  Mode De s c r i p t i o n s

This section describes how to define a structural mechanics model using the 
application modes. It consists of the following sections:

• Application mode properties

• Material properties

• Constraints

• Loads

The dialog boxes and options are similar for all of the application modes. However, the 
number of independent variables (spatial coordinates) and dependent variables 
(displacements) as well as their names vary depending on the application mode. For 
details on additional application-specific properties, see the following sections, which 
describe the application modes.

Application Mode Properties

To specify application mode properties, choose Properties from the Physics menu to 
open the Application Mode Properties dialog box.
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In this dialog box you can specify different global settings for the model:

• Make a selection from the Default element type list. This selection becomes the 
default on all subdomains. Available elements are:

- Lagrange - Linear, 1st-order Lagrange elements

- Lagrange - Quadratic, 2nd-order Lagrange elements

- Lagrange - Cubic, 3rd-order Lagrange elements

- Lagrange - Quartic, 4th-order Lagrange elements

- Lagrange - Quintic, 5th-order Lagrange elements

• Make a selection from the Analysis type list; the default is static analysis. Your choice 
affects the equations and which solver COMSOL Multiphysics uses if you previously 
selected the Auto select solver check box in the Solver Parameters dialog box.

• Indicate how you prefer to specify eigenvalues—using eigenvalues themselves or 
eigenfrequencies—by selecting from the Specify eigenvalues using list. This property 
is applicable only to eigenfrequency analyses.

• Control whether or not weak constraints should be available in the Weak constraints 
list by selecting On or Off.

Use weak constraints for accurate computation of reaction forces, solving for the 
reaction force, which is equal to the Lagrange multiplier that the weak constrain 
introduces as an additional dependent variable. When weak constraints are enabled, 
all constraints are weak constraints by default, but it is possible to change this setting 
for individual domains.

• Choose the type of constraint. Select Ideal or Non-ideal from the Constraint type list. 
See “Ideal vs. Non-Ideal Constraints” on page 351 for more information about 
these constrain types.
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Material Properties

You define material properties in a model by going to the Subdomain Settings dialog 
box and then the Material page.

The material properties for the structural mechanics application modes appear in the 
table below.

Young’s modulus    Defines the material’s modulus of elasticity, E. For isotropic 
materials it is the spring stiffness in Hooke’s law, shown in 1D form as

where σ is the stress and ε is the strain.

Poisson’s ratio   Denoted by ν, it defines the normal strain in the perpendicular 
direction generated from a normal strain in the other direction.

PARAMETER VARIABLE DESCRIPTION COMMENT

 E E Young's modulus 

 ν nu Poisson's ratio 

 ρ rho Density

 thickness thickness Thickness of the structure Plane stress and 
plane strain only

σ Eε=

ε⊥ υεl l–=
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Density   This property, ρ, specifies the material’s density. 

The COMSOL Multiphysics materials library contains values for many of these 
properties for common materials such as steel, copper, or aluminum. See “Using the 
Materials/Coefficients Library” on page 228 in the COMSOL Multiphysics User’s 
Guide.

Constraints

A constraint specifies the displacement of certain parts of a structure. You can define 
constraints on all domain levels:

• Points, edges, boundaries (faces), and subdomains in 3D 

• Points, boundaries, and subdomains in 2D.

To specify them, go to the Constraint page in the Subdomain Settings, Boundary Settings, 
Edge Settings, or Point Settings dialog boxes. The following image shows the Boundary 

Settings dialog box for the Solid, Stress-Strain application mode, but this page looks 
the same on all domain levels in all structural mechanics application modes.

You can describe a constraint using standard or general notation, an option you control 
using the Standard notation and the General notation, Hu=R buttons.

S T A N D A R D  N O T A T I O N  F O R  C O N S T R A I N T S

Using standard notation, you constrain each displacement direction independently:

1 Select the check boxes in front of Rx, Ry, and Rz to activate the constraint.
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2 Enter the value or expression for the displacement in the edit fields. The default 
value is 0.

G E N E R A L  N O T A T I O N  F O R  C O N S T R A I N T S

Using general notation (illustrated here for the 2D case), you define the H matrix and 
R vector in the relationship

to specify constraints as any linear combination of displacements components.

Enter the H matrix and R vector in special matrix dialog boxes by clicking the Edit 
buttons.

For example, to set the condition u = v, use the settings

,

which allow the domain to move only diagonally in the x-y plane.

The H Matrix dialog box for the above example is

Loads

A load is a general name for forces applied to a structure. You can specify loads on all 
domain types. To specify them, go to the Load page in the Subdomain Settings, Boundary 

Settings, Edge Settings, or Point Settings dialog boxes. The image below shows the 
Boundary Settings dialog box for the Plane Stress application mode, but this page looks 
similar on all domain levels in all structural mechanics application modes.

H u
v

R=

H 1 1–
0 0

,= R 0
0

=
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e (N/m3) 
a (N/m2)

e (N/m3)

e (N/m3)
When dealing with plane stress and plane strain, you can optionally specify a load in 
different ways using the thickness. The following table illustrates how to define loads 
on different domains in different application modes; the SI unit appears in parentheses.

Damping

To specify damping, click the Damping tab in the Subdomain Settings dialog box. You 
can choose between Rayleigh damping and no damping (the default) in the Damping 

model list. For specifying the Rayleigh damping, there are two damping parameters:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMAIN

Plane Stress, 
Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volum
or force/are

Axisymmetry, 
Stress-Strain

total force along the 
circumference (N)

force/area (N/m2) force/volum

Solid, 
Stress-Strain

force (N) force/length 
(N/m)

force/area (N/m2) force/volum

 αdM alphadM Mass damping parameter

 βdK betadK Stiffness damping parameter
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Th e  S o l i d ,  S t r e s s - S t r a i n  App l i c a t i o n  
Mode

This section explains how to use the Solid, Stress-Strain application mode for stress and 
strain analysis of 3D solids.

A 3D solid with applied loads and constraints in a stress analysis.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions.

PDE Formulation

COMSOL Multiphysics formulates this application mode using the equilibrium 
equations described in general terms in the section “Implementation” on page 207.
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A P P L I C A T I O N  M O D E  P A R A M E T E R S

The parameters that define the loads, material, and constraints are reviewed in the 
section “Application Mode Descriptions” on page 210.

Application Mode Variables

A large number of variables, listed below, are available for use in expressions and for 
postprocessing. The table uses an index convention, where a single index on ui (ui) 
means that i runs over the global displacements (u, v, w), whereas a single index on 
other names like si (σi) means that i runs over the global space variables (x, y, z), and 
a double index sij (τij) means that ij runs over the combinations (xy, yz, xz) of the 
space variables.

In addition to the variables in the table, almost all application mode parameters are 
available as variables. Some are different for some analyses; see the Analysis column, 
which uses the following abbreviations:

ANALYSIS ABBREVIATION

Static S

Transient T

TABLE 8-1:  SOLID, STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui  ui All All  xi displacement  ui

ui_t  uit T All  xi velocity  uit

disp  disp All All Total 
displacement

ex  εx All S  εx normal 
strain global 
system

eij  εij All S  εij shear strain 
global coord. 
system

ei_t  εit T S  εit normal 
velocity strain 
global system

ui( )real( )
i
∑

2

xi∂
∂ui

1
2
---

xj∂
∂ui

xi∂
∂uj+

⎝ ⎠
⎜ ⎟
⎛ ⎞

xi∂
∂uit
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 | ) , 
eij_t  εijt T S  εijt shear 
velocity strain 
global coord. 
system

en  εn All S  nth principal 
strain, 
n = 1, 2, 3

eni  εni All S  nth principal 
strain 
component in 
the xi direction, 
n = 1, 2, 3

si  σi All S  σi normal 
stress global 
coord. system

 D ε

sij  τij All S  τij shear stress 
global coord. 
system

 D ε

si_t  σit T S  σit time 
derivative of 
normal stress 
global coord. 
system

 D εt

sij_t  τijt T S  τijt time 
derivative of 
shear stress 
global coord. 
system

 D εt

sn  σn All S  nth principal 
stress, 
n = 1, 2, 3

sni  σni All S  nth principal 
stress 
component in 
the xi direction, 
n = 1, 2, 3

tresca  σtresca All S Tresca stress  max (max ( | σ1 − σ2 |, | σ2 − σ3

        | σ1 − σ3 |)

TABLE 8-1:  SOLID, STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

1
2
---

xj∂
∂uit

xi∂
∂ujt+

⎝ ⎠
⎜ ⎟
⎛ ⎞
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: sld), for example, 
mises_sld. (This does not apply to the dependent variables for the displacements.)

mises  σmises All S von Mises 
stress 

Tai  Tai All B Surface traction 
(force/area) in 
xi direction

Fig  Fig All All Body load, face 
load, edge load, 
point load, in 
global 
xi direction

TABLE 8-1:  SOLID, STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

Tax

Tay

Taz

σx τxy τxz

τxy σy τyz

τxz τyz σz

nx

ny

nz

=

Fxg

Fyg

Fzg

Fx

Fy

Fz

=
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Th e  P l a n e  S t r e s s  App l i c a t i o n  Mode

Use the Structural Mechanics Plane Stress application mode to analyze thin in-plane 
loaded plates. This application mode solves for the global displacements (u, v) in the 
x and y directions. In a state of plane stress the σz, τyz, and τxz components of the stress 
tensor are assumed to be zero.

Loads and constraints in a plane stress analysis.

Loads in the x and y directions are allowed. The mode assumes that the loads are 
constant throughout the thickness of the material but that thickness can vary in the x 
and y directions. The plane stress condition prevails in a thin flat plate in the xy-plane 
loaded only in its own plane and without any z-direction restraint.

Material

An additional material parameter for plane stress is the plate’s thickness.

PDE Formulation

COMSOL Multiphysics formulates the application mode using the equilibrium 
equations described in general terms in the section “Implementation” on page 207.

PARAMETER VARIABLE DESCRIPTION MATERIAL MODEL

th thickness The plate’s thickness All 
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A P P L I C A T I O N  M O D E  P A R A M E T E R S

The application mode parameters defining the loads, material and constraints are 
explained in the section “Application Mode Descriptions” on page 210.

Application Mode Variables

A large number of variables are available for use in expressions and for postprocessing. 
Table 8-2 uses an index convention where a single index on ui (ui) means that i runs 
over the global displacements (u, v), whereas a single index on other names like si (σi) 
means that i runs over the global space coordinates (x, y). A single index on xi means 
that i runs over the global space coordinates (x, y).

In addition to the variables listed below, almost all application mode parameters are 
available as variables. Some vary for different analyses, as seen in the Analysis column.

ANALYSIS ABBREVIATION

Static S

Transient T

TABLE 8-2:  PLANE STRESS APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui  ui All All  xi displacement  ui

ui_t  uit T All  xi velocity  uit

disp  disp All All Total 
displacement

ei  εi All S  εi normal strain 
global system

ez  εz All S  εz normal strain 
out of the 
xy-plane

exy  εxy All S  εxy shear strain 
global coord. 
system

ei_t  εit T S  εit velocity 
normal strain 
global coord. 
system

ui( )real( )
i
∑

2

xi∂
∂ui

D3k εk( )
k 1 2 4, ,=
∑⎝ ⎠

⎜ ⎟
⎛ ⎞

D33
-----------------------------------------------–

1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞

xi∂
∂uit
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ez_t  εzt T S  εzt velocity 
normal strain 
out of the x-y 
plane

exy_t  εxyt All S  εxyt velocity 
shear strain 
global coord. 
system

en  εn All S  nth principal 
strain, 
n = 1, 2, 3

eni  εni All S  nth principal 
strain 
component in 
the xi direction, 
n = 1, 2, 3

si  σi All S  σi normal 
stress global 
coord. system

sxy  τxy All S  τxy shear stress 
global coord. 
system

si_t  σit T S  σit time 
derivative of 
normal stress 
global coord. 
system

sxy_t  τxyt T S  τxyt time 
derivative of 
shear stress 
global coord. 
system

sn σn All S  nth principal 
stress, 
n = 1, 2, 3

TABLE 8-2:  PLANE STRESS APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

D3kεkt

k 1 2 4, ,=
∑

D33
---------------------------------------–

1
2
---

y∂
∂ut

x∂
∂vt+⎝ ⎠

⎛ ⎞

Dik εk( )( )
k
∑

D4kεk( )
k
∑

Dikεkt

k
∑

D4kεkt

k
∑
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sni  σni All S  nth principal 
stress 
component in 
the xi direction, 
n = 1, 2, 3

tresca  σtresca All S Tresca stress  max (max ( | σ1 − σ2 |, | σ2 − σ3

        | σ1 − σ3 |)

mises  σmises All S von Mises 
stress

Tai  Tai All B Surface traction 
(force/area) in 
xi direction

Fig  Fig All S Body load, in 
global 
xi direction

If force/area

If force/volume

Fig  Fig All B Edge load in 
global 
xi direction

If force/length

If force/area

Fig  Fig All P Point load in 
global 
xi direction

TABLE 8-2:  PLANE STRESS APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

Tax

Tay

σx τxy

τxy σy

nx

ny

=

Fxg

Fyg

Fx

Fy

=

Fxg

Fyg

th
Fx

Fy

=

Fxg

Fyg

Fx

Fy

=

Fxg

Fyg

th
Fx

Fy

=

Fxg

Fyg

Fx

Fy

=
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: ps), for example, 
mises_ps. (This does not apply to the dependent variables for the displacements.)
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Th e  P l a n e  S t r a i n  App l i c a t i o n  Mode

The Plane Strain application mode solves for the global displacements (u, v) in the x 
and y directions. In a state of plane strain, the εz, εyz, and εxz components of the strain 
tensor are assumed to be zero.

Loads in a plane strain analysis.

Loads in the x and y directions are allowed. The loads are assumed to be constant 
throughout the thickness of the material, but that thickness can vary in the x and 
y directions. The plane strain condition prevails in geometries that extend much 
farther in the z direction than in the x and y directions, or when the z-displacement is 
in some way restricted. The 2D geometry in a plane strain model represents a cross 
section that cuts a very long or infinite depth such that you can ignore any end effects. 
An example is a long tunnel along the z-axis where it is sufficient to study a unit-depth 
slice in the xy-plane. A plane strain model is sometimes also referred to as a unit-depth 
model.

Material Properties

An additional material property for plane strain analysis is the geometry’s thickness.

PARAMETER VARIABLE DESCRIPTION MATERIAL MODEL

th thickness The geometry’s thickness All 
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PDE Formulation

COMSOL Multiphysics formulates the application mode using the equilibrium 
equations described in general terms in the section “Implementation” on page 207.

A P P L I C A T I O N  M O D E  P A R A M E T E R S

The application mode parameters defining the loads, material, and constraints are 
explained in the section “Application Mode Descriptions” on page 210. 

Application Mode Variables

A large number of variables are available for use in expressions and for postprocessing. 
In addition to the variables listed below, almost all application mode parameters are 
available as variables. Some vary for different analyses as seen in the Analysis column. 

Table 8-3 uses an index convention where a single index on ui (ui) means that i runs 
over the global displacements (u, v), whereas a single index on other names like si (σi) 
means that i runs over the global spatial coordinates (x, y). A single index on xi means 
that i runs over the global spatial coordinates (x, y).

ANALYSIS ABBREVIATION

Static S

Transient T

TABLE 8-3:  PLANE STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

ui  ui All All  xi displacement  ui

ui_t  uit T All  xi velocity  uit

disp  disp All All Total 
displacement

ei  εi All S  εi normal strain 
global system

exy  εxy All S  εxy shear strain 
global coord. 
system

ui( )real( )
i
∑

2

xi∂
∂ui

1
2
---

y∂
∂u

x∂
∂v

+⎝ ⎠
⎛ ⎞
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ei_t  εit T S  εit velocity 
normal strain 
global system

exy_t  εxyt T S  εxyt velocity 
shear strain 
global coord. 
system

en  εn All S  nth principal 
strain, 
n = 1, 2, 3

eni  εni All S  nth principal 
strain 
component in 
the xi direction, 
n = 1, 2, 3

si  σi All S  σi normal 
stress global 
coord. system

sz  σz All S  σz normal 
stress

sxy  τxy All S  τxy shear stress 
global coord. 
system

si_t  σit T S  σit time 
derivative of 
normal stress 
global coord. 
system

sz_t  σz T S  σzt time 
derivative of 
normal stress

sxy_t  τxy T S  τxy shear stress 
global coord. 
system

sn  σn All S  nth principal 
stress, 
n = 1, 2, 3

TABLE 8-3:  PLANE STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

xi∂
∂uit

1
2
---

y∂
∂ut

x∂
∂vt+⎝ ⎠

⎛ ⎞

Dik εk( )
k 1 2 4, ,=
∑

D3k εk( )
k 1 2 4, ,=
∑

D4k εk( )
k 1 2 4, ,=
∑

Dikεkt

k 1 2 4, ,=
∑

D3kεkt

k 1 2 4, ,=
∑

D4kεkt

k 1 2 4, ,=
∑
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sni  σni All S  nth principal 
stress 
component in 
the xi direction, 
n = 1, 2, 3

tresca  σtresca All S Tresca stress  max(max( | σ1 − σ2 |, 
     | σ2 − σ3 |,  | σ1 − σ3 | ))

mises  σmises All S von Mises stress 

Tai  Tai All B Surface traction 
(force/area) in 
xi direction

Fig  Fig All S Body load in 
global 
xi direction

If force/area

If force/volume

Fig  Fig All B Edge load in 
global 
xi direction

if force/length

if force/area

Fig  Fig All P Point load in 
global 
xi direction

TABLE 8-3:  PLANE STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

Tax

Tay

σx τxy

τxy σy

nx

ny

=

Fxg

Fyg

Fx

Fy

=

Fxg

Fyg

th
Fx

Fy

=

Fxg

Fyg

Fx

Fy

=

Fxg

Fyg

th
Fx

Fy

=

Fxg

Fyg

Fx

Fy

=
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: pn), for example, 
mises_pn. (This does not apply to the dependent variables for the displacements.)
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Th e  A x i a l  S ymme t r y ,  S t r e s s - S t r a i n  
App l i c a t i o n  Mode

The Axial Symmetry, Stress-Strain application mode uses the cylindrical coordinates r, 
, and z. It solves the equations for the global displacement (u, w) in the r and 

z directions. The displacement v in the direction together with the , , , 
and components of the stresses and strains are assumed to be zero. In this mode, 
loads are independent of , and it allows them only in the r and z directions.

You can view the domain where the equations are solved as the intersection between 
the original axisymmetric 3D solid and the half plane , r ≥ 0. Therefore it is 
necessary to draw the geometry only in the half plane r ≥ 0. Later on, recover the 
original 3D solid by rotating the 2D geometry about the z-axis (see the figure below).

Loads in an axisymmetric stress-strain analysis. The modeling domain is the gray 2D 
section.

The equilibrium equations in axial symmetry read

ϕ
ϕ τrϕ τϕz γrϕ

γϕz
ϕ

ϕ 0=
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 (8-2)

The strain-displacement relationships for the axial symmetry case for small 
displacements are

To avoid division by r in the equilibrium equations (which causes problems on the axis, 
where r = 0), the COMSOL Multiphysics application mode transforms the equations. 
It multiplies the first equation by r2 and the second by r. This transformation is a 
natural choice because it appears in the principle of virtual work. Integrating over the 
volume, you must multiply the integrand by 2πr. The application mode introduces and 
solves for a new dependent variable

which replaces the true radial displacement u.

Note: r = 0 is the symmetry axis. In the Axial Symmetry, Stress-Strain application 
mode the r-axis is in the x direction (horizontal), and the z-axis is in the y direction 
(vertical).

PDE Formulation

COMSOL Multiphysics formulates this application mode by using the equilibrium 
equation (see Equation 8-2) described in general terms in the section 
“Implementation” on page 207.

A P P L I C A T I O N  M O D E  P A R A M E T E R S

The application mode parameters defining the loads, material, and constraints are 
explained in the section “Application Mode Descriptions” on page 210.

r∂
∂σr

z∂
∂τrz σr σθ–

r
------------------ Kr+ + + 0=

r∂
∂τrz

z∂
∂σz τrz

r
------- Kz+ + + 0=

εr r∂
∂u

= εϕ
u
r
---= εz z∂

∂w
= γrz z∂

∂u
r∂

∂w
+=

uor u
r
---=
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Application Mode Variables

A large number of variables are available for use in expressions and for postprocessing. 
In addition to the variables listed in Table 8-4, almost all application mode parameters 
are available as variables. Some vary for different analyses as you can see in the Analysis 
column.

ANALYSIS ABBREVIATION

Static S

Transient T

TABLE 8-4:  AXIAL SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

uor  uor All All  r displacement 
divided by r

 uor

uaxi  uaxi All All  r displacement  uor · r

w  w All All  z displacement  w

uor_t  uort T All  r velocity 
divided by r

 uort

uaxi_t  uaxit T All  r velocity  uort · r

w_t  wt T All  z velocity  wt

disp  disp All All Total 
displacement

er  εr All S  εr normal strain 
global system

ez  εz All S  εz normal strain 
global system

ephi All S normal strain  uor

erz  εrz All S  εrz shear strain 
global coord. 
system

er_t  εrt T S  εrt velocity 
normal strain 
global system

ez_t  εzt All S  εzt velocity 
normal strain 
global system

uaxi2 w2
+

uor
r∂

∂ uor( ) r⋅+

z∂
∂w

εϕ
εϕ

1
2
---

z∂
∂ uor( ) r⋅

r∂
∂w

+⎝ ⎠
⎛ ⎞

uort r∂
∂ uort( ) r⋅+

z∂
∂wt
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ephi_t All S  velocity 
normal strain

 uort

erz_t  εrzt All S  εrzt shear strain 
global coord. 
system

en  εn All S  nth principal 
strain, 
n = 1, 2, 3

eni  εni All S  nth principal 
strain 
component in 
the xi direction, 
n = 1, 2, 3

sr  σr All S  σr normal 
stress global 
coord. system

sphi All S normal 
stress

sz  σz All S  σz normal 
stress global 
coord. system

srz  τrz All S  τrz shear stress 
global coord. 
system

sr_t  σrt All S  σrt time 
derivative of 
normal stress 
global coord. 
system

sphi_t All S  time 
derivative of 
normal stress 

sz_t  σzt All S  σzt time 
derivative of 
normal stress 
global coord. 
system

TABLE 8-4:  AXIAL SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

εϕt
εϕt

1
2
---

z∂
∂ uort( ) r⋅

r∂
∂wt+⎝ ⎠

⎛ ⎞

D1k εk( )
k
∑

σϕ
σϕ D2k εk( )

k
∑

D3k εk( )
k
∑

D4k εk( )
k 1 2 4, ,=
∑

D1kεkt

k
∑

σϕt
σϕt

D2kεkt

k
∑

D3kεkt

k
∑
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Note: To form the complete application mode variable names, add a suffix consisting 
of an underscore and the application mode name (default: axi), for example, 
mises_axi. (This does not apply to the dependent variables for the displacements.)

srz_t  τrzt All S  τrzt time der. of 
shear stress 
global coord. 
system

sn  σn All S  nth principal 
stress, n = 1, 2, 
3

sni  σni All S  nth principal 
stress 
component in 
the xi direction, 
n = 1, 2, 3

tresca  σtresca All S Tresca stress  max(max( | σ1 − σ2 |, 
     | σ2 − σ3 |,  | σ1 − σ3 | ))

mises  σmises All S von Mises stress 

Tar, Taz  Tar, Taz All B Surface traction 
(force/area) in r 
and z direction

Frg, Fzg  Frg, Fzg All All Body, edge, 
point load in 
global r and 
z directions

TABLE 8-4:  AXIAL SYMMETRY STRESS-STRAIN APPLICATION MODE VARIABLES

NAME SYMBOL ANALYSIS DOMAIN DESCRIPTION EXPRESSION

D4kεkt

k 1 2 4, ,=
∑

Tar

Taz

σr τrz

τrz σz

nr

nz

=

Frg

Fzg

Fr

Fz

=
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Examp l e s  o f  S t r u c t u r a l  Me chan i c s  
Mode l s

Two structural mechanics benchmark models show how to perform a linear static stress 
analysis using:

• A uniformly distributed horizontal load along an outer edge

• A gravity load

The examples are taken from a NAFEMS benchmark collection (Ref. 1).

Tapered Membrane End Load

The first example shows a 2D plane stress model of a membrane with a thickness of 
0.1 m. The load is a uniformly distributed horizontal load of 10 MN/m (that is, a 
pressure of 100 MPa) along the right end. At the left end, there is no displacement in 
the x direction. Also, at a midpoint location, the left end is fixed in the y direction.

The model uses the following material properties:

• The material is isotropic.

• The Young’s modulus (elasticity modulus) is 210·103 MPa.

• The Poisson ratio is 0.3.
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Modeling in COMSOL Multiphysics

Using a Plane Stress application modes and a static analysis, it is straightforward to 
perform this stress analysis. The finite element model uses second-order triangular 
Lagrange elements. To show convergence toward the benchmark value, refine the 
mesh and recompute the solution twice.

Results

The solution shows an x-direction stress at the point (0, 2) that is in good agreement 
with the benchmark target value of 61.3 MPa. Using the initial mesh, the COMSOL 
Multiphysics solution gives a value of 61.41 MPa. Two successive mesh refinements 
provide stress values of 61.36 MPa and 61.35 MPa.

No x displacement

Fixed. Stress evaluation point

Uniform
edge load
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Figure 8-1: The x-direction stress distribution with a uniform edge load

Model Library path: COMSOL_Multiphysics/Structural_Mechanics/
edge_load_2d

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Select 2D in the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>Structural Mechanics 
folder and then the Plane Stress node. Select Static analysis.

3 Click OK.

G E O M E T R Y  M O D E L I N G

1 On the Draw menu, point to Specify Objects and then click Line.
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2 In the Line dialog box, type 0 4 4 0 0 in the x edit field and 0 1 3 4 0 in the 
y edit field.

3 Click OK.

4 Click the Zoom Extents button on the Main toolbar.

5 Click the Coerce to Solid button on the Draw toolbar.

6 On the Draw menu, point to Specify Objects and then click Point.

7 In the Point dialog box, type 0 in the x edit field and 2 in the y edit field.

8 Click OK.

The point is the location for the point constraint and also the benchmark value for the 
stress.

P H Y S I C S  S E T T I N G S

Boundary and Point Conditions—Loads and Constraints
1 From the Physics menu, choose Boundary Settings.

2 Select Boundaries 1 and 3 from the Boundary selection list.

3 Select the Rx check box.

4 Click the Load tab.

5 Select Boundary 5 in the Boundary selection list.

6 Type 10e6 in the Fx edit field.

7 Click OK.

8 From the Physics menu, choose Point Settings.

9 Select Point 2 from the Point selection list.

10 Select the Rx and Ry check boxes.
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11 Click OK.

Subdomain Settings—Material Properties
1 From the Physics menu, choose Subdomain Settings.

2 Select Subdomain 1 from the Subdomain selection list.

3 Type 210e9 in the E edit field for the Young’s modulus.

4 Type 0.3 in the ν edit field for the Poisson’s modulus.

5 Type 0.1 in the thickness edit field.

6 Click OK.

The other material properties are not used in this model.

M E S H  G E N E R A T I O N

Initialize an unstructured triangular mesh and refine it once:

1 Click the Initialize Mesh button on the Main toolbar.

2 Click the Refine Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the von Mises stress. To plot the x-direction stress, use the 
following steps:

1 From the Postprocessing menu, select Plot Parameters.

2 In the Plot Parameters dialog box, click the Surface tab.
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3 On the Surface Data tab, select sx normal stress global sys. from the 
Predefined quantities list.

4 Click OK.

To get a better look at the value of the x-direction stress at the point (0,2), use the 
Cross-Section Plot Parameters dialog box:

1 From the Postprocessing menu, select Cross-Section Plot Parameters.

2 Click the Point tab.

3 Select sx normal stress global sys. from the Predefined quantities list.

4 Type 0 in the x edit field and 2 in the y edit field.

5 Click OK.

This plot shows a straight line representing the value of the x-direction stress at the 
point (0, 2). You can also click at that point in the results plot. That prints the numeric 
value in the message log.

Tapered Cantilever Gravity Load

The second example shows another 2D plane stress model of a membrane with a 
thickness of 0.1 m. The load is a gravity load that acts in the negative y direction with 
an acceleration of 9.81 m/s2. The left end boundary is fully fixed (no displacements).

The model uses the following material properties:

• The material is isotropic.

• The Young’s modulus (elasticity modulus) is 210·103 MPa.

• The Poisson ratio is 0.3.

• The density is 7000 kg/m3.

Modeling in COMSOL Multiphysics

Using a Plane Stress application modes and a static analysis, it is straightforward to 
perform this stress analysis. You enter the gravity load as force/volume. COMSOL 
Multiphysics then computes the load using the thickness of the material. The finite 
element model uses second-order triangular Lagrange elements. For postprocessing, 
use a cross-section plot to show the value of the shear stress at the location (0, 2).
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Results

The solution shows a shear stress (sxy) at the point (0,  2) that is in good agreement 
with the benchmark target value of −0.200 MPa. Using the initial mesh, the 
COMSOL Multiphysics solution gives a value of −0.199 MPa.

Figure 8-2: The shear stress and the displacement (exaggerated) from a gravity load.

Model Library path: COMSOL_Multiphysics/Structural_Mechanics/
gravity_load_2d

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Select 2D from the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>Structural Mechanics 
folder and then the Plane Stress node. Select Static analysis.

3 Click OK.
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G E O M E T R Y  M O D E L I N G

1 On the Draw menu, point to Specify Objects and then click Line.

2 In the Line dialog box, type 0 4 4 0 0 in the x edit field and 0 1 3 4 0 in the y 
edit field.

3 Click OK.

4 Click the Zoom Extents button on the Main toolbar.

5 Click the Coerce to Solid button on the Draw toolbar.

P H Y S I C S  S E T T I N G S

Boundary Conditions—Constraints
1 From the Physics menu, choose Boundary Settings.

2 Select Boundary 1 in the Boundary selection list.

3 Select the Rx and Ry check boxes.

4 Click OK.

Subdomain Settings—Material Properties and Loads
1 From the Physics menu, choose Subdomain Settings.

2 Select Subdomain 1 in the Subdomain selection list.

3 Type 210e9 in the E edit field for the Young’s modulus.

4 Type 0.3 in the ν edit field for the Poisson’s ratio.
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5 Type 0.1 in the thickness edit field.

You can also type 7000 in the ρ edit field for the density, but the density value from 
this edit field is not used in the static analysis. The gravity appears in the specification 
of the gravity load below.

6 Click the Load tab.

7 Type -9.81*7000 in the Fy edit field for the y-direction body load.

8 Click the Body load is defined as force/volume using the thickness button.

9 Click OK.

M E S H  G E N E R A T I O N

Click the Initialize Mesh button on the Main toolbar.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.
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PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the von Mises stress. To plot the shear stress and also the 
deformed shape (displacements), use the following steps:

1 From the Postprocessing menu, select Plot Parameters.

2 In the Plot Parameters dialog box, click the Surface tab.

3 On the Surface Data tab, select sxy shear stress global sys. from the 
Predefined quantities list.

4 Click the Deform tab.

5 Select the Deformed shape plot check box. The deformation data is the x and y 
displacements by default.

6 Click OK.

The deformed shape plot uses a scaling factor to clearly show the deformation. The 
actual displacements are small compared to the model geometry. Click the Deform tab 
too see the scale factor or to enter a different scale factor.

To get a better look at the value of the shear stress at the point (0, 2), use the 
Cross-Section Plot Parameters dialog box:

1 From the Postprocessing menu, select Cross-Section Plot Parameters.

2 Click the Point tab.

3 Select sxy shear stress global sys. from the Predefined quantities list.

4 Type 0 in the x edit field and 2 in the y edit field.

5 Click OK.

The plot shows a straight line at the value of the shear stress at (0, 2). You can also click 
at that point in the results plot. That prints the numeric value in the message log.

Reference

1. D. Hitchings, A. Kamoulakos, G. A. O. Davies: Linear Statics Benchmarks Vol. 1, 
NAFEMS Ltd., Glasgow, 1987.
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P D E  M o d e s  f o r  E q u a t i o n - B a s e d  M o d e l i n g
This chapter describes the use of the PDE modes for equation-based modeling. A 
step-by-step example illustrates the use of the PDE modes for solving Poisson’s 
equation.
 245
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Th e  PDE Mode s

The PDE modes are application modes for equation-based modeling. They support 
three types of PDE formulation:

• Coefficient form for linear or almost linear PDEs, explained in detail in the section 
“Using the Coefficient Form PDEs” on page 247.

• General form for nonlinear PDEs. You find a detailed discussion about the general 
form in the section “Using the General Form PDE” on page 257.

• Weak form using the weak formulation of the PDE for maximum flexibility. For 
more information about the weak form, see “The Weak Form” on page 345.

In addition, a number of specialized instances of these PDE formulations provide 
interfaces for a number of classical PDEs. See “Classical PDEs” on page 268 for more 
information.

The following table lists the available PDE modes with their default application mode 
names:

TABLE 9-1:  DEFAULT APPLICATION MODE NAMES FOR THE PDE MODES

PDE MODE APPLICATION MODE NAME

PDE, Coefficient Form c

PDE, General Form g

Weak Form, Subdomain w

Weak Form, Boundary wb

Weak Form, Edge we

Weak Form, Point wp

Convection-Diffusion Equation cdeq

Heat Equation hteq

Helmholtz Equation hzeq

Laplace’s Equation lpeq

Poisson’s Equation poeq

Schrödinger Equation scheq

Wave Equation waeq
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U s i n g  t h e  PDE Mode s

Starting a Model Using a PDE Mode

Do as follows to create a new model using one of the PDE modes:

1 Start COMSOL Multiphysics or click New in the COMSOL Multiphysics window.

2 In the Model Navigator make a selection from the Space dimension list.

3 Go to the folder Application Modes>COMSOL Multiphysics>PDE Modes.

4 Open either the PDE, Coefficient Form folder, the PDE, General Form folder, or one of 
the weak form folders, and make an optional further selection between the available 
analysis types.

Alternatively, open the Classical PDEs folder to select from a list of classical PDEs, 
which are all special cases of the coefficient form formulation.

5 Click OK.

S P E C I F Y I N G  A  S Y S T E M  O F  P D E S

COMSOL Multiphysics allows the creation of PDEs with more than one dependent 
variable. To add variables, follow Steps 1 through 4 above and then enter all the 
variable names as space-separated entries in the Dependent variables edit field before 
clicking OK. (For the classical PDEs, you can change the name of the dependent 
variable but not add new ones.) The number of equations in the model equals the 
number of dependent variables. For example, to start a model with three dependent 
variables u1, u2, and u3, enter:

u1 u2 u3

You can also couple several scalar PDEs using a multiphysics approach.

Using the Coefficient Form PDEs

The coefficient form PDE mode covers many well-known PDEs. This section covers 
the formulation and settings pertaining to the coefficient form, as well as the general 
PDE terminology used in COMSOL Multiphysics.
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T H E  S C A L A R  C O E F F I C I E N T  F O R M  E Q U A T I O N

A single dependent variable u is an unknown function on the computational domain. 
COMSOL Multiphysics determines it by solving the PDE problem that you specify. In 
coefficient form, the PDE problem reads

 (9-1)

where

• Ω is the computational domain—the union of all subdomains

• ∂Ω is the domain boundary

• n is the outward unit normal vector on ∂Ω

The first equation in the list above is the PDE, which must be satisfied in Ω. The 
second and third equations are the boundary conditions, which must hold on ∂Ω. The 
second equation is a generalized Neumann boundary condition, whereas the third 
equation is a Dirichlet boundary condition. This nomenclature and the second 
equation above deviate slightly from traditional usage in potential theory where a 
Neumann condition usually refers to the case q = 0. The generalized Neumann 
condition is also called a mixed boundary condition or a Robin boundary condition. 
In finite element terminology, Neumann boundary conditions are called natural 
boundary conditions because they do not occur explicitly in the weak form of the PDE 
problem. Dirichlet conditions are called essential boundary conditions because they 
restrict the trial space. Dirichlet boundary conditions often represent constraints.

This manual uses the following conventions:

• The symbol   is the vector differential operator (gradient), defined as

The space coordinates are denoted x1, …, xn, where n represents the number of 
space dimensions.

• The symbol ∆ stands for the Laplace operator

ea
t2

2

∂
∂ u da+

t∂
∂u ∇+ c u∇– αu– γ+( )⋅ β ∇u au+⋅+ f= in Ω

n c u αu γ–+∇( )⋅ qu = g hTµ–+ on Ω∂

hu r= on Ω∂
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

∇

∇
x1∂
∂ …

xn∂
∂, ,⎝ ⎠

⎛ ⎞=
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•  means

•  means

where β1 ,  … ,  βn are the components of the vector β.

Within COMSOL Multiphysics, you specify the coefficients c, α, γ, β, a, q, and h, and 
the terms f, g, and r. They can all be functions of the spatial coordinates.

• A PDE is linear when the coefficients depend only on the spatial coordinates (or 
are constants).

• A PDE is nonlinear if the coefficients depend on u or its derivatives (the 
components of ).

• All the coefficients in the above equation are scalars except α, β, and γ, which are 
vectors with n components. The coefficient c can alternatively be an n-by-n matrix 
to model anisotropic materials. For more information see “Modeling Anisotropic 
Materials” on page 220 in the COMSOL Multiphysics User’s Guide.

The ea coefficient in Equation 9-1 is a scalar or a matrix for time-dependent systems 
called the mass matrix (or mass coefficient). The da coefficient represents a damping 
term (however, if ea = 0, then da is often called the mass coefficient). See “Solving 
Time-Dependent Problems” on page 264 for more information on time-dependent 
problems.

Interpreting Boundary Conditions
The formulation of the boundary conditions imposes both Dirichlet and Neumann 
conditions. This combination is possible because of a new dependent variable µ, which 
is defined only on the boundary. The unknown variable µ is called a Lagrange 
multiplier. Often you can reformulate boundary conditions without Lagrange 
multipliers. In structural mechanics problems the Lagrange multiplier equals the 
reaction forces on the boundary. The factor hT in the Neumann boundary condition 
is the transpose of h. If h is a scalar, then hT = h.

x1
2

2

∂
∂ …

xn
2

2

∂
∂

+ +

∇ c u∇( )⋅

x1∂
∂ c

x1∂
∂u

⎝ ⎠
⎛ ⎞ …

xn∂
∂ c

xn∂
∂u

⎝ ⎠
⎛ ⎞+ +

β u∇⋅

β1 x1∂
∂u … β+ n xn∂

∂u
+

u∇
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How do the Lagrange multipliers relate to the conventional formulation with either a 
Dirichlet or a Neumann boundary condition?

• First, assume that h = 1. Then the Dirichlet condition is u = r. The Neumann 
condition becomes:

The Lagrange multiplier, µ, adjusts so as to satisfy the requested Dirichlet condition. 
Specifying a nonzero g or q changes the value of the Lagrange multiplier but does 
not affect the actual solution u. Therefore, this equation can usually be ignored, 
leaving a pure Dirichlet condition.

• Second, assume that h = 0 and r = 0. Then the Dirichlet condition reads 0 = 0, and 
the Neumann condition is

This is the generalized Neumann condition without a Lagrange multiplier. For 
more on the Lagrange multiplier formulation, see “System for Two Variables in the 
General Form” on page 259.

The vector  is the flux vector. In transport equations its first term 
describes diffusion, the second term describes convection with a velocity −α, and the 
third term γ is a source term.

In certain applications Γ can be discontinuous across interior boundaries. There can be 
a jump in the normal component of Γ across such a boundary. For instance, denote the 
two adjacent subdomains as 1 and 2, and let Γi and ni be the values of Γ and n from 
the two subdomains. Then you can state the jump condition as the Neumann 
condition

where n1 is the outward normal from Subdomain 1, and n2 is the outward normal 
from Subdomain 2 so that n1 = −n2. At the same time there is a Dirichlet condition 
hu = r. (Let h = r = 0 to discard the Dirichlet condition and the Lagrange multiplier 
µ.) To specify such conditions on interior boundaries, select the Enable interior 

boundaries check box in the Boundary Settings dialog box.

The rest of this section handles stationary problems where ∂u/∂t = 0 and transient 
effects have vanished.

n c u αu γ–+∇( )⋅ qu = g µ–+

n c u αu γ–+∇( )⋅ qu = g+

Γ c u∇–= αu– γ+

n1 Γ1 n2 Γ2⋅–⋅– qu = g hTµ–+
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Specifying PDE Coefficients on Subdomains
To specify PDE coefficients, open the Subdomain Settings dialog box for a stationary, 
scalar 2D PDE problem in coefficient form. From the Physics menu, choose Subdomain 

Settings.

The default values correspond to Poisson’s equation with a source value of 1.

Specifying Boundary Conditions
To specify boundary conditions, open the Boundary Settings dialog box. From the 
Physics menu, choose Boundary Settings.

The default values correspond to homogeneous Dirichlet boundary conditions.

To specify boundary conditions:
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1 Make a selection from the Boundary selection list.

2 Select a Neumann or Dirichlet boundary condition type.

3 Type the values for the coefficients that are active for the boundary condition type.

Note: The c, α, and γ coefficients in the equations for the boundary conditions come 
from the PDE specification in the Subdomain Settings dialog box.

T H E  C O E F F I C I E N T  F O R M  E Q U A T I O N  S Y S T E M

With two independent variables u1 and u2, the stationary PDE problem in coefficient 
form results in the following equation system:

where u = (u1, u2). The mass term is defined as

Similarly, the damping term is

However, if ea = 0, then da is often called the mass coefficient.

The diffusive flux is defined as

ea
t2

2

∂
∂ u da t∂

∂u ∇ c u αu γ–+∇( )⋅– β ∇u⋅ au+ ++ f=

ea
t2

2

∂

∂ u ea11 ea12

ea21 ea22

t2

2

∂

∂ u1

t2

2

∂

∂ u2

ea11
t2

2

∂

∂ u1 ea12
t2

2

∂

∂ u2+

ea21
t2

2

∂

∂ u1 ea22
t2

2

∂

∂ u2+

= =

da t∂
∂u da11 da12

da21 da22

t∂
∂u1

t∂
∂u2

da11 t∂
∂u1 da12 t∂

∂u2+

da21 t∂
∂u1 da22 t∂

∂u2+

= =
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where  and  are column vectors. The flux matrix or flux tensor is a column 
vector in this presentation. For anisotropic materials, the components c11, c12, c21, and 
c22 can be matrices as described above for the one-variable coefficient form PDE. In 
this case, the diffusive flux reads

The conservative convective flux is defined as

c u∇
c11 c12

c21 c22

u1

u2

∇
c11 c12

c21 c22

u1∇

u2∇

c11 u1∇ c12 u2∇+

c21 u1∇ c22 u2∇+
= = =

c11
x∂

∂u1

y∂
∂u1

c12
x∂

∂u2

y∂
∂u2

+

c21
x∂

∂u1

y∂
∂u1

c22
x∂

∂u2

y∂
∂u2

+

c11 x∂
∂u1 c12 x∂

∂u2+

c11 y∂
∂u1 c12 y∂

∂u2+

c21 x∂
∂u1 c22 x∂

∂u2+

c21 y∂
∂u1 c22 y∂

∂u2+

cu1x

cu1y

cu2x

cu2y

= = =

u1∇ u2∇

c u∇
c11 c12

c21 c22

u1∇

u2∇

c1111 c1112

c1121 c1122

c1211 c1212

c1221 c1222

c2111 c2112

c2121 c2122

c2211 c2212

c2221 c2222

u1∇

u2∇
= =

c1111 c1112

c1121 c1122

u1∇
c1211 c1212

c1221 c1222

u2∇+

c2111 c2112

c2121 c2122

u1∇
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c2221 c2222
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u2

u2
Here the third index, k, of αijk corresponds to the space coordinate suffixes x and y.

The conservative flux source is defined as

Here the second index, j, of γij denotes the space coordinate suffixes for x and y.

For the flux terms the divergence operator works on each row separately. To illustrate 
this, consider the divergence of the conservative flux source

The convection term is defined as

The variable names for these components are beu1 and beu2.

The absorption term is defined as

αu α
u1

u2

α11 α12

α21 α22

u1

u2

α111

α112

α121

α122

α211

α212

α221

α222

u1

u2

=
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α112

u1
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α122

u2+

α211

α212

u1
α221

α222

u2+

= = =

γ

γ11

γ12

γ21

γ22

=

∇ γ⋅ ∇

γ11

γ12

γ21

γ22

⋅

∇
γ11

γ12

⋅

∇
γ21

γ22

⋅

= =

β u∇⋅
β11 β12

β21 β22

u1∇

u2∇
⋅

β111
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β212

β221
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⋅
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= = =
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The variable names for these components are au1 and au2.

The source term is defined as

The variable names for these components are f1 and f2.

The Boundary Condition Terms
The Dirichlet boundary condition, in expanded form, reads

If you choose the Dirichlet condition, you also get the generalized Neumann 
boundary condition, which reads

The normal vector n = (nx, ny) operates on the flux vector in the same way as the 
divergence operator as explained earlier. If h has full rank (as in the default identity 
matrix, for example) only the constraints from the Dirichlet condition are active.

If you choose the Neumann condition, you get only the boundary condition

The normal component of the diffusive flux is defined as

The normal component of the conservative convective flux is defined as

au
a11 a12

a21 a22

u1

u2

a11u1 a12u2+

a21u1 a22u2+
= =

f
f1

f2

=

h11 h12

h21 h22

u1

u2

r1

r2

=

n c u αu γ–+∇( )⋅ qu+ g hTµ–=

n c u αu γ–+∇( )⋅ qu+ g=

n c u∇⋅ n
c11 c12

c21 c22

u1∇

u2∇
⋅

n c11 u1∇ c12 u2∇+( )⋅

n c21 u1∇ c22 u2∇+( )⋅
= =
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The normal component of the conservative flux source is defined as

The boundary absorption term is defined as

The boundary source term is defined as

n αu⋅ n

α111

α112
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u2+

α211

α212

u1
α221

α222

u2+

⋅

nx ny,( )
α111

α112

u1
α121

α122

u2+
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅

nx ny,( )
α211

α212

u1
α221

α222

u2+
⎝ ⎠
⎜ ⎟
⎜ ⎟
⎛ ⎞

⋅

= =

n γ⋅ nx ny,( )

γ11

γ12

γ21

γ22

⋅

nx ny,( )
γ11

γ12

⋅

nx ny,( )
γ21

γ22

⋅

= =

qu
q11 q12

q21 q22

u1

u2

q11u1 q12u2+

q21u1 q22u2+
= =

g
g1

g2

=
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Specifying PDE Coefficients on Subdomains
The following figure shows the Subdomain Settings dialog box for a coefficient form, 
two-variable stationary 2D problem.

Specifying Boundary Conditions
The Boundary Settings dialog box looks like this:

Using the General Form PDE

The general form PDE provides a framework for specification of PDEs that can be 
nonlinear.
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Use the general form for nonlinear PDEs. Assuming that you are working with a single 
dependent variable u, then a stationary problem in general form reads

The first equation is the PDE. The second and third equations are the Neumann and 
Dirichlet boundary conditions, respectively. For information on the time-dependent 
general form equation, see “Solving Time-Dependent Problems” on page 264.

The terms Γ, F, G, and R are coefficients. They can be functions of the spatial 
coordinates, the solution u, and the space derivatives of u. The coefficients F, G, and 
R are scalar, whereas Γ is the flux vector. The superscript “T” in the Neumann 
boundary condition denotes the transpose. The variable µ is the Lagrange multiplier.

Specifying PDE Coefficients on Subdomains
The following image shows the Subdomain Settings dialog box for a general form, 
scalar, stationary 2D problem.

Specifying Boundary Conditions
The Boundary Settings dialog box entries are similar to the one for the coefficient form 
PDEs, but in general form you specify only the g and r coefficients.

∇ Γ⋅ F= in Ω

n– Γ⋅ G
u∂

∂R
⎝ ⎠
⎛ ⎞

T
µ+= on ∂Ω

0 R= on ∂Ω
⎩
⎪
⎪
⎨
⎪
⎪
⎧
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T H E  G E N E R A L  F O R M  E Q U A T I O N  S Y S T E M

In the case of several dependent variables u1, u2,  …, uN, the following system of 
equations represents a stationary problem in the general form:

The equation index l ranges from 1 to N, while the constraint index m ranges from 1 
to M. This discussion uses the summation convention. Fl, Gl, and Rm are scalars, 
whereas Γl is a vector. In this case there are several Lagrange multipliers: µ1, µ2,…, µM.

For a more compact form, let u be a vector with components uk, let Γ be a vector with 
components Γl, and so on. Then the system of equations takes on the same form as 
given above for a single dependent variable.

It is possible to rewrite the system to introduce the components Γlj of the vector Γl 
and the components nj of the normal vector n. Then the system of equations becomes

System for Two Variables in the General Form
The following example of a PDE in the general form is a stationary system for N = 2 
solution components in n = 2 space dimensions with M = 2 constraints:

with the generalized Neumann boundary conditions

∇ Γl⋅ Fl= in Ω

n– Γl⋅ Gl ul∂
∂Rmµm+= on ∂Ω

0 Rm= on ∂Ω
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

xj∂
∂Γlj Fl= in Ω

nj– Γlj Gl ul∂
∂Rmµm+= on ∂Ω

0 Rm= on ∂Ω
⎩
⎪
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎪
⎧

∇ Γ1⋅ F1= in Ω

∇ Γ2⋅ F2= in Ω
⎩
⎪
⎨
⎪
⎧
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and the Dirichlet boundary conditions

Specifying PDE Coefficients on Subdomains
The following image shows the Subdomain Settings dialog box for a general form, 
2-variable stationary 2D problem:

Specifying and Interpreting Boundary Conditions
The Boundary Settings dialog box is similar to the one for the coefficient form PDEs 
but in general form you specify only the g and r coefficients. To illustrate the flexibility 
of the boundary conditions, consider five cases:

1 Let R1 = R2 = 0. Then the Dirichlet boundary conditions give 0 = 0. In addition, 
the terms containing the Lagrange multipliers disappear from the Neumann 
boundary condition. Thus you have only the Neumann boundary conditions

n– Γ1⋅ G1 u1∂
∂R1µ1 u1∂

∂R2µ2+ += on Ω∂

n– Γ2⋅ G2 u2∂
∂R1µ1 u2∂

∂R2µ2+ += on ∂Ω
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

0 R1= on ∂Ω

0 R2= on ∂Ω
⎩
⎪
⎨
⎪
⎧
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2 Let R1 = r1 − u1 and R2 = r2  − u2. Then the Dirichlet conditions are the usual 
u1 = r1 and u2 = r2. The Neumann boundary conditions become

These equations impose no restrictions on u1 or u2, because the Lagrange 
multipliers µ1 and µ2 always adjust so as to fulfill the Dirichlet conditions. In this 
case, you can therefore ignore the Neumann boundary conditions.

3 Let R1 = r1 − u1 and R2 = 0. Then the Dirichlet conditions are

and the Neumann conditions are

The first Neumann condition can be ignored because it imposes no restriction on 
u1 or u2. You effectively have only the Dirichlet condition on u1 together with the 
second Neumann condition.

4 The same as Case 3 above but with the two PDEs interchanged (Γ1 and Γ2 as well 
as F1 and F2). Then the PDEs are

The Dirichlet condition is similar to that in Case 3: u1 = r1. The Neumann 
conditions then become

n– Γ1⋅ G1= on Ω∂

n– Γ2⋅ G2= on ∂Ω
⎩
⎪
⎨
⎪
⎧

n– Γ1⋅ G1 µ1–= on Ω∂

n– Γ2⋅ G2 µ2–= on ∂Ω
⎩
⎪
⎨
⎪
⎧

0 r1 u1–= on ∂Ω

0 0= on ∂Ω⎩
⎨
⎧

n– Γ1⋅ G1 µ1–= on Ω∂

n– Γ2⋅ G2= on ∂Ω
⎩
⎪
⎨
⎪
⎧

∇ Γ2⋅ F2= in Ω

∇ Γ1⋅ F1= in Ω
⎩
⎪
⎨
⎪
⎧
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Effectively, you have only the Neumann condition −n · Γ1 = G1. In comparison 
with Case 3 above, the PDEs and the Dirichlet conditions are identical, while the 
Neumann conditions are different. Thus, when mixing Dirichlet and Neumann 
conditions, the ordering of the equations and the dependent variables are 
important. However, the ordering of the Dirichlet conditions does not matter since 
the different Lagrange multipliers are for all practical purposes indistinguishable 
from each other.

5 Finally, let R1 = u2 − u1 and R2 = 0. Then the Dirichlet conditions are

and the Neumann conditions are

Note that the same Lagrange multiplier now appears in both Neumann conditions, 
which can have different definitions of Γ and G. Therefore, contrary to Cases 2 
and 3 above, the Neumann conditions cannot be ignored. Instead, adding the two 
conditions, it becomes apparent that the solution and flux on the boundary must 
fulfill

In these examples, the values of the Lagrange multipliers do not matter. However, they 
often have a physical significance. In structural mechanics, the term

n– Γ2⋅ G2 µ1–= on Ω∂

n– Γ1⋅ G1= on ∂Ω
⎩
⎪
⎨
⎪
⎧

0 u2 u1–= on ∂Ω

0 0= on ∂Ω⎩
⎨
⎧

n– Γ1⋅ G1 µ1–= on Ω∂

n– Γ2⋅ G2 µ1+= on ∂Ω
⎩
⎪
⎨
⎪
⎧

0 u2 u1–= on Ω∂

n– Γ2⋅ n Γ2⋅– G1 G2+= on ∂Ω
⎩
⎪
⎨
⎪
⎧

u∂
∂R
⎝ ⎠
⎛ ⎞

T
µ

 9 :  P D E  M O D E S  F O R  E Q U A T I O N - B A S E D  M O D E L I N G



in the Neumann condition is the reaction force necessary to satisfy the kinematic 
constraints described by the Dirichlet conditions. This term has a special form because 
of the variational principles that give rise to it (see “Variational Principles” on page 
362).

C O E F F I C I E N T  F O R M  V S .  G E N E R A L  F O R M

The following substitutions show that the coefficient form and the general form are 
equivalent:

Note: If r or h depend on u, there is a difference in the Neumann boundary 
condition because ∂R/∂u need not equal −h.

This duality lets you choose the representation that best suits a particular PDE. You 
can always convert a problem to a more general form:

• From the coefficient form to the general form

• From the coefficient or the general form to the weak form

Make this conversion by selecting another equation system form in the Model Settings 
dialog box.

COMSOL Multiphysics converts the coefficient form PDE to a general form PDE 
according to

using a notation where there is an implicit summation over the k (or l) and i indices 
in each product. The conversion only applies to the PDE coefficients and the boundary 
coefficients. Other settings on boundaries and subdomains such as initial values, shape 
functions, and weak form contributions remain unchanged.

Γ c u∇–= αu– γ F f β∇u– au G,–=,+ g qu R,– r hu–= =

Γlj clkji xi∂
∂uk– αlkjuk– γlj+=

Fl fl βlki xi∂
∂uk– alkuk–=

Gl gl qlkuk–=

Rm rm hmlul–=
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Solving Time-Dependent Problems

To get the equation for a time-dependent PDE in COMSOL Multiphysics, add terms 
containing time derivatives to the left-hand side of the stationary equation. The time 
derivatives must appear linearly, and the Dirichlet conditions must be linear. A 
time-dependent problem in the coefficient form reads

If u is a vector of dependent variables then the mass coefficient ea is a matrix. All 
coefficients can depend on time. The name mass matrix or mass coefficient stems 
from the fact that in many physics applications ea contains the mass density. The da 
coefficient represents damping for wave-type equations. However, if ea = 0, then da is 
often called the mass coefficient. The default settings are ea = 0 and da = 1, 
representing a time-dependent PDE such as the heat equation. Using ea = 1 and 
da = 0 represents an undamped wave equation.

For a stationary model, COMSOL Multiphysics ignores any values or expressions that 
you enter in the edit field for the da and ea coefficient. To activate the da and ea 
coefficients and convert the model into a time-dependent model, select a 
time-dependent solver in the Solver Parameters dialog box.

The time-dependent problem in the general form is

The flux vector Γ and the scalar coefficients F, G, and R can be functions of the spatial 
coordinates, the solution u, and the space and time derivatives of u. The superscript 
“T” in the Neumann boundary condition denotes the transpose. The variable µ is the 
Lagrange multiplier.

ea
t2

2

∂
∂ u da+

t∂
∂u ∇+ c u∇– αu– γ+( )⋅ β ∇u au+⋅+ f= in Ω

n c u αu γ–+∇( )⋅ qu = g hTµ–+ on Ω∂

hu r= on Ω∂
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

ea
t2

2

∂
∂ u da+

t∂
∂u ∇+ Γ⋅ F= in Ω

n– Γ⋅ G
u∂

∂R
⎝ ⎠
⎛ ⎞

T
µ+= on ∂Ω

0 R= on ∂Ω⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧
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f1

f2
For the weak form, the time-dependent problem (in 2D) looks like

where the integrands W(it) depend bilinearly on the test functions vl and on the first 
and second time derivatives of the dependent variables and their space derivatives. For 
example,

Time-Dependent Systems
For time-dependent systems of PDEs the da and ea coefficients are matrices. For 
example, for the system

the coefficient matrices are

(where each element cij can be an n-by-n matrix). Many interesting problems have a 
singular da matrix (with ea = 0), or a singular nonzero ea matrix. Such problems are 

W 2t( ) Ad
Ω
∫ W 1t( ) sd

B
∫ W 0t( )

P
∑+ + W 2( ) Ad

Ω
∫ W 1( ) sd

B
∫ W 0( )

+

P
∑+ +=

vl ul∂
∂Rm

2( )

µm
2( ) Ad

Ω
∫ vl ul∂

∂Rm
1( )

µm
1( ) sd

B
∫ vl ul∂

∂Rm
0( )

µm
0( )

P
∑+ + +

0 R 2( )
= on Ω

0 R 1( )
= on B

0 R 0( )
= on P  

W 2t( ) v1 t∂
∂u2

x∂
∂v1 3u1( )

t∂
∂u1 v2 t y∂

2

∂
∂ u2+cos–=

e11
t2

2

∂

∂ u e12
t2

2

∂

∂ u2 d11+ +
t∂

∂u1 d12 t∂
∂u2 ∇ c11– u1∇ c12∇u2–( ) a11u1 a12u2+ +⋅+ + =

e21
t2

2

∂

∂ u e22
t2

2

∂

∂ u2 d21+ +
t∂

∂u1 d22 t∂
∂u2 ∇ c21– u1∇ c22∇u2–( ) a21u1 a22u2+ +⋅+ + =

ea
e11 e12

e21 e22

= da
d11 d12

d21 d22

=

c
c11 c12

c21 c22

= a
a11 a12

a21 a22

=
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called differential-algebraic equation (DAE) systems. The COMSOL Multiphysics 
solver for time-dependent problems handles DAEs.

The models “Example—Resistive Heating” on page 387 and “Thermal Effects in 
Electronic Conductors” on page 36 in the COMSOL Multiphysics Quick Start and 
Quick Reference are both DAE systems.

Solving Eigenvalue Problems

COMSOL Multiphysics handles scalar eigenvalue problems for all PDE forms. These 
eigenvalue problems are related to time-dependent problems via the correspondence 
∂/∂t ↔ −λ, linking the time derivative to the eigenvalue λ (with the default eigenvalue 
name lambda). An eigenvalue problem in the coefficient form reads

where λ0 is the linearization point for the eigenvalue. Note that the source terms are 
ignored if the solution form is coefficient form. If the general or weak solution forms 
are used, the source terms are not ignored if they depend on the solution components. 
If the coefficients depend on u or the eigenvalue λ, COMSOL Multiphysics performs 
a linearization of the problem about the linearization point u = u0, λ = λ0. The 
software also performs this linearization for eigenvalue problems in the general and 
weak forms, though in a slightly different way. See “The Linear or Linearized Model” 
on page 386 in the COMSOL Multiphysics User’s Guide for information about 
linearization.

To specify the linearization point u0, use the settings in the Values of variables not 

solved for and linearization point area on the Initial Value page in the Solver Manager 
dialog box. To specify the linearization point λ0 use the Eigenvalue linearization point 
edit field in the Solver Parameters dialog box. You can also change the name of the 
variable that should be treated as the eigenvalue in the Eigenvalue name edit field.

λ λ0–( )2eau λ λ0–( )d– au ∇+ c u∇– αu–( )⋅ β ∇u au+⋅+ f= in Ω

n c u αu+∇( )⋅ qu = hTµ–+ on Ω∂

hu r= on Ω∂
⎩
⎪
⎪
⎨
⎪
⎪
⎧
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Interpreting PDE Coefficients

The COMSOL PDE formulations can model a variety of problems, but note that this 
documentation uses coefficient names that fall within the realm of continuum 
mechanics and mass transfer. For the coefficient form:

•  ea is the mass coefficient.

•  da is a damping coefficient or a mass coefficient.

•  c is the diffusion coefficient.

•  α is the conservative flux convection coefficient.

•  β is the convection coefficient.

•  a is the absorption coefficient.

•  γ is the conservative flux source term.

•  f is the source term.

There are many interesting PDE problems to which this interpretation does not apply. 
For instance, a time-harmonic PDE such as the Helmholtz equation represents a 
time-dependent phenomenon transformed into the frequency domain.

For the Neumann boundary condition of the coefficient form

•  q is the boundary absorption coefficient.

•  g is the boundary source term.

Diffusion

Convection

Source

Convection

Absorption

Source

ea
t2

2

∂
∂ u da+

t∂
∂u ∇ c u αu γ–+∇( )⋅– β ∇u⋅ au+ + f=

Conservative Flux

Damping/
MassMass

n c u α u γ–+∇( )⋅ qu = g hTµ–+
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Classical PDEs

Many classical PDEs are instances of the coefficient form. All the classical PDEs in this 
section have their own application modes. To find them, open the Model Navigator. In 
the Application Modes tree, within the COMSOL Multiphysics>PDE Modes section, find the 
Classical PDEs folder. The table below shows the available classical PDEs using two 
notations: the compact notation of vector analysis (used in this documentation) and an 
expanded mathematical notation.

Equation Variables

The equation variables denote certain terms in the equations in coefficient form. 
Equation variables are available only when you have selected the coefficient or general 
solution form. Use the Solution form setting on the Advanced page in the Solver 

Parameters dialog box to set the solution form to Coefficient or General. Avoid using 
equation variables if there are other alternatives because you cannot use these variables 

TABLE 9-2:  CLASSICAL PDES IN COMPACT AND STANDARD NOTATION

EQUATION COMPACT NOTATION STANDARD NOTATION (2D)

Laplace’s 
equation

Poisson’s 
equation

Helmholtz 
equation

Heat 
equation

Wave 
equation

Schrödinger 
equation

Convection- 
diffusion 
equation

∇ u∇( )⋅– 0=

x∂
∂

x∂
∂u

–
y∂

∂
y∂

∂u
– 0=

∇ c u∇( )⋅– f=

x∂
∂ c

x∂
∂u

⎝ ⎠
⎛ ⎞

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–– f=

∇ c u∇( )⋅– au+ f=

x∂
∂ c

x∂
∂u

⎝ ⎠
⎛ ⎞

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–– au+ f=

da t∂
∂u ∇ c u∇( )⋅– f= da t∂

∂u
x∂

∂ c
x∂

∂u
⎝ ⎠
⎛ ⎞

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–– f=

ea
t2

2

∂
∂ u ∇ c u∇( )⋅– f= ea

t2

2

∂
∂ u

x∂
∂ c

x∂
∂u

⎝ ⎠
⎛ ⎞

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–– f=

∇ c u∇( )⋅– au+ λu=

x∂
∂ c

x∂
∂u

⎝ ⎠
⎛ ⎞

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–– au+ λu=

da t∂
∂u ∇ c u∇( )⋅– β u∇⋅+ f= da t∂

∂u
x∂

∂ c
x∂

∂u
⎝ ⎠
⎛ ⎞–

y∂
∂ c

y∂
∂u

⎝ ⎠
⎛ ⎞–

βx x∂
∂u βy y∂

∂u
+ + f=
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when using the weak solution form. Often the application mode already contains 
variables with the corresponding quantities defined as application mode variables. The 
section “Using the Weak Solution Form” on page 348 explains how the weak solution 
form might be of advantage.

Recall the coefficient form system of equations

where k and l range from 1 to N, and m ranges from 1 to M, where . Let y be 
the name of space coordinate number j. The notation in the following table uses the 
summation convention; that is, there is an implicit sum over all pairs of equal indices. 

When there is only one dim variable, omit l from the equation variable names.

TABLE 9-3:  EQUATION VARIABLES ON SUBDOMAINS

VARIABLE MEANING DESCRIPTION

daul  dalkuk Mass coefficient multiplied with the solution

culy  clkji ∂uk /∂xi Component of the diffusive flux

aluly  αlkjuk Component of the conservative convective 
flux

galy  γlj Component of the conservative flux source

beul  βlkj ∂uk /∂xj Convection term

aul  alkuk Absorption term

fl  fl Source term

TABLE 9-4:  EQUATION VARIABLES ON BOUNDARIES

VARIABLE MEANING DESCRIPTION

qul  qlkuk Boundary absorption term

gl  gl Boundary source term

ea lk
t2

2

∂

∂ uk da lk t∂
∂uk ∇+ clk uk∇– αlkuk– γl+( )⋅ βlk ∇uk alkuk+⋅+ fl=+ in Ω

n clk uk αlkuk γl–+∇( )⋅ qlkuk = gl hmlµm–+ on Ω∂

hmkuk rm= on Ω∂
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

M N≤
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Note: In equation definitions, use the equation variables with caution to avoid 
circular definitions.

Boundary-Coupled Equation Variables

The boundary-coupled equation variables extrapolate the values of the equation 
variables to boundaries. The variables are available only when you have selected the 
coefficient or general solution form. To specify one of those solution forms, go to the 
Solve menu and open the Solver Parameters dialog box; click the Advanced tab and in 
the Solution form list select Coefficient or General. Avoid using equation variables if there 
are other alternatives because you cannot use these variables when using the weak 
solution form, which is the one in use for most cases when using the automatic solution 
form selection. Often the corresponding variables are already defined by the 
application mode as application mode variables. The section “Weak Form vs. Strong 
Forms” on page 349explains why the weak solution form can be of advantage.

Recall the coefficient form system of equations

The first type of boundary-coupled equation variables consists of equation variables 
restricted to the boundaries. Let l be an integer and y the name of space coordinate 
number j. The variables in the following table are defined on the boundaries. The 
upper and lower subdomains are the subdomains in the upward and downward 
directions (see the definition of normal vectors in “Direction of the Normal 
Component on Interior Boundaries” on page 172 of the COMSOL Multiphysics 

ea lk
t2

2

∂

∂ uk da lk t∂
∂uk ∇+ clk uk∇– αlkuk– γl+( )⋅ βlk ∇uk alkuk+⋅+ fl=+ in Ω

n clk uk αlkuk γl–+∇( )⋅ qlkuk = gl hmlµm–+ on Ω∂

hmkuk rm= on Ω∂
⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧
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User’s Guide). The table notation uses the summation convention, that is, there is an 
implicit summation over each pair of equal indices. 

TABLE 9-5:  BOUNDARY-COUPLED EQUATION VARIABLES

VARIABLE MEANING

uculy Value of clkji ∂uk/∂xi taken from the upper adjacent 
subdomain. 0 if there is no upper adjacent subdomain.

dculy Value of clkji ∂uk/∂xi taken from the lower adjacent 
subdomain. 0 if there is no lower adjacent subdomain.

culy If there are two adjacent subdomains, (uculy+dculy)/2. If 
there is one adjacent subdomain, the value clkji ∂uk / ∂xi taken 
from this subdomain. Otherwise undefined.

ualuly Value of αlkjuk taken from the upper adjacent subdomain (0 if 
such a subdomain does not exist)

daluly Value of αlkjuk taken from the lower adjacent subdomain (0 if 
such a subdomain does not exist)

aluly If there are two adjacent subdomains, (ualuly+daluly)/2. If 
there is one adjacent subdomain, the value αlkjuk taken from 
this subdomain. Otherwise undefined.

ugaly Value of γlj taken from the upper adjacent subdomain (0 if such 
does not exist)

dgaly Value of γlj taken from the lower adjacent subdomain (0 if such 
a subdomain does not exist)

galy If there are two adjacent subdomains, (ugaly+dgaly)/2. If 
there is one adjacent subdomain, the value γlj taken from this 
subdomain. Otherwise undefined.

ubeul Value of βlkj ∂uk/∂xj taken from the upper adjacent subdomain 
(0 if such a subdomain does not exist)

dbeul Value of βlkj ∂uk/∂xj taken from the lower adjacent subdomain 
(0 if such a subdomain does not exist)

beul If there are two adjacent subdomains, (ubeul+dbeul)/2. If 
there is one adjacent subdomain, the value  taken from this 
subdomain. Otherwise undefined.

uaul Value of alkuk taken from the upper adjacent subdomain (0 if 
such a subdomain does not exist)

daul Value of alkuk taken from the lower adjacent subdomain (0 if 
such a subdomain does not exist)

aul If there are two adjacent subdomains, (uaul+daul)/2. If there 
is one adjacent subdomain, the value alk taken from this 
subdomain. Otherwise undefined.
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When there is only one dependent variable, omit l from these variable names.

The second type of boundary-coupled equation variables involves the normal vector of 
the boundary. Some of these variables represent the jump in the terms in the normal 
component of the flux vector. Let nj denote the components of the outward normal 
vector, seen from the upper or lower adjacent subdomain. The table notations use the 
summation convention. 

When there is only one dependent variable, omit l from the above variable names. 

ufl Value of fl taken from the upper adjacent subdomain (0 if such 
a subdomain does not exist)

dfl Value of fl taken from the lower adjacent subdomain (0 if such 
a subdomain does not exist)

fl If there are two adjacent subdomains, (ufl+dfl)/2. If there is 
one adjacent subdomain, the value fl taken from this 
subdomain. Otherwise undefined.

TABLE 9-6:  BOUNDARY COUPLED EQUATION VARIABLES INVOLVING NORMAL TO BOUNDARY

VARIABLE MEANING

uncul Value of nj clkji ∂uk / ∂xi taken from the upper adjacent 
subdomain. 0 if there is no upper adjacent subdomain.

dncul Value of nj clkji ∂uk / ∂xi taken from the lower adjacent 
subdomain. 0 if there is no lower adjacent subdomain.

ncul uncul+dncul. Since the normal vectors used in uncul and 
dncul are opposite, ncul is a jump in normal diffusive flux.

unalul Value of njαlkjuk taken from the upper adjacent subdomain (0 
if such a subdomain does not exist)

dnalul Value of njαlkjuk taken from the lower adjacent subdomain (0 
if such a subdomain does not exist)

nalul unalul+dnalul

ungal Value of njγlj taken from the upper adjacent subdomain (0 if 
such a subdomain does not exist)

dngal Value of njγlj taken from the lower adjacent subdomain (0 if 
such a subdomain does not exist)

ngal ungal+dngal

TABLE 9-5:  BOUNDARY-COUPLED EQUATION VARIABLES

VARIABLE MEANING
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Note: In equation definitions, use boundary-coupled equation variables with caution 
to avoid circular definitions.

Ideal and Non-Ideal Constraints

Constraints formulated through the coefficients h and r in the PDE, Coefficient Form 
application mode and through the coefficient R in the PDE, General Form application 
mode, give rise to constraints called ideal. An ideal constraint dictates exactly how the 
the flux conditions (or Neumann boundary conditions) are influenced by the 
constraint force. For the coefficent form, the flux condition is

,

and for the general form, the flux condition is

.

The last term on the right-hand side in both expressions is the ideal constraint force. 
Thus, with ideal constraints you cannot enforce a flux condition independently of the 
constraints. In mathematics as well as in multiphysics modeling it is often necessary to 
enforce Neumann conditions and Dirichlet conditions more freely than what is 
possible through ideal constraints. As an example, consider again the general form 
example in Case 3 on page 261 and assume that you want to enforce the boundary 
conditions

.

If r1 = r1 ( u2 ), the first condition is fulfilled but not the second. This is because the 
ideal constraint force is not zero:

.

n c u αu+∇( )⋅ qu = g hTµ–+

n– Γ⋅ G
u∂

∂R
⎝ ⎠
⎛ ⎞

T
µ+=

0 r1 u1–= on ∂Ω

n– Γ2⋅ G2= on ∂Ω
⎩
⎪
⎨
⎪
⎧

n– Γ2⋅ G2 u2∂
∂R1µ1 u2∂

∂R2µ2+ + G2 u2∂
∂r1 µ1+ G2≠= =
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To remedy this limitation with ideal constraints you can use non-ideal constraints, by 
which you can specify the constraint force independently of the constraints. The term 
non-ideal refers to the fact that the constraint force differs from −hTµ  for coefficient 
form and from  for general form. In multiphysics modeling, non-ideal 
constraints are, for example, necessary for the following boundary conditions:

• Normal-direction constraints on a moving mesh, where the mesh motion is part of 
the problem. These conditions are of the type n · u − r = 0 where n = n( x ) is the 
boundary normal, u is a vector field (displacements or velocity), and x is the mesh 
coordinate vector. Ideal constraints give constraint forces not only on the equations 
for u but also on the equations for x, which typically are not wanted.

• Wall boundary conditions for turbulent fluid flow. For the k-ε turbulence model this 
condition is of the type k − r( ε ), , where r is a given function. Ideal 
constraints for the first relation imply that the second relation cannot hold.

Non-ideal constraints can be enforced in COMSOL Multiphysics both in a pointwise 
and in a weak sense. For descriptions of how to use pointwise and weak non-ideal 
constraints see “Constraint Forces” on page 276 and “Specifying Weak Constraints” 
on page 351, respectively.

Variables for PDEs in Weak Form

When you use the weak solution form (the default solution form with the automatic 
solution form setting), the shape function variables (and the boundary-coupled shape 
variables) are the only automatically generated field variables available as defaults. The 
shape function variables are available in the same way as described earlier for the 
coefficient form and general solution form. User-defined expression variables and 
coupling variables are also available.

In addition to shape function variables, meta variables for test functions, test-function 
derivatives, and time derivatives are available in the weak and dweak edit fields on the 
Weak page in the Subdomain Settings, Boundary Settings, Edge Settings, and Point 

Settings dialog boxes. The test function meta variables follow a naming convention 
similar to that used for variables; see “Variable Naming Conventions” on page 168 of 
the COMSOL Multiphysics User’s Guide.

u∂
∂R
⎝ ⎠
⎛ ⎞

T
µ

n– ε∇⋅ 0=
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To add weak terms, click the Weak tab in the Point Settings, Edge Settings, Boundary 

Settings, and Subdomain Settings dialog boxes. For the PDE, Coefficient Form 
application mode, the following dialog box is available for subdomains.

In the edit fields on the Weak page you can type a series of weak terms. The test 
functions always occur linearly in the weak terms. You can use these weak terms either 
alone to define the problem, as when using the weak form application modes, or in 
addition to the other coefficients in the coefficient form and general form application 
modes.

The following table shows the available test-function meta variables for a 2-variable 
weak form PDE. Let u be the name of the dependent variable and x, y, and z be the 
names of the independent variables.

The corresponding 2nd-order space derivatives are also available.

There is also a test operator with the same effect as the meta variables, so an alternative 
syntax to u1_test, for example, is test(u1). See “Using Special Operators” on page 
163 of the COMSOL Multiphysics User’s Guide for more information about the test 
operator and other operators.

1D 2D 3D

WEAK FORM 
META 
VARIABLE

u_test, ux_test u_test, ux_test, 
uy_test

u_test, ux_test, 
uy_test, uz_test
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C O N S T R A I N T  F O R C E S

On the Weak page you can also specify which constraint type to use. The default 
constraint type is ideal, which means that the PDE, Coefficient Form and PDE, 
General Form application modes derive the constraint force directly from the 
constraint specified in the constr field. Constraints specified using the h and r edit fields 
on the Coefficients page are always ideal and the Constraint type setting has no effect on 
them. 

If you choose to use the defaultnon-ideal constraints, the constraint force from a 
constraint written as constr = R = 0 on ∂Ω, changes according to 

where  is an identity operator for points on the boundary ∂Ω. If, for example, a 
two-variable problem for variables u1 and u2 specifies the constraints (using the constr 
field)

,

then the default non-ideal constraint force is −µ1 acting on u1 and −µ2 acting on u2. 
The corresponding ideal constraint would give reaction forces

acting on u1 and

acting on u1.

If you want a constraint force different from any of these two choices, you can specify 
a separate expression for it. Select User defined from the Constraint type list and enter 
the expression in the constf edit field. In this edit field you specify the constraint force 
Jacobian using the test operator. For example, the expression corresponding to the 
default non-ideal constraint in the example above is 

u∂
∂R
⎝ ⎠
⎛ ⎞

T
µ I Ω∂ µ–→

I Ω∂

0 R1 u1 u2,( )= on ∂Ω

0 R2 u1 u2,( )= on ∂Ω
⎩
⎪
⎨
⎪
⎧

u1∂
∂R1

⎝ ⎠
⎜ ⎟
⎛ ⎞

T

µ1 u1∂
∂R2

⎝ ⎠
⎜ ⎟
⎛ ⎞

T

µ2+

u2∂
∂R1

⎝ ⎠
⎜ ⎟
⎛ ⎞

T

µ1 u2∂
∂R2

⎝ ⎠
⎜ ⎟
⎛ ⎞

T

µ2+
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.

Note: The ideal constraint type normally generates a symmetric constraint Jacobian 
matrix and constraint force Jacobian matrix coupling for the discretized equations, 
while non-ideal constraints generate an unsymmetric coupling. See also “The 
Discretized Linearized Model” on page 388 of the COMSOL Multiphysics User’s 
Guide. 

Application Mode Variables

The following list shows the application mode variables that are available for 
postprocessing in addition to the other variables for PDEs:

NAME TYPE DESCRIPTION EXPRESSION

ui S, B The solution variable (dependent 
variable)

 ui

uixj S, B The derivative of the solution 
variable ui with respect to the 
space coordinate xj, for example, 
uy

uixjxk S, B The second derivative of the 
solution variable ui with respect 
to the space coordinates xj and 
xk, for example, uxx, uxy.

uit S, B The derivative of the solution 
variable ui with respect to time

uitt S, B The second derivative of the 
solution variable ui with respect 
to time

uixjt S, B The mixed derivative of the 
solution variable ui with respect 
to time and the space coordinate 
xj.

test u1( )–
test u2( )–⎩

⎨
⎧

ui∂
xi∂

--------

xj xk∂

2

∂
∂ ui

t∂
∂ui

t2

2

∂

∂ ui

xj t∂

2

∂
∂ ui
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Note: All application mode variables include a suffix indicating which application 
mode they belong to. Table 9-1 on page 246 lists the default suffix for the PDE 
modes. For example, the default suffix added to application mode variable names for 
a General Form application mode is _g. The dependent variables ui and their space 
and time derivatives do not include a suffix.

absuixi S, B Gradient of solution

abscuix S Value of the c*grad(ui) vector 
(Coefficient Form only). Only 
available when solving using 
coefficient form as solution form.

absgaix S Value of the Gamma vector 
(General Form only). Only 
available when solving using 
general form as solution form.

|Γ|

cuix S, B c*grad(ui) vector components 
(Coefficient Form only). Only 
available when solving using 
coefficient form as solution form.

ga1xi S, B Gamma vector components 
(General Form only). Only 
available when solving using 
general form as solution form.

γx

ncui B Normal components of the 
c*grad(ui) vector (Coefficient 
Form only). Only available when 
solving using coefficient form as 
solution form.

ngai B Normal components of the 
Gamma vector (General Form 
only). Only available when 
solving using general form as 
solution form.

 n · γ

NAME TYPE DESCRIPTION EXPRESSION

∇u ,
ui∂
xi∂

--------

c∇ u( )

c
ui∂
x∂

--------

n c∇u⋅
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PDE Coefficients and Boundary Conditions with Time Derivatives

The d coefficients relate to 1st-order time derivatives of the solution u. The only 
directly available d coefficient is da, the coefficient in front of ∂u/∂t; the subscript a is 
used because da is similar to the  a coefficient in the absorption term except that it 
multiplies ∂u/∂t instead of u. In contrast, the coefficients dc, , and  for ∂u/∂t—
analogous to the coefficients c, α, and β for u, respectively—in the extended PDE 
formulation

are not directly available in the general or coefficient form PDE models. Instead, you 
can enter them in the existing γ and f terms:

• In 1D, add -d_c*uxt-d_al*ut to the γ term, and add -d_be*uxt to the f term.

• In 2D, add -d_c*uxt-d_al1*ut to the first γ component, and add 
-d_c*uyt-d_al2*ut to the second γ component. Add -d_be1*uxt-d_be2*uyt to 
the f term.

Replace the variables d_c, d_al, d_be, d_al1, d_al2, d_be1, and d_be2 with 
appropriate expressions.

You enter 2nd-order time derivative terms in an analogous manner.

To specify a boundary condition containing time-derivative terms as in

,

add the terms -e_q*utt-d_q*ut to the g term, and provide appropriate values or 
expressions for the coefficients eq and dq in, for instance, the Options>Expressions>

Boundary Expressions dialog box.

Implementing a Point Source

Consider Poisson’s equation on the unit circle with a point source at the origin. Its 
formal expression is:

dα dβ

∇ dc∇∂u
∂t
------ dα

∂u
∂t
------+⎝ ⎠

⎛ ⎞⋅– dβ ∇∂u
∂t
------⋅ da

∂u
∂t
------ ∇ c– ∇u …+( )⋅+ + +

n c∇u …+( )⋅ eq
∂2u

∂t2
--------- dq+

∂u
∂t
------ qu+ + g hTµ–=

∇ ∇u( )⋅– δ= Ω
u 0= ∂Ω⎩

⎨
⎧
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where δ is the Dirac δ distribution located at the origin. The exact solution is 
, which has a singularity at the origin.

The easiest way to describe a point source is with an extra weak term. Understanding 
why requires some basic knowledge of FEM theory and the weak formulation of 
PDEs. To obtain the weak formulation of the general Poisson equation (where f is any 
source term), multiply it with a test function utest and integrate over the domain Ω:

Integrate by parts and introduce the Lagrange multiplier λ to account for the 
constraint on the boundary. This results in the weak formulation:

Most terms in these equations are sums of integrals over the domain, Ω, or over the 
domain boundary, ∂Ω. You can explicitly add extra weak terms to the equations. In 
addition to handling terms integrated over Ω or ∂Ω, COMSOL Multiphysics also 
handles contributions from integrals over edges and from single points. The software 
does not integrate contributions from points but instead collects them and adds them 
directly to the equations.

COMSOL Multiphysics discretizes the integral equations just given as long as the 
source term f is a function of the space coordinates, solution variables, and time. 
Unfortunately, you cannot express the Dirac δ distribution as a function that 
COMSOL Multiphysics can integrate numerically. The solution lies in noting that by 
the definition of the Dirac δ distribution, the following equality holds true:

u 1
2π
------– r( )log=

∇ ∇u( )⋅– utest
Ω
∫ futest

Ω
∫=

uutest
∂Ω
∫ 0=

utest∀,

⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

∇u ∇utest⋅
Ω
∫ λutest

∂Ω
∫+ futest

Ω
∫=

uutest
∂Ω
∫ 0=

utest∀,

⎩
⎪
⎪
⎪
⎨
⎪
⎪
⎪
⎧

δutest
Ω
∫ utest 0( )=
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Therefore, setting f to zero and adding utest as a weak term for a point at the origin 
provides the problem’s correct weak formulation. The following model handles the 
resolution of the singularity at the origin using local mesh refinement.

Model Library path: COMSOL_Multiphysics/Benchmarks/point_source

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator, select 2D from the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>PDE Modes folder and 
then Classical PDEs.

3 Select Poisson’s Equation. In the Element list be sure to select Lagrange - Quadratic.

4 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 Go to the Options menu and choose Axes/Grid Settings.
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2 In the Axes/Grid Settings dialog box, enter the following axis limits:

3 Click the Grid tab.

4 Clear the Auto check box.

5 Enter the following values in the edit fields for the grid spacings; when finished, click 
OK.

G E O M E T R Y  M O D E L I N G

1 Click the Ellipse/Circle (Centered) button on the Draw toolbar.

2 Using the right mouse button, draw a circle centered at (0, 0) with a radius of 1.

3 Click the Point button on the Draw toolbar and click once at the origin.

P H Y S I C S  S E T T I N G S

Point Settings
1 Go to the Physics menu and choose Point Settings.

2 In the Point Settings dialog box select Point 3.

AXIS

x min -2

x max 2

y min -1.5

y max 1.5

GRID

x spacing 0.5

Extra x

y spacing 0.5

Extra y
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3 Type u_test in the weak edit field.

4 Click OK.

Boundary Conditions
The default boundary condition in this mode is u = 0, so you do not need to change 
anything.

Subdomain Settings
1 From the Physics menu choose Subdomain Settings. 

2 Select Subdomain 1.

3 Enter these PDE coefficients; when finished, click OK.

M E S H  G E N E R A T I O N

Because the solution has a singularity at the origin, use a much higher mesh resolution 
around that point:

1 From the Mesh menu choose Free Mesh Parameters.

2 Click the Point tab.

3 Select Point 3.

4 In the Maximum element size edit field type 0.001.

5 Click the Remesh button.

6 Click OK.

PROPERTY VALUE

c 1

f 0
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C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

To view the solution as a 3D surface, click the 3D Surface Plot button on the Plot 
toolbar.

The exact solution is unbounded at the origin, which complicates evaluation of the 
error. Because the solution is axisymmetric, you can compare the COMSOL 
Multiphysics solution to the exact solution on a ray from just outside the origin to the 
boundary. 

1 From the Postprocessing menu choose Cross-Section Plot Parameters.

2 In the Cross-Section Plot Parameters dialog box, click the Line/Extrusion tab.

3 In the Expression edit field under y-axis data type u+log(x^2)/(4*pi).

4 In the Cross-section line data area, type 0.02 in the x0 edit field and type 1 in the x1 
edit field. Leave both y0 and y1 at the default value of 0.

5 Click OK.

Another way to check the solution’s accuracy is to integrate the difference between the 
exact solution and the FEM solution over the domain. The result shows that although 
the local error close to the origin is quite large, the global error in the L2 norm is small.
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U s i n g  Equa t i o n  Con t r i b u t i o n s  on 
I n t e r i o r  Me s h  Bounda r i e s

In COMSOL Multiphysics it is possible to have equation contributions also from mesh 
element boundaries that does not lie on a geometry boundary. This makes additional 
finite element formulations possible like, for example, the discontinuous Galerkin 
method in space for some transport and flow problems, and the ultraweak variational 
formulation for wave problems driven by a single frequency.

Note: The Acoustics Module provides a predefined interface for modeling pressure 
acoustics using the ultraweak variational formulation.

You specify these interior mesh boundary equation contributions on the 
corresponding subdomains. It is also possible to define expression variables to use on 
the interior mesh boundaries. Useful applications typically use discontinuous elements 
and the up and down operators in expressions to access values on elements adjacent to 
the interior mesh boundaries.

Specifying Equation Contributions

1 Open the Subdomain Settings dialog box from the Physics menu for any of the PDE 
Modes. For models with other application modes, choose Equation System>

Subdomain Settings.

2 Select the subdomain where you want to enter an equation contribution on the 
interior mesh boundaries.

3 Click the Weak tab or the bnd.weak tab depending on the equation system form.

4 Enter your equation contributions in the bnd.weak edit field or the edit fields in the 
bnd.weak terms area.

5 Click the Element tab.

6 Enter the desired integration order for the ultraweak equation contributions in the 
bnd.gporder text field.

7 Click OK.
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Specifying Interior Mesh Boundary Expressions.

To specify expression variables on the interior mesh boundaries, select 
Interior Mesh Boundary Expressions from the Expressions submenu on the Options 
menu.

The model example “A Transport Problem” on page 176 of the COMSOL 
Multiphysics Model Library shows how to implement the discontinuous Galerkin 
method with upwinding stabilization using equation contributions on interior mesh 
boundaries.
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S e n s i t i v i t y  A n a l y s i s
This chapter describes the Sensitivity Analysis application mode and how you can 
use it in models, for example for estimating modeling errors caused by uncertainties 
in material properties, or for predicting the effect of a geometrical change.
 287
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Th e  S e n s i t i v i t y  Ana l y s i s  App l i c a t i o n  
Mode

The Sensitivity Analysis application mode is different from most other application 
modes in that it does not contain any physics of its own. Instead, it is a tool that makes 
it possible to evaluate the sensitivity of a model with respect to almost any variable.

Introduction

Because the Sensitivity Analysis application mode does not contain any physics, it is not 
intended for use on its own. When you add Sensitivity Analysis to a multiphysics 
model, no new equations are introduced, and the set of solution variables remains the 
same. Instead, this application mode lets you introduce new sensitivity variables, 
which are stored in the solution vector but never solved for; the sensitivity variables are 
input quantities that you can use to control various aspects of your model’s physics.

The purpose of the Sensitivity Analysis application mode is to compute sensitivities—
which is the same thing as derivatives, or collectively the gradient—of various model 
quantities with respect to the sensitivity variables. To this end, the application mode 
lets you perform three distinct tasks:

• Select sensitivity variables and set their values

• Define an (optional) scalar objective function

• Compute the sensitivities efficiently using the sensitivity solver

Sensitivity Variable Selection

In the Sensitivity Analysis application mode you can define an arbitrary number of 
sensitivity variables. These can either be fields represented on the finite element mesh, 
just like the solution variables, or global scalar quantities. Variables of the former type 
can represent a density, a distributed force, or the deformation of a boundary, to 
mention just a few possibilities. You can set up scalar sensitivity variables to control, for 
example, global material properties, rigid body displacements, or a wave number.

Note the duality of the sensitivity variables: on one hand, they are independent 
variables whose values are not affected by the solution process; on the other hand, they 
are degrees of freedom (DOFs) stored in the solution vector. When defining a 
 1 0 :  S E N S I T I V I T Y  A N A L Y S I S



sensitivity variable, you must therefore supply its initial value, which the software uses 
to initialize the sensitivity variable DOFs; these remain fixed during the solution step.

S E N S I T I V I T Y  V A R I A B L E S  A N D  F I N I T E  E L E M E N T  R E P R E S E N T A T I O N

The sensitivity analysis is always performed on the discretized system of equations. 
When using a sensitivity variable field represented on the finite element mesh, the 
sensitivities are therefore associated with individual sensitivity variable degrees of 
freedom rather than with the field value at each point. This makes it difficult to 
interpret the result.

For example, if you set up a subdomain sensitivity variable using a 1st-order Lagrange 
shape function representation to control the material density in your model, your 
solution will contain the sensitivity of the objective function with respect to the 
discrete density value at each node point in the mesh. Because each node influences 
the density in a small surrounding region, the size of which varies from node to node, 
the individual sensitivities are not directly comparable to each other.

When you display such subdomain sensitivity variables, the varying element size gives 
you a plot which is not smooth and must not be used to draw any conclusions about 
the physics and the effect of changing the physical field represented by the sensitivity 
variable. Some insight may, however, be gained by looking at the sensitivities divided 
by the mesh volume scale factor dvol. This makes the sensitivities in the plot 
comparable between different parts of the surface, but still not mathematically well 
defined. In particular, using discontinuous constant shape functions together with the 
division by dvol gives you a plot which is proportional to the true pointwise sensitivity.

If you intend to use the sensitivities in an automatic optimization procedure, as is done 
in the Optimization application mode available with the optional COMSOL 
Optimization Lab, the discrete nature of the sensitivities causes no additional 
complication. The optimization solver searches for optimum values of the discrete 
sensitivity variables using the discrete gradient provided by the sensitivity analysis.

G E O M E T R I C A L  S E N S I T I V I T Y

You can use the sensitivity variables directly to parameterize any aspect of the physics 
which is controlled by an expression. This applies for example to material properties, 
boundary conditions, loads and sources. However, the shape, size, and position of 
parts of the geometry cannot be changed as easily at solution time, and therefore 
require special attention.

Sensitivity variables cannot be used directly in the geometry description. Instead, you 
must set up your model using ALE and tie all physics to an ALE frame controlled by 
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a Parameterized Geometry application mode (in 2D only) or a Moving Mesh (ALE) 
application mode. You can then use sensitivity variables to control the mesh 
movement, effectively parameterizing the geometry. 

See the chapter “Deformed Meshes” on page 445 for details on the Parameterized 
Geometry and Moving Mesh (ALE) application modes as well as on ALE in general. 
For an example, see “Example—Predicting the Effect of a Geometrical Change” on 
page 299 later in this chapter.

Scalar Objective Functions

In many practical situations, you are interested in the behavior of a single scalar 
quantity when you change your control variables but not in the effect on the solution 
at every single point. A common example is when your final goal is to perform 
optimization with respect to some objective function (also known under different 
names such as goal function, cost function, or quantity of interest). Computing the 
sensitivity of a scalar objective function is in most cases cheaper than computing the 
sensitivity of every solution component.

The Sensitivity Analysis application mode lets you specify a scalar objective function, 
which is a sum of contributions integrated over subdomains, boundaries, and edges, 
and summed over points. You can also add any valid global expression to the 
composite objective function. Examples of scalar objective functions from different 
applied fields include quantities such as total power, efficiency, cup mixing 
temperature, backscatter, mass flow, and capacitance.

The Principle of Virtual Work
Potential energy has a special status among scalar objective functions, because its 
derivatives with respect to scalar sensitivity variables can in many cases be interpreted 
as (true or generalized) forces. 

The optional AC/DC Module contains a Virtual Work predefined multiphysics 
coupling (for more information, see “Calculating Forces with Virtual Work” on page 
55 of the AC/DC Module User’s Guide), which uses this principle to calculate 
electromagnetic forces as derivatives of the total electromagnetic energy stored in the 
system. The model “Electromagnetic Forces on Parallel Current-Carrying Wires” on 
page 8 of the AC/DC Module Model Library demonstrates the excellent accuracy of 
the method on a benchmark problem.
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Objective Functions for Frequency-Domain Modeling
Sensitivity analysis can be applied only when the objective function is a real-valued 
differentiable function of the sensitivity variables. This is usually not a very severe 
constraint, even for frequency-domain models where the solution variables are 
complex valued. The reason is that physical quantities of interest to the analyst are 
always real-valued, and if complex valued sensitivity variables are required, the real and 
imaginary parts can be treated separately.

Many common quantities of interest are, however, time averages which can be written 
in the form Q = real(a·conj(b)), where a and b are complex-valued linear functions of 
the solution variables and therefore implicit functions of the sensitivity variables. The 
problem with this expression is that while Q is indeed a real-valued differentiable 
function of the sensitivity variables, it is not an analytical function of a and b. This 
complicates matters slightly because the sensitivity solver relies on partial 
differentiation and the chain rule.

While the partial derivatives of Q with respect to a and b are, strictly speaking, 
undefined, it can be proven that if they are chosen such that

 (10-1)

for any small complex increments δa and δb, the final sensitivities are evaluated 
correctly. The special function realdot(a,b) is identical to real(a*conj(b)) when 
evaluated but implements partial derivatives according to Equation 10-1. For that 
reason, use it in the definition of any time-average quantity set as objective function in 
a sensitivity analysis. For an example, see “Optimizing the Shape of a Horn” on page 
34 of the Acoustics Module Model Library (note that this model requires both the 
Optimization Lab and the Acoustics Module).

T H E  S E N S I T I V I T Y  S O L V E R

The sensitivity solver, which is intimately connected to the Sensitivity Analysis 
application mode, provides derivatives of model quantities with respect to the 
sensitivity variables. To evaluate these derivatives, or sensitivities, an auxiliary linear 
problem is solved, in addition to the original forward model. You have two options:

• Select the forward sensitivity method to evaluate the derivatives of all solution 
variables and an optional objective function.

• Select the adjoint sensitivity method to look only at derivatives of a scalar objective 
function.

Q a aδ+ b bδ+,( ) Q a b,( )
a∂

∂Q aδ
b∂

∂Q bδ+⎝ ⎠
⎛ ⎞real+≈
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Both methods have their benefits as will be explained below.

Sensitivity Analysis can be used together with all stationary and parametric standard 
solvers. The available solver settings are described in the section “Sensitivity Analysis 
and Optimization” on page 423 in the COMSOL Multiphysics User’s Guide. For 
technical details about the solution procedure, see “The Sensitivity Solver Algorithm” 
on page 543 in the COMSOL Multiphysics Reference Guide.

Forward Sensitivity
Use the forward sensitivity method to solve for the derivatives of all dependent 
variables, plus an optional scalar objective function, with respect to a small number of 
sensitivity variables. The forward method requires one extra linear system solution for 
each sensitivity variable.

The linear system that must be solved is the same as the last linearization needed for 
solving the forward model. Thus, when using a direct solver (for example, PARDISO) 
the extra work amounts only to one back-substitution per sensitivity variable DOF. 
The iterative linear and segregated solvers can reuse preconditioners and other data but 
must otherwise perform a complete solution each time.

Adjoint Sensitivity
The adjoint method solves for the derivatives of a single scalar objective function with 
respect to any number of sensitivity variables, requiring only one single additional 
linear system solution. In addition to the objective function gradient, the discrete 
adjoint solution is computed. This quantity represents the sensitivity of the objective 
function with respect to an additional generalized force applied as a nodal force to the 
corresponding solution component.

The auxiliary linear system is in this case the transpose of the last linearization needed 
for solving the forward model. The UMFPACK linear solver can always solve the 
transposed problem at the cost of a back-substitution, while remaining direct solvers 
need to do a new factorization if the problem is not symmetric or Hermitian. The 
iterative solvers can reuse most preconditioning information as can the segregated 
solver, which, however, loops over the segregated steps in reversed order.

PO S T P R O C E S S I N G  W I T H  T H E  S E N S ,  A D J ,  A N D  F S E N S  O P E R A T O R S

The solution returned from the sensitivity solver contains sensitivity information in 
addition to the forward model solution. The Sensitivity Analysis application mode 
defines postprocessing variables for direct access to the gradient of the objective 
function as well as that of the forward solution (if the forward method is used) or the 
adjoint solution (if the adjoint method is used).
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You can also postprocess the sensitivity data using a number of dedicated operators in 
your postprocessing expressions:

fsens(sensvar)   When you have specified an objective function, Q, the expression 
fsens(sensvar) evaluates to the derivative of Q with respect to sensitivity variable 
sensvar.

sens(expr,sensvar)   After using the forward sensitivity method, sens(expr,sensvar) 
evaluates the expression expr, replacing the forward model solution u with its 
derivative with respect to sensvar. For example, sens(u,p) evaluates the derivative 
of forward model solution variable u with respect to sensitivity variable p. Note that 
although the operator allows general expressions, it only makes sense for expressions 
which are linear in u.

adj(expr)   The adjoint sensitivity method computes and stores the adjoint solution 
with respect to the specified objective function. During postprocessing, the statement 
adj(expr) evaluates the expression expr with the adjoint solution substituted for the 
forward solution.

When working in a script environment, the corresponding sensitivity data are stored in 
the solution object fields fem.sol.fsens, fem.sol.sens and fem.sol.adj. The 
precise meaning of these fields is explained under femsol in the COMSOL 
Multiphysics Reference Guide.
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Model Navigator

You find the Sensitivity Analysis application mode in the Optimization and Sensitivity 
folder under COMSOL Multiphysics. No dependent variable names are required because 
the application mode does not add any new solution components.

The Model Navigator with the Sensitivity Analysis application mode selected.

Application Mode Properties

Unless your model contains more than one frame, there is only one property in the 
Application Mode Properties dialog box: using the Default element type list, select the 
default shape function for mesh-based sensitivity variables. If there are multiple frames, 
you can use the Frame list to select with respect to which coordinates spatial derivatives 
of sensitivity variables are defined.

Subdomain, Boundary, and Edge Settings

The Subdomain Settings, Boundary Settings, and Edge Settings (in 3D only) dialog boxes 
all have the same structure. This section shows the subdomain settings only.

On the Objective page, you specify contributions to the objective function. The 
program integrates any expression you enter in the Integrand edit field over the domain 
and adds it to the global objective function. You can also change the Integration order 
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used for evaluating the integral. If there is more than one frame in the model, an 
additional Frame selection list appears. Select the frame in which you want integration 
to be performed.

The Objective page of the Subdomain Settings dialog box.

Use the table on the Variables page to define mesh-based sensitivity variables. Enter a 
variable name in the Variable column and its value in the Init column. The Element and 
Shape function columns are automatically filled according to the preference setting in 
the Application Mode Properties dialog box. If you want a different discretization, select 
a predefined setting in the Element column, or modify the Shape function expression. 
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The accepted syntax is the same as on the Element page in any other application mode 
(see “Finite Elements” on page 484 in the COMSOL Multiphysics Reference Guide).

The Variables page of the Subdomain Settings dialog box.

Point Settings

Point Settings differs from Subdomain Settings in that summation is used instead of 
integration. Therefore, no integration order or frame can be specified on the Objective 
page. The local Point contribution evaluated on each point adds directly to the global 
objective function.

The Objective page of the Point Settings dialog box.
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The Variables page is also simplified, compared to Subdomain Settings. You only need 
to enter a sensitivity variable name in the Variable column and its value in the Init 
column. 

The Variables page of the Point Settings dialog box.

Scalar Settings

On the Objective page of the Scalar Settings dialog box, you provide any contribution 
to the objective function for the current geometry that is independent of the position. 
Enter its value in the Qs edit field.

The Objective page of the Scalar Settings dialog box.
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On the Variables page, enter the names of all global scalar sensitivity variables in the 
Variable column and their values in the Init column.

The Variables page of the Scalar Settings dialog box.
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Examp l e—Pred i c t i n g  t h e  E f f e c t  o f  a  
Geome t r i c a l  C h ang e

In this section, the Sensitivity Analysis application mode is applied to an existing model 
to predict the effect of changing its geometry slightly.

Introduction

The example “Stiffness Analysis of a Communication Mast’s Diagonal Mounting” on 
page 559 of the COMSOL Multiphysics Model Library shows how you can modify a 
3D CAD model in order to improve its performance. In that case, the applied changes 
were based solely on the analyst’s experience with similar structures. A senior design 
engineer can sometimes reach acceptable performance after analyzing only a handful 
of designs, while an unexperienced analyst may have to spend a lot of time on failed 
attempts.

Usually, you can indeed improve a design by trial and error, but it is difficult to ensure 
that the price you pay—in this example, added weight and material costs—is as low as 
possible. With sensitivity analysis, you can find the most cost-efficient direction for a 
small modification and estimate the effect it will have before attempting an updated 
design.

Model Definition

The original model simulates the deformation of a part of a communication mast 
(shown in Figure 10-1) under loads in the linear regime. A ratio of the part’s effective 
stiffness to the stiffness of an equal length of straight pipe is evaluated as a measure of 
its performance. Using sensitivity analysis together with a Moving Mesh application 
mode, you can predict what effect changing the dimensions of the end plate and the 
mount has on the part’s relative stiffness.
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Figure 10-1: The original CAD design of the part.

From the designer’s point of view, the material thickness of the end plate, t1, and of 
the mount, t2, are the most relevant parameters because they are easy to change both 
in the CAD system and on the production line. These quantities are, however, not 
directly comparable to each other because a unit change of t1 incurs a different cost—
added weight and material use—compared to a unit change in t2.

For a fair analysis, it is therefore more convenient to parameterize the model in terms 
of the masses m1 and m2 added to the plate and mount, respectively. The relation 
between added mass mi and thickness change di for i = 1, 2 is given by

where Ai is the area affected by the thickness change (m2) and ρ is the density of the 
material (kg/m3). You calculate the constant factor ρAi as an integration coupling 
variable MpLi in the model.

As output from a sensitivity analysis using the relative stiffness SR as objective function 
and the differential masses m1 and m2 as sensitivity variables, you get the partial 
derivatives

Applied load

Fixed displacement

End plate

Mount

mi ρAidi=
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For a modified geometry corresponding to small values of m1 and m2 you can 
therefore expect to see a change in the relative stiffness equal to ∆SR = Q1m1 + Q2m2. 
Note that this relation holds only for a small incremental change from the current 
configuration because the relative stiffness is clearly a nonlinear function of the 
thicknesses.

Now suppose that you want to select the best possible design update for a given added 
mass ∆m = m1 + m2 with the added condition that both m1 and m2 are nonnegative. 
It is not too difficult to realize that the best option is to take m1 = ∆m, m2 = 0 if 
Q1 > Q2, and m1 = 0, m2 = ∆m otherwise. 

The optimum stiffness for a given total mass of the structure can be sought by relaxing 
the nonnegativity condition for the updates and instead restricting the maximum 
change in m1 and m2 during one iteration. With the total mass as only constraint, you 
will find the optimum design at a point where Q1 = Q2. This follows strictly from the 
Karush-Kuhn-Tucker conditions but also from the simple fact that at such a point, the 
increased stiffness from adding mass to the plate is exactly cancelled by the decrease in 
stiffness from removing the same mass from the mount.

P A R A M E T E R I Z I N G  T H E  G E O M E T R Y

In the Sensitivity Application mode, you declare sensitivity variables, which can be 
used to parameterize the physics of the model. The sensitivity variables can appear 
anywhere COMSOL Multiphysics accepts an expression containing the dependent 
variables. However, neither dependent variables nor sensitivity variables can be used 
directly to set dimensions in the geometry.

To evaluate the sensitivity of a model with respect to geometrical changes, the 
geometry must first be made an active part of the system of equations. You accomplish 
this by moving all physics onto an ALE frame controlled by a Moving Mesh (ALE) 
application mode (described in the section “The Moving Mesh Application Mode” on 
page 455). The Moving Mesh (ALE) application mode sets up an equation governing 
the position of the mesh nodes inside the domains, while the outer shape of the domain 
is controlled by boundary conditions.

When doing sensitivity analysis, these boundary conditions are quite simple: on fixed 
surfaces, set the mesh displacement to zero; on surfaces which may be modified, specify 
the displacement in terms of the sensitivity variables. In this particular case, where the 

Qi mi∂
∂SR=
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material thickness of the end plate and the mount can change, it is enough to set the 
normal displacement of these surfaces equal to the thickness change calculated from 
the corresponding added mass.

On surfaces adjacent to a domain with a parameterized normal displacement, it is 
preferable to restrict the mesh displacement to zero only in the normal direction to 
avoid an inconsistent constraint on the common edge. However, any remaining 
inconsistencies do not invalidate your results completely but only effectively modify 
the parametrization. In cases like this, when the purpose of the analysis is a rough 
estimate and guidance for a manual redesign, such minor errors in the sensitivities are 
unimportant.

Another potential source of errors must be checked more carefully, though. Changing 
the material thickness of the mount also changes the area where the loading is applied. 
In the Solid, Stress-Strain application mode, the load is specified as a given force per 
area. If you keep this number fixed when the thickness of the part changes, the total 
applied load also changes; when evaluating the relative stiffness of the composite part 
you must account for this effect.

Alternatively, you can keep the total force fixed and make sure that the applied force 
per area is calculated using a hole area that follows the parametrization of the 
geometry. It turns out that in the original model, the applied load is indeed calculated 
based on a hole area which is evaluated using integration coupling variables sensitive 
to deformation of the geometry.

C H O O S I N G  F O R W A R D  O R  A D J O I N T  S E N S I T I V I T Y  A N A L Y S I S

By default, the Sensitivity Analysis application mode uses the adjoint method, which is 
more efficient than the forward method when the number of sensitivity variables is 
large. When there is only a handful of scalar parameters, as in this case, the forward 
method has the advantage that it returns the sensitivity of the entire solution with 
respect to the sensitivity variables in addition to the sensitivity of the objective 
function. This additional information can sometimes be important in itself, but more 
often it is useful for checking the model setup because it is easy to visualize.

Results and Discussion

The analysis shows that when the thickness of the end plate is 12 mm and the material 
thickness in the mount is 15 mm, the sensitivities to adding mass to the two details are 
Q1 = 0.27 and Q2 = 0.16, respectively. Because, apparently, adding mass to the end 
plate has more effect than adding it to the mount, the next redesign of the part should 
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be fitted with a thicker plate. You might even consider decreasing the material 
thickness of the mount while adding to the plate to keep the weight of the part 
constant.

Note that these conclusions only hold for the current instance of the design. An 
experienced analyst quickly realizes that the compliance of the plate is due to bending 
action, while the mount is in almost pure tension. A plate’s resistance to bending grows 
as its thickness cubed, while resistance to tension is proportional to the cross-sectional 
area. Therefore, as the thickness of the plate increases, its contribution to the 
compliance of the composite part decreases rapidly.

If you increase the thickness of the end plate too much, the compliance of the mount 
takes over as dominant factor in the overall behavior. Using sensitivity analysis, you can 
easily detect when this has happened, because it will lead to Q2 > Q1. As noted above, 
an optimum design for a given total mass is found when Q1 = Q2.

Because the sensitivity analysis was performed using the forward method, the 
derivatives of the solution with respect to the parameters m1 and m2 have also been 
stored. You can access this data during postprocessing by choosing them from the list 
of predefined quantities, or more generally using the syntax sens(expr,var). For 
example, by plotting the expression sens(w,m2), you can directly examine the local 
effect of a unit increase of the mount mass (see Figure 10-2). Note that, interestingly, 
increasing the material thickness in the mount reduces the bending of the end plate. 
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The reason is probably that, as the mount plates are getting thicker, they transfer the 
load closer to the edge of the end plate.

Figure 10-2: According to the linear approximation, increasing the thickness of the end 
plate by 5 mm would reduce its bending and make the mount plates nearly parallel.

It is also possible to use a composite expression such as u+0.005*MpL2*sens(u,m1) 
to display a linear approximation of the actual deformation that would result from a 
5 mm increase in the thickness of the end plate. In Figure 10-2 such expressions have 
been applied as boundary deformation data to let you can easily get an idea of the 
would-be effect of changing the geometry. Note that this is a very rough estimate 
because the bending stiffness as function of the plate thickness is far from linear.

Model Library path: COMSOL_Multiphysics/Structural_Mechanics/
mast_diagonal_mounting_sensitivity
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Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

You can use the Model Navigator to create a new model, open existing models and 
modify the application modes used in the current model. In this case, you have to do 
the two last. In the original model, the structural mechanics equations are defined in 
the reference coordinate system. For the sensitivity variables to have any effect on the 
structural simulation, you must transfer the latter to a moving frame defined by a 
Moving Mesh (ALE) application mode.

1 In the Model Navigator, go to the Model Library page and select COMSOL 

Multiphysics>Structural Mechanics>mast diagonal mounting mphbin.

2 Click OK to load the model.

3 From the Multiphysics menu, open the Model Navigator again.

4 In the Application Modes tree, select COMSOL Multiphysics>Deformed Mesh>Moving 

Mesh (ALE), then click Add.

5 Select Solid Stress-Strain (sld) in the Multiphysics tree, then click the Application Mode 

Properties button.

6 In the Application Mode Properties dialog box, select Frame (ale) from the Frame list. 
Click OK to close the dialog box.

7 Select COMSOL Multiphysics>Optimization and Sensitivity>Sensitivity Analysis from the 
Application modes tree, then click Add.

8 Click OK to close the Model Navigator.

O P T I O N S  A N D  S E T T I N G S

The original model already contains most of the variables needed for the sensitivity 
analysis. In particular, the objective function used to evaluate the performance of the 
design is defined as a global expression, Stiffness_ratio. To express the thickness 
change of the plate and mount in terms of added mass, you must add a pair of 
integration variables which evaluate the ratio of added mass to added thickness.

Integration Variables
1 From the Options menu, select Integration Coupling Variables>Boundary Variables.

2 Select Boundary 4. Add a variable with the Name MpL1 defined by the Expression 
rho_sld. Leave the other columns unchanged.

3 Select Boundaries 17 and 32, and create another variable with the Name MpL2 
defined by the same Expression, that is, rho_sld.
E X A M P L E — P R E D I C T I N G  T H E  E F F E C T  O F  A  G E O M E T R I C A L  C H A N G E  |  305



306 |  C H A P T E R
4 Click OK to close the dialog box.

Global Expressions
1 From the Options menu, choose Expressions>Global Expressions.

2 Add new variables d1 and d2 with defining expressions m1/MpL1 and m2/MpL2, 
respectively. 

3 Click OK.

P H Y S I C S  S E T T I N G S

The Moving Mesh (ALE) application mode is necessary to make the structural 
mechanics simulation sensitive to changes in the geometry. You calculate the sensitivity 
around the reference configuration, so all boundary displacements are set to zero, 
either directly or indirectly via the sensitivity variables.

Application Mode Properties—Moving Mesh (ALE)
1 From the Multiphysics menu, select the Moving Mesh (ALE) application mode.

2 Select Physics>Properties and set Weak constraints to Off.

3 Click OK to accept the change.

Subdomain Settings—Moving Mesh (ALE)
1 Choose Physics>Subdomain Settings to open the Subdomain Settings dialog box.

2 Select Subdomain 2, click the No displacement button, and then click OK.

Boundary Settings—Moving Mesh (ALE)
1 Open the Boundary Settings dialog box, then press Ctrl+A to select all boundaries.

2 From the Coordinate system list, select Tangent and normal coord. sys. in reference 

mesh.

3 Select the dn check box to lock the displacement in the normal direction. On most 
boundaries, the default zero displacement is the correct setting.

4 Select Boundary 3 and click the dt1 and dt2 check boxes to lock this boundary in all 
directions. This is necessary to prevent rigid-body rotation of the mesh.

5 Select Boundaries 4, 5, and 10 and set the dn field to d1.

6 Select Boundaries 19 and 27 and set dn to -d1.

7 Select Boundaries 17 and 32 and change the dn field to d2.

8 Click the Pairs tab and select Pairs 2 and 3.

9 Deselect the Active pair check box to decouple the pairs.

10 Click OK.
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Scalar Settings—Sensitivity Analysis
The sensitivity variables are global scalar parameters. You set them up and specify their 
values in the Scalar Settings dialog box, where you can also enter scalar contributions 
to the objective function. 

1 Activate the Sensitivity Analysis application mode by selecting it from the Multiphysics 
menu or in the Model Tree.

2 Choose Physics>Scalar Settings to open the Scalar Settings dialog box.

3 In the Scalar contribution edit field on the Objective page, enter Stiffness_ratio.

4 Click the Variables tab. In the Name column, enter the variable names m1 and m2 on 
separate lines in the table, both with Init value 0.

5 Click OK to close the dialog box.

C O M P U T I N G  T H E  S O L U T I O N

Apart from a few special properties—the choice between forward and adjoint method 
being the most important—the sensitivity solver accepts the same solver settings as the 
standard stationary solver. In this case, the mesh displacements must be a part of the 
solution, but because they are independent of the physics, it is possible to solve them 
in a separate step before solving the structural displacements. To do this, use the 
segregated solver. You can also solve the coupled problem efficiently using an iterative 
solver as described below.

Correct scaling is important for accurate sensitivity evaluation. The structural 
displacements are on the order of 10−5 m, while the mesh coordinates are on the order 
of 10−1 m. You can specify these scale factors manually to improve the stability of the 
solution.

1 Choose Solve>Solver Parameters or click the corresponding button on the Main 
toolbar to open the Solver Parameters dialog box.

2 From the Linear system solver list, select GMRES, and leave the default Geometric 

multigrid preconditioner.

3 Turn on the Sensitivity solver by selecting the Optimization/Sensitivity check box, 
then click the Optimization/Sensitivity tab.

4 Change the Sensitivity method from Adjoint to Forward.

5 On the Advanced page, in the Scaling of variables frame, select Manual scaling and 
enter x 1e-1 y 1e-1 z 1e-1 u 1e-5 v 1e-5 w 1e-5 in the Manual scaling edit 
field.

6 Click OK to close dialog box.
E X A M P L E — P R E D I C T I N G  T H E  E F F E C T  O F  A  G E O M E T R I C A L  C H A N G E  |  307



308 |  C H A P T E R
7 From the Solve menu, select Update Model to initialize the Moving Mesh (ALE) 
application mode.

8 Click the Solve button on the Main toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

To display the sensitivity of the deformation field and produce Figure 10-2, do the 
following:

1 Click Plot Parameters on the Main toolbar to open the corresponding dialog box.

2 On the Boundary page, select Sensitivity Analysis (sa)>Sensitivity of w to m2 from the 
Predefined quantities. 

3 Change Color map to hot.

4 Go to the Deform page and click the Boundary Data tab in the Deformation data 
frame. 

5 Set the edit fields according to the following table:

6 Click OK to close the dialog box and display the new plot.

Both the objective function and the sensitivity variables are global in this case, so 
you want to evaluate rather than plot them. 

7 From the Postprocessing menu, select Data Display>Global.

8 As a first check, select Sensitivity Analysis (sa)>Objective from the Predefined 

quantities list, then click Apply to verify that the stiffness ratio is still 0.52 as in the 
original model.

9 In the same manner, evaluate the predefined quantities Sensitivity Analysis 

(sa)>Objective sensitivity to m1 and Sensitivity Analysis (sa)>Objective sensitivity to 

m2. The values should be about 0.27 and 0.16, respectively.

The clear conclusion you can draw from these results is that adding thickness to the 
plate has better effect on the overall stiffness compared to adding the same mass to the 
mount.

FIELD EXPRESSION

X component u+0.005*MpL1*sens(u,m1)

Y component v+0.005*MpL1*sens(v,m1)

Z component w+0.005*MpL1*sens(w,m1)
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O p t i m i z a t i o n
If you have a license for the Optimization Lab, you get access to the Optimization 
application mode in the COMSOL Multiphysics graphical user interface. We have 
designed this application mode to facilitate setting up and solving constrained 
optimization and inverse-modeling problems based on multiphysics models.

This chapter describes the Optimization application mode’s user interface and 
illustrates some modeling guidelines through a tutorial example model. You find 
additional optimization models for a variety of application areas in the COMSOL 
Multiphysics Model Library as well as in the Model Libraries for the add-on 
modules; look for the symbol “¤” in the Model Library Guide tables.

For further background on optimization, see the SNOPT User’s Guide.

Note: The Optimization application mode requires the Optimization Lab.
 309



310 |  C H A P T E R
Th e  Op t im i z a t i o n  App l i c a t i o n  Mode

Introduction

Numerical optimization can be described as the art of finding an optimum set of 
parameters, or optimization-variable values, that minimize an objective function 
subject to a number of constraints. The objective function (also known under different 
names such as goal function, cost function, or quantity of interest) can be an explicit 
function of the optimization variables, or—which is a more interesting case—an 
output quantity from a simulation parameterized by the optimization variables.

While the Optimization application mode can indeed solve classical pure optimization 
problems, its real strength is its ability to compute accurate gradients also when the 
objective function and constraints depend on the solution to a multiphysics model. 
This enables the use of an efficient gradient-based optimization algorithm, reducing 
the number of multiphysics model evaluations required to find an optimal solution.

The Optimization application mode is in many ways similar to the Sensitivity Analysis 
application mode (see “The Sensitivity Analysis Application Mode” on page 288). 
Most importantly, they define variables and compute gradients in the same way. 
Moreover, neither application mode defines any physics of its own. Instead, you usually 
build an optimization model on top of an existing multiphysics model.

To define and solve a complete optimization problem, you need to perform four tasks 
in addition to those that apply when solving a standard PDE problem:

• Define a scalar objective function

• Select optimization variables

• Set additional constraints

• Compute optimal values of the optimization variables

The Optimization application mode provides an interface for handling all four tasks.

Optimization Problem Formulation

The Optimization application mode is built around a general minimization problem 
formulation, where you supply an objective function to be minimized and constraints 
on the optimization variables. On top of this, the complete multiphysics model and its 
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constraints serve as an additional condition on the optimization problem. For this 
reason, the procedure is sometimes referred to as PDE-constrained optimization.

After you have set up a complete optimization model, the goal of the optimization 
process can be stated roughly as “find the values of the optimization variables that 
minimize the objective function under the condition that u is a solution to the 
multiphysics model and no constraints are violated.” More formally, this can be stated 
as follows:

 (11-1)

The objective function Q(u, ξ) is a function of the optimization variables ξ ≡ {ξ i} both 
directly and indirectly through u, which is the solution to the general multiphysics 
problem L(u, ξ) = 0. The objective function is defined as the sum of integral 
contributions from all dimensions k in the d-dimensional multiphysics model, and a 
general scalar term:

The implicit dependence of u on ξ means that the entire multiphysics problem can be 
seen as a constraint on the minimization problem. Additional constraints can be of two 
types:

• Integral constraints

• Pointwise constraints

Integral constraints assign lower and upper bounds to quantities Pj with general 
integral contributions of the same type as the objective function,

for j = 1, …, nic, where nic is the number of integral constraints.

min
ξ

  Q u ξ,( )

L u ξ,( ) 0=

lbP P ξ u,( ) ubP≤≤

lbΨ  Ψ ξ( )  ubΨ≤≤

Q u ξ,( ) Qs u ξ,( ) Qk u ξ,( ) Vkd
Ωk

∫
k 0=

d

∑+=

lbP j, Pj ξ u,( ) ubP j, ,≤ ≤ Pj Ps j, u ξ,( ) Pk j, u ξ,( ) Vkd
Ωk

∫
k 0=

d

∑+≡
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Pointwise constraints, on the other hand, apply in any single dimension (0, …, d or 
scalar) separately. They specify lower and upper bounds for explicit functions of the 
optimization variables:

where npc is the total number of pointwise constraints in all dimensions. They are less 
general than the integral constraints because they cannot depend on u, but they are 
more efficient to compute. It is good practice to use pointwise constraints to restrict 
the space of allowed optimization variable vectors ξ as far as possible before calling the 
optimization solver.

Model Navigator

The Optimization application mode is available in all space dimensions. To include it 
in your model, open the Model Navigator, select the appropriate geometry from the 
Space dimension list, and then choose COMSOL Multiphysics>Optimization and 

Sensitivity>Optimization from the Application Modes tree.

The Optimization application mode in the Model Navigator.

Before clicking OK (or Add if you have previously clicked the Multiphysics button), you 
have the option of modifying the name in the Application mode name edit field (the 
default name is opt). In the Element list, you can specify which shape functions to use. 

lbΨ i, Ψi ξ( ) ubΨ i, ,≤≤ i 1 … npc, ,=
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The setting in this list determines the default option when you define your design 
variables, but you can easily change it later if necessary.

Application Mode Properties

In the Application Mode Properties dialog box—which you reach from the Model 

Navigator or by choosing Properties from the Physics menu—it is possible to specify the 
default element type in the list with the same name.

The Application Mode Properties dialog box.

If your model contains a Moving Mesh (ALE) or a Parameterized Geometry 
application mode, you can also select the frame for your Optimization application 
mode.

Subdomain Settings

In the Subdomain Settings dialog box for the Optimization application mode, you 
specify the objective function and any constraints that apply at the subdomain level. 
The settings are arranged in the following categories, to each of which corresponds a 
separate dialog-box page:

• Objective

• Integral Constraints

• Pointwise Constraints

• Variables

The following subsections describe these pages one by one. The presentation and the 
dialog-box snapshots apply to the case of a 3D geometry. However, the 
lower-dimensional cases are completely analogous.

T H E  O B J E C T I V E  P A G E

In 3D, the most general objective function takes the form

 (11-2)Q Qs Q0 Q1 Q2 Q3+ + + +=
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where Qs denotes the scalar contribution, and Qk denotes the contribution from 
domains of dimension k (k = 0,  …,  3). You specify these contributions on the 
Objective page of the Scalar Settings, Point Settings, Edge Settings, Boundary Settings, and 
Subdomain Settings dialog boxes, respectively.

Focusing first on the subdomain-level contribution, it is given by

 (11-3)

where the sum runs over all subdomains in the geometry. To define Q3, provide the 
integrand (q3)l for every applicable subdomain l by selecting the subdomain from the 
Subdomain selection list and entering the corresponding integrand in the q3 edit field. 
(If a single integrand expression applies to several subdomains, you can of course select 
them concurrently.) In the gporder edit field you can, optionally, alter the integration 
order.

T H E  I N T E G R A L  C O N S T R A I N T S  P A G E

In 3D, the most general integral constraint takes the form

 (11-4)

where Ps denotes the scalar contribution and Pk denotes the contribution from 
domains of dimension k (k = 0, …, 3). You specify the corresponding contributions on 
the Integral Constraints page of the Scalar Settings, Point Settings, Edge Settings, 
Boundary Settings, and Subdomain Settings dialog boxes, respectively.

Q3 q3( )l Ωld
Ωk

∫
l
∑=

lb P ξ u,( ) ub≤ ≤ P Ps P0 P1 P2 P3+ + + +=
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Note: Define the lower and upper bounds, lb and ub, in the Scalar Settings dialog 
box.

You can impose an arbitrary number of integral constraints, P(1),  …, P(N), identifying 
each one by a unique name that you supply in the Name column on the Integral 

Constraints page. As soon as you have defined any one of the terms on the right-hand 
side of the equation for P in Equation 11-4, the constraint automatically appears on 
the Integral Constraints page at all other levels.

To define a constraint contribution at the subdomain level in 3D,

 (11-5)

specify the integrand (p3)l for every subdomain l on which the constraint applies by 
selecting the subdomain from the Subdomain selection list and entering the 
corresponding integrand in the p3 column. Additionally, you need to specify the 
Integration order in the third column of the Integral constraints contributions table.

T H E  PO I N T W I S E  C O N S T R A I N T S  P A G E

On the Pointwise Constraints page of the Subdomain Settings dialog box, you specify 
constraints that apply at each point in a subdomain (or a set of subdomains) Ω:

P3 p3( )l Ωld
Ωk

∫
l
∑=

lb x( ) Ψ ξ x,( ) ub x( ),≤≤ x Ω∈
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For each constraint, supply the lower and upper bounds, lb(x) and ub(x), in the lb and 
ub columns, respectively, and the constraint expression Ψ(ξ, x) in the Expression 
column. In addition, you can specify the order of the constraint in the Constraint order 
column. The constraint is enforced discretely at Lagrange points of the specified order.

T H E  V A R I A B L E S  P A G E

On the Variables page, you define the variables for your optimization problem. For 
each optimization variable, type a name in the Variable column and an initial value in 
the Init column. To specify the shape function, either select one of the options in the 
Element drop-down list or type it in the Shape function column using the syntax 
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described in the COMSOL Multiphysics Reference Guide (see shdisc on page 440 
and shlag on page 444 for discontinuous and Lagrange elements, respectively).

Boundary Settings

The Boundary Settings dialog box for the Optimization application mode contains the 
same pages as the Subdomain Settings dialog box.

On the Objective page you define the term Q2 in Equation 11-2 in a way completely 
analogous to that for defining Q3 discussed in the previous section. In other words, 
you supply the integrands, (q2)l, and (optionally) adjust the integration order. See 
“The Objective Page” on page 313 for further details.

Similarly, on the Integral Constraints page, you define the term P2 in Equation 11-4 by 
supplying the same data as at the subdomain level; see “The Integral Constraints Page” 
on page 314.

The Pointwise Constraints page, too, has the same function and design as the 
corresponding page in the Subdomain Settings dialog box described on page 315.

Finally, the Variables page is also completely analogous to its counterpart in the 
Subdomain Settings dialog box. Therefore, consult “The Variables Page” on page 316 
for additional information.
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Edge Settings (3D Only)

On the Optimization application mode’s Edge Settings dialog box you specify the terms 
Q1 and P1 in Equation 11-2 and Equation 11-4, respectively, along with pointwise 
constraints and variables. Its design and usage are completely analogous to those of the 
Subdomain Settings dialog box. Therefore, see the section “Subdomain Settings” on 
page 313 for details.

Point Settings

Go to the Objective page of the Point Settings dialog box to specify any nonzero point 
contributions to the objective function, Q (the term Q0 in Equation 11-2). Note that 
these contributions are summed rather than integrated over the points.

On the Integral Constraints page, you specify the term P0 for constraints of the general 
form given in Equation 11-4. Again, the contribution is a sum rather than an integral.

Constraints that are independent of the PDE solution, u, and must hold at each point 
separately, can be defined on the Pointwise Constraints page.

On the Variables page, you can specify optimization variables defined at the point level 
and their initial values.
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Scalar Settings

On the Objective page of the Scalar Settings dialog box, you provide any contribution 
to the objective function that is independent of the geometry and position. In 
Equation 11-2 this corresponds to the term Qs. Enter its value in the Qs edit field.

On the Integral Constraints page, you specify scalar contributions as well as the lower 
and upper bounds for your integral constraints.
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On the Scalar Constraints page you can define any number of scalar constraints by their 
expressions and lower and upper bounds.

Note that the constraints you specify on this page are of the type “pointwise 
constraints” according to the classification given in the section “Optimization Problem 
Formulation” on page 310. Thus, they cannot depend on the solution to the PDE 
problem, but they are more efficient to compute than integral constraints with only a 
scalar term.

Finally, on the Variables page, you specify any design variables that are independent of 
the position and geometry. Define the variable names in the Variable column and the 
corresponding initial values in the Init column.
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Solver Settings

A C T I V A T I N G  T H E  O P T I M I Z A T I O N  P R O B L E M  S O L V E R S

To solve the optimization problem you have specified, you need to do some settings 
in the Solver Parameters dialog box before starting the solver.

1 Open the Solver Parameters dialog box from the Solve menu or by clicking the 
corresponding button on the Main toolbar.

2 Select the Optimization/Sensitivity check box.

3 Optionally, select the Plot while solving check box. After each optimization step 
COMSOL Multiphysics then displays a plot in a separate figure window using the 
current settings in the Plot Parameters dialog box. Select this option if you want to 
follow the optimization solver’s progress with regards to some specific solution 
properties. Note that you can always monitor the objective function’s value on the 
Progress and Log pages of the Progress dialog box.

4 Click the Optimization/Sensitivity tab.

5 If the Optimization application mode is the ruling application mode, the default 
setting for the Analysis is Optimization; otherwise the default is Sensitivity. Set the 
Analysis to Optimization to solve an optimization problem. It is, however, good 
practice to first solve once using the sensitivity solver, to check that the PDE model 
and optimization variables are set up correctly.
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6 The names of any optimization variables you have defined appear automatically in 
the Variables edit field in the form of a space-separated list. If you want to optimize 
with respect to a subset of these variables you can edit this entry.

This completes the optimization-problem solver settings that you always have to do. 
In some cases, you may need to perform some additional tuning as described in the 
subsequent subsections.

O P T I M I Z A T I O N  S O L V E R  S E T T I N G S

Often you do not need to worry about the settings described in this subsection, but 
they can sometimes be useful or necessary to adjust. Further details are available in the 
section “Optimization Solver Properties” on page 574 of the COMSOL Multiphysics 
Reference Guide.

Gradient Evaluation Method
In the Gradient method list, you can choose between Analytic (default) and Numeric. 
With the Analytic option set, the gradient is computed by the sensitivity solver using 
the adjoint method (see “The Sensitivity Solver” on page 291). For the Numeric 
option, the gradient is approximated by finite differences and computed by repeated 
evaluation of the objective function. The numeric method can be more robust in some 
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cases, but it must only be used when the number of degrees of freedom for the 
optimization variables is small. In general, the default setting is more accurate and 
efficient.

QP Solver Algorithm
In the QP solver list you can specify which strategy the optimization solver should use 
when solving quadratic-programming subproblems. The following options are 
available:

•  Cholesky (default)—For a small number of optimization-variable degrees of freedom 
(fewer than 1000 DOFs) it is most efficient to compute and store a complete 
Cholesky factorization of the reduced Hessian matrix. If the number of degrees of 
freedom is large (more than 1000 DOFs) the QP solver will automatically switch to 
the Quasi-Newton method.

•  Conjugate gradients—This is an appropriate choice for problems with many 
optimization-variable degrees of freedom. Because an iterative linear solver is used 
to generate step directions in the QP solver, no factorization of the reduced Hessian 
matrix needs to be stored.

•  Quasi-Newton—If the number of degrees of freedom is large, a partial Cholesky 
factor can be maintained instead of the complete factorization. This uses less 
memory than the Cholesky method, but should normally be more robust than 
Conjugate gradients.

For details, see “Qpsolver” on page 588 of the COMSOL Multiphysics Reference 
Guide.

Maximum Number of Model Evaluations
In the Maximum number of model evaluations edit field, you can set a limit on the 
number of times the solver evaluates the objective function before terminating, even if 
the optimality criterion has not been met. The default value is 500.

By setting this parameter to a smaller value and calling the optimization solver 
repeatedly, you can study the convergence rate and stop when further iterations with 
the optimization solver no longer have any significant impact on the value of the 
objective function.

Tolerances
In the Tolerances area, it is possible to adjust four related parameters:

•  Optimality tolerance—A parameter used by the linear and quadratic solvers to 
determine, on the basis of the reduced-gradient size, whether optimality has been 
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reached (for details, see “Opttol” on page 584 of the COMSOL Multiphysics 
Reference Guide). For small values of the objective function, 0.01 times the 
parameter value is used as absolute tolerance. The default value is 10−6.

•  Bound and linear constraint tolerance—This parameter controls when linear 
constraints are considered to be satisfied (for details, see “Feastol” on page 577 of 
the COMSOL Multiphysics Reference Guide). The default value is 10−6.

•  Nonlinear constraint tolerance—This parameter specifies the accuracy with which the 
nonlinear constraints should be satisfied (for details, see “Majfeastol” on page 581 
of the COMSOL Multiphysics Reference Guide). The default value is 10−6.

•  Function precision—This parameter gives a measure of the relative accuracy with 
which the objective function and constraints can be evaluated (for details, see 
“Funcprec” on page 578 of the COMSOL Multiphysics Reference Guide). For 
function values smaller than 1, the parameter is used as an absolute precision. The 
default value is 10−6.

The optimality tolerance is the most important setting. In particular, it can play tricks 
on you if your objective function or your optimization variables are badly scaled. 
Preferably, the objective function and scalar constraints, as well as the optimization 
variables, should be of the same order, and ideally of order 1.

If the optimization solver reports a converged solution after just a few iterations, try 
to restart it with a tighter tolerance to make sure it has actually found the solution. If, 
on the contrary, it seems to iterate forever—despite the value of the objective function 
having converged (check the output on the Log page in the Progress window)—chances 
are that the tolerance value is too strict.

Note that the function precision specifies the expected stability of the numerical model 
rather than its accuracy as a model of physical reality. When using a direct linear solver 
on a linear model, the function precision should be set to a value of the same order as 
the inverse of the condition number. For a nonlinear or iterative solver, you can expect 
the precision to be of the same order as the solver tolerances.

Use Step Limit Condition
Selecting the Use step limit condition check box activates the Step limit condition edit 
field. In this edit field, you can enter an expression that tells the optimization solver to 
reduce the step length in the current line search because it has reached a point in the 
parameter space where the PDE problem is not well defined.

A typical example is when a mesh element becomes inverted during geometry 
optimization using a Moving Mesh ALE application mode. The step limit condition 
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that identifies this situation takes the form minqual1_ale-0.05, where 0.05 is a 
threshold value for the mesh quality. This step limit condition has a direct analog in 
the stop condition for the time-dependent and parametric solvers discussed in the 
section “Stop Condition” on page 460; see that section for additional details.

Note that the step limit condition should be used only as a last resort to keep the 
optimization solver in a feasible region. Instead, if possible, use pointwise constraints 
on the optimization variables to enforce the condition.

When the step limit condition is violated, the line-search step is reduced until an 
acceptable point is found. However, because no Jacobian is computed for the step limit 
condition, there is no mechanism to prevent the solver from immediately attempting 
another step in the same infeasible direction. As a result, it may get stuck at the same 
point without converging until the maximum number of model evaluations is reached 
or you stop the iteration manually by clicking the Stop button in the Progress window.

Manual Tuning of Hessian Updates
Select the Manual tuning of Hessian updates check box to activate the Hessian updates 
edit field. This parameter (with default value 10) controls the quality of the 
approximate Hessian matrix. Reducing its value can lead to shorter solution times 
because each QP subproblem becomes less expensive to solve. Increasing the number 
of Hessian updates, on the other hand, improves the robustness of the outer iterations. 
For details, see “Hessupd” on page 579 of the COMSOL Multiphysics Reference 
Guide.

P L O T  W H I L E  S O L V I N G

To plot the multiphysics model solution in a separate window after each optimization 
step, select the Plot while solving check box. The current settings in the Plot Parameters 
dialog box are then transferred to the solver. This lets you follow the progress of the 
optimization procedure via a suitably selected model quantity.
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Examp l e—Min im i z i n g  t h e  F l ow 
V e l o c i t y  i n  a  M i c r o c h ann e l

Introduction

Topology optimization of the Navier-Stokes equations is encountered in different 
branches and applications, such as in the design of ventilation systems for cars and 
optimal reactors. A common technique applicable to such problems is to let the 
distribution of porous material vary continuously. In this model, the objective is to find 
the optimal distribution of a porous material in a microchannel such that the 
horizontal velocity component at the center of the channel is minimized.

The model is inspired by Ref. 1.

Model Definition

The model geometry (Figure 11-1) consists of three regions: the inlet channel, the 
design domain, and the outlet channel. A prescribed pressure drop between the inlet 
and the outlet drives the flow.

Figure 11-1: The model geometry.

channel centerinlet
outlet

mm

m
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The fluid flow in the channel is described by the Navier-Stokes equations

 (11-6)

where −α( γ ) u is a force term in which the coefficient

 (11-7)

characterizes the flow in a porous medium. In Equation 11-7, α is interpreted as a 
continuous mapping determined by the function γ: Ω → [0, 1], which in the limit of 
decreasing Darcy number and decreasing mesh size should be a discrete-valued 
function. When γ equals 1, α is zero, corresponding to free flow. Conversely, for γ = 0, 
α = αmax, where αmax is related to the dimensionless Darcy number, Da, according to

 (11-8)

The convergence of the optimization process depends on three important factors: the 
Darcy number, the mesh size, and the coefficient q. Rewriting Equation 11-7 it is 
easily seen that α/αmax → 1 − γ in the limit . In this limit, γ can be interpreted 
as the local porosity, ranging between 0 (filled) and 1 (open channel).

Results and Discussion

Figure 11-2 displays the design variable, γ, which represents the distribution of porous 
material. As the plot shows, γ is either 0 or 1 in most of the domain, with a narrow 
transition zone in between. The width of this transition zone is mesh dependent; you 
can reduce it by decreasing the mesh-element size. Alternatively, decreasing the Darcy 
number also gives harder boundaries at the interface between porous and open 
domains.

ρ u ∇⋅( )u ∇– p ∇+ η ∇u ∇u( )T
+( ) α γ( )u–⋅=

∇ u⋅ 0=

α γ( ) αmax
q 1 γ–( )

q γ+
--------------------≡

Da η
αmaxL2
---------------------=

q ∞→
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Figure 11-2: Distribution of porous material; the red areas represent open channel.

A question that naturally arises in this type of problems concerns uniqueness of the 
solution. In this case, there is at least one more solution that gives exactly the same 
result; because the channel has no upside or downside, a solution mirrored around the 
axis y = 0.5 mm would give exactly the same flow.

Figure 11-3 contains a surface plot of the horizontal velocity component and a 
streamline plot of the velocity field resulting from the optimization process. In 
addition, the contour γ = 0.5 indicates the border between the open channel and filling 
material. The plots reveal how the flow turns around, with a negative horizontal 
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velocity at the center of the channel. Note also that the x-velocity has a minimum of 
roughly  −15 mm/s at the design point.

Figure 11-3: The horizontal velocity (surface plot) and velocity field (streamlines) after 
optimization. In addition, the contour γ = 0.5 indicates the border between open channel 
and filling material.

If you were to increase the streamline density in the above plot, some streamlines 
passing through the barriers would appear. This effect is due to a small amount of 
leakage, which can be reduced further by increasing the mesh resolution.
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Figure 11-4 shows the pressure distribution, verifying the prescribed pressure drop 
through the channel length. The pressure drop is naturally concentrated to the region 
with porous material.

Figure 11-4: Pressure distribution in the channel, the pressure drop is concentrated to the 
porous domain.
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Modeling in COMSOL Multiphysics

This model combines the Optimization application mode and the Incompressible 
Navier-Stokes application mode. First, you calculate the solution for the flow in an 
empty channel (that is, with no porous material). You then use this solution as a 
starting point for the optimization. In each iteration, the software calculates a solution 
for the flow problem and feeds it to the optimization routine, which updates the design 
variables. If the specified convergence criterion is fulfilled, the solution process 
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terminates; otherwise the new design-variable values are used in the next calculation of 
the flow problem.

Setting up this kind of model with a general optimization routine would require quite 
a bit of work, but as you will discover, solving this problem with the built-in tools for 
optimization in COMSOL Multiphysics is easy.

Model Library path: COMSOL_Multiphysics/Fluid_Dynamics/reversed_flow

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 In the Model Navigator begin by clicking the Multiphysics button.

2 Select COMSOL Multiphysics>Fluid Dynamics>Incompressible Navier-Stokes, then click 
Add.

3 Select COMSOL Multiphysics>Optimization and Sensitivity>Optimization, then click 
Add.

4 Click OK to close the Model Navigator.

G E O M E T R Y  M O D E L I N G

1 Create three rectangles according to the following table. For each rectangle, 
Shift-click the Rectangle/Square button on the Draw toolbar; then specify width, 
height, and corner position; and finally click OK.

2 Click the Zoom Extents button to fit the model geometry to the drawing area.

3 Draw a point at the center of the channel by shift-clicking the Point button and then 
entering 5e-3 and 0.5e-3 in the x and y edit fields, respectively.

The geometry should now look like that in Figure 11-1.

C O N S T A N T S  A N D  E X P R E S S I O N S

1 From the Options menu, open the Constants dialog box.

WIDTH HEIGHT CORNER

2.5e-3 1e-3 (0, 0)

5e-3 1e-3 (2.5e-3, 0)

2.5e-3 1e-3 (7.5e-3, 0)
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2 Define constants according to the following table (the descriptions are optional):

The purpose of the constant u0 is to introduce a rough velocity scale that you can 
use to make the objective function dimensionless with a value of the order 1.

3 Click OK to close the dialog box.

4 Choose Options>Expressions>Subdomain Expressions.

5 Select Subdomain 2, then enter names and expressions according to the following 
table:

6 Click OK.

P H Y S I C S  S E T T I N G S

Subdomain Settings—Incompressible Navier-Stokes
1 From the Model Tree or the Multiphysics menu, select the Incompressible 

Navier-Stokes (ns) application mode.

2 From the Physics menu, open the Subdomain Settings dialog box.

3 Select all subdomains, and type rho in the Density edit field and eta in the Dynamic 

viscosity edit field.

4 Select Subdomain 2, and type -alpha*u in the Volume force, x dir. edit field and 
-alpha*v in the Volume force, y dir. edit field.

5 Click OK.

Boundary Conditions—Incompressible Navier-Stokes
In the next steps, you specify the pressure drop along the channel length by prescribing 
the pressure at the inlet and at the outlet. The resulting pressure gradient drives the 
flow in the channel.

NAME EXPRESSION DESCRIPTION

q 1 Optimization parameter

Da 1e-5 Darcy number

L 1[mm] Inlet height

rho 1e3[kg/m^3] Density of water

eta 1e-3[Pa*s] Viscosity of water

u0 10[mm/s] Flow velocity scale

NAME EXPRESSION

alpha_max eta_ns/(Da*L^2)

alpha alpha_max*q*(1-gamma)/(q+gamma)
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1 From the Physics menu, open the Boundary Settings dialog box.

2 Enter the boundary conditions according to the following table:

Keep all other boundaries at the default condition, which is the no-slip condition.

3 Click OK.

Subdomain Settings—Optimization
1 From the Model Tree, select Optimization (opt).

2 Open the Subdomain Settings dialog box.

Only the center part of the channel geometry is needed in the optimization, so you 
can deactivate the other subdomains.

3 Select Subdomains 1 and 3, and then clear the Active in this domain check box.

4 Select Subdomain 2 and go to the Variables page.

5 Edit the fields according to the following table:

This defines shape functions for gamma, which is the design variable used in the 
optimization. The initial value 1 corresponds to a channel free from porous material. 
In the next step, you constrain the design variable to the range [0, 1].

6 Click the Pointwise Constraints tab.

7 Type 0 in the lb field, gamma in the Expression field, and 1 in the ub field.

8 Click OK.

Point Settings—Optimization
1 Choose Physics>Point Settings.

2 Select Point 5 from the list. On the Objective page, type u/u0 in the q0 edit field.

This defines the objective function to be proportional to the x-component of the 
velocity at the center and normalized by the velocity-scale constant u0.

3 Click OK.

SETTINGS BOUNDARY 1 BOUNDARY 10

Boundary type Inlet Outlet

Boundary condition Pressure, no viscous stress Pressure, no viscous stress

p0 2 0

VARIABLE INIT ELEMENT

gamma 1 Lagrange - Linear
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M E S H  G E N E R A T I O N

This model is naturally highly dependent on the mesh size. In this example, choose a 
dense mesh; note, however, that this mesh can be further improved.

1 From the Mesh menu, open the Free Mesh Parameters dialog box.

2 On the Global page, click the Custom mesh size button.

3 In the Element growth rate edit field, type 1.1.

4 Click the Subdomain tab. Select all three subdomains.

5 In the Subdomain mesh parameters area, select Triangle from the Method list.

6 Select Subdomain 2 only, then set the Maximum element size to 0.12e-3.

7 On the Point page, select Point 5 and set the Maximum element size to 0.03e-3.

8 Click the Remesh button to generate the mesh.

9 When the mesher has finished, click OK to close the Free Mesh Parameters dialog box.

Computing the Solution—Static Flow

First solve the model for an empty channel (that is, with no porous material) to check 
that the initial solution looks reasonable. Once you have established that this is the 
case, you can use this solution as a starting point for the optimization. Note that, as an 
alternative, it is possible to solve the full optimization problem in one go.

1 Click the Solver Parameters button on the Main toolbar.

2 From the Linear system solver list, select Direct (PARDISO).
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3 Make sure that Optimization/Sensitivity is not selected.

4 Click OK to close the Solver Parameters dialog box.

5 Click the Solve button to compute the solution.

The default plot shows the velocity field in the channel.

C O M P U T I N G  T H E  S O L U T I O N — O P T I M I Z A T I O N

1 Open the Solver Parameters dialog box.

2 Select the Optimization/Sensitivity check box, then click the Optimization/Sensitivity 
tab.

3 From the Analysis list, select Optimization.

4 On the Stationary page, clear the Highly nonlinear problem check box. The reason 
behind this setting is that the model already has the correct solution for the starting 
point of the optimization. It assumes that at each optimization step the solution 
from the previous step is a good initial guess of the solution. If this assumption is 
not correct, it may be necessary to select the Highly nonlinear problem check box.

5 Click OK to close the Solver Parameters dialog box.

6 Open the Solver Manager.
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7 On the Initial Value page, click the Current solution button in the Initial value area, 
then click OK.

8 Click the Solve button on the Main toolbar to solve the model.

The optimization routine requires approximately 90 steps requiring about 150 model 
evaluations and takes about 10 to 15 minutes depending on the computer.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the velocity field. To evaluate the horizontal velocity in the 
center of the channel, follow these steps:

1 Choose Postprocessing>Point Evaluation.

2 Select Point 5 from the list.

3 In the Expression edit field, enter u.

4 Click OK.

The value appears in the lower part of the interface and should be about −0.013 m/s.

To plot the design variable, γ, as seen in Figure 11-2, do the following:

1 Click the Plot Parameters button on the Main toolbar.

2 Click the Surface tab. Type gamma in the Expression edit field on the Surface Data page 
or select Optimization (opt)>gamma from the Predefined quantities list.

3 Click Apply to generate the plot.

4 Click the Zoom In button on the Main toolbar twice to zoom in on the geometry.

To generate the pressure plot in Figure 11-4 proceed as follows:

1 Still on the Surface Data page, change the text in the Expression edit field to p.

2 Click Apply.

Finally, generate Figure 11-3 with the following instructions:

1 Change the text in the Expression edit field to u (or select Incompressible 

Navier-Stokes (ns)>x-velocity from the Predefined quantities list).

2 From the Unit list, select mm/s.

3 Click the Contour tab and select the Contour plot check box.

4 On the Contour Data page, type gamma in the Expression edit field.

5 In the Contour levels area, click the Vector with isolevels option button and then type 
0.5 in the associated edit field.
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6 In the Contour color area, click first the Uniform color option button and then the 
Color button.

7 In the Contour Color dialog box select black, then click OK.

8 Clear the Color legend check box.

9 Click the Streamline tab and select the Streamline plot check box.

10 Leave the default selection (Velocity field) on the Streamline Data page.

11 From the Streamline plot type list, select Magnitude controlled.

12 On the Density page, set the Density to 10.

13 On the Line Color tab, click the Color button.

14 In the Streamline Color dialog box select white, then click OK.

15 In the Plot Parameters dialog box, click OK to close the dialog box and generate the 
plot.
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 12
G l o b a l  E q u a t i o n s  a n d  O D E s
This chapter describes the use of COMSOL Multiphysics to solve global equations 
such as ODEs, algebraic equations, and transcendental equations. You can solve 
such equations separately or coupled to a full finite-element model. Quick examples 
show how to specify and solve these types of equations.
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S o l v i n g  ODE s  and G l o b a l  Equa t i o n s

Adding ODEs and Other Global Equations

When working on complex models, you frequently need to introduce single named 
degrees of freedom, or states, which are not logically related to any particular point in 
space, and their corresponding equations. In particular, such situations arise when 
modeling physics in interaction with an external system, for example, a controller or 
an electrical circuit built from standard components. It is often possible to describe 
such systems by a system of ordinary differential equations, ODEs, with a limited 
number of degrees of freedom.

The Global Equations dialog box is designed for implementing this type of external 
equation, tightly coupled to a PDE model in a physical domain. You can use it for 
ODEs, differential algebraic equations, purely algebraic equations and conditions, and 
transcendental equations, or to add degrees of freedom to a PDE using the introduced 
states. Possible uses include:

• Controllers (see “Process Control Using a PID Controller” on page 331 in the 
COMSOL Multiphysics Model Library)

• Rigid-body mechanics (see “Terminal Falling Velocity of a Sand Grain” on page 220 
in the COMSOL Multiphysics Model Library)

• Nonlinear eigenvalue problems

• Continuation

• Integral constraints (see “The Two-Term Boltzmann Equation” on page 183 in the 
COMSOL Multiphysics Model Library)

• Augmented or generalized equations (see “Stress-Optical Effects with Generalized 
Plane Strain” on page 467 in the Structural Mechanics Module Model Library, 
also available in the RF Module Model Library)

The Global Equations Dialog Box

To add a space-independent equation such as an ODE, choose Global Equations from 
the Physics menu. On the States page, each row corresponds to a named state, that is, 
a single degree of freedom. Fill in the name of the state variable in the first column 
(Name (u)). This also defines time-derivative variables. If a state variable is called u, its 
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first and second time derivatives are ut and utt, respectively. These variables become 
available in all domains in all geometries. Therefore the names must be unique. 

Figure 12-1: The Global Equations dialog box, States page. The ODEs in the dialog box 
are the Lotka-Volterra or predator-prey equations.

Use the Equation column to specify an expression that is set equal to zero and added 
to the global system of equations. You can use all state variables and their time 
derivatives as well as any constants, global expression variables, and 
integration-coupling variables with a global destination. Setting an equation for a state 
is optional. The default value of 0 means that COMSOL Multiphysics does not add 
any additional condition to the model.

If the time derivative of a state variable appears somewhere in the model during a 
time-dependent solution, the state variable needs an initial condition. Models that 
contain second time derivatives also require an initial value for the first time derivatives 
of the state variables. You set these conditions in the third (Init (u)) and fourth 
(Init (ut)) columns. The last column, Description, gives you the option to enter 
comments about the state or the equation.

Solving ODEs—the Lotka-Volterra Equations

As an example, the ODEs in Figure 12-1 are the Lotka-Volterra equations:

r· ar br f–=

f· c f– dr f+=
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where r is the rabbit population, and f  is the population of foxes.

Another option is to enter equations in the weak form on the Weak page. This is 
convenient in advanced modeling because it gives you control over the test variables 
multiplying the equations. Wherever a test function of a state variable appears (in the 
Global Equations dialog box or elsewhere in the model), whatever it multiplies ends up 
in the same equation in the discrete system. On the Weak page you can also use test 
functions of integration-coupling variables. This way you can keep the definition of a 
controller and its influence on a PDE in the same dialog box. Note that you can have 
zero or more weak expressions, regardless of the number of states.

Figure 12-2: The Global Equations dialog box, entering an ODE in the weak form.

To postprocess the solution to an ODE, type the name of the state variable in the 
Expression edit field in most postprocessing dialog boxes, for example, on the Point 
page in the Domain Plot Parameters dialog box for a plot of the time evolution. The 
state variables are available globally so you can select any point in the geometry.

Solving Algebraic and Transcendental Equations

As an example of an algebraic equation, consider the following:

This equation has a single root at u = 1. To enter it into the Global Equations dialog 
box, type u in the Name (u) column and u^3+u-2 in the Equation column (both entries 
on the same row). Then click the Solve button on the Main toolbar to compute the 

f u( ) u3 u 2–+=
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solution. To display the solution in the message log, choose Postprocessing>

Data Display>Global and type u in the Expression edit field in the Global Data Display 
dialog box. Click Apply, and Value: 1, Expression: u appears in the message log.

As an example of a transcendental equation, consider the following:

A root to this equation is approximately 0.56714. To enter it into the Global Equations 
dialog box, type u in the Name (u) column and exp(-u)-u in the Equation column 
(both entries on the same row). Then click the Solve button on the Main toolbar to 
compute the solution. To display the solution in the message log, choose 
Postprocessing>Data Display>Global and type u in the Expression edit field in the Global 

Data Display dialog box. Click Apply, and Value: 0.567143, Expression: u appears in the 
message log.

Adding an ODE to a Boundary

Sometimes a boundary equation is coupled to a PDE in an adjacent subdomain. For 
example, adding an ODE for v on a boundary such that

where u is the dependent variable in an adjacent subdomain. To implement an ODE 
on a boundary, do the following:

1 Add a Weak Form, Boundary application mode.

2 Go to the Physics menu and choose Boundary Settings. In the Boundary Settings 
dialog box, select the boundary or boundaries where you want to defined the ODE.

3 Click the Weak tab and type v_test*u in the weak edit field and v_test*v_time in 
the dweak edit field. This is the weak formulation of the ODE.

4 Select the remaining boundaries where there is no ODE and then clear the Active in 

this domain check box to exclude these boundaries.

5 When done, click OK.

Also keep in mind that there must be no constraint (Dirichlet condition) for u on the 
boundaries where you defined the ODE.

f u( ) e u– u–=

∂v
∂t
------ u=
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 13
T h e  W e a k  F o r m
This chapter explains weak form modeling, its purpose, and how to use it. The 
weak form in COMSOL Multiphysics is a particular way of specifying a model, one 
in which you use a more general syntax to describe the problem. The discussion 
concludes with a section giving some theoretical background.

Do not be misled by the term “weak:” the weak form is very powerful and flexible. 
We have borrowed the term weak form  from mathematics, but in this context it 
has a slightly different meaning; this implementation incorporates features in 
addition to those defined in the mathematical weak form. Moreover, knowledge of 
the mathematical weak form is not prerequisite to using the COMSOL 
Multiphysics implementation.

The distinguishing features of the weak form in COMSOL Multiphysics are that it 
makes it possible to:

• Solve strongly nonlinear and nonlocal models that need an exact Jacobian for 
convergence.

• Enter certain equations which can be derived from an energy principle in a very 
compact and convenient form. Such equations, for example, arise in structural 
mechanics.
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• Add and modify nonstandard constraints, such as various contact and friction 
models.

• Build models with PDEs on boundaries, edges, and points.

• Use the test operator to conveniently work with problems in variational calculus and 
parametric optimization.

COMSOL Multiphysics provides two different ways of modeling with the weak form:

• Weak form application modes

• Weak form contributions

In addition, you can add weak constraints, which, for example, provide accurate fluxes 
and reaction forces.

There are many additional benefits of the weak form, and we mention some of them 
in the context of specific models in other books in this documentation set.
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Weak Fo rm Mode l i n g

The weak form application modes enable all of the weak form features outlined above. 
In particular, you need to use these application modes for models with separate PDEs 
on boundaries, edges, or points. However, modeling with the weak form does not 
always require using the weak form application modes; sometimes adding weak form 
contributions  is sufficient, as described below.

By default, all models are converted to the weak solution form before solving. 
Although this feature is a part of the solution technique rather than part of the 
modeling process, it nonetheless belongs in this discussion because it is based on the 
weak form implementation. Using the weak solution form gives you the most 
important benefit of the weak form—the exact Jacobian necessary for fast convergence 
of strongly nonlinear problems—while you can still do the modeling and view the 
equations in the equation form of your choice.

The discussion in this chapter reviews the easiest ways to work with the weak form 
before going on to describe the weak form application modes.

Adding Weak Form Contributions

To add weak contributions to a model you are describing in a physics mode, follow 
these steps:

1 In the Physics menu, point to Equation System and then select Subdomain Settings, 
Boundaries Settings, Edge Settings, or Points settings depending on where you need 
to add the contributions.

2 In the corresponding dialog box, click the Weak tab.

3 Enter the weak contribution in the weak or dweak edit fields.

To add weak contributions to a model you are describing in a coefficient form or 
general form PDE mode, use the Subdomain Settings dialog box and other settings 
directly available in the Physics menu.

A D D I N G  E D G E  A N D  PO I N T  S O U R C E S  A N D  C O N S T R A I N T S

Using weak form contributions, you can also add sources and constraints on edges and 
points. The section “Specifying Point and Edge Settings” on page 254 in the 
COMSOL Multiphysics User’s Guide describes the procedure.
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A D D I N G  WE A K  C O N S T R A I N T S

The weak form can assist in making accurate flux or reaction-force computations. The 
section “Using Weak Constraints” on page 350  describes how to use weak constraints 
for this purpose.

VA R I A T I O N A L  C A L C U L U S

Use the test operator to conveniently work with problems in variational calculus and 
optimization theory.

Modeling with PDEs on Boundaries, Edges, and Points

The weak form makes it possible to do PDE modeling on boundaries, edges, and 
points, thus opening up a wider class of models than the other application modes. This 
is the only type of modeling where you need the weak form application modes.

Using weak form application modes is also a smart way of handling thin layers; 
COMSOL Multiphysics then solves the problem by modeling rather than meshing. 
This approach reduces the solution time, and is sometimes what makes a solution 
possible at all.

The model “Transport and Adsorption” on page 32 of the COMSOL Multiphysics 
Model Library shows how to use the weak form boundary mode to model a thin 
adsorbtion layer with diffusion as a PDE on the boundary of a convection-diffusion 
problem. Another model using tangential derivative variables is “Shell Diffusion” on 
page 153 of the COMSOL Multiphysics Model Library.

Using Weak Coefficients or the Weak Modes

U S I N G  T H E  WE A K  S O L U T I O N  F O R M

By using the weak solution form (the default solution form) you can model with one 
of the strong forms of the PDE using, for example, the PDE application modes, yet 
still take advantage of some of the abilities of the weak form. COMSOL Multiphysics 
converts all your equations to the weak form before solving the problem. 
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WE A K  F O R M  V S .  S T R O N G  F O R M S

Some features in COMSOL Multiphysics are available only in either strong or weak 
form. When a feature is available in the weak form but not in a strong form, you can 
always

• Display and modify the equations in the weak form using the weak equation system 
form

• Convert to the weak form when solving using the weak solution form (this is the 
default behavior)

When a feature is available only in a strong form, however, you must model using this 
form.

Strong Form Features
• When using residual method Coefficient, the adaptive mesh refinement considers 

only the strong form coefficients when computing the error estimators. The default 
residual method Weak accounts for all contributions, on weak and strong form.

• The equation variables and coupled boundary equation variables are available only 
for the strong forms.

Weak Form Features
The weak form automatically computes the Jacobian contributions for all variables, 
including coupling variables. The strong forms only consider Jacobian contributions 
from coefficients. Thus, to get an accurate Jacobian when dealing with for example 
coupling variables and mixed time-space derivatives you might have to use the weak 
solution form.
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U s i n g  Weak Con s t r a i n t s

The weak constraints feature in COMSOL Multiphysics implements constraints by 
using finite elements on the constrained domain for the Lagrange multipliers, and by 
solving for the Lagrange multipliers along with the original problem. The weak 
constraints have a number of distinct advantages. They can:

• Provide very accurate flux computations—the Lagrange multipliers along the 
constraints optimally balance the finite element projection of the applied loads 
(reaction forces). See “Computing Accurate Fluxes” on page 266 in the COMSOL 
Multiphysics User’s Guide  for more information and an example. For computing 
integrals of reaction forces or fluxes during postprocess, the reaction force operator 
(reacf) is a better alternative than weak constraints. See the section “The reacf 
operator” on page 167 of the COMSOL Multiphysics User’s Guide. The reaction 
force operator does not have the drawbacks discussed below.

• Handle nonlinear constraints—the nonlinear solver does not store the Lagrange 
multipliers arising from standard constraints from one step to the next, which affects 
the convergence when constraints are nonlinear. Weak constraints can handle 
general nonlinearities because the Lagrange multipliers are updated as a part of the 
solution vector and give correct contributions to the stiffness matrix.

• Implement constraints including derivatives—constraints only on the tangential 
component of the derivative work when using standard constraints, whereas you 
must use weak constraint to be able to handle nontangential constraints. Note that 
boundary conditions involving the normal component of the derivative can almost 
always be reformulated as a Neumann condition, which is usually preferable.

Weak constraints also come with the following drawbacks:

• Because extra unknowns are introduced for the Lagrange multipliers the problem 
size increases compared to when eliminating the constraints.

• The formulation normally implies that a saddle-point problem is introduced with 
zeros on the main diagonal of the Jacobian of the discretized equations. This class 
of problems is often more difficult to solve. Because iterative methods for linear 
systems are sensitive to the eigenvalue distribution of the system matrix, a weak 
constraint formulation can be much more difficult to solve than the corresponding 
pointwise constraint formulation.

• Discontinuous constraints result in (theoretically) infinite Lagrange multipliers. In 
practice you get large oscillations.
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Specifying Weak Constraints

In the graphical user interface you can add weak constraints using the Weak constraints 
application mode property. The following procedure applies to the physics modes:

1 From the Physics menu select Properties.

2 In the Application Mode Properties dialog box, select On from the Weak constraints 
list.

3 Select Ideal or Non-ideal from the Constraint type list (see “Ideal vs. Non-Ideal 
Constraints” on page 351).

4 Click OK.

The variable names in the application modes using weak constraints, such as lm1, 
correspond to the Lagrange multipliers. The weak constraints supersede the original 
constraints and implement them using a weak formulation. By default, weak 
constraints are active on all boundaries. To control the use of weak constraints on 
individual boundaries, open the Boundary Settings dialog box and click the Weak 

Constr. tab. On this tab, which appears when you add weak constraints, you can select 
boundaries and then select or clear the Use weak constraints check box to include or 
turn off the weak constraints for the selected boundaries. You can also set element type, 
shape function, and initial values for the weak constraint variables (Lagrange 
multipliers).

I D E A L  V S .  N O N - I D E A L  C O N S T R A I N T S

Ideal weak constraints in theory implement the same boundary conditions as the 
standard, pointwise, constraints. In some cases, the result may differ slightly, but this 
is only due to the different discretization. Using non-ideal constraints, on the other 
hand, modifies the way boundary conditions are interpreted. Switching from pointwise 
constraints to non-ideal weak constraints therefore can modify the physics of the 
model, while using ideal weak constraints only affects the numerics.

The difference between ideal and non-ideal constraints is the way the Lagrange 
multipliers—which can be interpreted as generalized reaction forces—are applied. In 
an ideal constraint, the Lagrange multipliers are applied symmetrically on all 
dependent variables involved in the constraint so as to keep symmetric problems 
symmetric. In a non-ideal constraint, the reaction forces are applied only on the 
application mode’s dependent variable at the boundary where the constraint is 
specified.
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Imagine a model with two application modes A and B, with dependent variables u and 
v, respectively. If application mode A specifies a standard constraint as R = 2u − 3v = 0, 
COMSOL Multiphysics implements the ideal weak boundary constraint by adding the 
weak term

where µ and  are the Lagrange multiplier and corresponding test function, and  
and  are the test functions corresponding to u and v, respectively. Since µ multiplies 
both test functions in the second integral, both u and v are affected by the constraint, 
which is therefore bidirectional.

The corresponding non-ideal weak constraint adds the weak form contribution 

Here, the Lagrange multiplier µ only multiplies the test function . All reaction forces 
therefore apply only to u, while v is left unaffected by the constraint. This makes the 
non-ideal constraint unidirectional. Note also that the non-ideal constraint does not 
consider the factor 2 in front of u when applying the forces. Even if the constraint 
would contain spatial derivatives, the Lagrange multiplier would still be applied only 
directly on the dependent variable itself.

For more information on the effects of ideal and non-ideal constraints, see “Example—
Coupling Variables and Boundary Constraints” on page 354. For a model that uses 
ideal weak constraints for accurate outward normal current densities, see 
“Semiconductor Diode” on page 492 of the COMSOL Multiphysics Model Library. 
For a model that uses non-ideal weak constraints to get the correct reaction forces, see 
“Sloshing Tank” on page 259 of the COMSOL Multiphysics Model Library.

Weak Constraints in Assemblies

When using assemblies, the application modes add a constraint on the dependent 
variables on the destination domains of the identity pairs. If you use weak constraints, 
the application modes also turn these constraints into weak constraints. Unlike other 
physics settings on pairs you do not control the use of weak constraints on pairs on the 
Pair tab in the Boundary Settings dialog box. If you would like to change the settings 
for the weak constraints on the destination boundaries of a pair go to the Boundaries 

µ̂ 2u 3v–( )⋅
B
∫ ds µ 2û 3v̂–( ) sd⋅

B
∫+

µ̂ û
v̂

µ̂ 2u 3v–( )⋅
B
∫ ds µ û sd⋅

B
∫+

û
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tab and change the settings there. See the section “Specifying Physics Settings on 
Pairs” on page 415 for general information about physics settings on pairs.

The constraints on pairs, which makes sure that the dependent variables are continuous 
across the pair boundary, are always implemented as ideal constraints. This because the 
non-ideal constraints do not conserve the flux from the source side to the destination 
side of the pair.

Limitations of Weak Constraints

Weak constraints are more difficult to use than conventional pointwise constraints. 
Consider the following tips when using them:

• Pointwise and weak constraints on the same set of variables on adjacent boundaries 
(boundaries that share common node points in the mesh) do not work. This means 
that if you must constrain all boundaries on a solid and want to use a weak constraint 
on one boundary segment (one face), you must use the weak constraint on the 
entire boundary of the solid (if the boundary is connected).

• You must always have a nontrivial constraint (that is, a Dirichlet condition) on the 
boundaries where you enable the weak constraint for the constraint to take effect.

• Problems with the scaling of linear systems sometimes arise in conjunction with 
weak constraints. The Lagrange multiplier variables always have a different unit than 
the main system variables, and can therefore be of a completely different order of 
magnitude. Usually the automatic variable scaling in the solvers is sufficient, but 
there are cases when you may want to consider manual scaling.

• Always use the same shape function type for the weak constraint as for the variables 
that you constrain, possibly with lower-order elements for the weak constraint. In 
some cases, for example when constraining derivatives, the system of equations may 
become singular. The reason is usually that there are redundant Lagrange multiplier 
degrees of freedom in the model. Try to lower the order of the Lagrange multiplier 
variables, or use constraints on the Lagrange multiplier to remove some degrees of 
freedom.

• If you want to use iterative methods for the linear system and if the weak constraint 
formulation gives zero’s on the diagonal of the system matrix, the SOR class of 
preconditioners and smoothers will not work. Instead try use the Vanka algorithm 
with the Lagrange multipliers as the Vanka variables, or use the incomplete LU 
factorization algorithm.
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Examp l e—Coup l i n g  V a r i a b l e s  and 
Bounda r y  Con s t r a i n t s

Boundary Constraints in a Heat Transfer Model

This example describes the difference between different boundary constraints when 
using a coupling variable to map a function of a solution from one boundary to 
another. 

Consider the following example:

M O D E L  N A V I G A T O R

1 In the Model Navigator, select 2D in the Space Dimension list.

2 In the list of application modes, select COMSOL Multiphsyics>Heat 

Transfer>Conduction>Steady-state analysis.

G E O M E T R Y  M O D E L I N G

1 Draw a rectangle with diagonal corners at (0, 0) and (2, 1).

2 Draw a circle with center at (1, 0.5) and radius 0.1.

3 Subtract the circle from the rectangle to create a hole: Press Ctrl+A to select both 
objects and click the Difference button.

P H Y S I C S  S E T T I N G S

Boundary Conditions
1 From the Physics menu, open the Boundary Settings dialog box.

2 Select the boundaries of the circle (Boundaries 5–8) and select Temperature in the 
Boundary condition list. Type 300 in the Temperature edit field to specify the value of 
the fixed temperature (in kelvin). The circle then acts as a heat sink.

3 Select Boundary 3 (the top boundary) and then select Heat flux in the Boundary 

condition list. Type 10000*x in the Inward heat flux edit field. This creates a heat flux 
of 0 to 20,000 W/m2, which increases linearly from left to right.

4 The other boundaries are thermally insulated, which is the default setting. Click OK 
to close the Boundary Settings dialog box.
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Subdomain Settings
There are no changes to the settings in the Subdomain Settings dialog box (the default 
material properties are for copper).

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button (=) on the Main toolbar (or select Solve Problem from the Solve 
menu) to solve the problem.

The maximum temperature, about 340 K, appears in the upper-right corner.

Now, what if you want to set the temperature along the left boundary of the rectangle 
equal to the average temperature of the right boundary? To do so, you can use an 
integration coupling variable, which computes the average temperature of the right 
boundary and stores the value in a variable.

O P T I O N S  A N D  S E T T I N G S

1 From the Options menu, choose Integration Coupling Variables>Boundary Variables.

2 Select Boundary 4 (the rightmost boundary). Define an integration coupling 
variable Tint for the integrated temperature in the top row by typing Tint in the 
Name column and T in the Expression column. Also, define a second variable on the 
next row with the name blen and an expression (integrand) that is 1. The variable 
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Tint stores the value of the integral of T along the boundary, and the variable blen 
stores the value of the length of the boundary. The average temperature then 
becomes Tint/blen.

3 Click OK to close the Boundary Integration Variables dialog box.

B O U N D A R Y  C O N D I T I O N S

4 From the Physics menu, open Boundary Settings.

5 Select Boundary 1 (the leftmost boundary) and then select Temperature from the 
Boundary condition list.

6 Type Tint/blen in the Temperature edit field.

7 Click OK to close the Boundary Settings dialog box.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar.

The maximum temperature is about 332 K close to, but not exactly in, the upper-right 
corner. The default type of boundary constraint in COMSOL Multiphysics is an ideal 
boundary constraint, which is a bidirectional constraint. COMSOL Multiphysics 
supports two different kinds of ideal boundary constraints: pointwise and weak. Now 
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switch to a unidirectional, or non-ideal, boundary constraint, and solve the modified 
problem.

P H Y S I C S  S E T T I N G S

1 From the Physics menu, select Properties.

2 Select On from the Weak constraints list and Non-ideal from the Constraint type list to 
change from no weak constraints (equal to pointwise ideal constraint) to non-ideal 
weak constraints.

3 Click OK to close the Application Mode Properties dialog box.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to solve the problem with the modified 
constraints.

This time the maximum temperature is about 341 K, in the exact upper-right corner.

PO S T P R O C E S S I N G

Do the following steps if you want to check that this is the average temperature:

1 From the Postprocessing menu, select Data Display>Global.
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2 For the Expression to evaluate, type Tint/blen. Click OK.

This displays the average temperature value, about 327 K, in the message log. To 
compare this with the values in the plot, just click close to the left boundary. This 
displays the solution at the grid locations of the background grid, which you can see 
in the Draw mode. The same value appears for all points on the left boundary.

The subsequent sections explain the differences between the different types of 
boundary constraints.

No Weak Constraints

The pointwise ideal boundary constraint is what you get if you select Off from the Weak 

constraints list and Ideal from the Constraint type list. These are the default settings and 
correspond to the most common type of boundary constraint for virtually all boundary 
conditions of the Dirichlet type. In the previous example, when using the pointwise 
ideal boundary constraint together with the integrated coupling variables, the 
coupling is bidirectional.

Weak Ideal Constraints

The weak ideal boundary constraint gives the same result as if the weak constraints are 
turned off, except that using weak ideal constraints adds an additional dependent 
variable (known as a Lagrange multiplier), which you can use for extremely accurate 
postprocessing.

If you select Ideal from the Constraint type list in the previous example, you get the 
same solution. If you then open the Solver Manager and click the Solve For tab, the list 
of variables to solve for contains an additional dependent variable. The name of this 
Lagrange multiplier variable is lm1. The Lagrange multiplier is available for 
postprocessing via boundary integration on boundaries and provides an accurate value 
for the integrated flux.

Weak Non-Ideal Constraints

The weak non-ideal boundary constraints gives a different solution. In this case the 
coupling is unidirectional, and it provides information transfer from the right 
boundary to the left boundary but not the other way around. The left boundary and 
the solution in the vicinity of the left boundary do not affect the solution at the right 
boundary. This type of unidirectional constraint can be explained intuitively as a 
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controller that senses the average temperature at the right boundary and forces the 
temperature at the left boundary to take this value. The left boundary has, however, 
no way of telling the right boundary of its temperature.

In general, use non-ideal boundary constraints for automatic control design and 
similar applications, where values from one part of the solution are “forced upon” 
another part of the solution. On the other hand, use ideal boundary constraints for 
problems where the model is “left by itself,” and the laws of nature balance the 
solution to an energy minimum (or, for problems with no well-defined energy, a saddle 
point).

Whenever using coupling variables in constraint expressions as in this example, make 
sure you do not use a different constraint at an adjacent boundary, because this would 
most likely create an ill-posed problem with no well-defined solution.
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Th eo r e t i c a l  Ba c k g r ound

The mathematical weak form gives you direct access to the terms of the weak equation 
and provides maximum freedom in defining finite element problems. This section 
provides a theoretical background to the weak form in COMSOL Multiphysics.

Deriving the Weak Form

Before describing what the weak form is, this discussion first looks at the conversion 
of a simple problem in general form to the weak form.

Consider a stationary PDE problem for a single dependent variable, u, in two space 
dimensions: 

Now let v be an arbitrary function on Ω, and call it the test function (v should of 
course belong to a suitably chosen well-behaved class of functions, V). Multiplying the 
PDE with this function and integrating leads to

where dA is the area element. Now use Green’s formula (Gauss’ formula) to integrate 
by parts:

where ds is the length element. Then use the Neumann boundary condition

to arrive at the following equation:

∇ Γ⋅ F in Ω=

v∇ Γ⋅ Ad
Ω
∫ vF Ad

Ω
∫=

vΓ n⋅ sd
Ω∂
∫ v∇ Γ⋅ Ad

Ω
∫– vF Ad

Ω
∫=

n Γ⋅– G
u∂

∂Rµ+=

0 v∇ Γ⋅ vF+( ) Ad
Ω
∫ v G

u∂
∂Rµ+⎝ ⎠

⎛ ⎞ sd
Ω∂
∫+=
 1 3 :  T H E  W E A K  F O R M



Together with the Dirichlet condition, this is a weak reformulation of the original PDE 
problem. Note that the requirement is that the above weak equation should hold for 
all  test functions v. You can reverse the steps of the derivation to show that if the 
functions u and µ satisfy the weak formulation, then they also satisfy the original 
formulation. However, this holds true only if the solutions and coefficients are 
sufficiently smooth. For instance, in the case of discontinuities in material properties, 
you can have a solution of the weak formulation while the strong formulation has no 
meaning. The names “weak” and “strong” stem from this distinction: the weak 
formulation is a weaker condition on the solution than the strong formulation. A 
benefit of the weak formulation is that it requires less regularity of Γ. This is important 
in the finite element method.

For the most part, the weak reformulation of a system of equations in general form is

where you use the summation convention. If the boundary conditions are given on 
interior boundaries, ∂Ω can be enlarged to include these. You now have several test 
functions v1, v2, …, vN, one for each of the original PDEs. The weak equation is 
required to hold for all test functions (in the suitably chosen function space V). Of 
course, in three dimensions, for dA and ds you must substitute the volume and surface 
area elements, respectively. In one dimension, for dA substitute the length element, 
and interpret the boundary integral as a sum over the boundary points.

Weak Form Application Modes

In COMSOL Multiphysics you can add weak form PDEs on all domain levels. From 
the PDE Modes folder in the Model Navigator, select from:

•  Weak Form, Subdomain

•  Weak Form, Boundary

•  Weak Form, Edge (3D only)

•  Weak Form, Point

The Weak Form, Boundary application modes are of great use when you must define 
a PDE on a boundary and couple this equation to an equation in a subdomain. A 

0 vl∇ Γl⋅ vlFl+( ) Ad
Ω
∫ vl Gl ul∂

∂Rmµm+
⎝ ⎠
⎜ ⎟
⎛ ⎞

sd
Ω∂
∫+=

0 Rm on ∂Ω=
⎩
⎪
⎪
⎨
⎪
⎪
⎧
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typical example exists in adsorption processes when you are coupling a material balance 
of the adsorbed species on the boundary to the material balance of a species defined in 
the domain (see “Transport and Adsorption” on page 32 of the COMSOL 
Multiphysics Model Library).

In addition, you can add weak form contributions to other application modes on the 
Weak page in the Subdomain Settings, Boundary Settings, Edge Settings, and 
Point Settings dialog boxes.

For an example of how to use a weak form contribution to implement a point source, 
see “Implementing a Point Source” on page 279.

VA R I A T I O N A L  P R I N C I P L E S

This section provides some background on the weak formulation. You can eliminate 
the Lagrange multipliers from the weak equation in the previous section by 
introducing the following boundary conditions on the test functions:

This means that the functions ul + vl satisfy the linearized version of the Dirichlet 
boundary conditions. Then the weak formulation becomes the following: find 
functions ul such that

holds for all test functions vl that satisfy the above boundary condition. Such a 
formulation arises when you have a variational principle; for instance, to find the 
functions ul that minimizes the energy of some physical system under the constraints 
0 = Rm. If the energy is given as an integral of some expression involving the ul, then 
the stationarity condition on the solution is precisely the weak formulation above. 
Because variational principles are more fundamental than the corresponding PDE, the 
weak form is often more natural than the strong forms. The connection to variational 
principles also shows why the term involving the Lagrange multipliers takes the form 
it does (that is, how ideal constraints come about). 

0
ul∂

∂Rmvl on ∂Ω=

0 vl∇ Γl⋅ vlFl+( ) Ad
Ω
∫ vlGl sd

Ω∂
∫+=

0 Rm on ∂Ω=
⎩
⎪
⎪
⎨
⎪
⎪
⎧
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T H E  WE A K  F O R M  P D E  S T R U C T U R E

Now consider what a problem on the weak form can look like. It can be more general 
than the weak equations derived from the general form above because it also contains 
integrals over edges (in 3D) or points (in 2D and 3D). Similarly, you can also have 
constraints on subdomains, edges, and points. Further, expressions occurring in the 
integrands can be more or less arbitrary functions of the variables ul, the test functions 
vl, and their derivatives. One important restriction, though, is that the test functions 
enter linearly. A problem in weak form has the following structure (in 2D):

The first equation is the weak equation, and the others are the constraints. Here Ω is 
the subdomain, B is the boundary (including ∂Ω and interior boundaries), and P 
represents the vertices (points) defined in the geometry. The integrands W(n), which 
correspond to the sum of all weak field entries for dimension n, are scalar expressions 
involving the dependent variables u1, u2,..., uN as well as the test functions v1, v2,..., 
vN and their derivatives. You must enter the test functions and their derivatives linearly. 
For instance, you can have

The integrands W(nt) which correspond to the dweak fields have exactly the same form 
as the W(n), but enter with opposite sign. 

The quantities R(i) occurring in the constraints are vector-valued functions of the 
dependent variables. Sometimes they also depend on the derivatives of the dependent 
variables. In such cases there are additional terms accounting for this dependence in 
the integrals with Lagrange multipliers. Note that you now also can have Lagrange 
multipliers on subdomains (µ(2)) and on vertices (µ(0)).

0 W 2( ) W 2t( )
–( ) Ad

Ω
∫ W 1( ) W 1t( )

–( ) sd
B
∫ W 0( ) W 0t( )

–( ) +

P
∑+ +=

vl ul∂
∂Rm

2( )

µm
2( ) Ad

Ω
∫ vl ul∂

∂Rm
1( )

µm
1( ) sd

B
∫ vl ul∂

∂Rm
0( )

µm
0( )

P
∑+ + +

0 R 2( )
= on Ω

0 R 1( )
= on B

0 R 0( )
= on P  

W 2( ) v1 x∂
∂u2

x∂
∂v2 u1sin

y2

2

∂

∂ v1+ +=
T H E O R E T I C A L  B A C K G R O U N D  |  363



364 |  C H A P T E R
In 3D, contributions to the weak equation and the constraints can also come from 
edges (curves). 

C O N V E R S I O N  T O  WE A K  F O R M

It is possible to convert equations in coefficient form or general form to weak form by 
setting the equation system form to weak using the Equation system form list in the 
Model Settings dialog box, which opens from the Physics menu. To view the result of 
the conversion, go to the Physics menu, point to Equation System and then click on a 
domain type settings command. COMSOL Multiphysics also carries out this 
conversion conceptually in the finite element method. The following equations 
describe the obtained weak form problem as well as problems given directly in weak 
form. For simplicity this discussion considers a stationary problem in 2D.

Here v is a vector whose components are the test functions vl, while µ(d) are column 
vectors of Lagrange multipliers µm

(d). The elements of matrices h(d) are

for a problem given directly in weak form. For a problem originally given in coefficient 
form or general form, the vectors R(2) and R(0) as well as the Lagrange multipliers µ(2) 
and µ(0) are empty. In addition, W(0) = 0. For the general form you have

For the coefficient form, you have h(1) = h.

For a problem given directly in weak form, the constraints can also depend on variables 
other than the ul (for instance the space derivatives of ul). In such cases, the quantities 

 are augmented with additional terms that account for this dependence.

0 W 2( ) W 2t( )
–( ) Ad

Ω
∫ W 1( ) W 1t( )

–( ) sd
B
∫ W 0( ) W 0t( )

–( )
P
∑+ +=

v h⋅ 2( )Tµ 2( ) Ad
Ω
∫– v h⋅ 1( )Tµ 1( ) sd

B
∫– v h 0( )Tµ 0( )⋅

P
∑–

0 R 2( )
= on Ω

0 R 1( )
= on B

0 R 0( )
= on P  

hml
d( )

ul∂
∂Rm

d( )

–=

hlm
1( )

ul∂
∂Rm–=

v h⋅ d( )T
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Conversion from general form to weak form is performed according to

where there is an implicit summation over repeated indices in each product. The 
superscript (n) is the space dimension, while the superscript 0 marks explicit weak 
contributions added to the general form equation. Note that explicit time derivative 
terms for historical reasons are collected in the W(nt). There is nothing prevent you 
from entering time derivatives in W(n), though.

If you are working with MATLAB, see the entry flform in the COMSOL 
Multiphysics Reference Guide for more information about the conversion to weak 
form.

Entering a PDE in Coefficient Form Using the Weak Form

Derive the weak equation for a coefficient form problem:

Suppose c is a scalar. Using the weak form meta variables for a 2D problem, follow 
these steps:

1 In the weak edit field of Ω in the Subdomain Settings dialog box, type

ux_test*(-c*ux-alx*u+gax)+uy_test*(-c*uy-aly*u+gay)+...
    u_test*(f-bex*ux-bey*uy-a*u)

2 In the weak field of ∂Ω in the Boundary Settings dialog box, type

u_test*(-q*u+g)

W n( ) Γlj xj∂
∂vl Flvl Wl

0 n( )

l
∑+ +=

W nt( ) dalk t∂
∂ukvl Wl

0 nt( )

l
∑+=

W n 1–( ) Glvl Wl
0 n 1–( )

l
∑+=

Rm
n( ) Rm=

0 v∇ c u∇– αu– γ+( )⋅ v f β ∇u au–⋅–( )+( ) Ad
Ω
∫ v qu g hTµ–+–( ) sd

Ω∂
∫+=
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The variables alx, aly, bex, bey, gax, and gay are the components of α, β, and γ, 
respectively. You must replace the coefficients in this weak form expression (for 
example, c, alx and q) with appropriate expressions.

COMSOL Multiphysics automatically adds the Lagrange multiplier µ, while the 
constraint matrix h is specified indirectly by the constraints.
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M u l t i p h y s i c s  M o d e l i n g
This chapter covers the use of COMSOL Multiphysics for multiphysics modeling 
and coupled-field analyses. It first describes the various ways of building 
multiphysics models. Then a step-by-step example shows how to model Joule 
heating (also called resistive heating) taking into account thermal-electric 
couplings.
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C r e a t i n g  Mu l t i p h y s i c s  Mode l s

Multiphysics Modeling Approaches

The ability to create multiphysics models—those with more than one type of physics 
or equation such as coupled-field problems—is one of COMSOL Multiphysics’ most 
powerful capabilities. In such a model, the software can solve all the equations, taken 
from various areas of physics, as one fully coupled system.

Within COMSOL Multiphysics you can choose from several ways to approach 
multiphysics modeling and coupled-field analysis. They all use the Model Navigator to 
specify the application modes and their properties.

Figure 14-1: The Model Navigator for a multiphysics model combining the Conductive 
Media DC and Heat Transfer by Conduction application modes.

Using Predefined Multiphysics Couplings

COMSOL Multiphysics and the add-on modules provide a number of predefined 
multiphysics couplings. They appear in the Model Navigator’s list of application 
modes, in folders with the names in the Category/Folder column in Table 14-1. For 
each predefined multiphysics coupling, there is an entry in the Model Navigator in all 
products that support it. The predefined multiphysics couplings consist of two or more 
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S

application modes that COMSOL Multiphysics adds to a model. In addition, default 
settings provide the typical field couplings for the multiphysics application. The 
available predefined multiphysics couplings vary depending on the installed modules 
(see the following table for details).

TABLE 14-1:  PREDEFINED MULTIPHYSICS COUPLINGS

CATEGORY/ FOLDER NAME SPACE DIMENSION REQUIRED 
MODULES

OPTIONAL 
MODULES

Electro-Thermal 
Interaction

Joule Heating 2D, 2D Axi, 3D None AC/DC, Heat
Transfer, MEM

Electro-Thermal 
Interaction

Perpendicular 
Induction Heating

2D AC/DC Heat Transfer

Electro-Thermal 
Interaction

In-Plane Induction 
Heating

2D AC/DC Heat Transfer

Electro-Thermal 
Interaction

In-Plane 
Microwave 
Heating

2D RF Heat Transfer

Electro-Thermal 
Interaction

Meridional 
Induction Heating

2D Axi AC/DC Heat Transfer

Electro-Thermal 
Interaction

Azimuthal 
Induction Heating

2D Axi AC/DC Heat Transfer

Electro-Thermal 
Interaction

Meridional 
Microwave 
Heating

2D Axi RF Heat Transfer

Electro-Thermal 
Interaction

Induction Heating 3D AC/DC Heat Transfer

Electro-Thermal 
Interaction

Microwave 
Heating

3D RF Heat Transfer

Fluid-Chemical 
Reactions

Reacting Flow 2D, 2D Axi, 3D Chemical 
Engineering

Fluid-Structure 
Interaction

Plane Strain with 
Fluid Interaction

2D Structural 
Mechanics or 
MEMS

Chemical 
Engineering

Fluid-Structure 
Interaction

Axial Symmetry, 
Stress-Strain with 
Fluid Interaction

2D Axi Structural 
Mechanics or 
MEMS

Chemical 
Engineering

Fluid-Structure 
Interaction

Solid, Stress- 
Strain with Fluid 
Interaction

3D Structural 
Mechanics or 
MEMS

Chemical 
Engineering
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Fluid-Thermal 
Interaction

Fluid-Thermal 
Incompressible 
Flow

2D, 2D Axi, 3D None

Fluid-Thermal 
Interaction/Flow 
with Variable 
Density

Non-Isothermal 
Flow (laminar)

2D, 2D Axi, 3D Chemical 
Engineering or 
Heat Transfer

Fluid-Thermal 
Interaction/Flow 
with Variable 
Density

Turbulent 
Non-Isothermal 
Flow

2D, 2D Axi, 3D Chemical 
Engineering or 
Heat Transfer

Thermal-Structural 
Interaction

Plane Stress with 
Thermal 
Expansion

2D Structural 
Mechanics or 
MEMS

Heat Transfer

Thermal-Structural 
Interaction

Plane Strain with 
Thermal 
Expansion

2D Structural 
Mechanics or 
MEMS

Heat Transfer

Thermal-Structural 
Interaction

Axial Symmetry, 
Stress-Strain with 
Thermal 
Expansion

2D Axi Structural 
Mechanics or 
MEMS

Heat Transfer

Thermal-Structural 
Interaction

Solid, Stress- 
Strain with 
Thermal 
Expansion

3D Structural 
Mechanics or 
MEMS

Heat Transfer

Thermal-Structural 
Interaction

Shell with 
Thermal 
Expansion

3D Structural 
Mechanics or 
MEMS, Heat 
Transfer

Thermal-Electric- 
Structural 
Interaction

Plane Stress with 
Thermal-Electric 
Interaction

2D Structural 
Mechanics or 
MEMS

Heat Transfer,
AC/DC

Thermal-Electric- 
Structural 
Interaction

Plane Strain with 
Thermal-Electric 
Interaction

2D Structural 
Mechanics or 
MEMS

Heat Transfer,
AC/DC

TABLE 14-1:  PREDEFINED MULTIPHYSICS COUPLINGS

CATEGORY/ FOLDER NAME SPACE DIMENSION REQUIRED 
MODULES

OPTIONAL 
MODULES
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Thermal-Electric- 
Structural 
Interaction

Axial Symmetry, 
Stress Strain with 
Thermal-Electric 
Interaction

2D Axi Structural 
Mechanics or 
MEMS

Heat Transfer,
AC/DC

Thermal-Electric- 
Structural 
Interaction

Solid, Stress 
Strain with 
Thermal-Electric 
Interaction

3D Structural 
Mechanics or 
MEMS

Heat Transfer,
AC/DC

Acoustic-Structure 
Interaction

Plane Strain with 
Acoustic 
Interaction

2D Acoustics Structural 
Mechanics, 
MEMS

Acoustic-Structure 
Interaction

Axial Symmetry, 
Stress-Strain with 
Acoustic 
Interaction

2D Axi Acoustics Structural 
Mechanics, 
MEMS

Acoustic-Structure 
Interaction

Solid, 
Stress-Strain with 
Acoustic 
Interaction

3D Acoustics Structural 
Mechanics, 
MEMS

Structural 
Mechanics

Plane Strain with 
Film Damping

2D MEMS

Structural 
Mechanics

Axial Symmetry, 
Stress-Strain with 
Film Damping

2D Axi MEMS

Structural 
Mechanics

Solid, Stress- 
Strain with Film 
Damping

3D MEMS

Microfluidics Flow with Species 
Transport

2D, 2D Axi, 3D MEMS

Microfluidics Electroosmotic 
Flow

2D, 2D Axi, 3D MEMS

Rotating 
Machinery

Rotating 
Perpendicular 
Currents

2D AC/DC

Rotating 
Machinery

Rotating 
Navier-Stokes

2D Chemical 
Engineering

TABLE 14-1:  PREDEFINED MULTIPHYSICS COUPLINGS

CATEGORY/ FOLDER NAME SPACE DIMENSION REQUIRED 
MODULES

OPTIONAL 
MODULES
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The predefined multiphysics coupling makes use of an application mode in the 
optional modules if your license includes them; otherwise the coupling uses the 
corresponding but more limited application mode in COMSOL Multiphysics or the 
required module. The couplings are identical in both cases, but the application mode 
from the optional module typically offers additional functionality in other areas. These 
predefined multiphysics couplings are quick entry points for common multiphysics 
applications. It is possible to create the same couplings using any of the other methods 
for multiphysics modeling, and you can continue to add, modify, and remove 
application modes in a model that you start using one of the predefined multiphysics 
couplings. If you want to add additional application modes directly in the Model 

Navigator, click the Multiphysics button and then the Add button. You can then see the 
application modes from the predefined multiphysics coupling in the Multiphysics area 
and select new application modes that you add to the model using the Add button.

In the Model Navigator, the Dependent variables list contains the dependent variables, 
and the Application mode name edit field contains the default application mode names 
for the application modes that the predefined multiphysics coupling includes. The 
Element list in the Model Navigator provides a selection of suitable element types for all 
the dependent variables. You can also select element types individually using the 
Element tab in the Subdomain Settings dialog box (and, in some cases, the Boundary 

Settings dialog box).

E L E C T R O - T H E R M A L  I N T E R A C T I O N — J O U L E  H E A T I N G

The Joule Heating predefined multiphysics coupling combines a Conductive Media 
DC application mode from COMSOL Multiphysics or the AC/DC Module with the 

Poroelasticity Plane Strain, 
Pressure/Pressure 
head/Hydraulic 
head

2D Earth Science, 
Structural 
Mechanics/
MEMS

Poroelasticity Stress-Strain, 
Pressure/Pressure 
head/Hydraulic 
head

2D Axi Earth Science, 
Structural 
Mechanics/
MEMS

Poroelasticity Stress-Strain, 
Pressure/Pressure 
head/Hydraulic 
head

3D Earth Science, 
Structural 
Mechanics/
MEMS

TABLE 14-1:  PREDEFINED MULTIPHYSICS COUPLINGS

CATEGORY/ FOLDER NAME SPACE DIMENSION REQUIRED 
MODULES

OPTIONAL 
MODULES
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Heat Transfer by Conduction application mode from COMSOL Multiphysics or the 
General Heat Transfer application mode from the Heat Transfer Module. The 
interaction is fully coupled in both directions:

• In the heat transfer application mode, resistive heating appears as a heat source (the 
resistive heating variable Q_dc (or Q_emdc) appears in the Q edit field).

• In the Conductive Media DC application mode, the definition of the conductivity 
σ uses the thermal heating model 1/(ρ0(1+α(T−T0))), where T is the dependent 
variable for temperature from the heat transfer application mode. The values for ρ0 
(resistivity at reference temperature), α (temperature coefficient), and T0 (reference 
temperature) are default values that you can change to match your modeling 
situation.

You can select a steady-state or a transient analysis.

For an example of a model using the Joule Heating predefined multiphysics coupling, 
see “Example—Resistive Heating” on page 387.

E L E C T R O - T H E R M A L  I N T E R A C T I O N — I N D U C T I O N  H E A T I N G

The Induction Heating predefined multiphysics coupling combines an application 
mode for induction currents from the AC/DC Module with the Heat Transfer by 
Conduction application mode from COMSOL Multiphysics or the General Heat 
Transfer application mode from the Heat Transfer Module. The predefined interaction 
adds the resistive heating from the induction currents as a heat source in the 
application mode for the heat transfer.

For more information, see the AC/DC Module User’s Guide.

E L E C T R O - T H E R M A L  I N T E R A C T I O N — M I C R O W A V E  H E A T I N G

The Microwave Heating predefined multiphysics coupling combines an application 
mode for electromagnetic waves from the RF Module with the Heat Transfer by 
Conduction application mode from COMSOL Multiphysics or the General Heat 
Transfer application mode from the Heat Transfer Module. The predefined interaction 
adds the resistive heating from the electromagnetic waves as a heat source in the 
application mode for the heat transfer.

For more information, see the RF Module User’s Guide.

F L U I D - C H E M I C A L  R E A C T I O N S  I N T E R A C T I O N — R E A C T I N G  F L O W

The Reacting Flow predefined multiphysics coupling requires the Chemical 
Engineering Module. Reacting Flow combines a Convection and Diffusion mass 
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balance application mode with an Incompressible Navier-Stokes application mode, 
both from the Chemical Engineering Module. The interaction is a one-way coupling 
using the velocity described by the Navier-Stokes equations as part of the convective 
mass transfer. The components of the velocity vector u from the Incompressible 
Navier-Stokes application mode appear in the u, v, and w edit fields in the Subdomain 

Settings dialog box for the Convection and Diffusion application mode.

By default, COMSOL Multiphysics solves for the velocity field, pressure, and species 
concentrations simultaneously. For large problems, you can take advantage of the 
one-way coupling and solve the problem sequentially (unless there are fluid-flow 
properties that depend on the species concentrations): First solve for velocities and 
pressures, and then solve the mass balance equation using the computed velocities 
from the Navier-Stokes equation. See “Solving for a Subset of the Dependent 
Variables” on page 381 on how to select which variables to solve for.

F L U I D - S T R U C T U R E  I N T E R A C T I O N  ( F S I )

The Fluid-Structure Interaction (FSI) predefined multiphysics coupling is available in 
the MEMS Module and the Structural Mechanics Module. FSI combines fluid flow 
with structural mechanics, using a Moving Mesh (ALE) application mode to capture 
the fluid movement. Predefined groups of boundary settings help to define the fluid 
loads on the solid domain and the structural velocity’s effect on the fluid. For more 
information and example models, see the Structural Mechanics Module and MEMS 
Module documentation.

F L U I D - T H E R M A L  I N T E R A C T I O N — F L U I D - T H E R M A L  I N C O M P R E S S I B L E  

F L O W

The Fluid-Thermal Incompressible Flow predefined multiphysics coupling in 
COMSOL Multiphysics combines an Incompressible Navier-Stokes application mode 
with the Convection and Conduction application mode. The interaction is a one-way 
coupling using the velocity described by the Navier-Stokes equations as part of the 
convective heat transfer. The components of the velocity vector u from the 
Incompressible Navier-Stokes application mode appear in the u, v, and w edit fields in 
the Subdomain Settings dialog box for the Convection and Conduction application 
mode.

By default, COMSOL Multiphysics solves for the velocity field, pressure, and species 
concentrations simultaneously. For large problems, you can take advantage of the 
one-way coupling and solve the problem sequentially (unless there are fluid-flow 
properties that depend on the temperature): first solve for velocities and pressures and 
then solve the heat transfer equation using the computed velocities from the 
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Navier-Stokes equation. See “Solving for a Subset of the Dependent Variables” on 
page 381 on how to select which variables to solve for.

F L O W  W I T H  V A R I A B L E  D E N S I T Y — N O N - I S O T H E R M A L  F L O W

The Chemical Engineering Module and the Heat Transfer Module include the 
Non-Isothermal Flow and Turbulent Non-Isothermal Flow predefined multiphysics 
couplings (in the Chemical Engineering Module you select both laminar and turbulent 
non-isothermal flow in the Flow with Variable Density>Non-Isothermal Flow folder; in 
the Heat Transfer Module, you select a laminar or turbulent non-isothermal flow in 
the Fluid-Thermal Interaction folder), which are similar but model non-isothermal 
laminar and turbulent fluids. For more information about these predefined couplings, 
see the Chemical Engineering Module and Heat Transfer Module documentation.

T H E R M A L - S T R U C T U R A L  I N T E R A C T I O N — T H E R M A L  E X P A N S I O N

The predefined multiphysics couplings for structural mechanics with thermal 
expansion requires the Structural Mechanics Module or the MEMS Module. They 
combine the Heat Transfer by Conduction application mode from COMSOL 
Multiphysics or the General Heat Transfer application mode from the Heat Transfer 
Module with the following application modes from the Structural Mechanics Module 
or the MEMS Module:

• Plane Stress in 2D

• Plane Strain in 2D

• Axial Symmetry, Stress-Strain in 2D axisymmetry

• Solid, Stress-Strain in 3D

The interaction is a one-way coupling using the temperature described by a heat 
transfer application mode to define the strain temperature. On the Load page in the 
Subdomain Settings dialog box in the structural mechanics application mode, the 
Include thermal expansion check box is selected, and the dependent variable for 
temperature from the heat transfer application mode appears in the Temp edit field for 
the strain temperature. The Tempref edit field contains a default value (0) for the strain 
reference temperature. If necessary, adjust the strain reference temperature to a 
suitable value for your model.

You can select a steady-state, transient, or quasi-static analysis.

By default, COMSOL Multiphysics solves for the temperature and displacements 
simultaneously. For large problems, you can take advantage of the one-way coupling 
and solve the problem sequentially (unless there are thermal properties that depend on 
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the displacements): first solve for temperature and then perform the stress-strain 
analysis using the computed temperature field from the heat transfer equation. See 
“Solving for a Subset of the Dependent Variables” on page 381 on how to select which 
variables to solve for.

T H E R M A L - E L E C T R I C - S T R U C T U R A L  I N T E R A C T I O N

The predefined multiphysics couplings for structural mechanics with thermal-electric 
interaction requires the Structural Mechanics Module or the MEMS Module. They 
combine the Heat Transfer by Conduction application mode from COMSOL 
Multiphysics or the General Heat Transfer application mode from the Heat Transfer 
Module plus the Conductive Media DC application mode with the following 
application modes from the Structural Mechanics Module or the MEMS Module:

• Plane Stress in 2D

• Plane Strain in 2D

• Axial Symmetry, Stress-Strain in 2D axisymmetry

• Solid, Stress-Strain in 3D

The interactions include Joule heating, which is fully coupled in both directions (see 
“Electro-Thermal Interaction—Joule Heating” on page 372), and thermal expansion, 
which is a one-way coupling (see “Thermal-Structural Interaction—Thermal 
Expansion” on page 375).

• In the heat transfer application mode, resistive heating appears as a heat source (the 
resistive heating variable Q_dc (or Q_emdc) appears in the Q edit field).

• In the Conductive Media DC application mode, the definition of the conductivity 
σ uses the thermal heating model 1/(ρ0(1+α(T−T0))), where T is the dependent 
variable for temperature from the heat transfer application mode. The values for ρ0 
(resistivity at reference temperature), α (temperature coefficient), and T0 (reference 
temperature) are default values that you can change to match your modeling 
situation.

You can select a steady-state or transient analysis (where the conductive media and 
structural mechanics equations are stationary).

By default, COMSOL Multiphysics solves for the temperature, electric potential, and 
displacements simultaneously.
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A C O U S T I C - S T R U C T U R E  I N T E R A C T I O N

The predefined multiphysics coupling for acoustic-structural interaction is available in 
the Acoustics Module and in the Structural Mechanics Module and the MEMS 
Module, if the license also includes the Acoustics Module. This multiphysics coupling 
connects the acoustics pressure in a fluid domain with the structural deformation in a 
solid domain. Predefined groups of boundary settings help to define the fluid loads on 
the solid domain and the structural acceleration’s effect on the fluid.

For mode information, see the Acoustics Module documentation.

S T R U C T U R A L  M E C H A N I C S  I N C L U D I N G  F I L M  D A M P I N G

The MEMS Module includes the Plane Strain with Film Damping and Solid, 
Stress-Strain with Film Damping predefined multiphysics couplings. The couple the 
structural mechanics application mode with the Film Damping application mode, for 
transient and frequency-response analysis of microsystems that include film damping. 
The Film Damping application mode models film damping on boundaries, and the 
predefined multiphysics coupling sets the boundary deformation to the displacement 
variables from the structural mechanics application mode.

For more information, see the MEMS Module documentation.

M I C R O F L U I D I C S — F L O W  W I T H  S P E C I E S  TR A N S P O R T

This suite of predefined multiphysics couplings combines the application modes for 
microfluidics (General Laminar Flow, Incompressible Navier-Stokes, Non-Isothermal 
Flow, Stokes Flow, and Non-Isothermal Stokes Flow) with the Convection and 
Diffusion application mode. The coupling is similar to the one in the Reacting Flow 
predefined multiphysics coupling (see “Fluid-Chemical Reactions Interaction—
Reacting Flow” on page 373), combining fluid flow with species (mass) transport.

For more information, see the MEMS Module documentation.

M I C R O F L U I D I C S — E L E C T R O O S M O T I C  F L O W

This suite of predefined multiphysics couplings for electroosmotic flow modeling 
combines the application modes for microfluidics (General Laminar Flow, 
Incompressible Navier-Stokes, Non-Isothermal Flow, Stokes Flow, and 
Non-Isothermal Stokes Flow) with the Conductive Media DC application mode.

Using the Electroosmotic Flow predefined multiphysics coupling, both application 
modes include boundary groups for defining boundaries as electrodes, ground, 
electroosmosis, inlets, and outlets.
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For more information, see the MEMS Module documentation.

R O T A T I N G  M A C H I N E R Y — R O T A T I N G  P E R P E N D I C U L A R  C U R R E N T S

For modeling of rotating machinery such as motors and generators, the Rotating 
Perpendicular Currents predefined multiphysics coupling combines the Perpendicular 
Induction Currents application mode with a Moving Mesh (ALE) application mode. 
The Moving Mesh (ALE) application mode, which captures the rotation, contains 
predefined groups with settings for fixed parts and parts that rotate clockwise or 
counterclockwise.

For more information, see the AC/DC Module documentation.

R O T A T I N G  M A C H I N E R Y — R O T A T I N G  N A V I E R - S T O K E S

For modeling of rotating machinery with fluids (such as stirrers), the Rotating 
Navier-Stokes predefined multiphysics coupling combines the Incompressible 
Navier-Stokes application mode with a Moving Mesh (ALE) application mode. The 
Moving Mesh (ALE) application mode, which captures the rotation, contains 
predefined groups with settings for fixed parts and parts that rotate clockwise or 
counterclockwise.

For more information, see the Chemical Engineering Module documentation.

PO R O E L A S T I C I T Y

This predefined multiphysics coupling is available in the Earth Science Module and 
combines the Darcy’s Law application mode from that module with a structural 
mechanics application mode from the Structural Mechanics Module or the MEMS 
Module (one of those modules are required in addition to the Earth Science Module). 
The Poroelasticity predefined multiphysics coupling is useful for modeling poroelastic 
phenomena such as diffusion in elastic solids or elasticity of fluid-infiltrated porous 
solids. For more information, see the Earth Science Module documentation.

Adding Physics Sequentially

With this approach you can verify that each type of physics or PDE gives the expected 
results before adding more complexity to the model by adding another physics or 
coupling fields.

Use these steps to add one application mode at the time:

1 Select an application mode.

2 Draw the geometry.
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3 Define the physics settings.

4 Solve and visualize the results.

Then add another application mode:

5 Go to the Multiphysics menu and choose Model Navigator.

6 Select a new application mode.

7 In the Multiphysics area, click the Add button.

8 Click OK.

9 Add and modify settings in the Physics menu, including couplings between the 
physics.

Building a Coupled Multiphysics Model Directly

Another approach is to include multiple application modes when you start creating the 
model in the Model Navigator:

1 Select an application mode for the model.

2 Click the Multiphysics button.

3 In the Multiphysics area, click the Add button.

4 Continue selecting application modes and adding them to the model by clicking 
Add.

5 Click OK.

Removing Application Modes

To remove an application mode from a model:

1 Choose Model Navigator from the Multiphysics menu.

2 Select the application mode from the list under Multiphysics. You can also select a 
geometry in the list to remove the entire geometry and all application modes that it 
contains.

3 Click Remove.

4 Click OK.
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Multiphysics Model Properties

When you add or remove application modes, COMSOL Multiphysics updates some 
model properties to:

• Include all dependent variables in the added application modes in the list of variables 
to solve for.

• Update all application-dependent dialog boxes.

A C T I V E  A P P L I C A T I O N  M O D E

The application mode selected under Multiphysics becomes the active application mode 
when you begin modeling.

To shift between the different application modes during modeling, select one from the 
Multiphysics menu to make it active.

R U L I N G  A P P L I C A T I O N  M O D E

The ruling application mode determines the global settings for the multiphysics 
model from its application mode properties. For example, if the analysis type is 
different for two application modes in the same model, the software selects the solver 
based on the analysis type from the ruling application mode. You select the ruling 
application mode for a multiphysics model in the Model Navigator. In the Solver 

Parameters dialog box, you can see (and change) the analysis types for all application 
modes in the Analysis types area. In this area, the ruling application mode appears on 
top using a bold font.

Managing the Solver and Solution Components

The Solver Manager dialog box provides several options for managing the solution 
process for multiphysics analyses.

R E S T A R T I N G  T H E  S O L V E R  A N D  U S I N G  I N I T I A L  V A L U E S

When adding equations and physics to an existing model, you can restart the model 
using the current solution as an initial value. Doing so can accelerate the convergence 
for a coupled multiphysics model. To restart the solver, click the Restart button on the 
Main toolbar.

To specify initial values:

1 Go to the Solve menu and choose Solver Manager.

2 In the Solver Manager dialog box click the Initial Value tab.
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3 Click the Initial value expression using current solution button (the default setting) to 
evaluate the expressions for the initial values as specified for each application mode 
using the current solution.

4 Click OK.

Figure 14-2: The Solver Manager settings for evaluation the initial value expressions using 
the current solution.

S O L V I N G  F O R  A  S U B S E T  O F  T H E  D E P E N D E N T  V A R I A B L E S

The solver normally solves for all dependent variables. It is also possible to have it solve 
for a subset of the dependent variables. The initial conditions then define the value of 
the other variables. To specify which variables to solve for:

1 Go to the Solve menu and choose the Solver Manager.

2 In the Solver Manager dialog box click the Solve For tab.

3 Within the Solve for variables list the software selects all application modes by 
default. Clear the selections for those application modes whose dependent variables 
you do not want to solve for.

4 To select individual dependent variables for an application mode, click the plus sign 
to open the application mode folder and select the dependent variables to include.
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5 Click OK.

Figure 14-3: The Solve For page of the Solver Manager set up to solve for the displacements 
in the Plane Stress application model only.

Use this subset approach to reduce the computational load when there is only a 
one-way coupling in the multiphysics model:

1 Solve for the variables that are not affected by the coupling.

2 Solve for the remaining variables, using the solution from the initial analysis by 
restarting the solver using the previous solution data.

For a fully coupled multiphysics model with bidirectional couplings you can also use 
this approach to reach convergence in an iterative manner. Solve for one type of physics 
at a time and then use that solution as the initial value when solving for the other type 
of physics. This method provides a “weakly coupled” way of solving a coupled 
multiphysics model. Using the standard COMSOL Multiphysics approach to solving 
fully coupled equations simultaneously normally provides better convergence. The 
stationary and time-dependent segregated solvers provide an efficient way of solving 
fully coupled and “one-way coupled” multiphysics models. Several predefined 
multiphysics couplings provide suitable default settings using the segregated solvers.
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U S I N G  V A R I A B L E S  D U R I N G  A N A L Y S I S  O N L Y

In a similar way you can choose to output the results for a subset of the dependent 
variables:

1 In the Solver Manager dialog box click the Output tab.

2 In the Output for variables list select from the application modes and their dependent 
variables in the same way as for the variables to solve for.

3 Click OK.

This method can be useful if you want to include variables for multiphysics couplings 
during the analysis but are not interested in using them for postprocessing.

If you include nonsolved variables for output they take on the specified initial value as 
their solution data in the output from the solver.

Figure 14-4: The Output page of the Solver Manager. By default, COMSOL Multiphysics 
includes all dependent variables from all application modes in the results data.

Deactivating Physics or Equations

Sometimes subdomains have different types of physics associated with them, and an 
application mode might not be meaningful in a subdomain. For example, fluid flow 
can be present only in some subdomains of a model whereas heat transfer takes place 
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in the entire geometry. By default all application modes are active in all subdomains. 
To deactivate an application mode, select the subdomains where the application 
mode’s physics do not take place. Then clear the Active in this subdomain check box in 
the Subdomain Settings dialog box and click Apply. Some interior boundaries then 
become exterior boundaries, and some of the original boundaries are absent for certain 
application modes.

Using the Model Navigator for Multiphysics Models

To add and remove application modes and geometries for a multiphysics model, go to 
the Multiphysics menu and then open the Model Navigator. Use its Multiphysics area to 
make changes to the current model’s multiphysics properties.

A D D I N G  G E O M E T R I E S  T O  A  M O D E L

A model always has at least one geometry. To add another geometry to a model, click 
the Add Geometry button in the Multiphysics area of the Model Navigator. In such an 
extended multiphysics model the geometries can have different space dimensions. You 
can also choose the names of the independent variables (spatial coordinates).

C H A N G I N G  A P P L I C A T I O N  M O D E  P R O P E R T I E S

Before adding an application mode, you can edit its name and dependent variables. 
COMSOL Multiphysics provides a unique name for each application mode in the 
model to identify the origin of the variables. You can change the name to any other 
name that is unique within the model.

You can also specify the element type, although the default is usually a good choice.

To set the analysis type and other application mode properties for the active application 
mode in a multiphysics model, click the Application Mode Properties button. These 
properties vary depending on the application mode.

Figure 14-5: The Application Mode Properties dialog box. The contents vary depending on 
the active application mode.
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Specifying Settings for Multiphysics Models

In multiphysics models with multiple application modes, you can work with the 
settings for more than one application mode at a time. Selecting a settings command 
from the Physics menu opens the dialog box for the current application mode. All 
application modes in the model are listed in the Multiphysics menu. In that list, a bullet 
indicates the current application mode. To open a settings dialog box for another 
application mode, make it current by choosing it from the Multiphysics menu. You can 
now open the physics settings dialog boxes for this application mode. Any open physics 
settings dialog boxes for other application mode remain open and available for model 
specification. From the Model Tree, you can reach most of the dialog boxes on the 
Physics menu for all application modes in a model.

T H E  E Q U A T I O N  S Y S T E M  V I E W

The physics application modes and the application modes in the optional COMSOL 
modules provide built-in equations and the convenient specification of the physics that 
the application mode covers. Instead of entering PDE coefficients and general 
boundary coefficients, you select from typical material properties, sources, boundary 
conditions, and other physics settings. To find details on what these application modes 
provide, see the COMSOL Multiphysics Modeling Guide as well as the documentation 
that accompanies the optional modules. 

COMSOL Multiphysics, however, always presents a model in terms of the underlying 
system of PDEs, the equation system view. In the Physics menu, point to Equation 

System and then open the dialog box for subdomain, boundary or point settings. You 
can also open these dialog boxes by Ctrl-clicking the corresponding selection mode 
button on the Main toolbar.

The equation system is the underlying representation of any model as a system of one 
or more PDEs in the coefficient or general forms. This representation is useful for 
several reasons:

• To let you introduce additional terms to a predefined physics mode

• To let you modify the equation, boundary conditions, and other settings from a 
predefined physics mode

• To add multiphysics couplings on the system level

• To check how COMSOL Multiphysics translates the equation and other settings in 
terms of physics
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For more about the equation system views, see “Viewing and Modifying the Full 
Equation System” on page 217 and “Modifying Boundary Settings for the Equation 
System” on page 249 of the COMSOL Multiphysics User’s Guide.
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Examp l e—Re s i s t i v e  Hea t i n g

For an example of a multiphysics model with thermal-electric couplings, look at 
resistive heating in a copper plate.

Introduction

The material heats up when an electric current passes through it due to electric 
resistance. This is called resistive heating or Joule heating. There is also a coupling 
working in the opposite direction: the material’s electric resistance varies with the 
temperature, increasing as the material heats up.

Model Definition

Imagine a copper plate measuring 1 m × 1 m that also contains a small hole. The 
plate’s thickness has no effect on the model. Suppose that you subject the plate to an 
electric potential difference across two opposite sides (all other sides are insulated). 
The potential difference induces a current that heats the plate.

Figure 14-6: The model geometry and electric boundary conditions.

In the 2D model you view the plate from above.

0.1 V

Copper Plate

0 V

Current

1 m
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Modeling in COMSOL Multiphysics

This example sets up the coupled thermal-electric analysis using the predefined 
multiphysics coupling for Joule Heating, which combines a Conductive Media DC 
application mode with a Heat Transfer by Conduction application mode. The potential 
distribution in the conductive media occurs almost instantly, but because unsteady heat 
transfer is a transient phenomenon, the full multiphysics model uses a transient 
analysis.

A D D I T I O N A L  M U L T I P H Y S I C S  C O U P L I N G S

By adding a structural mechanics application mode to this model you could represent 
a thermomechanical coupling with a body force proportional to the temperature 
gradient. For more information on thermomechanical multiphysics, see the model 
“Simulation of a Microrobot” on page 403 in the COMSOL Multiphysics Model 
Library and the documentation for the Structural Mechanics Module.

Model Library path: COMSOL_Multiphysics/Multiphysics/
resistive_heating

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 On the New page, select 2D from the Space dimension list.

2 In the list of application modes, open the COMSOL Multiphysics>Electro-Thermal 

Interaction folder and then the Joule Heating folder. Select Transient analysis.

3 Click OK.
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O P T I O N S  A N D  S E T T I N G S

1 From the Options menu choose Constants.
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2 Enter the following constant names, expressions, and (optionally) descriptions:

Enter the constant’s name in the Name edit field, then place its value and unit in the 
Expression field, and finally add a description in the Description edit field:

3 Click OK.

G E O M E T R Y  M O D E L I N G

Define the model geometry:

1 Shift-click the Rectangle/Square (Centered) toolbar button.

2 In the Square dialog box, click OK to use the default values and create a unit square 
with corners at (0, 0) and (1, 1).

3 Click the Zoom Extents toolbar button (on the Main toolbar).

4 Shift-click the Ellipse/Circle (Centered) toolbar button.

5 In the Circle dialog box, type 0.1 in the Radius edit field and then type 0.5 in the x 
and y edit fields in the Position area. Click OK.

6 To create a hole, select both geometry objects by pressing Ctrl+A.

 NAME EXPRESSION DESCRIPTION

r0 1.754e-8[ohm*m] Resistivity at reference temperature

T0 20[degC] Reference temperature

alpha 0.0039[1/K] Temperature coefficient

V0 0.1[V] Electric potential
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7 Click the Difference button on the Draw toolbar.

P H Y S I C S  S E T T I N G S

The electric boundary conditions appear in Figure 14-6 on page 387. For the thermal 
boundary conditions, an air stream at 300 K (27 °C) cools the plate except on the 
thermally insulated upper and lower edges:
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Figure 14-7: The model geometry and the thermal boundary conditions.

In Joule heating, the temperature increases due to the resistive heating from the 
electric current. The electric potential V is the solution variable in the Conductive 
Media DC application mode. The generated resistive heat Q is proportional to the 
square of the magnitude of the electric current density J. Current density, in turn, is 
proportional to the electric field, which equals the negative of the gradient of the 
potential V:

The coefficient of proportionality is the electric resistivity ρ = 1/σ, which is also the 
reciprocal of the temperature-dependent electric conductivity σ = σ(T). Combining 
these facts gives the fully coupled relation

This resistive heating source term is directly available as the variable Q_dc (Q_emdc if 
you use the AC/DC Module) and is predefined as the source term in the heat transfer 
application mode when using the Joule Heating predefined multiphysics coupling.

Quantities other than σ also vary with temperature. For example, the thermal 
conductivity is temperature dependent, and a refined model would take this into 
account.
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Over a range of temperatures the electric conductivity σ is a function of temperature 
T according to

where σ0 is the conductivity at the reference temperature T0. α is the temperature 
coefficient of resistivity, which describes how the resistivity varies with temperature. A 
typical value for copper is 0.0039 per kelvin.

In the Conductive Media DC application mode you can specify the electric 
conductivity for Joule heating in terms of this equation. The predefined multiphysics 
coupling sets up this specification of sigma with the variable for temperature in the T 
edit field and default values suitable for copper. The only thing you have to add is the 
reference temperature, T0.

Boundary Conditions—Heat Transfer
1 Make sure that Heat Transfer by Conduction (ht) or General Heat Transfer (htgh) (if 

you use the Heat Transfer Module) is the selected application mode in the 
Multiphysics menu.

2 Open the Boundary Settings dialog box from the Physics menu.

The thermal boundary conditions are:

3 Select all boundaries.

4 Select Temperature from the Boundary condition list.

5 Type 300 in the T0 (temperature) edit field. This value corresponds to holding all 
boundaries at 300 K by positioning them in an air stream at room temperature.

6 Select Boundaries 2 and 3, the top and bottom boundaries, and then select Thermal 

insulation from the Boundary condition list.

7 Click OK.

SETTINGS BOUNDARIES 1, 4–8 BOUNDARIES 2, 3

Type Temperature Thermal insulation

T0 300

σ
σ0

1 α T T0–( )+
-----------------------------------=
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Subdomain Settings—Heat Transfer
The material properties for heat transfer are:

1 From the Physics menu choose Subdomain Settings.

2 Select Subdomain 1 from the Subdomain selection list.

3 Type 8930 in the Density edit field (the density of copper in kg/m3).

4 Type 340 in the Heat capacity at constant pressure edit field. The unit for heat 
capacity in this model is J/(kg·K), the SI unit.

5 Type 384 in the k (isotropic) edit field for the thermal conductivity.

This coefficient has the SI unit W/(m·K) and represents the material’s ability to 
conduct heat per unit time.

6 The predefined setting in the Heat source edit field is Q_dc (or Q_emdc). This is a 
predefined variable for the resistive heating from the Conductive Media DC 
application mode and includes the temperature-dependent conductivity and the 
gradient of the electric potential.

PROPERTY VALUE

 ρ 8930

 Cp 340

 k (isotropic) 384

 Q Q_dc
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Initial Conditions—Heat Transfer
Also enter the initial value for the temperature, which is 300 K just as the boundary 
condition:

1 Click the Init tab in the Subdomain Settings dialog box.

2 Type 300 as the initial value in the edit field for T(t0).

3 Click OK.

Application Mode Selection
To define the settings for the copper plate’s electric properties, switch to the 
Conductive Media DC (dc) application mode, selecting it from the Multiphysics menu 
or using the Model Tree.

Boundary Conditions—Conductive Media DC
1 Open the Boundary Settings dialog box by choosing Boundary Settings from the 

Physics menu. The boundary conditions for the Conductive Media DC application 
mode in this example are:

2 Press Ctrl+A to select all boundaries.

3 From the Boundary condition list select Electric insulation.

Change the conditions on Boundaries 1 and 4:

4 From the Boundary selection list select Boundary 1, the left boundary.

5 From the Boundary condition list select Electric potential and type V0 in the V0 edit 
field.

6 Select Boundary 4.

7 From the Boundary condition list select Ground.

8 Click OK.

Subdomain Settings—Conductive Media DC
1 From the Physics menu choose Subdomain Settings.

2 Select Subdomain 1 from the Subdomain selection list.

3 From the Conductivity relation list, select Linear temperature relation.

4 Make sure that the T edit field contains the field variable for temperature, T.

5 Type r0 in the ρ0 edit field for the resistivity at the reference temperature.

SETTINGS BOUNDARY 1 BOUNDARY 4 BOUNDARIES 2, 3, 5–8

Type Electric potential Ground Electric insulation

V V0
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6 Type alpha in the α edit field for the temperature coefficient.

7 Type T0 in the T0 edit field for the reference temperature.

Initial Conditions—Conductive Media DC
1 In the Subdomain Settings dialog box, click the Init tab.

2 Type V0*(1-x[1/m]) in the edit field for V(t0). This expression means that the 
initial potential distribution varies linearly from V0 (0.1 V) at the left boundary (x = 
0) to 0 V at the right boundary (x = 1). This is an initial condition that matches the 
boundary conditions. The reason for the multiplying x with the unit [1/m] is to 
make it dimensionless.

3 Click OK.

M E S H  G E N E R A T I O N

Click the Initialize Mesh button on the Main toolbar to create a mesh using the default 
settings.

C O M P U T I N G  T H E  S O L U T I O N

The heat transfer in this model is a transient process, so the model uses a 
time-dependent solver for a transient analysis. First specify the simulation’s time 
interval and the points in time to present solution data.

1 Open the Solver Parameters dialog box from the Solve menu.

2 Type range(0,50,2000) in the Times edit field. Doing so produces a vector of 41 
output times, linearly distributed every 50 seconds from 0 to 2000 seconds, for 
which the solution is available for postprocessing.
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3 Click OK.

C O M P U T I N G  T H E  S O L U T I O N

You can now run the transient analysis. To do so, click the Solve button on the Main 
toolbar.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot from this analysis shows the temperature or the potential distribution.
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Visualizing Heat Flux Using Arrow Plots

A quantity that is interesting to animate is the heat flux:

1 Open the Plot Parameters dialog box from the Postprocessing menu.

2 Click the Arrow tab.

3 Select the Arrow plot check box.

4 Select Heat Transfer by Conduction (ht)>Heat flux from the Predefined quantities list.

5 Click the Color button and select a color for the arrows, for example, white.

6 Click OK.

Checking Heat Transfer Dynamics
Use a plot of temperature over time to determine if the time span for the simulation is 
sufficient to reach steady state:

1 From the Postprocessing menu choose Cross-Section Plot Parameters.

2 Make sure to select all time steps in the Solutions to use list on the General page.

3 Click the Point plot button.

4 Click the Point tab.

5 Select Heat Transfer by Conduction (ht)>Temperature in the Predefined quantities list.
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6 In the Coordinates area, type 0.5 in the x edit field and 0.75 in the y edit field.

7 Click OK.

The plot of temperature as a function of time shows that it has reached a steady state. 
The temperature hardly increases at all if you extend the simulation over a longer time 
span.

Figure 14-8: Heat transfer dynamics visualized as temperature versus time.

C O M P U T I N G  T H E  S O L U T I O N  U S I N G  A  S E G R E G A T E D  S T A T I O N A R Y  S O L V E R

You can also solve this model for the steady-state condition. There is no problem 
solving this coupled multiphysics model using the standard stationary solver because 
the model is small. For large models, a segregated solver approach can be beneficial. 
This example shows how to solve a multiphysics model using the segregated stationary 
solver. You continue with the Resistive Heating model, adding the following steps:

1 From the Solve menu, choose Solver Parameters.

2 Select Stationary from the Analysis list.

3 Select Stationary segregated from the Solver list. COMSOL Multiphysics has two 
predefined groups, one for each application mode (the temperature T and the 
electric potential V). All you need to do is to specify the tolerances so that the 
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segregated solver scheme converges to the same solution as the standard stationary 
solver. Use the default linear solver settings (the direct solver UMFPACK).

4 Type 1e-6 in the Tolerance edit field for both groups (Group 1 for T and Group 2 
for V). The following figure shows the settings for the stationary segregated solver.

5 Click OK.

6 Click the Solve button on the Main toolbar.
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Work i n g  w i t h  Componen t s

A multiphysics model can consist of one or several components. Each component can 
have material data and physics. To build a model consisting of several components you 
can build one component at a time and save it in a Model MPH-file. When you have 
all the components you can start to put them together by merging them with or adding 
them to the current model.

The Component Library

To store Model MPH-files for use as components, you can use the Component 
Library. To open the Component Library, choose File>Open Component Library, or 
open the Model Navigator from the Multiphysics menu. Click the Component Library tab 
to see the components shipped with COMSOL Multiphysics.

Figure 14-9: The Component Library in the Model Navigator.

The User Components page is available for selecting those components you have 
created. Click the Library Root button to specify the root directory for your own 
component libraries.
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Adding Components

To add a component to a model on which you are working, select Add Component from 
the File menu; alternately, select the component you want to add in the Component 
Library and click the Add button. You can also add a component from the Model Tree 
when you choose the Detail and Inspect views. Right-click the top node with the 
model’s name, and then select Add Component.

COMSOL Multiphysics creates a new geometry page and adds the component to this 
geometry. If the component has several geometries, the software adds all the 
geometries to the model. Adding a component includes the component’s physics and 
mesh but not the solution.

Merging Components

To merge a component to the model on which you are working, either select Merge 

Component from the File menu or select the component you want to merge in the 
Component Library and click the Merge button. You can also add a component from the 
Model Tree. Right-click the geometry node where you want to merge a component 
with the current mode, and then select Merge Component.

When merging a component the Merge Component dialog box appears.

In the Geometry list you can find the geometries in the component. Select the 
geometry you want to merge into the model. Clicking Merge merges the geometry 
objects in the selected geometry into the current geometry in your model. The 
resulting geometry becomes an assembly.

When you select a geometry in the dialog box, the application modes in this geometry 
appear in a list. If application modes of the same type as the selected one already exist 
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in the model, you can choose to merge the component’s application mode with one of 
the application modes in the model. Select the model’s application mode from the 
Merge application mode with list. The resulting application mode then includes the 
physics settings for the component.

If you want the component application mode to exist as a new application mode, select 
None in the Merge application mode with list. If you do not want to merge the 
application modes, you must make sure that the application mode names are unique. 
The program suggests unique names for the dependent variables and the application 
mode in the corresponding edit fields. If there are no application modes to merge with, 
or if None is selected, COMSOL Multiphysics adds a new application mode to the 
model. This application mode is only active in the domains belonging to the 
component.

When you have application modes in the model that the software does not merge with 
application modes from the component, they are active only in the domains that 
belonged to the model before the merge.

Because of geometry changes the merge does not include the mesh and the solution. 
Also, coupling variables that have other destinations than global are not merged.

For an example of how to work with components and merging them into a model, see 
“Heat-sink Experiments Using the Component Library” on page 303 of the 
COMSOL Multiphysics Model Library.
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 15
U s i n g  A s s e m b l i e s
This chapter explains how to model using assemblies where the geometry consists 
of separate parts. There are special considerations and possibilities during meshing 
as well as setting up the boundary conditions for an assembly model.
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C r e a t i n g  A s s emb l i e s

The Analyzed Geometry—Assembly vs. Composite Geometry

When you leave Draw mode COMSOL Multiphysics analyzes the geometry to find all 
subdomains, boundaries, edges, and points in the geometry. When doing this 
COMSOL Multiphysics creates an analyzed geometry that you apply the physics on. 
You can choose between two types of analyzed geometries:

• A composite geometry. The analyzed geometry object that the software creates is a 
single object (that typically consists of several subdomains), which effectively is the 
same object you would get if you select all objects in Draw mode and create the 
union of them. This is the default type of analyzed geometries, for which COMSOL 
Multiphysics automatically connects the geometry, mesh, and physics at the interior 
interfaces.

• An assembly. In this case you get an analyzed geometry that consists of several parts 
(disjoint composite geometries), each object in Draw mode becoming a part of the 
assembly. For an assembly, you must manually connect the geometry, mesh, and 
physics at the part interfaces.

If there are no problems using a composite geometry this is usually preferred because 
it automatically provides continuity in the physical fields at part interfaces and material 
discontinuities as well as accurate solutions and conforming mesh elements and nodes 
at part interfaces. There are some cases, however, when an assembly is the best choice:

• Sometimes the software fails to create a composite geometry. In those cases you can 
choose to use an assembly. It is a simpler operation to create an assembly, and it 
often succeeds even if creating a composite geometry fails.

• Each part in an assembly gets a separate mesh. This can make it easier to mesh a 
complicated geometry, where the mesh generator creates a too dense mesh or even 
fails to create a mesh for the composite geometry. Bear in mind that having separate 
meshes means that the meshes might not be compatible at the two sides of a border 
between two parts. This can give you a less accurate solution.

• Assemblies make it possible to apply boundary conditions where the dependent 
variable is discontinuous at the interface between two parts. One example is a 
contact resistance boundary condition for electric currents where the electric 
potential is discontinuous.
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To choose between using a composite geometry and using an assembly, toggle the 
Use Assembly menu item on the Draw menu.

Creating Pairs

For the physics application modes to be able to connect the physics between the parts 
in the assembly you need to create identity pairs. The physics application modes use 
the pairs when defining their equations. An identity pair consists of two sets of 
domains: one set with domains from one part and a second set with domains in the 
other part. The domains in the pairs are those which are in contact with each other. 
Each pair consists of boundaries, edges, or points, but never a mixture of domain types. 
For more details about identity pairs, see the section “Identity Pairs” on page 410.

When you create the pairs, you can choose to make imprints of one geometry in 
another. If the boundaries of the two parts which are in contact with each other are of 
different sizes, COMSOL Multiphysics can create an imprint of the smaller boundary 
on the larger boundary. In 2D this inserts points on the larger boundary, and in 3D 
this creates a curve on the larger boundary. The advantage of making imprints is that 
the two sides of the pair match. When you mesh the parts, the meshes match along the 
border of the pair of boundaries. This provides a more accurate solution than in the 
case without the imprint, where the meshes do not match.

To create the pairs either use the Create Pairs dialog box on the Draw menu or the 
Create Pairs and Imprints button and the Create Pairs button on the Draw toolbar.

E X A M P L E  O F  C R E A T I N G  P A I R S

This example uses a cylinder placed on top of a cube. To create a pair between them 
open the Create Pairs dialog box by choosing Create Pairs from the Draw menu.
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The Create imprints check box controls whether to create imprints or not. In the list 
select which objects to create pairs between. In this case there are only two objects, but 
when there are more than two, the software tries to create pairs between all pairs of the 
selected objects. For each pair of objects that touch each other the software creates 
identity pairs, usually one boundary pair, one edge pair, and one point pair.

If you create pairs between the cube and the cylinder without imprints, the rectangular 
surface of the cube and the circular end of the cylinder become an identity pair.

In the following figure the boundaries that belong to the boundary pair have a yellow 
color.

If you instead create pairs and imprints, the software creates a circular curve on the 
cube’s surface. This circular surface on the cube and the cylinder surface become a pair. 
In the following figure you can see this circle.
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If your license includes the Structural Mechanics Module or the MEMS Module you 
can also create contact pairs using the Create Pairs dialog box. To do this select Contact 

pair in the Pair type list. This list is absent in the dialog box if you do not have any of 
these two modules. Contact pairs are used when modeling structural contact. You can 
read about this topic in the Structural Mechanics Module User’s Guide and the 
MEMS Module User’s Guide.

C O N T R O L L I N G  T H E  R E P A I R  TO L E R A N C E

When creating pairs, the software ignores gaps that are smaller than a certain tolerance. 
You can change this value in the Repair tolerance edit field. This value is relative to the 
overall dimensions of the geometry. For example, if the dimensions are in meters, the 
default repair tolerance of 10−6 makes the software ignore gaps that are smaller than 
about a micrometer (10−6 m). If your geometry has larger defects, you might need to 
increase this tolerance. To resolve extremely small gaps, you might need to decrease 
the repair tolerance. To turn off the repair functionality, clear the Repair check box. 
This is equivalent to using 10−10 as repair tolerance. Note that the repair tolerance in 
the Create Pairs dialog box is used also when you click the Create Pairs and Imprints 
button or the Create Pairs button on the Draw toolbar.
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I d e n t i t y  Pa i r s

When making models with assemblies you need to define identity pairs, which define 
where the parts of the assemblies are connected. The application modes use the pairs 
to put constraints on the equations such that the solution becomes continuous across 
the border between the parts. An identity pair consists of two sets of domains, either 
two sets of boundaries, two sets of edges, or two sets of points. Such pairs are called 
identity boundary pairs, identity edge pairs, and identity point pairs, respectively. The 
two sets of domains are the source domains and the destination domains. The 
application modes put a constraint on the dependent variables on the destination 
domains, forcing them to be equal to the value on the source domains. When the 
source and destination do not match each other completely you obtain the best 
numerical result if you let the destination be the smaller of the two. When creating 
pairs using either the Create Pairs dialog box or any of the Create Pairs and Imprints 
button or the Create Pairs button on the Draw toolbar, the smaller side always becomes 
the destination. The easiest way to create the identity pairs is to use the dialog box or 
the toolbar buttons. For details see the section “Creating Pairs” on page 407; it 
describes how to manually define the pairs, which becomes necessary if the automatic 
generation fails, or if you need to adjust the pairs that the automatic generation 
created.
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The Identity Pair Dialog Box

To define identity pairs, choose any of the commands on the Physics>Identity Pairs 
menu. Doing so opens the dialog box for the identity pairs of the selected domain type, 
for example, the Identity Boundary Pairs dialog box.

Each pair has a name. The application modes use this name to refer to the pair. The 
names must be unique for each domain level, but pairs on different domain levels can 
have the same name. For example, two boundary pairs cannot have the name “Pair 1,” 
while there can be both a boundary pair and a point pair called “Pair 1.”

The two domain lists show the source and destination domains of the pair selected in 
the list on the left. The check boxes beside the domain numbers indicate which 
domains belong to the source and which to the destination.

Clicking the buttons Check Selected below the lists selects the check boxes of the 
domains highlighted in the list. This is equivalent to selecting the individual check 
boxes and is a quick way to select multiple check boxes. Clicking the button Clear 

Selected similarly clears the check boxes of the selected domains.

Use the buttons Select Source and Select Destination to select the source and destination 
domains in the main window and in the selection lists.

Clicking the arrow button between the selection lists interchanges the source and 
destination domains.
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T I P S  F O R  M O D E L I N G  U S I N G  I D E N T I T Y  P A I R S

Note these aspects of the modeling procedure using identity pairs:

• When adding identity pairs, use the domain with the coarser mesh as the source 
domain and the domain with a finer mesh as the destination domain.

• When using identity pairs to connect boundaries or edges that do not have 
equivalent meshes, use the sparse null-space function, particularly in 3D. Normally 
the automatic selection takes care of this. To specify the sparse null-space function, 
open the Solver Parameters dialog box, click the Advanced tab, and select Sparse from 
the Null-space function list.

C O U P L I N G  O P E R A T O R S

On the Advanced page in the Identity Boundary Pairs, Identity Edge Pairs, and Identity 

Point Pairs dialog box you can define the names of the pair’s coupling operators. A 
coupling operator evaluates its argument on one side of the pair and makes the result 
available on the other side.

In the previous figure you can see two operators: src2dst_ip5, mapping from the 
source of the pair to the destination, and dst2src_ip5, mapping in the other 
direction. For example, if u is a variable on the source side then you can use the 
expression src2dst_ip5(u) on the destination side.

When creating a pair COMSOL Multiphysics automatically defines the operators and 
give them a name. The names have to be unique within the whole model.

The application modes use the operators to define the constraint which forces the 
dependent variables to be continuous across the border between the parts of the 
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assembly. For example, if u is a dependent variable, the application modes define the 
constraint src2dst_ip5(u) = u on the destination side of the pair.

You can also use the operators in logical expressions. The operator name without an 
argument evaluates to true in the points which have a corresponding source point in 
the same position. As an example consider the cube and cylinder in Figure 15-1below. 
Assume that the rectangle on top of the cube is the source of a pair and that the bottom 
cylinder surface is the destination. Further assume that the operator src2dst maps 
from the source to the destination. Then you can use the expression 
if(src2dst,1,2) on the source side (the cube). It evaluates to 1 in the points on the 
surface touching the cylinder and to 2 in the other points.

Figure 15-1: A cube and a cylinder which are two parts of an assembly. The cube’s upper 
surface is the source boundary of an identity pair and the cylinder’s bottom surface is the 
destination boundary of the pair.

U S I N G  F R A M E S  F O R  P A I R S

If there is more than one frame in a model you can choose on which frame to evaluate 
the expressions when using coupling operators. If you choose two different frames for 
the source and destination, you can simulate that the source and destination are 
translated or rotated relative to each other.

The panel where you can select frames does not appear when there are no extra frames 
in the model.
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Selection Colors for Pairs

When you select a domain it is normally highlighted in red. In 3D selected domain can 
also be blue and green for confirmed selections (see “Object Selection Methods in 3D” 
on page 127 of the COMSOL Multiphysics User’s Guide). In addition, pairs have their 
own selection colors.

In Draw mode the domains belonging to a pair have a yellow color. This is true 
whether they are selected or not.

In the Subdomain, Boundary, Edge, and Point selection modes the pair domains have 
three possible selection colors. When you select a source domain it becomes 
highlighted in cyan. A destination domain which you select becomes highlighted in 
magenta. If a domain is a source domain to one pair and a destination domain to 
another pair it is highlighted in yellow. These specific selection colors for pairs override 
the red selection color but not the green and blue colors for confirmed selections.

You can deactivate the pair colors and use only the red selection color. To do so open 
the Preferences dialog box, and on the Visualization page clear the Pair colors check box. 
This also turns off the yellow color for the pairs in Draw mode.
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S p e c i f y i n g  Ph y s i c s  S e t t i n g s  on Pa i r s

The application modes use the identity pairs described in the previous chapter to define 
the boundary conditions at the border between the domains in the pair. The default 
boundary condition ensures continuity of the dependent variables across this border, 
but you can specify other boundary conditions. To do this, use the Boundary Settings, 
Edge Settings, and Point Settings dialog boxes. Whenever there are pairs in a model, a 
Pairs page appears in the dialog box (see the following figure).

The boundary condition that you apply to a pair is active everywhere where the two 
sides of the pair are in contact. But you can also set boundary conditions on the 
individual boundaries of the pair. Do so on the Boundaries page. These settings are 
active everywhere where the domains of the pair are not in contact with each other. To 
clarify how this works, consider the example of a cube with a cylinder on top of it in 
Figure 15-1 on page 413. Assume that the cube’s upper surface is Boundary 4 and the 
cylinder’s bottom surface is Boundary 9. The boundary condition on the pair applies 
to the circular area where the two surfaces are in contact. You specify the boundary 
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condition for the rest of Boundary 4 on the Boundaries page. In the following figure 
this boundary condition is a heat flux boundary condition.

If you specify a boundary condition at Boundary 9 in this list, this boundary condition 
has no effect. This is because all of Boundary 9 is in contact with Boundary 4 and 
therefore the boundary condition of the pair applies everywhere on this boundary.

Controlling the Use of Pairs

On the Pairs page you find the Active pair check box. Clearing this check box makes 
the pair inactive for this application mode. In this case the application mode does not 
use the boundary condition on the pair but instead uses the boundary conditions on 
the individual boundaries that you specify on the Boundaries page. When a pair is not 
active the application mode does not ensure that the dependent variables are 
continuous across the border between the parts. Instead the boundaries on the two 
sides of the pair behave like exterior boundaries, and the parts are completely insulated 
from each other.

Pairs also become inactive if you have deactivated the application mode in one part of 
the geometry such that one or both sides of the pair belongs to the inactive part. In 
that case the active side of the pair is an exterior boundary, and the settings on the 
Boundaries page apply.
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Edge and Point Pairs

You specify the settings for edge and point pairs in the same way as for boundary pairs. 
But most application modes do not use the edge and point pairs. The application 
modes that define their equations on the subdomain level use boundary pairs only. The 
reason is that because the setting on the boundary pair ensures that the dependent 
variables are continuous between the boundaries, this also ensures that they are 
continuous between the edges and points adjacent to the boundaries in contact. 
Putting constraints on the edges and points is therefore unnecessary.

The application modes which define their equations on the boundary level use the pairs 
on edges in 3D or on points in 2D. The dependent variables of these application modes 
need a constraint on the edges (or points) to be continuous.

Similarly, the application modes that define their equations on the edge level use the 
point pairs.

Slit Boundary Conditions

On the borders between pairs in an assembly, you can specify special “slit boundary 
conditions,” which represent a discontinuity in the field due to, for example, contact 
resistance. The following application modes include a boundary condition of this type:

These boundary conditions are available in the Boundary Settings dialog box by clicking 
the Pairs tab and selecting the pairs where you want to apply the boundary condition. 
In addition to the physical quantity listed in Table 15-1, you must also enter the 
thickness of the layer or gap. For an example model, see “Example—Thin-Film 
Resistance” on page 422.

TABLE 15-1:  SLIT BOUNDARY CONDITIONS

APPLICATION MODE BOUNDARY CONDITION PHYSICAL QUANTITY

Conductive Media DC Contact resistance Electric conductivity

Electrostatics Thin highly capacitive layer Permittivity

Diffusion, Convection and 
Diffusion, Electrokinetic Flow

Thin boundary layer Diffusion coefficient

Heat Transfer by Conduction, 
Convection and Conduction, 
General Heat Transfer

Thin thermally resistive layer Thermal conductivity

Magnetostatics, No Currents Thin low permeability gap Permeability
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Note: The General Heat Transfer application mode is available only in the Heat 
Transfer Module, and the Magnetostatics, No Currents application mode is available 
only in the AC/DC Module. The Electrokinetic Flow application mode is available 
only in the MEMS Module and the Chemical Engineering Module.
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Me sh i n g  A s s emb l i e s

A geometry object that is to be meshed is classified as either a composite geometry or 
an assembly. For more information on the two geometry types see “The Analyzed 
Geometry—Assembly vs. Composite Geometry” on page 406.

When meshing an assembly, the mesh generator creates meshes for the individual parts 
of the assembly independently of each other. This means that a geometry object of 
assembly type often gives you more freedom when determining the meshing strategy 
than the corresponding composite geometry. Furthermore, in most cases, an assembly 
generates a mesh with fewer elements than the corresponding composite geometry.

Whether you create an assembly with or without imprints also affects the meshing 
process. An assembly created without imprints gives you even more freedom when 
determining the meshing strategy than the corresponding assembly with imprints.

Example—Meshing a Composite Geometry or an Assembly

To show the different meshing possibilities for a geometry object of composite 
geometry type and assembly type (with and without imprints), this example uses the 
following geometry object consisting of two subdomains.

C O M P O S I T E  G E O M E T R Y

If the geometry object is a composite geometry, there is only one face connecting the 
two subdomains. This face, common to both subdomains, is called an interior 
boundary of the geometry object. Due to topology reasons of the lower subdomain 
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(that is, the connectivity of the faces about the subdomain) you must use the free 
mesher when meshing the lower subdomain. This means that the interior boundary 
face contains triangular boundary elements (see the following figure).

When meshing the upper subdomain you can use the free mesher or the swept mesher. 
However, if you use the swept mesher for this subdomain the interior boundary face 
must be used as the source face or the target face for the sweep. Hence, it is not 
possible to create a swept hexahedral mesh on the upper subdomain. The next figure 
shows a swept prism mesh on the upper subdomain.

A S S E M B L Y  W I T H  I M P R I N T S

If you model the geometry object as an assembly with imprints, COMSOL 
Multiphysics creates two separate faces of the same shape, belonging to each part, at 
the border between the parts. The meshes for these faces are independent of each 
other. Due to the imprint on the lower part, it is only possible to create a free mesh on 
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this part. However, because you can create a mesh for the upper part independently of 
the lower part you can create a swept hexahedral mesh on the upper subdomain.

A S S E M B L Y  W I T H O U T  I M P R I N T S

If you form an assembly without imprints you can freely mesh the two parts 
(subdomains) independently of each other. Because there is no imprint of the upper 
part on the lower part, it is now possible to create a swept mesh on the lower part as 
well. In the next figure, the mesh generator creates a swept hexahedral mesh on both 
parts of the assembly.
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Examp l e—Th i n - F i lm Re s i s t a n c e

When modeling transport by diffusion or conduction in thin layers, large differences 
in dimensions of the different subdomains are common. If the model has a sandwich 
structure, you can replace the thinnest layers with a thin-layer approximation, provided 
that the difference in thickness is large.

Model Definition

This study explains the principle of the thin-layer approximation in direct current 
conduction problems. A comparison of a structure with three subdomains to a 
simplified model that replaces the domain in the middle with a thin-layer 
approximation shows the benefit of this approach (see Figure 15-2).

Figure 15-2: Exact domain description (left) and approximation (right). The current 
flows from the base plate to the circular plate on the upper surface of the device.

Equation 15-1 below describes the current balance in all three subdomains in the real 
sandwich structure:

 (15-1)

In this equation, σ represents the conductivity and V the electric potential. In this case, 
there is a substantial difference in conductivity between the thin and thicker layers of 
the structure. The boundary conditions include a current inlet in the base plate of the 
device and a constant potential at the upper circular boundary (see Figure 15-2). All 
other boundaries are insulated.

The simplified model is based on the assumption that the components of the current 
density vector in the x and y directions are small and that the dominating transport 

z Constant
potential

Inlet
current

∇ σ∇V–( )⋅ 0=
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through the thin structure is obtained in the z direction. For the middle layer, this 
implies that you can approximate Equation 15-1 by the one-dimensional equation

 (15-2)

It is possible to solve this equation analytically if the potential is given at the lower and 
upper surfaces of the middle layer:

 (15-3)

 (15-4)

You can integrate Equation 15-2 analytically to give:

 (15-5)

where a and b are integration constants. If you arbitrarily place z = 0 at the lower 
boundary of the middle layer, you get the constants a and b from the boundary 
conditions in Equation 15-3 and Equation 15-4:

 (15-6)

 (15-7)

This gives:

 (15-8)

 (15-9)

The resulting equation for the potential is thus

 (15-10)

The current density is defined as

 (15-11)

Combining Equation 15-10 and Equation 15-11 gives

σd2V

dz2
-----------– 0=

Vδ 0= V1=

Vδ δ1= V2=

V az b+=

V1 b=

V2 aδ b+=

b V1=

a
V2 V1–

δ
--------------------=

V
V2 V1–

δ
--------------------⎝ ⎠
⎛ ⎞ z V1+=

Jz σdV
dz
--------–=
E X A M P L E — T H I N - F I L M  R E S I S T A N C E  |  423



424 |  C H A P T E R
 (15-12)

In the thin-film approximation the potential is discontinuous at the film boundary. 
Using an assembly it is possible to model such a potential. The Conductive Media DC 
application mode has a contact resistance boundary condition available at pairs, which 
uses the thin-film approximation.

It is also possible to derive the expression for the current density in Equation 15-12 by 
approximating the gradient using the potential difference over the thin layer. This 
example includes the previous tedious derivation to show that this is exactly what you 
obtain from the solution of Equation 15-2.

The approximation presented in this example is not limited to direct current problems: 
You can also use it for modeling of diffusion, heat conduction, flow through porous 
media using Darcy’s law, and other types of physics that the divergence of a gradient 
flux describes.

In general, the application of this simplification is appropriate in cases where the 
differences in thickness are so large that the mesh generator cannot even mesh the 
domain. In some cases, the mesh generator might be able to mesh the domain but then 
creates a very large number of elements.

Results

Figure 15-3 shows a comparison between the exact solution of the problem using 
three conductive layers and the thin-film approximation. The comparison reveals an 
excellent agreement in the potential and current distribution despite that the middle 
film in this study is relatively thick. The approximation becomes even more accurate as 
the film thickness between the upper and lower subdomain decreases.

Jz σ
V2 V1–

δ
--------------------⎝ ⎠
⎛ ⎞–=
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Figure 15-3: Potential distribution in the modeled device. The value of the potential loss 
over the device at a current of 0.3 A is almost identical in the two models: the full model 
(left) and thin-film approximation (right).

Figure 15-4 shows a cross-section plot of the potential through the structure’s center 
for the full model and for the approximation. The plots show the excellent agreement 
obtained between the two models.

Figure 15-4: Potential distribution along the z direction in the middle of the device. 
Solution for the full model (left) and for the thin-film approximation (right).

Model Library path: COMSOL_Multiphysics/Electromagnetics/
thin_film_resistance
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Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Start COMSOL Multiphysics.Under the New tab select 3D in the Space dimension 
list.

2 From the list of application modes, select Conductive Media DC, which you find under 
COMSOL Multiphysics>Electromagnetics.

3 Click OK.

G E O M E T R Y  M O D E L I N G

1 Draw the bottom block by selecting Draw>Block. Set the thickness of the block to 
0.1 in the z direction (this is set in the Length frame) and leave the other settings as 
they are. Click OK.

2 Draw the top block in the same way except for the Axis base point, which should be 
at x  =  0, y  =   0, and z   =  0.1.

3 Click the Zoom Extents button on the Main toolbar to get a better view of the 
geometry.

4 Now go to Draw>Work-Plane Settings and click OK to create a work plane with the 
default settings. A work plane is created under the new Geom2 tab, while the original 
3D geometry remains under the Geom1 tab.

5 Now go to the work plane by clicking on the Geom2 tab. Click Zoom Extents to see 
the outlines of the 3D geometry from Geom1.

6 Draw a circle centered at (1, 0) with a radius of 0.6. This is done by selecting 
Draw>Specify Objects>Circle. In the Size area set the Radius to 0.6, and in the Position 
area set Base to Center and the coordinate x to 1 and y  to  0. Click OK.

7 Draw a square by clicking the Rectangle/Square button from the Draw toolbar on the 
left and click on the point (0, 1) and then (1, 0).

8 Create an object by finding the intersection of the square and the circle. This is done 
by selecting both objects (press Ctrl+A) and then clicking on the Intersection tool 
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on the Draw toolbar on the left. The 2D geometry in Geom2 should now look as in 
the figure below:

The work plane.

9 Now embed the quarter-circle in the 3D geometry by selecting Draw>Embed and 
clicking OK.

10 Move the flat quarter-circle surface to the top corner of the structure by pressing 
Ctrl+X followed by Ctrl+V. For the displacements, type -1, 1, and 0.2 in the x, y, 
and z edit fields, respectively, then click OK.

11 Rotate the quarter circle by first selecting it and then clicking the Rotate button on 
the Draw toolbar on the left. Type 180 in the Rotation angle edit field (the rotation 
angle α in degrees) and specify the point on the rotation axis to be (0, 1, 0) in the 
Point on rotation axis area. Click OK.

12 Select the embedded object EMB1 and the upper block BLK2 and click the Coerce to 

Solid button to combine the two objects to a single object.

13 Click the Create Pairs button on the Draw toolbar to create the pair joining the two 
objects.
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The final geometry should look as in the figure below:

The final 3D geometry.

P H Y S I C S  S E T T I N G S

Subdomain Settings
1 Select Physics>Subdomain Settings.

2 Select all subdomains.

3 In the σ edit field (Electric conductivity) type 1. Click OK.

Boundary Conditions
1 Select Physics>Boundary Settings and set the following boundary conditions:

2 Click the Pairs tab and select Pair 1. From the Boundary condition list, select Contact 

resistance. In the σ edit field, enter the electric conductivity 1e-2 and in the d edit 
field enter the thickness 0.02. Click OK.

C O M P U T I N G  T H E  S O L U T I O N

Click the Solve button on the Main toolbar to mesh and solve the model.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

Reproduce the right panel of Figure 15-3 by following these instructions:

SETTINGS BOUNDARY 3 BOUNDARY 11 ALL OTHERS

Boundary condition Inward current flow Ground Electric insulation

Jn 0.3
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1 Click the Plot Parameters button on the Main toolbar.

2 On the General page, clear the Slice check box and select the Boundary check box.

3 Click the Boundary tab.

4 From the Predefined quantities list, select Conductive Media DC (dc)>Electric potential.

5 Clear the Smooth check box.

6 Click OK.

To generate the plot in the right panel of Figure 15-4, proceed with the following 
steps:

1 From the Postprocessing menu, select Cross-Section Plot Parameters.

2 On the Line/Extrusion page, verify that the selection in the Predefined quantities list 
in the y-axis data area is Electric potential.

3 In the x-axis data area, click first the lower option button and then the Expression 
button.

4 In the X-Axis Data dialog box, type z in the Expression edit field. Click OK.

5 In the Cross-section line data area, enter the following settings:

6 Click OK to close the Cross-Section Plot Parameters dialog box and generate the plot.

Comparing the Thin-Film Approximation with the Full 3D Model

You can easily reproduce the full 3D model that served as a reference model for 
comparison in this example. To do so, move the upper block, CO1, a distance 0.02 in 
the z direction, then add a thin block with the height 0.02 in between the top and 
bottom block. Here it is not necessary to use an assembly, so you can clear Use Assembly 
in the Draw menu. Set the conductivity to 0.01 in this thin middle subdomain (leave it 
at 1 in the top and bottom subdomains). Let the boundary conditions for the top and 
bottom of the thin layer be inactive, which means that the solution is continuous across 
the interfaces. Let the exterior boundary conditions be the same (that is, electric 
insulation), and compute the solution for this model.

It should now be apparent that the two solutions show good agreement and that the 
first approach consumes significantly less time and memory.

x0 0.5 x1 0.5

y0 0.5 y1 0.5

z0 0 z1 0.2
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U s i n g  I d e n t i t y  C ond i t i o n s

To connect the fields of physics across different geometries, you can use identity 
conditions that make the physical quantities equal across the different parts. The 
identity boundary conditions and identity conditions on other domain types define a 
constraint that makes two quantities equal on two separate (but usually 
equally-shaped) domains in two different geometries where you do not need a 
coordinate transformation between the source and destination domains. That is, the 
source and the destination domains must lie in the same place in the coordinate space.

Note: Using an assembly and identity pairs, you can work with a geometry that 
consists of several parts without using multiple geometries and identity conditions.

Creating Identity Conditions

When you do not need a transformation, you specify an identity condition in the same 
way as you specify a periodic condition:

1 Select the source geometry for the coupling variable.

2 In the Options menu, point to Identity Conditions, and then click on the domain type: 
Identity Subdomain Conditions, Identity Boundary Conditions, Identity Edge Conditions 
(3D only), or Identity Point Conditions.

3 In the dialog box for the identity conditions, start by specifying the source geometry 
on the Source page. Enter the expression that you wish to use in the identity 
coupling for the source. Refer to each constraint in the identity coupling by a name. 
A default name appears for the constraint that implements the identity coupling. To 
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change the default name of the constraint while working on the source page, type 
another name in the Constraint name column.

Figure 15-5: The Source page in the Identity Boundary Conditions dialog box.

4 Click the Destination tab to define the destination domains. Select the destination 
geometry in the Geometry list. Then select the constraint that you want to specify in 
the Constraint name list. Select the check boxes for the appropriate domains such as 
Boundary 4 in Figure 15-6, for example. Finally specify the expression that becomes 
equal to the expression on the source domain for the corresponding constraint.

Figure 15-6: The Destination page in the Identity Boundary Conditions dialog box.

5 Click OK when you have defined all the identity conditions for the domain type that 
you are working with.

See the model example on the following pages for a description of how to combine 
two geometries with brick and prism meshes using an identity boundary condition.
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M O D E L I N G  P R O C E D U R E  W H E N  U S I N G  I D E N T I T Y  C O N D I T I O N S

Note the following aspects of the modeling procedure when using identity conditions:

• When adding identity conditions, use the domain with the coarser mesh as the 
source domain and the domain with a finer mesh as the destination domain.

• For an identity boundary condition, use a Neumann boundary condition for the 
boundaries on both the source and destination domains. The identity boundary 
conditions do not work if you use a Dirichlet boundary condition. You specify the 
boundary conditions in the Boundary Settings dialog box.

• If the source domain is larger than the destination domain and you would like to 
use a different type of boundary condition on the part of that boundary that is not 
connected to the destination boundary in the other domain, you can introduce a 
smaller domain that matches the destination domain. This might, however, limit the 
possibilities to use a mapped 2D mesh and then also a 3D mesh using brick 
elements. In that case, consider using an unstructured triangular 2D mesh and mesh 
extrusion to form a 3D mesh using prism elements if you want to avoid an 
unstructured tetrahedral mesh.

• When using identity-coupling variables to connect boundaries or edges that do not 
have equivalent meshes, use the sparse null-space function, particularly in 3D. 
Normally the automatic selection takes care of this. To specify the sparse null-space 
function, open the Solver Parameters dialog box, click the Advanced tab, and select 
Sparse in the Null-space function list.

• Use the same name for the dependent variables and the application modes that 
represent the same physics in different geometries. This makes it convenient to 
postprocess the results in the entire geometry. Select all the geometries in the 
Geometries to use list in the Plot Parameters dialog box to plot the results in all parts 
of the model. The default is that you have unique names, but it is possible to edit 
the names of the application mode and the dependent variable to be the same as 
long as the application modes belong to different geometries. For an example of 
how to do this, see “Example—Thin-Layer Diffusion” on page 434.

I M P L E M E N T A T I O N  O F  T H E  I D E N T I T Y  C O N D I T I O N S

COMSOL Multiphysics implements an identity condition as a special case of the 
extrusion coupling variable. In particular, it adds a variable name equal to the 
constraint name on the destination domains with a value equal to the constrained 
expression. The constraint works as an ideal constraint, that is, the derivatives of the 
constraint with respect to the solution help form the reaction forces. If you need more 
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freedom in specifying how the reaction forces are applied, use the extrusion coupling 
variable directly and specify the reaction force and constraint as weak contributions.

Note: It is normally much easier to work with an assembly that consists of two or 
more geometrical parts. You can then use identity pairs and interactive meshing to 
create a model where the physics is connected and where you can use different types 
of meshes in each part.

M O D E L I N G  P R O C E D U R E  F O R  M U L T I G E O M E T R Y  L I N K I N G

The following list shows the main steps you must take to make a model with a 
continuous field that you link between two or more geometries:

1 Create the full geometry using separate geometries (parts) in the COMSOL 
Multiphysics model. Use the View All 3D Geometries/View All 2D Geometries button 
in the Visualization/Selection toolbar or the View Geometries dialog box to show 
other geometries than the current geometry during modeling. This helps to see that 
the geometries are spatially connected and that the total geometry looks right.

2 Create the meshes for the different geometries. These can be of different kinds, 
which is not possible using a single geometry. This is the main advantage with this 
multigeometry approach.

3 Add the physics to the different geometries. It is typically the same type of physics, 
and the field is continuous across the geometries. For this purpose, use the same 
name for the field variables (dependent variables) and the application modes. You 
can then visualize and postprocess the solution on the entire geometry using the 
same variable names for both dependent variables and application mode variables 
that use the application mode name as a suffix.

Note: The default names for the application modes and dependent variables are 
different for each application mode that you add. Make sure to edit these to make all 
names the same.

4 Use identity boundary conditions to link the physics across the different geometries.

5 Compute the solution.

6 For visualization plot the results in all geometries simultaneously. To do so, select 
all the geometries in the Geometries to use list in the Plot Parameters dialog box.
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Examp l e—Th i n - L a y e r  D i f f u s i o n

The following example shows how to link two separate geometries into a 3D thin-layer 
diffusion model using identity boundary conditions. It also illustrates the use of 
different mesh element types; the brick and prism elements provide a large reduction 
in the number of degrees of freedom (DOFs) for this thin geometry. For more 
information about mesh elements and meshing options, see “Meshing” on page 299 
of the COMSOL Multiphysics User’s Guide.

In this model you can significantly reduce the number of DOFs—and thus the solution 
time—by taking advantage of the geometry shape using brick and prism meshes 
instead of an unstructured tetrahedral mesh. The total model has only about 2300 
DOFs using this approach. Using a default tetrahedral mesh on the same geometry 
leads to a problem with roughly 18,000 DOFs.

The physics in this model is a single-species diffusion. The dependent variable is the 
concentration, c. All boundaries are insulated except the inlet and the outlet. At the 
inlet boundary the concentration is c0. At the outflow boundary (the bottom surface) 
there is an outward flux of  −rsurf c/c0 (COMSOL Multiphysics defines the inward flux 
as positive), where rsurf is the reaction rate at the surface. An effective diffusion 
coefficient takes the porous material in the thin bottom plate into account. Table 15-2 
on page 441 lists all material properties in the model.

The interface condition at the connection between the top and bottom parts is that 
the concentration c is equal on both sides.
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Figure 15-7: Resulting concentration distribution in the full geometry.

Model Library path: COMSOL_Multiphysics/Diffusion/
thin_layer_diffusion

Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Start COMSOL Multiphysics.

2 In the Model Navigator click the Multiphysics button.

3 Click the Add Geometry button to add a 2D geometry.

4 Click OK to accept the default settings and create the first geometry: Geom1 (2D).

5 Repeat Steps 3 and 4 to create a second 2D geometry: Geom2 (2D).

6 Select Geom1 (2D) to make it the current geometry.

7 Click OK.
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G E O M E T R Y  M O D E L I N G

Geometry 1 (Base Block Work Plane)
1 Shift-click the Rectangle/Square button on the Draw toolbar.

2 In the Rectangle dialog box, type 11e-6 in the Width edit field and 6e-6 in the Height 
edit field.

3 Click OK.

4 Click the Zoom Extents button on the Main toolbar.

Geometry 2 (Top Layer Work Plane)
1 Click the Geom2 tab to switch to the other 2D geometry.

2 From the Options menu choose View Geometries.

3 In the View Geometries dialog box select Geom1 (2D), then click OK.

You can also use the View All 2D Geometries button in the Visualization/Selection 
toolbar.

4 Click the Zoom Extents button on the Main toolbar.

5 Draw a rectangle with corners at (3e-6, 5e-6) and (1.1e-5, 4e-6).

6 Press Ctrl+C to make a copy of the rectangle, then press Ctrl+V to paste the copy.

7 In the Paste dialog box, type -3e-6 in the y edit field, then click OK.

8 Draw a centered circle, C1, with its center at (3e-6, 3e-6) and a radius of 2e-6 by 
first clicking the Ellipse/Circle (Centered) button on the Draw toolbar, and then using 
the right mouse button in the drawing area.

9 Draw another centered circle, C2, with its center at (3e-6, 3e-6) and a radius of 
1e-6.

10 Draw a rectangle, R3, with corners at (3e-6, 5e-6) and (5e-6, 1e-6).

11 From the Draw menu choose Create Composite Object.

12 In the Set formula edit field, type C1-C2-R3. Click OK.
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M E S H  G E N E R A T I O N

Geometry 2 (Top Layer Work Plane)
Click the Initialize Mesh button to create a triangular mesh for the top U-shaped part.

The triangular mesh for the top layer.

Geometry 1 (Base Block Work Plane)
1 Click the Geom1 tab.

2 From the Mesh menu, choose Mapped Mesh Parameters.

3 Click the Boundary tab.

4 Select Boundary 1.

5 Click to select the Constrained edge element distribution check box.

6 In the Number of edge elements edit field, type 4.

7 Select Boundary 3.

8 Click to select the Constrained edge element distribution check box.
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9 In the Number of edge elements edit field, type 6.

10 Click the Remesh button. This creates a 4-by-6 quadrilateral mesh.

11 Click Cancel.

The quadrilateral mesh for the base block work plane.

Geometry 3 (Base Block)
The next step is to extrude the mapped mesh into a 3D brick mesh.

1 From the Mesh menu, choose Extrude Mesh.
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2 In the Distance edit field, type -4e-7.

3 Click OK to extrude the quadrilateral mesh 0.4 micrometer in the negative 
z direction. This creates a brick mesh in a new 3D geometry, Geom3 (3D).

Geometry 4 (Top Layer)
1 Click the Geom2 tab.

2 From the Mesh menu, choose Extrude Mesh.

3 In the Distance edit field, type 2e-7.

4 From the Extrude to geometry list, select New geometry.

5 Click OK to extrude the triangular mesh 0.2 µm in the positive z direction. This 
creates a prism mesh in a new 3D geometry, Geom4 (3D).

6 In the View Geometries dialog box, select Geom3 (3D). Click OK to view both 3D 
geometries.
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7 Click the Zoom Extents button on the Main toolbar.

The extruded prism mesh. The blue lines indicate the base block geometry.

Model Navigator
Open the Model Navigator from the Multiphysics menu to add Diffusion application 
modes to both 3D geometries:

1 From the Multiphysics menu, choose the Model Navigator.

2 Select Geom3 (3D) in the list of geometries in the Multiphysics area.

3 In the list of application modes, open the COMSOL Multiphysics> 
Convection and Diffusion folder. Select Diffusion, then click Add.

4 Select Geom4 (3D) in the list of geometries in the Multiphysics area.

Add another Diffusion application mode with the same name and dependent 
variable:

5 Make sure that Diffusion is selected in the list of application modes.

6 Type c in the Dependent variables edit field.
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7 In the Application mode name edit field, type di.

8 Click Add, then click OK.

O P T I O N S  A N D  S E T T I N G S

1 From the Options menu, choose Constants.

2 Enter the constants from the following table (the descriptions are optional); when 
finished, click OK.

P H Y S I C S  S E T T I N G S

Subdomain Settings—Base Block
1 Click the Geom3 tab.

2 In the View Geometries dialog box, select Geom4 (3D). Click OK to view both 3D 
geometries.

3 From the Physics menu, choose Subdomain Settings.

TABLE 15-2:  MODEL DATA

NAME EXPRESSION DESCRIPTION

r_surf 0.005[mol/(m^2*s) Reaction rate, outlet

c0 7[mol/m^3] Concentration, inlet

D1 5e-5[m^2/s] Diffusion coefficient, top layer

D1_eff 1e-6[m^2/s] Effective diffusion coefficient, base block
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4 Select Subdomain 1.

5 Type D1_eff in the D (isotropic) edit field for the isotropic diffusion coefficient.

6 Click the Init tab.

7 In the c(t0) edit field, type c0.

8 Click OK.

Boundary Conditions—Base Block
1 From the Physics menu, choose Boundary Settings.

2 Select Boundary 3 (the bottom boundary).

3 From the Boundary condition list, select Flux.

4 Type -r_surf*c/c0 in the N0 edit field for the inward flux to define an outward 
flux.

5 Click OK.

Subdomain Settings—Top Layer
1 Click the Geom4 tab.

2 In the View Geometries dialog box, select Geom3 (3D). Click OK to view both 3D 
geometries.

3 From the Physics menu, choose Subdomain Settings.

4 Press Ctrl+A to select all subdomains.

5 Type D1 in the D (isotropic) edit field for the isotropic diffusion coefficient.

6 Click the Init tab.

7 In the c(t0) edit field, type c0.

8 Click OK.

Boundary Conditions—Top Layer
1 From the Physics menu, choose Boundary Settings.

2 Select Boundary 18 (the top inflow boundary).

3 Select Concentration in the Boundary condition list.

4 In the c0 edit field for concentration, type c0.

5 Click OK.

Identity Boundary Conditions
To couple the concentration values from the base block to the top layer, use an identity 
boundary condition.
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1 Click the Geom3 tab.

2 In the Options menu, point to Identity Conditions, and then click Identity Boundary 

Conditions.

3 Select Boundary 4 (the top boundary).

4 Type c in the top row under Expression.

5 Move to the Constraint name column. The default name ipconstr1 appears 
automatically.

6 Click the Destination tab.

7 From the Geometry list, select Geom4.

8 Select Boundaries 3, 9, and 14 in the user interface. Click to select the Use selected 

boundaries as destination check box or click to select these boundaries directly in the 
Boundary selection list.

9 In the Expression edit field, type c.

10 Click OK.
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Computing the Solution
Click the Solve button on the Main toolbar to start the analysis.

Postprocessing and Visualization
To show the concentration distribution in the entire geometry, do the following steps:

1 From the Postprocessing menu, choose Plot Parameters.

2 On the General page, select both Geom3 and Geom4 in the Geometries to use list.

3 In the Plot type area click to clear the Slice check box, then select the Subdomain 
check box.

4 Click OK.
 1 5 :  U S I N G  A S S E M B L I E S



 16
D e f o r m e d  M e s h e s
This chapter explains how to use the application modes that control mesh 
deformation: the Moving Mesh (ALE) application mode and the Parameterized 
Geometry application mode.
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De f o rmed Me s h  Fundamen t a l s

A deformed mesh can be useful if the boundaries of your computational domain are 
moving in time or as a function of a parameter. The point is that a new mesh need not 
be generated for each configuration of the boundaries—instead, the software simply 
perturbs the mesh nodes so they conform with the moved boundaries.

In COMSOL Multiphysics, you can control the movement of the interior nodes in 
three ways:

• By propagating the moving boundary displacement throughout the domain to 
obtain a smooth mesh deformation everywhere — this is done by solving PDEs for 
the mesh displacements (a Laplace or Winslow smoothing PDE) with boundary 
conditions given by the movement of the boundaries.

• By specifying an explicit formula for the mesh deformation.

• By letting the mesh movement be determined by some physical deformation 
variables, such as the displacement components of structural mechanics.

The technique for mesh movement is called an arbitrary Lagrangian-Eulerian 
(ALE) method. In the special case of a Lagrangian method, the mesh movement 
follows the movement of the physical material. Such a method is often used in solid 
mechanics, where the displacements often are relatively small.

When the material motion is more complicated, like in a fluid flow model, the 
Lagrangian method is not appropriate. For such models, an Eulerian method, where 
the mesh is fixed, is often used—except that this method cannot account for moving 
boundaries.

The ALE method is an intermediate between the Lagrangian and Eulerian methods, 
and it combines the best features of both—it allows moving boundaries without the 
need for the mesh movement to follow the material.

Mathematical Description of the Mesh Movement

Though moving meshes are also possible in 3D, consider a 2D geometry for simplicity. 
First denote the spatial coordinates as (x, y) and then let (X, Y) be the coordinates of 
a mesh node in the initial, undeformed configuration. To describe the spatial 
coordinates (x, y) of the same mesh node in the deformed configuration, you can use 
the functions
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where t is time or some other parameter. This coordinate transformation relates two 
frames (coordinate systems):

• The spatial frame is the usual, fixed coordinate system with the spatial coordinates 
(x,y). In this coordinate system the mesh is moving, that is, the coordinates (x,y) of 
a mesh node are functions of time.

• The reference frame is the coordinate system defined by the reference coordinates 
(X,Y). In this coordinate system the mesh is fixed to its initial position. You can view 
the reference frame as a curvilinear coordinate system that follows the mesh.

Figure 16-1: An undeformed mesh. The spatial frame (x, y) and the reference frame 
(X, Y) coincide.

Figure 16-2: A deformed mesh with spatial frame (x, y) and reference frame (X, Y).

Some geometric variables that the software defines are available for both the spatial and 
the reference frames (see “Geometric Variables” on page 170 in the COMSOL 
Multiphysics User’s Guide).

x x X Y t, ,( ) y, y X Y t, ,( )= =
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Derivatives

S P A T I A L  D E R I V A T I V E S

For a dependent variable u, there are two kinds of spatial derivatives:

• ux and uy, the derivatives in the spatial frame. That is, u is considered as a function 
of x and y (and t). These are typically denoted ux and uy in the software.

• uX and uY, the derivatives in the reference frame. That is, u is considered as a 
function of X and Y (and t). These are typically denoted uX and uY in the software.

In COMSOL Multiphysics it is only possible to use one of these types of derivatives 
depending on the frame associated with the application mode that defines u.

T I M E  D E R I V A T I V E S

There are two kinds of time derivatives related to the two frames:

• The common spatial time derivative is related to the spatial frame:

The spatial coordinates (x, y) are fixed when computing this derivative; that is, you 
consider a fixed point in space. This derivative is often denoted ut in the software 
(see page 453).

• The reference time derivative (or mesh time derivative) is related to the reference 
frame:

The reference coordinates (X, Y) are fixed when computing this derivative; that is, 
you consider a point that follows the moving mesh, for instance a mesh node. This 
derivative is denoted uTIME in the software.

The two derivatives are related by the chain rule:

where (xTIME, yTIME) is the mesh velocity. The reference time derivative is often less 
important from the user point view because its value depends on the mesh movement, 
which has no physical significance. However, for the special case when the mesh 

ut t∂
∂u

x y,
=

uTIME t∂
∂u

X Y,
=

ut uTIME uxxTIME– uyyTIME–=
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follows the material’s motion (the Lagrangian method), the reference time derivative 
is physically significant and is also called the material time derivative.

The solvers assemble the discretized model on the deformed mesh, using the reference 
time derivative of the solution as input. They also compute the spatial time derivative 
by the preceding formula. This implies that the PDEs do not have to be reformulated 
when you use a deformed mesh. However, if you use a Lagrangian method, some 
material properties might depend on the material deformation (which is then the same 
as the mesh deformation).
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F r ame s  f o r  De f o rmed Me s h e s

When modeling deformed meshes you need two frames. A frame is a coordinate 
system, and it includes a set of coordinate names. The two frames are:

• The reference frame, which is the frame in which the mesh is fixed. This is the frame 
in which you draw the geometry and gives the shape of the geometry before it is 
deformed. This frame is associated with the geometry, and it exists even when you 
do not use deformed meshes.

• The spatial frame, which is the usual coordinate system that is fixed in space. In this 
frame the mesh is moving according to the settings in the deformed mesh 
application mode. The spatial frame is associated with the deformed mesh 
application mode.

Frames in the Model Navigator

Before you have added a deformed mesh application mode, there is only one frame, 
the reference frame. The reference coordinates are the independent variables in the 
 1 6 :  D E F O R M E D  M E S H E S



geometry, x, y, z, by default. You can change these names and the name of the 
reference frame in the Add Geometry dialog box.

Figure 16-3: The Model Navigator with a deformed mesh application mode selected in the 
list to the left.

When you select a deformed mesh application mode from the list of application modes 
to the left in the Model Navigator, you can specify the names of the spatial coordinates 
in an edit field below the list. By default they take the names of the independent 
variables of the geometry. If you do not change the default, the independent variables 
of the geometry (the reference coordinates) get new names. The software creates the 
names by capitalizing the spatial coordinates. For example, if the spatial coordinates are 
x, y, and z, it renames the reference coordinates to X, Y, and Z. If you edit the default 
spatial coordinates so that they are not equal to the current reference coordinates, the 
reference coordinates retain their names.

When you add a deformed mesh application mode, the software automatically adds a 
spatial frame. Its name coincides with the name of the deformed mesh application 
mode with which it is associated (either ale or pg). Alternatively, you can add the 
spatial frame in advance by going to the Multiphysics area on the right side of the Model 
Navigator and clicking the Add Frame button. This opens the Add Frame dialog box, 
where you can specify the names of the spatial coordinates and the spatial frame. If you 
then add a deformed mesh application mode, it is associated with the previously 
defined frame.
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The Multiphysics area to the right displays the spatial frame as a node attached to the 
geometry node. The deformed mesh application mode—in this case a Moving Mesh 
(ALE) application mode—is attached to the spatial frame it defines. All other 
application modes are attached to the frame in which their equations are formulated. 
Application modes attached directly to the geometry are associated with the reference 
frame.

Figure 16-4: The Model Navigator with a Moving Mesh (ALE) application mode in the 
model. The Plane Stress application mode’s equations are formulated on the reference 
frame and the Electrostatics application mode’s equations are formulated on the frame 
defined by the Moving Mesh (ALE) application mode.

When you add an application mode, it becomes attached to the reference frame or the 
spatial frame depending on which node you selected in the Multiphysics area. If you 
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want to change the frame to which an application mode is attached, open the 
Application Mode Properties dialog box and select a frame in the Frame list 

Figure 16-5: The Application Mode Properties dialog box. The Frame property indicates 
which frame the application mode uses.

In normal situations, follow these guidelines when attaching an application mode to a 
frame:

• When using the Parameterized Geometry application mode, attach all application 
modes to the spatial frame.

• When using the Moving Mesh (ALE) application mode, attach structural mechanics 
application modes to the reference frame. This is because a structural analysis 
computes the mesh displacements that you typically use as input for the Moving 
Mesh (ALE) application mode when it defines the spatial frame. Attach all other 
application modes to the spatial frame defined by the Moving Mesh (ALE) 
application mode. In, for example, fluid-structure interaction models, consider 
taking the area effect into account, because the fluid force is defined on the 
deformed mesh in the spatial frame whereas the structural mechanics loads use the 
fixed reference frame. You specify this factor as the mesh element scale factor for the 
spatial frame divided by the mesh element scale factor for the reference frame. This 
expression is typically dvol_ale/dvol. You find the names of the mesh element 
scale factors in the Frames area of the Model Settings dialog box on the Physics menu.

An application mode’s frame affects the names of its variables. Specifically, the software 
uses the frame’s coordinate names when forming derivatives and vector components. 
In addition, it interprets a time derivative ut as a derivative in the application mode’s 
frame, while uTIME is always a derivative in the reference frame. See also “Shape 
Function Variables” on page 176 of the COMSOL Multiphysics User’s Guide.
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The two application modes defining the deformed mesh have two frame properties:

• The Defines frame property indicates which frame’s spatial coordinates that the 
application mode defines (the spatial frame). This frame cannot be the reference 
frame associated with the geometry.

• The Motion relative to property indicates which frame serves as the reference frame. 
By default this is the reference frame associated with the geometry. It cannot be the 
same frame as the frame that the application mode defines.

Figure 16-6: The Application Mode Properties dialog box of the Moving Mesh (ALE) 
application mode.

Settings for Frames

In the Model Settings dialog box, which you open from the Physics menu, you can 
control some settings for each frame (see “Model Settings with Multiple Frames” on 
page 186 of the COMSOL Multiphysics User’s Guide). In particular, you can select 
the order of the shape functions that describe the moving mesh. This order must agree 
with the element order you choose in the Subdomain Settings dialog box for the 
deformed mesh application mode (see “Subdomain Settings” on page 455). The 
default choice Automatic takes care of this.

Frame Selection for Coupling Variables

If you work with coupling variables, periodic conditions, or identity conditions when 
you have multiple frames, you need to select the appropriate frame in the 
corresponding dialog boxes. See “Integrating on a Deformed Mesh” on page 271 of 
the COMSOL Multiphysics User’s Guide for details.
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Th e  Mov i n g  Me s h  App l i c a t i o n  Mode

With the Moving Mesh (ALE) application mode you can create models where the 
geometry (actually the mesh) changes shape due to some physics in the model. You 
can study both static and time-dependent deformations where the geometry changes 
its shape due to the dynamics of the problem.

Subdomain Settings

The Subdomain Settings dialog box in this application mode contains properties 
pertaining to the moving mesh.

Figure 16-7: The Subdomain Settings dialog box of the Moving Mesh application mode.

On the Mesh tab you can specify how the software computes the mesh displacement in 
each subdomain. The available options are:

• Free displacement. This is the default setting, and it means that the mesh 
displacement is constrained only by the boundary conditions on the surrounding 
boundaries. The displacement in the subdomain is obtained by solving a PDE (see 
“Smoothing Methods” on page 458).

• Physics induced displacement. Use this option when another application mode 
calculates the displacement. Normally that other application mode is a structural 
mechanics application mode, and the displacement variables to enter in the edit 
fields are the dependent variables of the structural mechanics application mode. In 
other words, a Lagrangian method is used where the mesh movement follows the 
material motion. The contents of the edit fields for the displacement variables must 
be a single dependent variable discretized with Lagrange shape functions. The order 
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of these shape functions must be compatible with the order chosen on the Element 
tab.

• Prescribed displacement. Use this when expressions define the displacement. These 
should not depend on variables that the model solves. If they do, this dependence 
does not contribute to the Jacobian matrix, which can cause convergence 
difficulties. This is useful, for example, in axisymmetric structural models, where the 
dependent variable represents u/r rather than the displacement u itself, which you 
have access to as an expression variable.

• No displacement. The mesh is not deformed at all.

The physics-induced displacement and prescribed displacement might seem very 
similar because they both require that you enter the displacements as expressions. The 
difference is that you can use the physics-induced displacement only when the 
displacement is equal to the dependent variables of an application mode. You cannot 
use it for general expressions. The prescribed displacement, on the other hand, assumes 
that the expressions are functions of variables whose values are known (the reference 
coordinates, for instance).

On the Init tab you can give initial values for the mesh positions x, y, and z (if the 
Laplace smoothing method is used), or the mesh displacements dx, dy, and dz (if the 
Winslow smoothing method is used).

On the Element tab you can select the order of the Lagrange shape functions that 
define the mesh positions x, y, and z (if the Laplace smoothing method is used), or the 
mesh displacements dx, dy, and dz (if the Winslow smoothing method is used). The 
shape functions are only used on subdomains where Free displacement has been 
selected. You can also select the Integration order and Constraint order used when 
discretizing the PDE for the mesh movement and its boundary conditions.
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Boundary Conditions

At the boundaries you can set constraints on the mesh displacement or, in the transient 
case, on the mesh velocity. You can set constraints on the exterior boundaries of the 
subdomains where you use free displacement.

Figure 16-8: Boundary Settings dialog box of the Moving Mesh application mode.

If you want to constrain a certain displacement component, select its check box and 
enter a expression in the Mesh displacement edit field. If the check box is not selected, 
the boundary gets a Neumann boundary condition. You can also select in which 
coordinate system the displacement is specified.

For example, if you have a free boundary, it is appropriate to constrain the normal 
component of the mesh velocity to be equal to the normal component of the material 
velocity. You can do this by selecting the Tangent and normal coordinate system, 
entering the expression nx*u+ny*v for the normal velocity, and using a Neumann 
condition on the tangential velocity. This setup allows the mesh to slip relative to the 
material along the boundary, which improves mesh quality. Note that (nx, ny) denotes 
the normal of the deformed mesh, while (nX, nY) denotes the normal of the 
undeformed mesh. Similar naming conventions hold for other geometric variables, see 
“Geometric Variables” on page 170 of the COMSOL Multiphysics User’s Guide.

If the boundary condition involves variables from another application mode (like in the 
free boundary condition), the usual pointwise constraints or ideal weak constraints 
make unwanted modifications of the boundary condition for the other application 
mode. For this reason, the Moving Mesh (ALE) application mode uses non-ideal weak 
constraints by default.
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It is important that the boundary conditions are consistent with the settings in the 
adjacent subdomains. If the subdomain settings define a certain displacement, the 
boundary must be displaced in the same way.

Smoothing Methods

In the domains with free displacement, the Moving Mesh (ALE) application mode 
solves an equation for the mesh displacement. This equation smoothly deforms the 
mesh given the constraints you place on the boundaries. You can choose between 
Laplace smoothing and Winslow smoothing. To specify the smoothing methods, use 
the Application Mode Properties dialog box, which you access from the Multiphysics area 
in the Model Navigator or from the Physics menu.

To see how these smoothing methods differ, let x and y be the spatial coordinates of 
the frame which the application mode defines, and let X and Y be the reference 
coordinates of the reference frame. If you choose Laplace smoothing, the software 
introduces deformed mesh positions x and y as degrees of freedom in the model. In 
the static case, it solves the equation

and in the transient case it solves the equation

Similar equations hold for the y coordinate.

If you choose Winslow smoothing, the software solves the equation

and does the same for Y. Equivalently, X and Y satisfy Laplace equations as functions 
of the x and y coordinates.

Remeshing

If the mesh displacement becomes large, the mesh elements eventually have a very bad 
quality or even become inverted. Depending on the specific model, either smoothing 
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technique may do a better job avoiding inverted mesh elements. Once a mesh element 
becomes inverted, it is no longer possible to solve any other equation on that frame. 
This section describes how to remesh the geometry when this happens and how to 
continue solving.

E N A B L I N G  R E M E S H I N G

You enable the remeshing support in the Moving Mesh (ALE) application mode in the 
Application Mode Properties dialog box. Set the property Allow remeshing to On. You 
must make this selection before solving the model. If you attempt to solve it and later 
realize that you need to remesh while remeshing support is not activate, you must go 
back, activate it, and re-solve the model.

F R A M E S  W H E N  U S I N G  R E M E S H I N G

When you set the application mode property Allow remeshing to On, the software adds 
an extra frame. The three frames are now:

• The spatial frame, usually denoted by ale or pg (the name of the application mode 
controlling the deformed mesh). This is the usual coordinate system. The 
corresponding coordinates are called x and y by default.

• The reference frame, usually denoted by ref. This coordinate system describes the 
original configuration (before remeshing). The corresponding coordinates are 
called X and Y by default. If the mesh movement follows the material movement (as 
is common in solid mechanics), this frame is also called the material frame. In this 
case, X and Y are the coordinates of the material point in the original configuration. 
The software stores the values of X and Y for all nodes as degrees of freedom in the 
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solution vector but never solves for them. Their values only change when mapping 
the solution, which happens when you click the Restart button after a remeshing.

• The mesh frame, usually denoted by mesh. This coordinate system describes the 
configuration just after the latest remeshing. The corresponding coordinates are 
called Xm and Ym by default.

The guidelines on page 453 regarding which frame to attach the physics application 
modes to still apply. Note that no physics application mode should be attached to the 
mesh frame. In the Model Navigator the mesh frame is associated with the geometry and 
the reference frame is a separate node. This differs from the case without remeshing 
where the reference frame was associated with the geometry.

S T O P  C O N D I T I O N

To make the solver stop when the mesh quality is poor you need to activate a stop 
condition in the Solver Parameters dialog box. Such a stop condition exists for the 
time-dependent solver and the parametric solver.

The solver halts when the expression in the Stop condition edit field becomes negative. 
The default value for the stop condition is minqual1_ale-0.05. The Moving Mesh 
(ALE) application mode defines the variable minqual1_ale, which represents the 
minimum quality of the deformed mesh. The variable name begins with minqual 
followed by the geometry number. This nomenclature creates unique variables in the 
case where a model has multiple geometries. For models with one geometry this 
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number is 1, resulting in minqual1. The variable name for the minimum quality ends 
with an underscore (_) followed by the name of the frame for the deformed mesh. In 
this case, the name of that frame is ale, which means that the name of the quality 
variable becomes minqual1_ale. To find the name of the frame, open the Model 

Navigator and see to which frame the Moving Mesh (ALE) application mode is 
attached. You can also look in the Application Mode Properties dialog box. The Defines 

frame property gives the name of the frame of the deformed mesh.

The default stop condition makes the solver stop when the minimum quality is less 
than 0.05. Depending on the initial quality of the mesh, you might have to change this 
number.

If the model has more than one geometry with a deformed mesh, the stop condition 
uses the minimum quality of all the geometries. In a model with two geometries, use 
the stop condition min(minqual1_ale,minqual2_ale)-0.05.

R E M E S H I N G  S T E P  B Y  S T E P

To solve using remeshing of a deformed mesh follow these steps:
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1 Activate the remeshing support in the application mode by setting the property 
Allow Remeshing to On in the Application Mode Properties dialog box.

2 Specify the stop condition in the Solver Parameters dialog box.

3 Solve. If the solver stops before is has reached the final time continue with the next 
step below.

4 Next you need to create a new geometry from the deformed mesh. From the Mesh 
menu, open the Create Geometry From Mesh dialog box. Click the Deformed Mesh 
option button to use the deformed mesh as the source for the new geometry. You 
can choose at which time to pick the mesh but in general use the last one.

5 Mesh the new geometry just created. This mesh gets a better quality than the 
previous deformed mesh.

6 In the Solver Parameters dialog box change the initial time (or the first parameter 
value if you are using the parametric solver) to the last value that the solver reached.

7 Click the Restart button to continue solving. This uses the previous solution as the 
initial value and thus continue solving where the solver had stopped.

8 If the solver again stops before the final time go to Step 4 again.

R E M E S H I N G — A  S I M P L E  E X A M P L E

This section describes the remeshing technique by building a simple model where a 
force bends a beam.

1 In the Model Navigator, select 2D from the Space dimension list.

2 In the COMSOL Multiphysics folder, select Deformed Mesh>Moving Mesh (ALE)> 

Transient analysis.
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3 Click the Multiphysics button and then click the Add button to add the Moving Mesh 
application mode to the model.

4 In the list of application modes, select Structural Mechanics>Plane Stress>Transient 

analysis. In the Multiphysics area select the node Geom1 (2D). Then click Add to add 
the Plane Stress application mode.

5 Click OK to close the Model Navigator.

Geometry Modeling
1 Draw a rectangle with a width of 1.6, height of 1.2, and with its lower left corner at 

(−0.6, −0.4).

2 Draw a second rectangle with a width of 1.4, height of 0.2, and its lower left corner 
at (−0.6, −0.2).

Physics Settings
1 In the Subdomain Settings dialog box of the Plane Stress application mode clear the 

Active in this domain check box for Subdomain 1 (the air).

2 You also need to add some damping to stabilize the transient solution. To do so, 
select Subdomain 2 (the beam), and then click the Damping tab.

3 Select Rayleigh from the Damping list.

4 Type 1 in the αdM edit field and 0.001 in the βdK edit field.

5 Click OK to close the dialog box.

6 In the Boundary Settings dialog box select Boundary 3 and activate the constraints 
Rx and Ry by selecting the corresponding check boxes. Go to the Load page and 
select Boundaries 4, 6, and 8. Enter a force that increases with time by setting Fy to 
-1[MN/m/s]*t. Click OK to close the dialog box.

7 From the Multiphysics menu, select the Moving Mesh (ALE) (ale) application mode.

8 In the Subdomain Settings dialog box of the Moving Mesh application mode select 
Subdomain 2 and click the Physics induced displacement button. Enter the 
displacement variables u and v in the dx and dy edit fields. Click OK to close the 
dialog box.

9 In the Boundary Settings dialog box select Boundaries 4, 6, and 8. Select the dx and 
dy check boxes and then enter the mesh displacement u and v in the corresponding 
edit fields.

10 Select Boundaries 1, 2, 5, 7, and 9. Select the dx and dy check boxes and leave the 
mesh displacements at their default zero values to prevent these boundaries from 
moving. Click OK to close the dialog box.
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Note: To obtain a correct solution, you should use the support for large 
deformations in the Plane Stress application mode, but that feature is available only in 
the extended Plane Stress application mode in the Structural Mechanics and MEMS 
modules.

The next step is to activate support for remeshing in the Moving Mesh application mode:

1 Open the Application Mode Properties dialog box by selecting Properties from the 
Physics menu.

2 Select On from the Allow remeshing list, then click OK.

You must make this selection before solving the model. If you attempt to solve it and 
later realize that you need to remesh while remeshing support is not activate, go back, 
activate it, and then re-solve the model.

Mesh Generation
1 Initialize the mesh.

2 Refine it once.

Computing the Solution
To make the solver stop when the mesh quality becomes poor, first enable a stop 
condition in the Solver Parameters dialog box.

1 From the Solve menu open the Solver Parameters dialog box. In the Times edit field 
enter range(0,0.01,0.3).
 1 6 :  D E F O R M E D  M E S H E S



2 Go to the Time Stepping page and select the Use stop condition check box.

3 Click OK to close the Solver Parameters dialog box and then click the Solve button 
on the Main toolbar.

The solver stops somewhere around t = 0.12.

Geometry Modeling
Next you need to create a new geometry and mesh from the deformed mesh.

1 From the Mesh menu open the Create Geometry From Mesh dialog box.
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2 Click the Deformed mesh button, then click OK.

This creates a new geometry from the deformed mesh at the last time step.

Mesh Generation
Using buttons on the Main toolbar, initialize the mesh and refine it once. This creates 
a new mesh with higher quality for the deformed geometry.

Computing the Solution
1 Open the Solve>Solver Parameters dialog box and on the General page change the 

list of times in the Times edit field to start from the last time of the current solution. 
Generally when solving time-dependent problems this is not absolutely necessary, 
but in this case it is important because the force in the Plane Stress application mode 
depends on time explicitly.

2 When you continue solving the model, it is important to use the solution from the 
last time step as the new initial value when restarting the solver. Do this by clicking 
the Restart button on the Main toolbar.
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The solver continues solving and stops when the mesh quality again becomes poor.

PO S T P R O C E S S I N G

To postprocess the two parts of the simulation together, you can export the FEM 
structure to the command line after each part of the simulation. Use 
File>Export>Export FEM Structure to save each FEM structure with a new name. Then 
use the ability of the postmovie command to postprocess several FEM structures.

R E S T O R I N G  T H E  O R I G I N A L  G E O M E T R Y

Assume you want to go back and restart the solver from the very beginning. In this 
case you first must restore the original geometry. To do so, go to the Draw mode. 
Because you have generated a deformed geometry, the objects in Draw mode do not 
represent the current geometry. The software therefore asks if you want to use the 
current objects in Draw mode or replace them with the deformed geometry (see 
“Entering Draw Mode” on page 36 in the COMSOL Multiphysics User’s Guide). 
Using the current Draw mode objects restores the original geometry.
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Examp l e—El e c t r o c h em i c a l  Po l i s h i n g

Introduction

This example illustrates the principle of electrochemical polishing. The simplified 2D 
model geometry consists of two electrodes and an intermediate electrolyte domain 
The positive electrode has a protrusion, representing a surface defect. The purpose of 
the model is to examine how this protrusion and the surrounding electrode material 
are depleted over a period of time.

Model Definition

The potential drop over the electrodes is 30 V, and the electrolyte has a conductivity 
of 10 S/m.

Modeling the depletion of the positive electrode requires a moving boundary because 
the geometry changes and the current density distribution with it. A simple model for 
the depletion is based on the assumption that the depletion rate is proportional to the 
normal current density at the electrode surface. The velocity, U, normal to the mesh 
at the electrode surface then becomes

where K is the coefficient of proportionality, and Jn is the normal current density. In 
this model, K = 10−11 m3/As.

Electrode Material

Electrode Material

30 V

Ground (0 V)

Electrolyte

U KJn–=
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The part of the electrode and electrolyte that the model includes is about 3 mm wide 
and the distance between the electrodes is 0.4 mm.

Modeling in COMSOL Multiphysics

This model uses the Conductive Media DC and transient Moving Mesh (ALE) 
application modes. The variable for the normal current density defines the mesh 
velocity. The dynamics of the model is quasi-static in nature, and the time dependence 
only enters in the depletion (removal of material) of the electrode.

Results

After 10 s, the protrusion is somewhat smoothed out, and a significant portion of the 
positive electrode has been depleted:

Model Library path: COMSOL_Multiphysics/Electromagnetics/
electrochemical_polishing
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Modeling Using the Graphical User Interface

M O D E L  N A V I G A T O R

1 Select 2D in the Space dimension list. (This model can easily be generalized to 3D.)

2 In the application mode list, open COMSOL Multiphysics>Deformed Mesh and then 
Moving Mesh (ALE)>Transient analysis.

3 Click the Multiphysics button and then the Add button.

4 In the application mode list, open 
COMSOL Multiphysics>Electromagnetics>Conductive Media DC.

5 Click the Add button. This adds the Conductive Media DC application mode to the 
moving mesh frame.

6 Click OK to close the Model Navigator.

O P T I O N S

1 From the Options menu, open the Constants dialog box.

2 Enter a constant with the name K, the expression 1e-11[m^3/(A*s)], and the 
description Coefficient of proportionality (the description is optional).

3 Click OK to close the Constants dialog box.

G E O M E T R Y  M O D E L I N G

1 Click the Rectangle/Square button on the Draw toolbar, and draw a rectangle with 
corners at x = −1.4, y = 0 and x = +1.4, y = 0.4.

2 Shift-click the Ellipse/Circle (Centered) button.

3 In the Circle dialog box, type 0.3 in the Radius edit field and set the center 
coordinates to (0, 0.6) by typing 0 in the X edit field and 0.6 in the Y edit field.

4 Click OK.

5 Select both objects by using the keyboard shortcut Ctrl+A. Both objects are now 
highlighted in red.

6 Click the Difference button on the Draw toolbar to remove the circle object from the 
rectangle. This creates the protruding part of the electrode.

7 The model needs to be the order of mm and not m. Click to select the object and 
then click the Scale button on the Draw toolbar.

8 Enter a scale factor of 10−3 by typing 1e-3 in both the X and Y edit fields in the Scale 
factor area. Click OK.

9 Click the Zoom Extents button on the Main toolbar.
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The geometry is now ready.

P H Y S I C S  S E T T I N G S

Subdomain Settings—Conductive Media DC
1 From the Multiphysics menu, select the Conductive Media DC application mode.

2 From the Physics menu, select Subdomain Settings.

3 In the Subdomain Settings dialog box, select Subdomain 1 (the only one) and type 
10 in the Electric conductivity edit field.

4 Click OK to close the Subdomain Settings dialog box.

Boundary Settings—Conductive Media DC
1 From the Physics menu, select Boundary Settings.

2 For Boundaries 3, 4, 6, and 7, select the Electric potential in the Boundary condition 
list and type 30 in the Electric potential edit field.

3 For Boundaries 1 and 5, select Electric insulation in the Boundary condition list. 
Electric insulation is a good approximation if you want to simulate that the 
electrodes are extended indefinitely in both directions.

4 For Boundary 2, select Ground as the boundary condition.

5 Click OK to close the Boundary Settings dialog box.

Boundary Settings—Moving Mesh (ALE)
1 From the Multiphysics menu, select the Moving Mesh (ALE) application mode.

2 From the Physics menu, select Boundary Settings.

3 In the Boundary Settings dialog box, for boundary 2, click the Mesh displacement 
button and set the mesh displacement in both directions to 0 by selecting the dx and 
dy check boxes.

4 For Boundaries 1 and 5, click the Mesh velocity button and set the mesh velocity, in 
the x direction to 0 by selecting the vx check box.

5 Select Boundaries 3, 4, 6, and 7, and select Tangent and normal coord. sys. in 

deformed mesh in the Coordinate system list. Click the Mesh velocity button. Then 
select the vn check box and type -K*nJ_dc in the Mesh velocity, n direction edit field. 
This makes the normal mesh velocity equal to −K Jn (nJ_dc is the variable for the 
current density outflow from the Conductive Media DC application mode).

6 Click OK.
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M E S H  G E N E R A T I O N

1 Click the Initialize Mesh button on the Main toolbar.

2 Click the Refine Mesh button on the Main toolbar once.

C O M P U T I N G  T H E  S O L U T I O N

1 From the Solve menu, select Solver Parameters.

2 In the Time stepping area, type range(0,10) for Times. This defines a simulation 
that runs from 0 to 10 s in steps of 1 s.

3 Click OK to close the Solver Parameters dialog box.

4 Click the Solve button (equal sign) on the Main toolbar to solve the model (or 
choose Solve Problem from the Solve menu).

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N

The default plot shows the x-displacement for the moving mesh. Change the 
visualization settings to plot the current density distribution:

1 From the Postprocessing menu, select Plot Parameters.

2 On the Surface page, select Conductive Media DC (dc)>Total current density, norm 

from the Predefined quantities list.
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3 Click OK to plot.

The maximum current density appears to be of the order of 106 A/m2. To see the 
magnitude of the depletion in the y direction more easily, plot the ALE-displacement 
variable dy:

1 From the Postprocessing menu, select Plot Parameters.

2 On the Surface page, type dy_ale in the Expression edit field.

3 Click OK to plot.
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The maximum value for the y-displacement is approximately 10−4 m (or 0.1 mm).

You can now compare this with an approximate formula for the total depletion 
increment, d:

This shows that the approximate formula (which does not take effects from the curved 
boundary into account) is in fact very accurate.

d U ∆t K Jn ∆t 10 11–  m
3

As
-------⎝ ⎠

⎛ ⎞ 106 A
m
-----⎝ ⎠

⎛ ⎞ 101s( )⋅ ⋅ 10 4–  m= = = =
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Th e  Pa r ame t e r i z e d  Geome t r y  
App l i c a t i o n  Mode

Using the Parameterized Geometry application mode you can study how the physics 
changes when the geometry changes as a function of a parameter. The geometry 
cannot change dynamically. Rather you have a series of fixed geometries of different 
shapes. The Parameterized Geometry application mode is available for 2D geometries.

The Parameterized Geometry application mode uses the same technique to calculate 
the mesh displacement as the Moving Mesh (ALE) application mode. The difference 
between the two application modes is the available settings on subdomains and 
boundaries.

See also the “The Moving Mesh Application Mode” on page 455 for more 
information about deformed meshes. The sections about frames, smoothing methods, 
and remeshing also applies to the Parameterized Geometry application mode.

Subdomain Settings

The Subdomain Settings dialog box in this application mode contains properties for the 
mesh displacement.

Figure 16-9: The Subdomain Settings dialog box of the Parameterized Geometry 
application mode.
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On the Mesh page you can specify how the displacement of the mesh is computed in 
each subdomain. The available options are:

• Free displacement. The default value. Use this option in domains that change their 
shapes as a function of the geometrical parameter. The mesh displacement is 
constrained only by the boundary conditions on the surrounding boundaries. The 
software obtains the displacement in the subdomain by solving Winslow’s 
smoothing PDE (see “Smoothing Methods” on page 458).

• No displacement. Use this in domains that are not affected by the geometrical 
parameter.

The Init and Element pages in the same as in the Moving Mesh (ALE) application mode 
(see “Subdomain Settings” on page 455).

Boundary Conditions

To set the boundary conditions, use the Boundary Settings dialog box.

Figure 16-10: The Boundary Settings dialog box of the Parameterized Geometry 
application mode.

The boundary conditions in this application mode fall into three categories:

• Prescribed displacement. Choose this option to define the displacement as an 
expression.

• Linear displacement. Choose this option when you have prescribed the displacement 
of the boundary’s end points. The linear displacement then ensures that you get a 
smooth deformation of the mesh between the end points. The displacement can be 
a linear function of X, Y, the curve parameter s, the angular coordinate , or the 
radial coordinate r (the latter two are only available when you select Polar 

ϕ
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coordinates). For example, if you choose the displacement dx = x − X to be 
Linear in X, then the software imposes the constraint

along the boundary, where dx = dx1 at one end point X = X1 and dx = dx2 at the 
other end point X = X2.

• Free. Choose this option if you want the boundary to move freely without any 
constraint on the displacement.

• Similarity transformation. Choose this option when you have prescribed the 
displacements of the boundary’s end points. The software translates, rotates, and 
scales the boundary so that the constraints at the end points are satisfied. If dx and 
dy are the displacements in the x and y directions, dx1 and dy1 are the values at X 
= X1, and dx2 and dy2 the values at X = X2, then the similarity transformation is

For the prescribed and linear-displacement boundary conditions, you can choose 
condition on the two displacement components independently.

In the Coordinate system list you choose the coordinate system for the mesh 
displacements in the prescribed and linear-displacement boundary conditions:

• Cartesian coordinates. Choose this option to specify conditions on the Cartesian 
mesh displacements dx = x − X and dy = y − Y.

• Polar coordinates. Choose this option to specify the center point (x0, y0) of a polar 
coordinate system with radial coordinate R and angular coordinate Φ. You can also 
specify an angle from the x-axis where the angular coordinate will be discontinuous. 
This makes it possible to specify conditions on the radial displacement dr = r − R 
and the angular displacement , where r and  are the values of the 
polar coordinates in the deformed configuration.

• Tangent and normal coordinate system in reference mesh. Choose this option to 
specify conditions on the displacements tangential and normal to the reference 
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boundary. That is, you can specify conditions on the tangential displacement 
tX*dx+tY*dy and the normal displacement nX*dx+nY*dy.

• Tangent and normal coordinate system in deformed mesh. Choose this option to 
specify conditions on the displacements tangential and normal to the deformed 
boundary. That is, you can specify conditions on the tangential displacement 
tx*dx+ty*dy and the normal displacement nx*dx+ny*dy.

Point Settings

In the Point Settings dialog box it is possible to constrain the displacement of points in 
the geometry. You can choose to specify the displacements in Cartesian or polar 
coordinates.
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Re t r i e v i n g  t h e  De f o rmed Me s h

You can retrieve a deformed mesh by selecting Create Geometry From Mesh from the 
Mesh menu.

Figure 16-11: The Create Geometry From Mesh dialog box.

To retrieve a deformed mesh, select Deformed Mesh in the Source frame. The Frame and 
Parameter value or Solution at time drop-down lists let you select which source frame 
and solution to retrieve the deformed mesh from.

In the Destination frame you can select if you want to create a mesh and an analyzed 
geometry or a mesh, an analyzed geometry and a Draw mode object from the 
deformed mesh. Use the Generate in drop-down list to select which geometry to put 
the deformed mesh in.

In the Max angle between elements in planar face edit field you specify the maximum 
allowed angle between two boundary elements to be part of the same planar face. This 
parameter is only available if the mesh was initially imported and has no 
parametrization.
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L im i t a t i o n s  o f  t h e  De f o rmed Me s h  
F e a t u r e

The following limitations apply to the deformed mesh feature:

• The connectivity of the mesh remains unchanged during the mesh deformation, 
which means that topological changes in the geometry are not allowed.

• When the mesh deformation becomes large, the quality of the mesh can deteriorate. 
If this happens, the solver runs into convergence problems. Sometimes you see the 
warning Inverted mesh element in the Progress window for the solver, which means 
that a mesh element has (partially) warped inside-out. Use a smaller mesh 
deformation if you get these problems.

• If you work with finite elements of types other than Lagrange, solving for the mesh 
deformation coupled to the non-Lagrange elements can result in convergence 
problems. However, solving first for the mesh deformation and then for the physics 
in a one-way coupled fashion works. The reason for this is that if u is discretized with 
non-Lagrange elements, first-order spatial derivatives like ux does not give a 
contribution to the Jacobian matrix from the dependence on the mesh motion. 
Moreover, second-order spatial derivatives never make such Jacobian contributions.

• Solving time-dependent wave equations on a moving mesh does not work, because 
the formula for the second-order spatial time derivative utt in terms of reference 
time derivatives is not implemented.

• When using second-order (or higher-order) elements in the deformed mesh 
application modes, the mesh moving techniques often produce elements with 
distorted shapes. The measure of mesh quality does not capture these distorted 
shapes because it is computed from the positions of the corners of the mesh element 
(ignoring mid-side nodes, for instance). For these reasons, it is often best to use 
linear elements for the mesh positions in the deformed mesh application modes. You 
can select element type on the Element tab in the Subdomain Settings dialog box for 
the Moving Mesh (ALE) and Parameterized Geometry application modes. You 
must also open the Model Settings dialog box from the Physics menu and select the 
ALE frame (typically Frame (ale)) in the Frames list and select the appropriate 
element order (typically Linear) in the Geometry shape order list.
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S t a b i l i z a t i o n  T e c h n i q u e s
Numerical solutions of transport equations can sometimes exhibit oscillations 
even when the exact solutions are smooth. These spurious oscillations are caused 
by numerical instabilities.

The first section of this chapter describes when spurious oscillations can arise. To 
restore numerical stability COMSOL Multiphysics provides a set of stabilization 
techniques, which are described in the second section.

This chapter does not contain description of the user interface which is instead 
described in conjunction with each application mode that supports any stabilization 
technique.
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Nume r i c a l  S t a b i l i z a t i o n

This chapter discusses the numerical stability of the generic scalar convection-diffusion 
transport equation

 (17-1)

where β is the convective velocity vector, c is the diffusion coefficient, u is a transported 
scalar, and F is a source term. The underlying finite element discretization method in 
COMSOL Multiphysics is the Galerkin method. When discretizing Equation 17-1 
using the Galerkin Method, it is well known that the resulting numerical problem 
becomes unstable for an element Péclet number (Pe) larger than one (Ref. 1):

 (17-2)

where h is the mesh element size. The Péclet number is a measure of the relative 
importance of the convective effects compared to the diffusive effects; a large Péclet 
number indicates that the convective effects dominate over the diffusive effects.

Oscillations can occur where any of the following conditions exist and the Péclet 
number exceeds one:

• A Dirichlet boundary condition can lead to a solution containing a steep gradient 
near the boundary, forming a boundary layer. If the mesh cannot resolve the 
boundary layer, this creates a local disturbance. 

• A space-dependent initial condition that the mesh does not resolve can cause a local 
initial disturbance that propagates through the computational domain.

• A small initial diffusion term close to a non-constant source term or a non-constant 
Dirichlet boundary condition can result in a local disturbance.

As long as diffusion is present, there is—at least in theory—a mesh resolution beyond 
which the discretization is stable. This means that the spurious oscillations can be 
removed by refining the mesh. In practice, this method is seldom feasible because it 
can require a very dense mesh. Instead, it is common practice to use stabilization 
methods, that is, methods that adds artificial diffusion. COMSOL Multiphysics 
provides several of these methods and they are described in the next section.

u∂
t∂

------ β ∇u⋅+ ∇ c∇u( ) F+⋅=

Pe β h
2c

------------ 1>=
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Stabilization—An Example

To illustrate the concepts of this chapter, consider the problem

 (17-3)

solved on the unit square. Equation 17-3 is discretized using 10 times 10 biquadratic 
Lagrangian elements. The boundary conditions are:

• u = 1 for x = 0

• u = 1 for y = 0

• u = 0 for x = 1

• u = 0 for y = 1

Figure 17-1 shows the mesh and boundary conditions. In general, using uniform 
meshes for transport problems is not recommended. Nevertheless, this example uses a 
uniform mesh to demonstrate the different stabilization techniques.

Figure 17-1: The computation domain, mesh and boundary condition for Equation 17-3.
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The expected solution rises slowly and smoothly from the left and lower boundaries, 
and has sharp boundary layers along the upper and right boundaries. Figure 17-2 
shows a reference solution obtained using 100-by-100 biquadratic Lagrangian 
elements, Galerkin least-squares, and crosswind diffusion (see the next section). The 
arrows indicate the direction of β.

Figure 17-2: Reference solution of Equation 17-3. Solved using 100 times 100 biquadratic 
elements, GLS, and crosswind diffusion.

The cell Péclet number for this example is

Figure 17-3 displays the solution obtained using the mesh shown in Figure 17-1 and 
(unstabilized) Galerkin discretization. As can be expected with such a high Péclet 
number, the unstabilized solution shows little, if any, resemblance to the reference 
solution in Figure 17-2. The right plot in Figure 17-3 shows a cross-sectional plot 

Pe 1 0.1⋅
2 10 4–⋅
------------------- 500>>1= =
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along the dashed line, y = 0.8 and the corresponding reference solution. Notice that 
the unstabilized solution is completely destroyed by oscillations.

Figure 17-3: Equation 17-3 solved using unstabilized Galerkin formulation. The right 
plot compares the unstabilized solution (dashed line) along the dashed line in the left 
plot(y = 0.8) with the reference solution (solid line).

The next section explores how different stabilization techniques affect the solution of 
this example.

Note: The example uses the General Heat Transfer application mode in the Heat 
Transfer Module.
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A r t i f i c i a l  D i f f u s i o n  T yp e s

Several techniques for handling numerical instabilities without the need for mesh 
refinement are available. They all have in common that they add terms to the transport 
equation. These terms introduce artificial diffusion (artificial viscosity or numerical 
diffusion/viscosity are also common names) that stabilize the solution. The 
stabilization methods in COMSOL Multiphysics are described below.

Isotropic Diffusion

Adding isotropic diffusion is equivalent to adding a term,

,

to the physical diffusion coefficient, c. Here, δid is a tuning parameter. This means that 
you do not solve the original problem, Equation 17-1, but rather, the modified O(h) 
perturbed problem

With the default value of δid = 0.5, the new cell Péclet number can be expressed as

Clearly, as ||β|| approaches infinity, Pe approaches, but never exceeds, one. 

While a solution obtained with isotropic diffusion might not be satisfactory in all cases, 
the added diffusion definitely dampens the effects of oscillations and impedes their 
propagation to other parts of the system. It is not always necessary to set δid as high as 
0.5 to get a smooth solution, and it should be chosen smaller if possible.

cart δidh β=

u∂
t∂

------ β ∇u⋅+ ∇ c cart+( )∇u( ) F+⋅=

Pe h β
2 c cart+( )
--------------------------- h β

2c h β+
------------------------= =
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Figure 17-4 shows the effect of isotropic diffusion on Equation 17-3 with δid = 0.5. 
Although the solution is smooth, the comparison with the reference solution in the 
right plot reveals that the isotropic diffusion introduces far too much diffusion.

Figure 17-4: Equation 17-3 solved using isotropic diffusion. The right plot compares the 
stabilized solution (dashed line) along y = 0.8 with the reference solution (solid line).

Streamline Diffusion

Most application modes that support streamline diffusion support one or several of the 
following three types:

• Anisotropic diffusion

• Streamline upwind Petrov-Galerkin (SUPG)

• Galerkin least-squares (GLS)

The rest of this section describes each of these methods. For theoretical details, see Ref. 
1 and Ref. 2.

A N I S O T R O P I C  D I F F U S I O N

Anisotropic diffusion is a direct refinement of the isotropic diffusion method described 
above. In many cases, there is no need for any artificial diffusion in the direction 
orthogonal to β. It is therefore possible to modify cart to a form that only adds artificial 
diffusion in the direction of the flow (the streamline direction).

The normal interpretation of the diffusivity in Equation 17-1 is as a scalar number, but 
it can in the general case be a tensor. This implies that you can also define the 
coefficient of artificial diffusion as a tensor. The natural choice is to define cart as

cart ij,
δhβiβj

β
-----------------=
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where δ is a tunable parameter that controls the amount of artificial diffusion. The 
value δ = 0.5 guarantees that the cell Péclet number measured in the streamline 
direction does not exceed one (compare to isotropic diffusion). Chose δ smaller than 
0.5 if possible. A good rule of thumb is to select δ = 0.5/p where p is the order of the 
basis functions.

Analogous to the case of isotropic artificial diffusion, a problem stabilized with 
anisotropic diffusion is not identical to the original problem. In fact, the exact solution 
to the original equations does not solve the stabilized problem. However, the errors 
introduced by the anisotropic artificial diffusion are far less serious than the ones 
created by isotropic artificial diffusion.

Figure 17-5 displays the effect of anisotropic diffusion on the solution of 
Equation 17-3 with δ = 0.25. The stabilized solution curve closely follows the 
reference solution up to the sharp boundary layers where oscillations occur. Choosing 
higher values of δ gives a smoother solution. For this simple example, it is possible to 
get very close to the solution obtained using SUPG by selecting δ = 0.5. In general, 
anisotropic streamline diffusion can at best give solutions close to those obtained by 
SUPG, but never better.

Figure 17-5: Equation 17-3 solved using anisotropic diffusion. The right plot compares the 
stabilized solution (dashed line) along y = 0.8 with the reference solution (solid line).

S T R E A M L I N E  U P W I N D  P E T R OV - G A L E R K I N  ( S U P G )

The Streamline upwind Petrov-Galerkin method is a consistent method, which means 
that it does not perturb the original transport equation (Equation 17-1). A model that 
converges with this method can be considered to be a solution to the discrete 
counterpart of Equation 17-1. It is closely related to upwinding schemes in finite 
difference and finite volume methods.
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SUPG can be shown to add a smaller amount of stability than anisotropic diffusion (see 
Ref. 3). But while the accuracy of anisotropic diffusion is at best O(h), the accuracy of 
SUPG can be shown to be at least O(hp+1/2) where p≥1 is the order of the basis 
functions.

Compared to Galerkin least-squares (GLS), SUPG is, on the one hand, less 
sophisticated and thereby less stabilizing; on the other hand, SUPG involves fewer 
discrete terms and is therefore computationally less expensive.

Figure 17-6 displays the effect of SUPG on the solution of Equation 17-3. The 
solution closely follows the reference solution away from the boundary layers, but at 
the boundary layers, oscillations occur. This is a typical behavior for streamline 
diffusion: the solution becomes smooth and exact in smooth regions but can contain 
oscillations at sharp gradients.

Figure 17-6: Equation 17-3 solved using streamline upwind Petrov-Galerkin. The right 
plot compares the stabilized solution (dashed line) along y = 0.8 with the reference solution 
(solid line).

G A L E R K I N  L E A S T - S Q U A R E S  ( G L S )

Galerkin least-squares (GLS) is a more advanced version of SUPG, with which it shares 
many features. GLS, for example, is also a consistent method and has the same order 
of accuracy as SUPG.

To understand the differences between GLS and SUPG, consider the following 
extended form of Equation 17-1:

 (17-4)

where s is a production coefficient if s > 0 and an absorption coefficient if s < 0.

u∂
t∂

------ β ∇u⋅+ ∇ c∇u( ) su F+ +⋅=
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If the order, p, of the basis functions is greater than one, GLS introduces 
superviscosity, that is, higher-order terms that provide extra stability. GLS and SUPG 
coincide if s = 0 and p = 1. If s ≠ 0, the numerical solution of Equation 17-4 is 
characterized by the Péclet number (see Equation 17-2) and the element Damköhler 
number:

A new dimensionless number can be formed by combining the Damköhler number 
and the Péclet number:

 (17-5)

The (unstabilized) Galerkin discretization becomes unstable if 2DaPe > 1 (Ref. 4), 
that is, if the production/absorption effects dominate over the viscous effects. GLS 
differs from SUPG in that GLS relaxes this requirement while SUPG does not.

While GLS is in some cases superior to SUPG, it is also computationally more 
expensive.

The effect of GLS on the example model (Equation 17-3) is almost exactly that given 
by SUPG. The difference between the methods is visible only in more advanced 
examples or if |s| >> 1.

Crosswind Diffusion

Streamline diffusion introduces artificial diffusion in the streamline direction. This is 
often enough to obtain a smooth numerical solution provided that the exact solution 
of Equation 17-1 (or Equation 17-4) does not contain any discontinuities. At sharp 
gradients, however, undershoots and overshoots can occur in the numerical solutions. 
Crosswind diffusion addresses these spurious oscillations by adding diffusion 
orthogonal to the streamline direction, that is, in the crosswind direction.

Most crosswind diffusion methods are consistent; that is, they do not alter the 
equation. The most efficient methods are nonlinear. This means that the discrete 
equation system becomes nonlinear even if the original equation (Equation 17-1 or 
Equation 17-4) is linear, which can increase the computational cost.

Da s h
β

---------=

2DaPe s h2

c
------------=
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Use crosswind diffusion if it is important to avoid undershoots or overshoots. Typical 
examples are concentrations that must not become negative and mass fractions that 
must not be greater than one.

Ref. 5 presents a comprehensive review of most of the existing crosswind diffusion 
methods.

Figure 17-7 shows the example problem (Equation 17-3) solved using SUPG and 
crosswind diffusion. Oscillations at the boundary layers are almost completely removed 
(compare with Figure 17-6), but it has been achieved by the introduction of some 
extra diffusion. In general, crosswind diffusion tries to smear out the boundary layer 
so that it becomes just wide enough to be resolved on the mesh (Figure 17-1). To 
obtain a sharper solution and remove the last oscillations, the mesh needs to be refined 
locally at the boundary layers.

Figure 17-7: Equation 17-3 solved using streamline upwind Petrov-Galerkin and 
crosswind diffusion. The right plot compares the stabilized solution (dashed line) along 
y = 0.8 with the reference solution (solid line).
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test function derivatives, meta variable 

for 274

test operator 275

thermal analysis, model examples of 188

thermal conductivity 169, 171, 173

temperature dependent 392

thermal expansion 375

thermal insulation 174

thermal-structural interaction 375

thickness 225

in plane strain models 225

in plane stress models 220

thin boundary layer 417

for convection-diffusion 55

for diffusion 48

thin highly capacitive layer 417

thin low permeability gap 417

thin structures, modeling using prism and 

brick meshes 434

thin thermally resistive layer 176, 417

thin-film resistance 422

time derivatives 448

boundary conditions with 279

meta variables for 274

TIME suffix 453

time-dependent analysis 208

time-dependent coefficient form equa-

tion 264

time-dependent general form equation

258

time-dependent problem 249, 264

in general form 264

in weak form 265

time-dependent system 249, 265

time-harmonic model 267

time-scaling coefficient

for diffusion models 47

in the heat equation 172

topology optimization, example of 326

transcendental equations 342

transient analysis 208

transient solver settings, for Navi-

er-Stokes 150

transients, avoiding 11

typographical conventions 11

U ualu boundary coupled equation varia-

ble 271

uau boundary coupled equation variable

271



ubeu boundary coupled equation varia-

ble 271

ucu boundary coupled equation variable

271

uf boundary coupled equation variable

272

uga boundary coupled equation variable

271

ultraweak variational formulation 285

UMFPACK direct solver, contiguous 

memory block for 8

unalu boundary coupled equation varia-

ble 272

unconstrained displacement 477

uncu boundary coupled equation varia-

ble 272

unga boundary coupled equation varia-

ble 272

unit-depth model. See Plane Strain appli-

cation mode

V Vanka preconditioner/smoother 150

variables

boundary coupled equation 271

for multiphysics couplings only 383

variational principle 362

vector differential operator 248

velocity, in fluids 135

viscosity

dynamic 135

shear-rate dependent 135

viscous damping 209

viscous velocity factor 151

volume force field 135, 152

volume forces 207

W wave direction cosines 27

wave equation 264, 268

wave number 29

weak constraints

applications for 350

in assembly geometries 352

in structural mechanics 211

limitations when using 353

specifying 351

weak form 5

application modes for 347, 361

definition of 360

edit fields for specifying 274

of time-dependent problem 265

theoretical background for 360

usage of 345

weak form contributions, adding 347

weak formulation vs. strong formulation

361

weak ideal constraints 358

weak non-ideal constraints 358

weak solution form 347, 348

weak terms

for implementing point sources 280

using 275

weakly coupled model 382

Winslow smoothing 458

Y Young’s modulus 206, 212
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